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Learning AutoCAD 2010 Vol-2

CHAPTER: 6 Working with Layouts

Users မ်ားအေနျဖင့္ designs မ်ားကုိ ကြဲျပားျခားနား Informations အမ်ိဳးမ်ိဳးျဖင့္ ဖန္တီး ထားၾကမည္ျဖစ္ျပီး၊ ထုိဖန္တီးထားေသာ

designs မ်ားကုိ ပုံသ႑ာန္မ်ိဳးမ်ိဳးျဖင့္ Print ထုတ္တတ္ဖို႕လည္း လိုအပ္ပါသည္။ မိမိတုိ႕ ဖန္တီးထားေသာ designs မ်ားကုိ

ေနာက္ဆုံးအဆင့္ Paper န႕ဲ Electronic media သုိ႕ေနာက္ဆံုး တင္ဆက္ရာတြင္ Layouts န႕ဲ viewports လြန္စြာ အေထာက္အကူ

ျပဳလွပါသည္။

Users မ်ားအေနျဖင့္ မိမိတို႕ ဖန္တီးထားေသာ drawings မ်ားကို dimensions နဲ႕ text မ်ားမ Add မီ Layouts န႕ဲ Viewports

တုိ႕အလုပ္လုပ္ပုံကို ေကာင္းေကာင္းနားလည္ သေဘာေပါက္ဖို႕ လုိအပ္ပါသည္။

Objectives

ဤသင္ခန္းစာကို ေလ့လာျခင္း ျပီးစီးသြားပါက -

 Data မ်ားကုိ Plot ျခင္းနွင့္ Layout အသစ္ဖန္တီးျခင္းတုိ႕ကုိ ကြဲကြဲျပားျပား သိလာေစရန္။

 Viewports မ်ားဖန္တီးျခင္းႏွင့္ အသံုးခ်ျခင္း တုိ႕ကို နားလည္းသေဘာေပါက္လာေစရန္။

Lesson: Using Layouts

ဤသင္ခန္းစာတြင္ New Layout မ်ားဖန္တီးျခင္း၊ မိမိတုိ႕ ဖန္တီးထားေသာ drawings မ်ားကို Plotting လုပ္ရန္ Environment

ကုိျပင္ဆင္ျခင္း အပိုင္းကို ေလ့လာသြားရမည္ ျဖစ္ပါသည္။ Layouts န႕ဲ Layout viewports တုိ႕ အၾကား အခ်ိန္းအေျပာင္း

လုပ္ပုံကုိလည္း ေလ့လာသြားရမည္ ျဖစ္ပါသည္။ Plotting လုပ္ျခင္း အပိုင္းသည္ မိမိတုိ႕ ဖန္တီးထားေသာ designs မ်ားထုတ္ရာတြင္

အေရးပါဆုံးေသာ အဆင့္ျဖစ္သည္။ ေအာက္ေဖာ္ျပပါ ပုံကုိတြင္ ဖန္တီးထားေသာ geomentry ကုိ model space ျဖင့္ Plot ရန္

ျပင္ဆင္ထားေသာ ပုံျဖစ္ပါသည္။
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About Layouts

Layout သည္ Drawing data မ်ားကို Output လုပ္ေသာအခ်ိန္တြင္ အသံုးျပဳေသာ Environment တစ္ခုျဖစ္ပါသည္။ Model space

တြင္ဖန္တီးထားေသာ drawing ကို layout သုိ႕ေျပာင္းျပီး၊ Plot ပါက အရည္အေသြး ပိုမို ေကာင္းမြန္ေသာ ပုံကိုရရိွလာမည္ ျဖစ္သည္။

ေအာက္ေဖာ္ျပပါပုံသည္ မည္သည့္ပုံမွ ေရးဆြဲထားျခင္း မရိွေသာ drawing layout ပုံျဖစ္ပါသည္။ Dashed lines အတြင္းမွ area သည္

Print ထုတ္ႏိုင္ေသာ area ျဖစ္ျပီး၊ rectangular viewport သည္ selected layout ျဖစ္ပါသည္။
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Defining the Layout

Layout တြင္ မိမိတို႕ Print ခ်င္ေသာ Paper size ကုိ select ႏိုင္ပါသည္။ Paper size ၏ full scale ကုိ dashed rectangle ျဖင့္

ေဖာ္ျပေပးမည္ ျဖစ္ျပီး၊ ထုိ Paper size အတြင္းမွ selected plotter ကုိ Print ထုတ္ႏိုင္မည္ ျဖစ္သည္။ Paper ၏အေနအထား

(ေဒါင္လုိက္/ အလ်ားလုိက္) ကုိလည္း မိမိတို႕ စိတ္ၾကိဳက္ ေရြးခ်ယ္ သတ္မွတ္ႏိုင္ပါသည္။ Layout ထဲမွ Paper ေပၚတြင္ model space

geomentry ကို viewport မ်ားျဖင့္ ဖန္တီးျပီး ေဖာ္ျပနိုင္ပါသည္။ Multiple viewports မ်ားဖန္တီးႏိုင္ျပီး၊ ၎တုိ႕၏ scale နဲ႕ location

ကုိလည္း စိတ္ၾကိဳက္ျပင္ဆင္ သတ္မွတ္ႏိုင္ပါသည္။

Layout မွာ save ႏိုင္ေသာ properties နဲ႕ settings တစ္ခ်ိဳ႕ကုိ ေအာက္တြင္ ေဖာ္ျပေပးလိုက္ပါသည္။

 Printer/plotter

 Paper size

 Plot area

 Plot offset

 Plot style table

 Drawing orientation

 Plot scale တုိ႕ျဖစ္ပါသည္။

Example of Layouts

Drawing sheet တစ္ခုတည္းမွာပဲ multiple scale factors ကိုအသံုးျပဳျပီး၊ layouts ျဖင့္ Plot လုပ္ႏိုင္ပါသည္။ ဥပမာ အားျဖင့္ floor

plan တစ္ခုလံုးကုိ Scale တစ္ခုတည္းျဖင့္ ျခံဳငုံၾကည့္နိုင္သလို၊ layout အတြင္းမွာပဲ ထိုပုံႏွင့္ ကပ္လ်က္တြင္ floor plan အတြင္းမွ

geomentry မ်ားကို ၎တို႕၏ မူရင္း Scale ျဖင့္ အေသးစိတ္ ထပ္မံ ၾကည့္ရႈ႕ႏိုင္ပါသည္။ ေအာက္ေဖာ္ျပပါ ပုံမွာ သာမန္ scale

ျဖင့္ေဖာ္ျပထားေသာ Floor plan ပုံအျပည့္အစုံ၊ smaller scale ျဖင့္ ေဖာ္ျပေပးေသာပုံန႕ဲ stairwell ကုိ larger scale ျဖင့္အေသးစိတ္

ေဖာ္ျပေပးထားေသာ ပုံမ်ားျဖစ္ပါသည္။
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Creating a New Layout

Template file မွ layout ေပၚတြင္မူတည္ျပီး၊ လက္ရိွေရးဆြဲေနေသာ drawing မ်ားကုိ layouts မ်ား add ႏိုင္ပါသည္။ New Layouts

မ်ား add ရန္အတြက္ Layout, New Layout (သို႕မဟုတ္) Create Layout Wizard commands မ်ားကို အသံုးျပဳႏိုင္ပါသည္။

Command Access

LAYOUT

Command Line: Layout > New

Status Bar: click to view Layout; right-click to Display Layout and Model Tabs
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Layout tab or Model tab shortcut menu: right-click ႏိွပ္ျပီး options မ်ားကို display ႏိုင္ပါသည္။

Menu Bar: Insert > Layout > New Layout

Procedure: Creating a New Layout

Drawing တြင္ New layout ဖန္တီးျခင္းကို ေအာက္တြင္ အဆင့္ဆင့္ ေဖာ္ျပေပးထားပါသည္။

၁) Model tab (သို႕မဟုတ္) layout tab တစ္ခုခုတြင္ Right – click ႏိွပ္ပါ။

၂) New Layout ကို click လုိက္ပါ။

၃) အသစ္ ဖန္တီးလုိက္ေသာ layout အတြက္ layout tab ကုိ click လိုက္ပါ။

Procedure: Creating a New Layout with the Layout Wizard

Drawing တြင္ Layout Wizard ကုိ အသုံးျပဳျပီး New layout ဖန္တီးျခင္းကုိ ေအာက္တြင္ အဆင့္ဆင့္ ေဖာ္ျပေပးထား ပါသည္။
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၁) Command line တြင္ LAYOUTWIZARD ကိုရိုက္ထည့္လုိက္ပါ။

၂) wizard screen ေရာက္ရန္ ေအာက္ပါ အဆင့္မ်ားကုိ ျဖည့္စြက္ေက်ာ္ျဖတ္ရန္ -

 Name the layout

 Select a configured plotter

 Select a paper size and its units of measurement

 Select a paper orientation

 Pick a standard title block if desired

 Define the number of viewports and their scales

 Set the location for the viewports on the paper

၃) Finish ကို click လုိက္ပါ။

 Practice Exercise: Create a New Layout

 Layout tab နဲ႕ Layout Wizard ကေန New layout ဖန္တီးပုံျခင္း လက္ေတြ႕ေလ့က်င့္ခန္းကို လုိက္ပါေလ့က်င့္ ၾကည့္ပါ။

၁) Layout (သို႕မဟုတ္) Model tab ကေန New layout ဖန္တီးရန္ -

 Layout (သို႕မဟုတ္) Model tab တြင္ Right – click ႏိွပ္ပါ။

 New layout ကုိ click လိုက္ပါ။

မွတ္ခ်က္။ ။ Tabs မွ ေထာက္လို႕မရလွ်င္၊ Status bar တြင္ရိွေသာ Display Layout and Model Tabs ကို click လုိက္ပါ။
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 New Layout tab ကို select ပါ။

 Layout setting သည္ Previous က layout ေပၚတြင္မူတည္ျပီး ေပၚလာမည္ ျဖစ္သည္။

၂) Layout Wizard ကိုအသုံးျပဳျပီး New layout ဖန္တီးရန္ -

 Command line တြင္ LAYOUTWIZARD ကိုရိုက္ထည့္လုိက္ပါ။

 New layout အတြက္ နာမည္ ရိုက္ထည့္ေပးပါ။ Floor Plan ဟုရိုက္ထည့္ေပးျပီး Next ကို click လုိက္ပါ။

 Printer အတြက္ DWG to PDF.pc3 ကို select ျပီးလွ်င္ Next ကုိ click ပါ။

 Paper Size အတြက္ ARCH D (36.00 x 24.00 Inches), Drawing units တြင္ Inches ကို select ျပီး၊ Next ကုိ click

လုိက္ပါ။

 Landscape orientation ကို select ျပီး၊ Next ကုိ click လိုက္ပါ။

 Architectural Title Block.dwg ကုိ select ျပီး၊ Next ကုိ click လိုက္ပါ။

 Viewport setup တြင္ Single ကို select ကာ Viewport scale အတြက္ 1/8" = 1'-0" ကို select လိုက္ပါ။ ျပီးလွ်င္ Next ကို

click လိုက္ပါ။

 Layout page ေပၚတြင္ Viewport ကုိေနရာ သတ္မွတ္ေပးရန္၊ Select location ကုိ click ျပီး၊ viewport window တြင္

ေအာက္ေဖာ္ျပပါ ပုံအတုိင္း Point (1) န႕ဲ Point (2) သတ္မွတ္ေပးလိုက္ပါ။

 Finish ကို click လုိက္ပါ။

Exercise: Create Layouts

ဤလက္ေတြ႕ ေလ့က်င့္ခန္းတြင္ မတူညီေသာ Layout ကို activate လုပ္ေပးရမည္ ျဖစ္သလုိ၊ Layout ႏွစ္ခုကိုလည္း ဖန္တီးသြားရမည္

ျဖစ္သည္။
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The completed exercise

၁) M_Create-Layouts.dwg ကိုဖြင့္လုိက္ပါ။

၂) Layout ကို activate လုပ္ရန္ -

 Layout1 tab ကို click ပါ။

 Layout format န႕ဲ ေဖာ္ျပေပးထားေသာ information ကုိ ျပန္လည္ ဆန္းစစ္ၾကည့္ပါ။
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မွတ္ခ်က္။ ။ Tabs မွ ေထာက္လို႕မရလွ်င္၊ Status bar တြင္ရိွေသာ Display Layout and Model Tabs ကို click လုိက္ပါ။

၃) ေနာက္ထပ္ Layout တစ္ခုကုိ Activate လုပ္ရန္ -

 Model space တြင္ ျမင္ေတြ႕ရေသာ geomentry သည္ လက္ရိွ Layout တြင္ ေဖာ္ျပပုံ၊ page size နဲ႕ orientation တုိ႕ဟာ

ကြဲျပားေနသည္ကို ေတြ႕ရမည္။

၄) New layout ဖန္တီးရန္ -

 Layout tabs တြင္ Right – click နိွပ္ပါ။

 New layout ကုိ click ပါ။
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၅) ဖန္တီးလိုက္ေသာ Layout ကုိ ျပန္လည္ဆန္းစစ္ရန္ Layout tabs 3 ကုိ click ပါ။ ထို layout တြင္ single viewport နွင့္ page

ဖြဲ႕စည္းပုံသည္ software ကို Run စဥ္ခါက သတ္မွတ္ခဲ႕ေသာ default option setting ေပၚတြင္သာ မူတည္ျပီး ေဖာ္ျပေပးမည္

ျဖစ္သည္။

၆) New layout ကုိထည့္သြင္းရန္ အတြက္ Menu bar မွ Insert > Layout > Create Layout Wizard ဟူ၍ အဆင့္ဆင့္ သြားလုိက္ပါ။

Menu Bar သည္ Invisible ျဖစ္ေနလွ်င္ turn on လုပ္လိုက္ပါ။ (သုိ႕မဟုတ္) Command line တြင္ LAYOUTWIZARD

ကိုရုိက္ထည့္လိုက္ပါ။

၇) Layout Name သတ္မွတ္ေပးရန္ -

 Layout Name Prompted ေသာအခါ Wizard Layout ဟုရိုက္ထည့္ ေပးလုိက္ပါ။

 Next ကို click လုိက္ပါ။

၈) Printer အတြက္ -

 Printer lists မွ DWG to PDF.pc3 ကုိ select လုိက္ပါ။

 Next ကို click ပါ။



“Workgroup” AotoCAD & 3ds Max Job Training Center မွ ပညာဒါန အခမ့ဲ ျဖန္႔ေ၀သည္။

( ဤစာအုပ္ကုိ ေငြေၾကးျဖင့္ ျပန္လည္ေရာင္းခ် ခြင့္မျပဳပါ )

ေအာင္ေဇာ္လတ္ {(Master of Engineering in Science and Production Engineering) Moscow State University Of Railway Engineering}

ဘာသာျပန္ ေရးသား ျပဳစုသည္။

“Workgroup “ AutoCAD & 3ds Max Training Center, International Computer Driving Licence Approved Test Center,
Rm- 403, Excel Tower, Yangon, Myanmar.

Ph: 951 559377 Ext: 6413 or 6403, Email – infor@workgroupweb.com

12

၉) Paper size ကုိသတ္မွတ္ရန္ -

 Paper size lists မွ ISO A1 (841.00 x 594.00 MM) ကို select လိုက္ပါ။

 Next ကို click ပါ။

၁၀) Paper orientation အတြက္ Landscape ကုိ select ျပီး Next ကို click လုိက္ပါ။

၁၁) Title block မပါ၀င္ေစရန္ -

 Title block lists မွ None ကို select လိုက္ပါ။

 Next ကို click ပါ။

၁၂) Viewport Scal သတ္မွတ္ေပးရန္ အတြက္ -

 Viewport setup တြင္ Single ကို select ကာ Viewport scale အတြက္ 1:50 ကုိ select လုိက္ပါ။

 Next ကို click လုိက္ပါ။
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၁၃) Layout အတြက္ Location သတ္မွတ္ေပးရန္ -

 Location ကုိ select ပါ။

 Paper အတြင္းက အေပၚဘယ္ေထာင့္ကုိ click လိုက္ပါ။

 Page ရ႕ဲေအာက္ကေန တစ္၀က္တိတိ ေအာက္ေဖာ္ျပပါ ပုံအတိုင္း click လုိက္ပါ။

 Finish ကို click လုိက္ပါ။

၁၄) Files အားလုံးကို မ Save ပဲပိတ္လိုက္ပါ။
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Lesson: Using Viewports

ဤသင္ခန္းစာမွာေတာ႕ rectangular viewport အသစ္ကို မည္သုိ႕ ဖန္တီးရမည္၊ viewport scale factor ကိုမည္သို႕ ျပင္ဆင္ေျပာင္းလဲ

သတ္မွတ္ရမည္ စသည္တုိ႕ကုိ ေလ့လာသြားရမည္ ျဖစ္ပါသည္။ Viewports သည္ Layout ကေန model space geomentry မ်ားကို

အေကာင္းဆုံး Plot ေပးႏိုင္ေအာင္ ကူညီေပးမည့္ အဓိက Key ျဖစ္ပါသည္။ Layout တစ္ခုတည္းမွာ multiple viewports မ်ားဖန္တီးျပီး၊

Scale အမ်ိဳးမ်ိဳးေသာ model geomentry မ်ားကို Page တစ္ခုတည္းတြင္ ေဖာ္ျပႏိုင္ပါသည္။

Objectives

ဤသင္ခန္းစာကို ေလ့လာျခင္း ျပီးစီးသြားပါက -

 Rectangular viewport မ်ားကုိ ဖန္တီးတတ္လာေစရန္။

 Viewport scale factor မ်ားကုိ Modify လုပ္တတ္လာေစရန္။

 Viewports မ်ားကုိ move, copy, resize, rotate နဲ႕ delete တုိ႕လုပ္တတ္လာေစရန္။

 Viewport မ်ားမွ view တစ္ခုခ်င္းစီကို rotate လုပ္တတ္လာေစရန္။

Creating Rectangular Viewports

Rectangular viewport ကုိဖန္တီးရာတြင္ Rectangle တစ္ခုကို ဖန္တီးေသာ နည္းလမ္းျဖင့္ အတူတူပင္ ျဖစ္သည္။ သို႕ေသာ္လည္း

rectangular သည္ လက္ရိွ Layout page ထဲသုိ႕ ေရာက္ေနေသာ Model space view မွ geomentry မ်ားကို ေဖာ္ျပေပးေသာ Layout

window တြင္ဖန္တီးထားျခင္း ျဖစ္ပါသည္။
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Typically viewport သည္ Plotted မည္မဟုတ္ေပ။ Viewport ကို သီးသန္႕ Layer တစ္ခုတြင္ ဖန္တီးႏိုင္ေသာေၾကာင့္၊ Layer ၏

Properties ကုိအသုံးျပဳျပီး၊ Plotting မွ viewport boundary ကိုတားဆီးသတ္မွတ္ႏိုင္ပါသည္။

Command Access

Single Viewport

Command Line: VPORTS

Ribbon: View tab > Viewports panel > New > Viewports dialog box > Single

Viewports dialog box:
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Menu Bar: View > Viewports > 1 Viewport

Procedure: Creating Rectangular Viewports

Rectangular viewports ဖန္တီးပုံကုိ ေအာက္တြင္ အဆင့္ဆင့္ ေဖာ္ျပေပးထားပါသည္။

၁) Layout Tabs မွ ေထာက္လို႕မရလွ်င္၊ Status bar တြင္ရိွေသာ Display Layout and Model Tabs ကုိ click လိုက္ပါ။

၂ Layout Tabs ကုိ Activate လုပ္ပါ။

၃) Layout အတြက္ Paper size ကုိအတည္ျပဳပါ။

 Layout Tabs ကုိ Right – click ႏိွပ္ျပီး၊ Page Setup Manager ကို select လုပ္ပါ။
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 Plot Size paper မွာ လိုခ်င္ေသာ အရြယ္အစား (1) ျဖစ္ေၾကာင္း အတည္ျပဳရန္။

 လုိခ်င္ေသာ အရြယ္အစား မရေသးပါက Modify (2) ကုိ select ျပီး ျပန္လည္ ျပင္ဆင္သတ္မွတ္ ေပးႏိုင္သည္။

၄) Title block တစ္ခု Inserted မလုပ္ရေသးပါက Insert လုပ္ေပးပါ။
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၅) Viewports command ကုိ activate လုပ္ရန္ -

 Viewports panel မွ New (1) ကို click ပါ။

 Viewports dialog box တြင္ရိွေသာ New Viewports tab ကို click ပါ။ ျပီးလွ်င္ Standard Viewports ေအာက္က Single

(2) ကုိ click ပါ။

၆) Viewport ဖန္တီးရန္ -

 First corner (1) ကုိသတ္မွတ္ေပးပါ။

 ဆန္႕က်င္ဘက္ Corner (2) ကုိ သတ္မွတ္ေပးပါ။
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၇) Print မလုပ္ရန္ သတ္မွတ္ထားေသာ Viewport layer တြင္ ေနရာသတ္မွတ္ေပးရန္ -

 Command line ကုိ blank အေနထားျဖင့္၊ viewport ကို select လိုက္ပါ။

 Layer Control list မွ Layer ကုိ select ပါ။

 Viewport ကို deselect လုပ္ရန္ Esc key ကုိႏိွပ္ပါ။
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Setting Viewport Scale Factor

Layout viewport ကုိဖန္တီးျပီး သြားလွ်င္ paper units ျဖင့္ႏိႈင္းယွဥ္ျပီး၊ geometry ၏ display scale ကို ျပင္ဆင္ ႏိုင္ပါသည္။ Layout

ကို 1:1 scale ထားျပီး Plot မည္ဆိုလွ်င္ viewport အတြင္းမွ geometry သည္ Paper ေပၚမိမိ တုိ႕ႏွစ္သက္ေသာ

Scale အတိုင္းေရာက္မည္မွာ အေသအခ်ာပင္ ျဖစ္သည္။

ေအာက္တြင္ေဖာ္ျပေပးထားေသာ ပုံတြင္ေလ့လာၾကည့္ပါ။ အကယ္၍ 1:30 scale ကိုေရြးခ်ယ္လိုက္မည္ ဆုိလွ်င္၊ model space ထမွဲ

geomentry သည္ Paper ေပၚတြင္ အဆ ၃၀ ေသးငယ္ေနမည္ ျဖစ္သည္။ အကယ္၍ Paper ေပၚတြင္ 1 units ကုိ millimeter နဲ႕

တိုင္းတာျပီး၊ model space ေပၚတြင္လည္း millimeter ျဖစ္တိုင္းတာမည္ ဆုိလွ်င္၊ Model space တြင္ 30 millimeters အရွည္ရိွေသာ

Line သည္ Paper ေပၚတြင္ 1 millimeter ရိွမည္ ျဖစ္သည္။ Paper ေပၚတြင္ 1 units ကုိ inches န႕ဲ တုိင္းတာမည္၊ model space

ေပၚတြင္ feet ျဖစ္တိုင္းတာမည္ ဆုိလွ်င္၊ Model space တြင္ 30 feet အရွည္ရိွေသာ Line သည္ Paper ေပၚတြင္ 1 inche အရွည္ရိွမည္

ျဖစ္သည္။

Viewport Scale Access

Viewport Scale
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Status Bar: Viewport Scale

Layout tab ကုိ selected ထားရမည္။

model (သုိ႕မဟုတ္) paper space နွစ္ခုလုံးကို ဖြင့္ထားႏိုင္သည္။

 Model space on: Viewport ကို activate လုပ္ႏိုင္သည္။

 Paper space on: Viewport ကို selected ထားႏိုင္သည္။

Viewport scale ေရြးခ်ယ္အသံုးျပဳ ႏိုင္သည္။

Procedure: Setting and Locking Viewport Scale

Viewport scale setting ႏွင့္ viewport ကုိ locking လုပ္ျခင္းကို ေအာက္တြင္အဆင့္ဆင့္ ေဖာ္ျပေပးထားပါသည္။ Viewport ကုိ locked

လုပ္လိုက္ပါပါက ျပင္ဆင္ေျပာင္းလမွဲဳ႕မ်ား လုပ္၍ရေတာ႕မည္ မဟုတ္ေပ။

၁) layout tab ကေန viewport border ကုိ select ပါ။
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၂) Status bar ေပၚရိွ viewport scale list မွ မိမိတို႕ အသုံးျပဳလုိေသာ viewport scale ကုိ select လုပ္ပါ။
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၃)မိမိတုိ႕ selected ထားေသာ viewport ကုိ Model space တြင္ activate ျဖစ္ရန္ double – click နိွပ္ပါ။ ျပီးလွ်င္ Pan ကုိအသံုးျပဳျပီး၊

Viewport ထဲမွ Objects မ်ား၏ ေနရာကို ျပင္ဆင္လုိက္ပါ။

၄) မိမိတုိ႕ selected ထားေသာ viewport ကို Paper space တြင္ activate ျဖစ္ရန္ double – click နိွပ္ပါ။ Viewport border ကုိထပ္မံ

select လိုက္ပါ။ Status bar ေပၚတြင္ရိွေသာ Lock/Unlock Viewport ကို click ပါ။ ထိုအခါ Viewport သည္ မိမိတုိ႕ selected

ထားေသာ scale ျဖင့္ locked ျဖစ္သြားမည္ ျဖစ္သည္။

၅) Viewport ကုိ selected ထားေသာ အေျခအေနကုိ၊ status line တြင္ လက္ရိွ အခ်ိန္၌ condition နဲ႕ scale သည္ locked

ျဖစ္ေနသည္ကုိ ျပေပးမည္ ျဖစ္သည္။

Practice Exercise: Setting Viewport Scale Factor

ဤလက္ေတြ႕ ေလ့က်င့္ခန္းတြင္ model space တြင္ object အခ်ိဳ႕ကို ေရြးဆြဲျပီး selected ထားေသာ layout tab တြင္ rectangular

viewport ကို ဖန္တီးေပးရမည္ ျဖစ္သည္။

၁) ေအာက္တြင္ ေဖာ္ျပေပးထားသည့္ အတိုင္း geomentry အခ်ိဳ႕ကို ေရးဆြဲရန္ -
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 acad.dwt ျဖင့္ New drawing ကုိ ဖြင့္လိုက္ပါ။

 Drawing area အတြင္းတြင္ Zoom လုံး၀ အသံုးမျပဳပ၊ဲ objects တစ္ခ်ိဳ႕ကုိ ဖန္တီးလိုက္ပါ။

၂) Layout tab ကို select လုိက္ပါ။

 Single viewport တစ္ခုရိွျပီးသား ျဖစ္ေနလိမ္႕မည္။ ထို viewport ကုိ delete လုပ္ျပီး၊ own viewport ေလးတစ္ခု

ဖန္တီးလိုက္ပါ။

၃) Single viewport ဖန္တီးျခင္းကို ေလ့က်င့္ရန္၊ လက္ရိွ ရိွျပီးသား viewport ကို delect လုိက္ပါ။

 Command line ကုိ blank အေနအထားျဖင့္၊ viewport ကုိရိုက္ထည့္လိုက္ပါ။

 Modify panel မွ Erase ကို click ပါ။
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၄) Single viewport ဖန္တီးရန္ -

 Command line တြင္ -vports ကုိရိုက္ထည့္ျပီး၊ Enter နိွပ္ပါ။

 Corner တစ္ခုတြင္ viewport (1) ကုိ သတ္မွတ္ေပးလိုက္ပါ။

 ဆန္႕က်င္ဖက္ Corner တြင္ viewport (2) ကုိ သတ္မွတ္ေပးလိုက္ပါ။

၅) Viewport အတြင္းမွ goementry မ်ားကုိ Zoom ျဖင့္ ေအာက္ေဖာ္ျပပါ ပုံအတိုင္း လုပ္လုိက္ပါ။

၆) Viewport အတြင္းတြင္ double – click ႏိွပ္လုိက္ပါ။
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 Viewport rectangle သည္ bold တင္သြားမည္ ျဖစ္သလုိ၊ active လည္းျဖစ္သြားမည္ ျဖစ္သည္။

 Viewport အတြင္းမွ drawings မ်ားကို Zoom နဲ႕ Pan ကုိအသုံးျပဳျပီး realtime view လုပ္လိုက္ပါ။

၇) Drawing layout တစ္ခုလံုးကုိ Zoom ခ်ဲ႕ရန္ -

 Viewport အျပင္ဖက္တြင္ double – click ႏိွပ္လိုက္ပါ။

 Rectangular boundary သည္ bold မျဖစ္ေတာ႕သည္ကုိ ေတြ႕မည္။

 မိမိတုိ႕၏ Paper layout ကုိၾကည့္ရန္ Zoom and Pan real-time command ကိုအသံုးျပဳလိုက္ပါ။

 Layout အတြင္းမွ ပုံတစ္ခုလံုး ျမင္ရေအာင္ Zoom ခ်ဲ႕လိုက္ပါ။

၇) Viewport scale သတ္မွတ္ရန္ -

 Viewport ကုိ select လိုက္ပါ။

 Status bar ေပၚမွ Viewport scale ကို click လုိက္ပါ။
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 Lists တြင္ 1:2 ကုိ select လိုက္ပါ။

 Viewport ကို deselect လုပ္ရန္ Esc key ႏိွပ္ပါ။

၈) Viewport Scale ကို ျပင္ဆင္ျပီး၊ Viewport ကုိ lock ရန္ -

 Viewport ကို Selectပါ။

 Status bar ေပၚမွ Viewport scale ကို click လုိက္ပါ။

 Lists တြင္ 1:4 ကုိ select လိုက္ပါ။

 Status bar ေပၚမွ Lock/Unlock Viewport ကို click ပါ။

 Locked icon ေလးအျဖစ္သို႕ ေျပာင္းလဲသြားလိမ္႕မည္။

 Viewport ကို deselect လုပ္ရန္ႏွင့္ result ကိုၾကည့္ရန္ Esc key ႏိွပ္ပါ။
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Manipulating Viewports

Viewport ကုိနည္းလမ္းေပါင္း မ်ားစြာျဖင့္ ျခယ္လွယ္အသုံးျပဳ နိုင္ပါသည္။ အကယ္၍ Viewport မ်ားကုိ အသုံးမလို ေသာ အခါမ်ိဳးျဖစ္ေစ၊

ေဖာ္ျပေပးေသာ data မ်ားကုိ မလိုအပ္ေသာ အခါမ်ိဳးျဖစ္ေစ၊ Erase command ျဖင့္ အလြယ္တကူ delete လုပ္ႏိုင္ ပါသည္။ Move

command ကိုအသံုးျပဳျပီး၊ Paper ေပၚမွ Viewport တည္ေနရာကုိ အခ်ိန္းအေျပာင္း လုပ္ႏိုင္ပါသည္။ Copy command

ကိုအသံုးျပဳ၍လည္း Viewport ကုိမိတၱဴပြားႏိုင္ပါသည္။ Grips ကိုအသံုးျပဳျပီး viewport ရ႕ဲ size မ်ားကုိလည္း ျပင္ဆင္သတ္မွတ္ေပး

ႏိုင္ပါသည္။

Model space layer ၏ display ကို Freeze လုပ္၍လည္း Viewport ကို ထိန္းခ်ဳပ္ႏိုင္ပါသည္။ Current Viewport (1) ၏ display ကို

freeze (သုိ႕မဟုတ္) Thaw လုပ္ရန္အတြက္၊ layout viewport သည္ active ေနရမည္။ Layout viewport ကို active လုပ္ရန္

viewport boundary အတြင္းတြင္ double-click ေပးရပါမည္။ Active ျဖစ္ေနေသာ viewport သည္ ေအာက္ေဖာ္ျပပါ ပုံအတုိင္း (2)

အေရာင္မိွန္ေနမည္ Users မ်ားအေနျဖင့္ သိျပီးသား ျဖစ္ေနေပလိမ္႕မည္။ အကယ္၍ Cursor သည္ viewport boundary

ကိုေက်ာ္ျဖတ္သြားလွ်င္ crosshair မွ arrow cursor သို႕ေျပာင္းသြားလိမ္႕မည္ ျဖစ္သည္။

Erasing Viewports

Viewport မ်ားကုိ အသုံးမလို ေသာ အခါမ်ိဳးျဖစ္ေစ၊ ေဖာ္ျပေပးေသာ data မ်ားကုိ မလုိအပ္ေသာ အခါမ်ိဳးျဖစ္ေစ၊ Erase command ျဖင့္

အလြယ္တကူ delete လုပ္ႏိုင္ ပါသည္။ Viewport ကုိ delete အျပင္၊ move နဲ႕ copy လည္း ျပဳလုပ္ႏိုင္ပါသည္။
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Moving, Copying, and Resizing Viewports

Move command ကိုအသံုးျပဳျပီး၊ Paper ေပၚမွ Viewport တည္ေနရာကုိ အခ်ိန္းအေျပာင္း လုပ္ႏိုင္ပါသည္။ Copy command

ကိုအသံုးျပဳ၍လည္း Viewport ကုိ မိတၱဴပြားႏိုင္ပါသည္။ Grips ကုိအသံုးျပဳျပီး viewport ရ႕ဲ size မ်ားကုိလည္း ျပင္ဆင္သတ္မွတ္ေပး

ႏိုင္ပါသည္။

Altering Layers in Viewports

Selected ထားေသာ Viewport display ကုိ Freeze လုပ္ႏိုင္ပါသည္။ Layer Property Manager တြင္ selected ထားေသာ Layer ၏

VP Freeze option မ်ားကုိ လိုအပ္သလုိ ထိန္းခ်ဳပ္ ျပဳျပင္ႏိုင္ပါသည္။ ထုိသုိ႕ ထိန္းခ်ဳပ္ ျပဳျပင္မွဳ႕မ်ား လုပ္လုိပါက layout viewport သည္

active ေနရမည္။ Layout viewport ကုိ active လုပ္ရန္ viewport boundary အတြင္းတြင္ double-click ေပးရပါမည္။ Active

ျဖစ္ေနေသာ viewport သည္ ေအာက္ေဖာ္ျပပါ ပုံအတိုင္း (2) အေရာင္မိွန္ေနမည္ Users မ်ားအေနျဖင့္ သိျပီးသား ျဖစ္ေနေပလိမ္႕မည္။

အကယ္၍ Cursor သည္ viewport boundary ကိုေက်ာ္ျဖတ္သြားလွ်င္ crosshair မွ arrow cursor သို႕ေျပာင္းသြားလိမ္႕မည္ ျဖစ္သည္။

Layer Property Manager တြင္ ထိန္းခ်ဳပ္ႏိုင္ေသာ Properties (၄) ခုမွာ -

 VP Color

 VP Linetype

 VP Lineweight

 VP Plot Style တုိ႕ျဖစ္ပါသည္။

 Procedure: Moving and Resizing a Viewport

 Viewport ကို Moving နဲ႕ Resizing လုပ္ပုံကုိ ေအာက္တြင္ အဆင့္ဆင့္ ေဖာ္ျပေပးထားပါသည္။

၁) Move command ကိုစတင္ျပီး viewport border ကို click လုိက္ပါ။ Selection ျပီးဆံုးေၾကာင္း အတည္ျပဳရန္ Enter ႏိွပ္ပါ။
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၂) Base point တစ္ခု select ျပီး Viewport ကို ေနရာတစ္ေနရာသုိ႕ ေရြ႕ရန္ drag ကာ second point ကုိ သတ္မွတ္ ေပးလိုက္ပါ။

၃) Viewport ရဲ႕ border ကို select လိုက္ပါ။ Grip ရ႕ဲ corner တစ္ခုကို hot ျဖစ္ေအာင္လုပ္လုိက္ျပီး (grip hot အေၾကာင္း အထက္တြင္

ေဆြးေႏြးျပီးျဖစ္သည္) cursor ကုိ drag ျပီး Viewport ကုိၾကီးလာေအာင္ (သို႕မဟုတ္) ငယ္သြားေအာင္ ျပဳလုပ္ေပးႏိုင္ပါသည္။
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Practice Exercise: Manipulating Viewports

ရိုးရွင္းေသာ geomentry မ်ားေရးဆြထဲားသည့္ Viewport ရ႕ဲ Layer ကုိ freezing လုပ္ျခင္းကို လက္ေတြ႕ေလ့က်င့္ သြားရမည္

ျဖစ္သည္။

၁) ေလ့က်င့္ရမည့္ drawing ကိုအရင္ဆံုး ေရးဆြဲရန္ -

 New drawing ကုိ စတင္လိုက္ပါ။

 Layer Properties Manager တြင္ ေအာက္ေဖာ္ျပပါ Properties မ်ားျဖင့္ Layers မ်ား add လိုက္ပါ။

 Layer name: Center

 Color: Red

 Linetype: Center

 Layer name: HiddenColor

 BlueLinetype: Hidden

 Layer name: ViewportsColor
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 CyanLinetype: Continuous

 Drawings မ်ားကို အထက္ပါတြင္ ေဖာ္ျပေပးထားသည့္ အတိုင္း ဆင္တူေရးဆြဲလုိက္ပါ။

၂) Layer tab 1 ကုိ select လုိက္ပါ။

၃) Viewport size ကုိျပင္ဆင္သတ္မွတ္ရန္ -

 Command line ကုိ blank အေနအထားျဖင့္ viewport ကို select လိုက္ပါ။

 Grips ကုိအသံုးျပဳျပီး၊ viewport ကိုေအာက္ေဖာ္ျပပါပုံအတိုင္း size မ်ားျပင္ဆင္ သတ္မွတ္သြားမည္။

၄) Viewport အတြင္းမွ view ကိုျပင္ဆင္သတ္မွတ္ရန္ -

 Viewport အတြင္းတြင္ Double-click ႏိွပ္ပါ။

 Status bar ေပၚမွ၊ Viewport scale list မွ 1:2 scale ကုိ select လုိက္ပါ။
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၅) Viewport ကုိ Move လုပ္ရန္ -

 Viewport ၏အျပင္ဖက္ကို Double-click ႏိွပ္ပါ။

 Move command ကိုစတင္လိုက္ပါ။

 Viewport boundary ကို select ျပီး၊ Enter ႏိွပ္ပါ။

 Basepoint ကုိသတ္မွတ္ေပးျပီး၊ second point သတ္မွတ္ရန္ ေအာက္တြင္ ေဖာ္ျပေပးထားသည့္ ပုံအတိုင္း viewport ကုိ

ဘယ္ဖက္အလယ္သုိ႕ Move ျပီး Point သတ္မွတ္ေပးလိုက္ပါ။

၆) Viewport ကို Copy လုပ္ရန္ -

 Copy command ကုိစတင္လိုက္ပါ။
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 Viewport ကို select ျပီး၊ Enter ႏိွပ္ပါ။

 Viewport ၏ ညာဖက္တြင္ Single Copy တစ္ခုလုပ္ပါမည္။

 Copy command ကုိျပီးဆံုးေၾကာင္း အတည္ျပဳရန္ Enter ႏိွပ္ပါ။

၇) Selected ထားေသာ Viewport မွ layer ကို Freeze လုပ္ရန္ -

 Viewport ၏အတြင္းညာဖက္တြင္ Double – click ေပးလိုက္ပါ။

 Current Viewport မွ Center နဲ႕ Hidden layers ကုိ Freeze လုပ္ရန္ Layer Control list မွ ေအာက္တြင္

ေဖာ္ျပေပးထားသည့္ Icon ကို click လိုက္ပါ။

 Viewport ၏အျပင္ဖက္တြင္ Double – click ေပးလိုက္ပါ။

၈) Viewport ကို Viewports လို႕နာမည္ေပးထားေသာ Layer သို႕ေျပာင္းရန္ -

 Command line ကုိ blank အေနအထားျဖင့္၊ Viewports နွစ္ခုလံုးကုိ select လုိက္ပါ။

 Layer Control list မွ Viewports layer ကို select လိုက္ပါ။

 Viewport ကို deselect လုပ္ရန္ Esc key ႏိွပ္ပါ။
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၉) Viewport ကို Printing လုပ္ျခင္းမွ ခ်န္ထားရန္ (နည္းလမ္း - ၁) –

 Layer Control list မွ Viewports layer ကို Freeze လုပ္လုိက္ပါ။

 Viewport သည္ Layout view တြင္ visible မျဖစ္ေတာ႕သလို၊ Print ထုတ္၍ရမည္လည္း မဟုတ္ေပ။

 Viewport အတြင္းတြင္ Double–click ႏိွပ္ျပီး၊ viewport ကို active ေပးႏိုင္ေသာ္လည္း Modify လုပ္၍ရေတာ႕မည္ မဟုတ္ေပ။

Modify လုပ္လုိပါက Layer Control list မွ Viewports layer ကို Thaw ျပန္လုပ္ေပး ရမည္ျဖစ္သည္။

၁၀) Viewport ကုိ Printing လုပ္ျခင္းမွ ခ်န္ထားရန္ (နည္းလမ္း - ၂) –

 Layer Properties Manager မွ Viewports layer ကုိ select ပါ။

 Layer ကို Plotting လုပ္ျခင္း မျပဳရန္၊ Plot icon ကုိ click ပါ။
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 Layers Properties Manager dialog box ကုိ close လုိက္ပါ။

 Viewports layer သည္ drawing layout တြင္ visible ျဖစ္ေနမည္ ျဖစ္ေသာ္လည္း Plot လုပ္၍ရမည္ မဟုတ္ေပ။

Rotating Viewports

Rotate command (သုိ႕မဟုတ္) Grips ကုိအသုံးျပဳျပီး viewport ကုိ rotate လုပ္ႏိုင္ပါသည္။ VPROTATEASSOC ျဖင့္ system

variable setting ေျပာင္းျပီး Layout view တစ္ခုလုံးကို rotate လုပ္ႏိုင္ပါသည္။

ေအာက္ေဖာ္ျပပါပုံသည္ rotate မလုပ္ခင္ viewport နွင့္ rotate လုပ္ျပီးေသာ viewport ျဖစ္ပါသည္။

Before rotation After rotation

Command Access

VPROTATEASSOC

Command Line: VPROTATEASSOC
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VPROTATEASSOC System Variable

VPROTATEASSOC system variable ကုိေအာက္ပါအတိုင္း အခ်ိန္းအေျပာင္း လုပ္ႏိုင္ပါသည္။

 Viewport ကို rotated လုပ္ျပီးေသာ အခ်ိန္တြင္၊ View အတြင္းပုိင္းတြင္မူ rotate ျဖစ္မည္ မဟုတ္ေပ။

 Viewport ကုိ rotated လုပ္ျပီးေသာ အခ်ိန္တြင္ View အတြင္းပိုင္း အားလံုးသည္လည္း Viewport ႏွင့္ အတူ rotated

ျဖစ္ေနမည္။

Process: Rotating a View within a Viewport

Viewport အတြင္းမွ view မ်ား rotate လုပ္ပုံကုိ ေအာက္တြင္ အဆင့္ဆင့္ ေဖာ္ျပေပးထားပါသည္။

၁) Command prompt တြင္ VPROTATEASSOC ကုိရိုက္ထည့္လိုက္ပါ။

၂) System variable ကို 1 ေျပာင္းေပးလုိက္ပါ။

၃) Layout tab မွာ ႏွစ္သက္ေသာ View ကို select လိုက္ပါ။

၄) Viewport ကို မိမိတုိ႕ ႏွစ္သက္ေသာ angle အတုိင္း rotate လုပ္လုိက္ပါ။

၅) Viewport အတြင္းက rotated ျဖစ္သြားေသာ view ကို သတိျပဳေလ့လာၾကည့္ပါ။

Exercise: Create and Manipulate Viewports

Viewport scale factor ကိုေျပာင္းလဲျခင္း၊ viewport ကုိ Move ျခင္း၊ active ျဖစ္ေနေသာ viewport ၏ layer ကုိ freeze လုပ္ျခင္း၊

new viewport ဖန္တီးျခင္း စသည္တုိ႕ကုိ လက္ေတြ႕ ေလ့က်င့္ေလ့လာသြားရမည္ ျဖစ္သည္။
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The completed exercise

၁) M_Create-and-Manipulate- Viewports.dwg ကုိဖြင့္လုိက္ပါ။

၂) Layout1 tab မွ အစိမ္းေရာင္ rectangular viewport ကုိ select လုိက္ပါ။

၃) Viewport scale ကုိျပင္ဆင္သတ္မွတ္ရန္ -

 Status bar တြင္ရိွေသာ Viewport scale list မွ 1:30 ကို select လိုက္ပါ။

၄) Floor plan ကိုေအာက္ေဖာ္ျပပါ ပုံအတိုင္း ျမင္ေတြ႕ရမည္ ျဖစ္သည္။
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၅) Layout2 tab ကို click လုိက္ပါ။

၆) Viewport ကို Move ရန္ -

 Move command ကိုစတင္လိုက္ပါ။

 Circular staircase ကုိ display ထားေပးတဲ႕ အစိမ္းေရာင္ rectangular viewport ကုိ select လုိက္ပါ။

 ၎ကိုေအာက္ေဖာ္ျပပါ ပုံအတိုင္း border ရ႕ဲ အေပၚညာဖက္ေထာင့္ကို Move လုိက္ပါ။

၇) Layout ထဲက model space ကုိ Activate လုပ္ရန္ -

 Cursor ကို အစိမ္းေရာင္ rectangular viewport အတြင္းမွာ ရိွတ႕ဲSheet ရဲ႕ ဘယ္ဖက္ေထာင့္တြင္ ထားလုိက္ပါ။

 Viewport ေဘးတြင္ရိွေသာ Model space ကို activate လုပ္ရန္ Double – click ႏိွပ္လုိက္ပါ။

 Viewport သည္ active ျဖစ္သြားလွ်င္ Crosshairs န႕ဲ UCS Icon သည္ ေအာက္ေဖာ္ျပပါ ပုံအတုိင္း ျဖစ္သြားမည္။
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၈) Current viewport မွ Layer ကို freeze ရန္ -

 Layer Properties Manager ကုိဖြင့္လိုက္ပါ။

 Current viewport Layer ကို freeze ရန္ VP Freeze column မွ Icon ေလးကို click လုိက္ပါ။

 Ok ကုိ click လုိက္ပါ။

 Viewport အတြင္းမွ ဘယ္ဖက္တြင္ staircase ေပ်ာက္သြားပုံကို သတိထား ေလ့လာၾကည့္ပါ။ သုိ႕ေသာ္ viewport

၏ညာဖက္တြင္ ရိွေနမည္ ျဖစ္သည္။

၉) Current viewport မွာရိွေသာ Layer ကုိ color ေျပာင္းရန္ -

 Layer Properties Manager ကုိဖြင့္လိုက္ပါ။

 Furniture layer အတြက္ VP Color column မွ Icon ကုိ click ပါ။

 Magenta color သုိ႕ေျပာင္းေပးလုိက္ပါ။

 Ok ကုိ click ပါ။

၁၀) Furniture color သည္ Layout2 တြင္သာ ေျပာင္းသြားျခင္း ဟုတ္မဟုတ္ စစ္ေဆးရန္ -

 Model tab ကုိ click ပါ။

 Furniture color သည္ brown အျဖစ္သာ ရိွေၾကာင္း ေတြ႕ရမည္။

 Layout1 tab ကို click လုိက္ပါ။ Furniture color သည္ brown အျဖစ္သာ ရိွေနမည္ကို သတိထား ၾကည့္ၾကည့္ပါ။

 Layout2 tab ကို click လုိက္ပါ။ ဤ layout တြင္ Furniture color သည္ Magenta color တြင္ရိွမရိွ စစ္ေဆးၾကည့္ပါ။
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၁၁) Layout environment ကုိ Activate လုပ္ရန္ -

 Cursor ကို Paper အျပင္ဖက္ gray background ေနရာတြင္ ထားလုိက္ပါ။

 Focus ကို Layout environment သုိ႕ေျပာင္းရန္ Double-click ႏိွပ္လိုက္ပါ။

၁၂) Viewport ဖန္တီးရန္ -

 Command line တြင္ vports ကိုရိုက္ထည့္လုိက္ပါ။

 ေအာက္တြင္ ေဖာ္ျပေပးထားေသာ ပုံအတုိင္း paper layout တြင္ rectangular viewport ကို ေရးဆြဲျပီး click လိုက္ပါ။

၁၃) Viewport scale ကိုေျပာင္းရန္ -

 New viewport ကို active လုပ္ရန္ ထုိ Viewport အတြင္းတြင္ Double – click ႏွိပ္လိုက္ပါ။

 Status bar တြင္ရိွေသာ Viewport Scale list မွ 1:30 ကို select လိုက္ပါ။

၁၄) Viewport အတြင္းတြင္ ေအာက္ေဖာ္ျပပါ ျမင္ကြင္းအတိုင္း ရေအာင္ Pan အသုံးျပဳျပီး ေရြ႕လိုက္ပါ။

၁၅) Paper အျပင္ဖက္ gray background ေနရာတြင္ Double–click ေပးလိုက္ပါ။
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၁၆) ေအာက္ေဖာ္ျပပါပုံ အတုိင္း viewport ကို Edit လုပ္ရန္ ညာဖက္အေပၚေထာင့္ကုိ grips လုပ္လိုက္ပါ။

၁၇) အစိမ္းေရာင္ viewport layer သည္ Viewports layer တြင္တည္ရိွပါသည္။ ထုိ Layer ကို Plot လုပ္ရာတြင္ မပါ၀င္မည့္ setting

အျဖစ္သို႕ ေျပာင္းလဲေပးလိုက္ပါ။

 Layer Properties Manager ကုိဖြင့္လိုက္ပါ။

 Viewports layer အတန္းမွာ ရိွေသာ Print icon ကုိ click လိုက္ပါ။

 အဆိုပါ Setting အတုိင္းျပင္ဆင္ထားေသာ Layerသည္ drawing ကို Plot လုပ္ေသာအခါ ပါ၀င္မည္ မဟုတ္ေပ။

၁၈) Command line တြင္ VPROTATEASSOC ကုိရိုက္ထည့္လိုက္ပါ။ ျပီးလွ်င္ 1 ကုိရိုက္ထည့္လုိက္ပါ။

၁၉) မိမိတုိ႕ ဖန္တီးထားေသာ Viewport ကုိ select ျပီး၊ command line တြင္ Rotate command ကုိရိုက္ထည့္ လိုက္ပါ။

 Viewpoint ၏ ေထာင့္တစ္ေထာင့္တြင္ rotation အတြက္ basepoint ကို သတ္မွတ္ေပးလုိက္ပါ။

 Rotation angle အတြက္ 90 ရိုက္ထည့္ျပီး၊ Enter ႏိွပ္လိုက္ပါ။

၂၀) Files အားလုံးကို မ Save ပဲပိတ္လိုက္ပါ။

Challenge Exercise: Architectural

ဤလက္ေတြ႕ေလ့က်င့္ခန္းတြင္ အထက္တြင္ ေလ့လာခဲ႕ျပီး ျဖစ္ေသာ Layout ၊ Viewport စသည္တုိ႕ႏွင့္ ပတ္သက္ေသာ လက္ေတြ႕

ေလ့က်င့္ခန္းမ်ားကုိ ေလ့က်င့္သြားရမည္ ျဖစ္သည္။
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The completed exercise

Metric Units

၁) M_ARCH-Challenge- CHP06.dwg ကိုဖြင့္လိုက္ပါ။

၂) Layout1 ေအာက္ပါ setting ျဖင့္ Plot ႏိုင္ေအာင္ ျပင္ဆင္သတ္မွတ္ရန္ -

 Orientation: Landscape

 Scale:1:1

 Printer/Plotter: DWF6 ePlot.pc3

 Paper size: ISO A1 (841 x 594 mm) paper

၃) Layout1 မွ Plan View ဟု Rename ေပးလိုက္ပါ။

၄) Layout တြင္ main viewport ကို Add ရန္-

 Main floor plan ကို 1:60 scale တြင္ ထားလိုက္ပါ။

 ျပီးလွ်င္ viewport ကို Lock လိုက္ပါ။
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၅) Files အားလံုးကို Save ျပီး ပိတ္လုိက္ပါ။

Imperial Units

၁) I_ARCH-Challenge- CHP06.dwg ကုိဖြင့္လိုက္ပါ။

၂) ) Layout1 ေအာက္ပါ setting ျဖင့္ Plot ႏိုင္ေအာင္ ျပင္ဆင္သတ္မွတ္ရန္ -

 Orientation: Landscape

 Scale:1:1

 Printer/Plotter: DWF6 ePlot.pc3

 Paper size: ARCH expand D (36.00 x 24.00 Inches)

၃) Layout1 မွ Plan View ဟု Rename ေပးလိုက္ပါ။

၄) Layout တြင္ main viewport ကို Add ရန္-

 Main floor plan ကို 3/16" = 1' scale တြင္ ထားလုိက္ပါ။

 ျပီးလွ်င္ viewport ကို Lock လိုက္ပါ။
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၅) Files အားလံုးကို Save ျပီး ပိတ္လုိက္ပါ။

Challenge Exercise: Mechanical

ဤလက္ေတြ႕ေလ့က်င့္ခန္းတြင္ အထက္တြင္ ေလ့လာခဲ႕ျပီး ျဖစ္ေသာ Layout ၊ Viewport စသည္တုိ႕ႏွင့္ ပတ္သက္ေသာ လက္ေတြ႕

ေလ့က်င့္ခန္းမ်ားကုိ ေလ့က်င့္သြားရမည္ ျဖစ္သည္။

၁) M_ MECH -Challenge- CHP06.dwg ကိုဖြင့္လုိက္ပါ။
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၂) Layout အသစ္ကို ေအာက္ပါ setting အတုိင္း ဖန္တီးရန္-

 DWF6 ePlot.pc3

 ISO A3 (420 x 297)

 Plot ေပၚတြင္ viewports သုံးခုလံုးကုိ ျပမည္မဟုတ္ေပ။

 အေပၚဆံုးတြင္ ျမင္ေတြ႕ရေသာ ပုံ၏ scale factor ကုိ 1:1 ဟုသတ္မွတ္ေပးလိုက္ပါ။

 ဘယ္ဖက္တြင္ ျမင္ေတြ႕ရေသာ ပုံ၏ scale factor ကုိ 1:2 ဟုသတ္မွတ္ေပးလိုက္ပါ။

 ညာဖက္တြင္ ျမင္ေတြ႕ရေသာ ပုံ၏ scale factor ကို 1:4 ဟုသတ္မွတ္ေပးလိုက္ပါ။

၃) Cleanup လုပ္ရန္ -

 Layout Parts အျဖစ္ Rename ေပးလုိက္ပါ။

 Layout 2 ကုိ delete လုပ္လိုက္ပါ။

 Model space သို႕ ျပန္သြားလိုက္ပါ။

 ၄) Files အားလံုးကို Save ျပီး ပိတ္လုိက္ပါ။

Chapter Summary

Viewports သည္ Layout ကေန model space geomentry မ်ားကို အေကာင္းဆံုး Plot ေပးႏိုင္ေအာင္ ကူညီေပးမည့္ အဓိက Key

ျဖစ္ပါသည္။ Layout တစ္ခုတည္းမွာ multiple viewports မ်ားဖန္တီးျပီး၊ Scale အမ်ိဳးမ်ိဳးေသာ model geomentry မ်ားကုိ Page

တစ္ခုတည္းတြင္ ေဖာ္ျပႏိုင္ပါသည္။

ဤသင္ခန္းစာကို ေလ့လာျခင္း ျပီးစီးသြားပါက -

 Rectangular viewport မ်ားကုိ ဖန္တီးတတ္လာေစမည္။

 Viewport scale factor မ်ားကုိ Modify လုပ္တတ္လာေစမည္။

 Viewports မ်ားကုိ move, copy, resize, rotate နဲ႕ delete တုိ႕လုပ္တတ္လာေစမည္။
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 Viewport မ်ားမွ view တစ္ခုခ်င္းစီကုိ rotate လုပ္တတ္လာေစမည္။

CHAPTER :7 Annotating the Drawing

အထက္တြင္ Text ပါ၀င္ေသာ ေလ့က်င့္ခန္းမ်ားကို ေရးဆြဲေလ့က်င့္ခဲ့ျခင္း မရိွေသးေပ။ ဤသင္ခန္းစာတြင္မူ Text objects

မ်ားဖန္တီးျခင္းႏွင့္ Edit လုပ္ျခင္းတုိ႕ကို ေလ့လာသြားရမည္ ျဖစ္ပါသည္။

Objectives

ဤသင္ခန္းစားကုိ ေလ့လာျခင္း ျပီးစီးသြားေသာအခါ -

 Mtext command ကိုအသံုးျပဳျပီး၊ multiline text မ်ားကိုဖန္တီးတတ္လာေစရန္။

 Single line text မ်ားဖန္တီးတတ္လာေစရန္။

 Text styles မ်ားကို Manage လုပ္တတ္လာေစရန္။

Lesson: Creating Multiline Text

Multiline text ဖန္တီးျခင္း သင္ခန္းစားကို ရွင္းလင္းတင္ျပသြားမည္ ျဖစ္သည္။ Drawing အတြင္းတြင္ မွတ္ခ်က္ စာပုဒ္မ်ား ဖန္တီးျခင္းကုိ

ေလ့က်င့္သြားရမည္ ျဖစ္ပါသည္။ ေအာက္ေဖာ္ျပပါ ပုံသည္ Multiline text object ကိုဖန္တီး ထားျခင္းျဖစ္ပါသည္။
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About Multiline Text

Drawing area နဲ႕ Layout မ်ားအတြင္းတြင္ ေရးဆြဲထားေသာ drawings မ်ားနဲ႕ ပတ္သတ္ေသာ အခ်က္အလက္မ်ား၊ မွတ္ခ်က္မ်ားကုိ

Multiline Text မ်ားျဖင့္ ေဖာ္ျပျခင္းကုိ Multiline Text command ကိုအသုံးျပဳပါ။

စာလံုးမ်ားႏွင့္ စာပုဒ္ကို ပကတိအတုိင္းထားျပီး၊ စာပုဒ္အက်ယ္ကို grips ျဖင့္ edit လုပ္ႏိုင္ပါသည္။
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Multiline Text Defined

AutoCAD တြင္ပါ၀င္ေသာ Multiline Text Editor တြင္ Properties မ်ားကုိ စိတ္ၾကိဳက္သတ္မွတ္ေပးျပီး၊ စာပုဒ္မ်ား၊ သေကၤတမ်ားကုိ

ေရးသားႏိုင္ပါသည္။ Drawing area တြင္မိမိတို႕ Cursor ျဖင့္ေဘာင္ခတ္လိုက္ေသာ ေနရာ အထိစာလံုးမ်ားကုိ

ဆက္ေရးသြားႏိုင္မည္ျဖစ္ျပီး၊ ေဘာင္ခတ္ထားေသာ ေနရာသုိ႕ေရာက္ပါက ေနာက္တစ္ေၾကာင္း သို႕ဆင္းသြားမည္ ျဖစ္သည္။ Multiline

Text Editor တြင္ Right–click ေထာက္ျပီး၊ options မ်ားကုိ မိမိတို႕စိတ္ၾကိဳက္ ျပင္ဆင္သတ္မွတ္ ေပးႏိုင္သည္ကို ေအာက္ေဖာ္ျပပါ

ပုံတြင္ေလ့လာၾကည့္ပါ။
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Text Editor အတြက္ options မ်ားသည္ အျခားေသာ Word Program မ်ားက႕ဲသုိ႕ပင္၊ AutoCAD drawing environment အတြင္းတြင္

ေပၚလာမည္ျဖစ္သည္။

Example of Multiline Text

Multiline Text အတြက္ဥပမာကို ေအာက္တြင္ေဖာ္ျပေပးထားပါသည္။
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Example of Single Line Text

ေနာက္သင္ခန္းစာတြင္ ထပ္မံေလ့လာသြားရမည့္ single line text ျဖစ္ပါသည္။ Single line text သည္ စာပုဒ္ ပုံစံမ်ိဳး ဖန္တီး၍ရမည္

မဟုတ္ေပ။

Creating Multiline Text

စာပုဒ္မ်ား ဖန္တီးရန္ Multiline Text command ကိုအသံုးျပဳသြားရပါမည္။ Software ကသတ္မွတ္ထားေသာ စံပုံစံ (Standard option

) ျဖင့္ စာပုဒ္မ်ားဖန္တီး ၾကည့္ပါ။

Multiline Text editor တြင္ -

 စာပုဒ္ပုံစံျဖင့္ စာမ်ားဖန္တီးႏိုင္သည္။

 Numbered န႕ဲ bulleted lists ပုံစံမ်ား ဖန္တီးႏိုင္သည္။

 Engineering သေကၤတမ်ား ဖန္တီးႏိုင္သည္။

 Text မ်ားကို စာေၾကာင္းမ်ား ညိုေပးႏိုင္သည္။

 Text မ်ားကို columns မ်ားဖန္တီးႏိုင္သည္။

 Date, time န႕ဲ author စသည္ Fields မ်ားဖန္တီးႏိုင္သည္။

 Ribbon tab တြင္ Text Editor tool panels ကုိေဖာ္ျပေပးထားပါသည္။
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Command Access

Multiline Text

Command Line: MTEXT, MT, T

Ribbon: Annotate tab > Text panel > Multiline Text

Ribbon: Home tab > Annotation panel > Multiline Text

Menu Bar: Draw > Text > Multiline Text

Multiline Text Tab

Ribbon tab တြင္ ေဖာ္ျပေပးထားေသာ Annotation panel မွ Multiline Text ကုိ click ျပီး drawing တြင္စာေရးရန္

ေဘာင္ခတ္ေပးလုိက္ပါက Multiline Text Tab ေပၚလာမည္ ျဖစ္သည္။ ထုိ Panel တြင္ရိွေသာ Options မ်ားကုိအသံုးျပဳျပီး၊

လက္ရိွေရးသားေနေသာ Text obects မ်ားကို စိတ္ၾကိဳက္ ျပဳျပင္ဖန္တီးႏိုင္ပါသည္။
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Text style and text height မ်ားကုိ ျပဳျပင္ေပးႏိုင္သည္။

Text မ်ားကို bold, italic, underlined, (သုိ႕မဟုတ္) overlined စသည္တုိ႕ျဖင့္ Edit လုပ္ႏိုင္ပါသည္။ လက္ရိွ အသံုးျပဳမည့္ text

style၊ fonts ႏွင့္ colors မ်ားကုိလည္း ေရြးခ်ယ္ႏိုင္ပါသည္။

စာပုဒ္မ်ားတြင္ justification, line spacing, numbering, န႕ဲ bullets တို႕ျဖင့္ edit လုပ္ႏိုင္ပါသည္။

Symbols, columns, နဲ႕ fields (author န႕ဲ date က႕ဲသုိ႕ေသာ) အညြန္းမ်ားကို ထည့္သြင္းႏိုင္ပါသည္။

စာလံုးေပါင္း သတ္ပံုမ်ားကို (check spelling) ကုိစစ္ေဆးျခင္း။

စာလုံးမ်ားကုိ ရွာေဖြျခင္း၊ အစားထုိးျခင္းကုိ ျပဳလုပ္ေပးႏိုင္သည့္ Find & Replace tool.

text box rulers န႕ဲ text character မ်ားကို အခ်ိန္းအေျပာင္း လုပ္ေပးႏိုင္သည့္ Editor setting.

Multiline Text Editor ကုိ ပိတ္ျခင္း။

Procedure: Creating Multiline Text

Multiline Text ဖန္တီးပုံကုိ ေအာက္တြင္အဆင့္ဆင့္ ေဖာ္ျပေပးထားပါသည္။

၁) Multiline Text command ကိုစတင္လိုက္ပါ။

၂) အမွတ္ႏွစ္မွတ္ျဖင့္ text area ကုိသတ္မွတ္ေပးလုိက္ပါ။
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၃) Style panel မွ text style (1) န႕ဲ text height (2) setting ကုိ သတ္မွတ္ေပးလိုက္ပါ။

၄) Numbered (သုိ႕မဟုတ္) bulleted lists and symbols မ်ားကုိ လိုအပ္သလုိ အသံုးျပဳျပီး Text မ်ားဖန္တီး လိုက္ပါ။
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၅) လိုအပ္လွ်င္ Text area ၏ width န႕ဲ height ကို ruler အသံုးျပဳျပီး ျပဳႏိုင္ပါသည္။

၆) ေရးလုိက္ေသာ text ကိုလက္ခံျပီျဖစ္ေၾကာင္း အတည္ျပဳရန္ Text Editor ၏အျပင္ဖက္တြင္ double–click ေပးလိုက္ပါ။
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MText Columns and Grips

Mtext objects ကို drawing မ်ားတြင္ အသံုးျပဳေတာ႕မည္ ဆိုလွ်င္၊ text မ်ားကို column တြင္ Format ခ်တတ္ရန္

လည္းလိုအပ္ပါသည္။ Grips ကိုအသံုးျပဳ၍လည္း text မ်ားကို table ပုံစံမ်ိဳးျဖင့္လည္း edit လုပ္ႏိုင္ပါသည္။

Placing Mtext

Mtext ကိုအသံုးျပဳရန္ ေနရာသတ္မွတ္ ေပးျပီးေသာ အခ်ိန္တြင္ Text Editor tab သည္ ribbon ေပၚတြင္ activates ျဖစ္ေနမည္

ျဖစ္သည္။ Insert panel မွ Column option ျဖင့္ Text မ်ားကုိ columns တြင္ Format ခ်ေပးႏိုင္ပါသည္။

Column options on the ribbon Column Settings dialog box

အသံုးျပဳႏုိင္ေသာ column types မ်ားကုိ ေအာက္တြင္ေဖာ္ျပေပးလိုက္ပါသည္။
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Dynamic Column - ဖန္တီးေနေသာ Mtext object မ်ားကို dynamic columns mode ကုိထည့္လိုက္ပါက၊ Dynamic

Column သည္ text မ်ား၏ လားရာအတုိင္း ေဖာ္ျပေပးေနမည္။ Automatic (သုိ႕မဟုတ္) manual

height options ဟူ၍ dynamic columns mode ကိုေျပာင္းလဲ အသုံးျပဳႏိုင္ပါသည္။

Static Column - ဖန္တီးေနေသာ Mtext object မ်ားကုိ Static Column mode ကုိထည့္လိုက္ပါက၊ Mtext object

မ်ား၏ width နဲ႕ height တုိ႕ကို ျပင္ဆင္သတ္မွတ္ေပးႏိုင္သလို၊ မိမိတို႕ အသုံးျပဳလုိေသာ columns

အေရအတြက္ ကုိသတ္မွတ္၍လည္း text မ်ားကုိေရးသားႏိုင္ပါသည္။

No Column - ဖန္တီးေနေသာ Mtext object မ်ားကို columns မ်ားျဖင့္ အသံုးမျပဳျခင္း။

Editing Mtext with Grips

Grips ကုိအသုံးျပဳျပီး Text ၏ column width န႕ဲ height ကို editing လုပ္နိုင္ပါသည္။

Grips Location

Column Width

Mtext Width

Mtext Width and Mtext Height
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Mtext Height

Exercise: Create Multiline Text

ဤလက္ေတြ႕ေလ့က်င့္ခနး္တြင္ Multiline Text command ကုိအသုံးျပဳျပီး drawing အတြင္းတြင္ Mtext မ်ားဖန္တီး ေပးျခင္းကုိ

ေလ့က်င့္သြားရမည္ ျဖစ္သည္။

The completed exercise

၁) C_Create-Mtext.dwg ကိုဖြင့္လိုက္ပါ။

၂) Title block အတြင္း အေပၚညာေထာင့္ကို Zoom ခ်ဲ႕လိုက္ပါ။

၃) Status bar ေပၚမွ Object snap ကုိ ပိတ္လိုက္ပါ။

၄) Title block တြင္ လိပ္စာသတ္မွတ္ေပးရန္ -

 Multiline Text command ကိုစတင္လိုက္ပါ။

 Multiline Text box အတြက္ ေအာက္ေဖာ္ျပပါ ပုံအတုိင္း အမွတ္မ်ား သတ္မွတ္ေပးလိုက္ပါ။
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၅) Text height သတ္မွတ္ျပီး၊ လိပ္စာရိုက္ထည့္ရန္ -

 Style panel တြင္ရိွေသာ text size list တြင္ 6 ရိုက္ထည့္လုိက္ပါ။

 ေအာက္တြင္ေဖာ္ျပ ေပးထားသည့္ အတုိင္း text ရုိက္ထည့္လိုက္ပါ။

 ေနာက္ဆံုးစာေၾကာင္း ေရးျပီးပါက Enter ႏွိပ္လိုက္ပါ။

၆) Text height သတ္မွတ္ျပီး၊ phone နဲ႕ fax numbers ရိုက္ထည့္ရန္ -

 Text Height list တြင္ 3 ရိုက္ထည့္လိုက္ပါ။

 Enter ႏွိပ္္ပါ။

မွတ္ခ်က္။ ။ list တြင္ တန္ဖိုးမ်ားရုိက္ထည့္နိုင္သလို၊ list ထဲမွလည္း ေရြးခ်ယ္ႏုိင္ပါသည္။

 Phone န႕ဲ fax numbers ကုိေအာက္တြင္ ေဖာ္ျပေပးထားသည့္ အတိုင္းရိုက္ထည့္ပါ။
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 Close panel မွ Close Text Editor ကုိ Click ျပီး (သုိ႕မဟုတ္) Text Editor အျပင္ဖက္တြင္ Double–click ႏိွပ္ျပီး Text Editor

ကို ပိတ္လိုက္ပါ။

၇) Drawing ကုိ Zoom Extents လုပ္ေပးလိုက္ပါ။

၈) Label text တစ္ခုတည္း ေပၚေအာင္ Zoom ခ်ဲ႕လိုက္ပါ။

၉) Multiline Text command ကုိျပန္ေခၚလုိက္ပါ။ Multiline text box သတ္မွတ္ေပးရန္ ေအာက္ပါပုံအတုိင္း အမွတ္မ်ား

သတ္မွတ္ေပးလိုက္ပါ။

၁၀) Style panel တြင္ရိွေသာ text style list မွ ViewLabel ကို select လိုက္ပါ။
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၁၁) ေအာက္ေဖာ္ျပပါ ပုံအတုိင္း Text ထည့္လိုက္ပါ။

၁၂) Text Editor ကုိပိတ္ရန္ ၎ Text Editor ၏အျပင္ဖက္တြင္ Double – click ႏိွပ္လုိက္ပါ။

၁၃) Drawing ကို Zoom Extents ေပးလိုက္ပါ။

၁၄) Files အားလုံးကို မ Save ပဲပိတ္လိုက္ပါ။
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Mtext ကို Columns မ်ားအတိုင္း Display ေစရန္ Edit လုပ္ျခင္း

ဤလက္ေတြ႕ ေလ့က်င့္ခန္းတြင္ Column တစ္ခုတည္းျဖင့္ display ေနေသာ Mtext ကုိ Columns အေျမာက္အျမားျဖင့္ display ေစရန္

Edit လုပ္ျခင္းကုိ လက္ေတြ႕ ေလ့က်င့္သြားရမည္ ျဖစ္သည္။

၁) I_Mtext-Columns and Grips.dwg ကို ဖြင့္လုိက္ပါ။

၂) ေအာက္ေဖာ္ျပပါ ပုံအတုိင္း Title Block layout သို႕ေျပာင္းေပးလိုက္ပါ။

၃) Mtext object ကုိselect လိုက္ပါ။

၄) Command line မွ Properties palette ကုိေခၚလိုက္ပါ။ Text title ေအာက္တြင္ ရိွေသာ Columns ေဘးမွ […] ကုိ Click လုိက္ပါ။

(ေအာက္ေဖာ္ျပပါ ပုံအတုိင္း)
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၅) Column Settings dialog box မွ -

 Column Type ေအာက္မွ Dynamic Columns ကို select လိုက္ပါ။

 Height အတြက္ 6" ကုိရိုက္ထည့္လိုက္ပါ။

 Gutter အတြက္ 7/16" ကုိ ရိုက္ထည့္ေပးလိုက္ပါ။

 Ok ကုိ Click လိုက္ပါ။

 Mtext object သည္ Columns ေလးခုျဖင့္ display သြားမည္ ျဖစ္သည္။

 Mtext object တြင္ရွိေသာ Mtext Height grip ကုိ Click ေပးလုိက္ပါ။



“Workgroup” AotoCAD & 3ds Max Job Training Center မွ ပညာဒါန အခမ့ဲ ျဖန္႔ေ၀သည္။

( ဤစာအုပ္ကုိ ေငြေၾကးျဖင့္ ျပန္လည္ေရာင္းခ် ခြင့္မျပဳပါ )

ေအာင္ေဇာ္လတ္ {(Master of Engineering in Science and Production Engineering) Moscow State University Of Railway Engineering}

ဘာသာျပန္ ေရးသား ျပဳစုသည္။

“Workgroup “ AutoCAD & 3ds Max Training Center, International Computer Driving Licence Approved Test Center,
Rm- 403, Excel Tower, Yangon, Myanmar.

Ph: 951 559377 Ext: 6413 or 6403, Email – infor@workgroupweb.com

64

၇) Cursor ကိုအေပၚသို႕ drag လိုက္ျပီး၊ Viewport ၏အထက္တြင္ ေအာက္ေဖာ္ျပပါ ပုံအတုိင္း အမွတ္တစ္မွတ္ သတ္မွတ္ေပးလုိက္ပါ။

၈) ျပီးလွ်င္ အထက္၌ ေရြ႕ခ႕ဲေသာ grips ကုိပဲေအာက္သို႕ျပန္ drag လုိက္ပါ။ Fifth column သည္ removed ျဖစ္သြားသည္။

၉) Grips ကုိ clear လုပ္ရန္ Esc key ႏိွပ္လုိက္ပါ။

၁၀) Files အားလုံးကို မ Save ပဲပိတ္လိုက္ပါ။

Lesson: Creating Single Line Text

ဤသင္ခန္းစာတြင္ Text command ကုိအသံုးျပဳျပီး မိမိတုိ႕၏ drawing ထဲတြင္ Single text ဖန္တီးပံုကုိ ေလ့လာသြားရမည္ ျဖစ္ပါသည္။ Single line

text , textual object တုိ႕ျဖင့္ ဖန္တီးထားေသာ text objects မ်ားကုိ edit လုပ္ရာတြင္ လြတ္လပ္စြာ ျပဳလုပ္ႏိုင္ပါသည္။
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Mtext command တြင္ features မ်ားျပည့္ျပည့္စုံစံု ပါ၀င္ျပီး၊ Text objects မ်ားဖန္တီးရာတြင္ အားပါးတရ ရိွလွသည္။ Single line text

ျဖင့္ text objects မ်ားကုိ လ်င္ျမန္စြာ ဖန္တီးႏိုင္ျပီး၊ ေသးငယ္ေသာ text objects မ်ားဖန္တီးရာတြင္ အသံုး၀င္လွသည္။ သာမန္အားျဖင့္

Single line text ကို Objects မ်ားအမွတ္စဥ္တပ္ရာတြင္ (သုိ႕မဟုတ္) Circle အတြင္း စာမ်ားထည့္ရာတြင္ အမ်ားဆုံး

အသုံးျပဳေလ့ရိွၾကသည္။

Single line text ကို title block တြင္ heights, justification, န႕ဲ rotation angle အမ်ိဳးမ်ိဳးတုိ႕ျဖင့္ အသုံးျပဳ ေရးဆြဲထားေသာ

ေအာက္ေဖာ္ျပပါ ပုံကိုေလ့လာၾကည့္ပါ။

Objectives

ဤသင္ခန္းစာကုိ ေလ့လာျခင္း ျပီးစီးသြားပါက -

Single Line text မ်ားကို အသံုးျပဳတတ္လာေစရန္။

About Single Line Text

Single line text ကုိ အမ်ားအားျဖင့္ စကားစုမ်ား၌ လည္းေကာင္း၊ စာေၾကာင္းတုိမ်ား၌ လည္းေကာင္း၊ Objects မ်ား အညႊန္းတပ္ရာ၌ လည္းေကာင္း၊

အမွတ္စဥ္ တပ္ရာ၌ လည္းေကာင္း အသံုးျပဳၾကပါသည္။ ဥပမာအားျဖင့္ Circle အတြင္းတြင္ စာလံုးေရးထည့္ ထားသည္ကို ေလ့လာၾကည့္ပါ။
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အကယ္၍ Multiline text ကို explode လုပ္လိုက္မည္ဆိုပါက အဆုိပါ Multiline text သည္ Single line text အျဖစ္သို႕

ေျပာင္းလဲသြားမည္ ျဖစ္သည္။ Single line text command ကိုအသံုးျပဳ ေနခ်ိန္တြင္၊ Enter ႏိွပ္ျပီး Text အတြက္ New line

ကိုသတ္မွတ္ေပးရပါသည္။

Enter ကိုႏွစ္ၾကိမ္ဆက္ ႏိွပ္ပါက text command ကို exit ေပးျပီးသား ျဖစ္သြားလိမ္႕မည္။ Single line အသံုးျပဳထားေသာ text ကုိ

command line blank အေနအထားျဖင့္ select ပါက ထုိ text တြင္ grips တစ္ခုတည္း သာေပၚေနမည္ ျဖစ္သည္။

Multiline line အသုံးျပဳထားေသာ text ကို command line blank အေနအထားျဖင့္ select ပါက ထို text တြင္ grips ေလးခုေပၚေနမည္

ျဖစ္သည္။
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Single Line Text Defined

Single line text ျဖင့္ text မ်ားကုိ single line ဖန္တီးသည္။ Command ကို စတင္လိုက္သည္ႏွင့္ တစ္ျပိဳင္နက္တည္း၊ command line

တြင္ text တည္ေနရာအတြက္ single insertion point သတ္မွတ္ေပးရန္ Prompted ေပးသြားလိမ္႕မည္ ျဖစ္သည္။

ထိုအမွတ္ကုိ သတ္မွတ္ေပးျပီးပါက၊ height န႕ဲ rotation angle သတ္မွတ္ေပးရန္ Prompted ပါလိမ္႕မည္။ အျခားေသာ Options

မ်ားျဖစ္ေသာ Justify န႕ဲ Style ကုိ Right–click ႏိွပ္၍ shortcut menu မွလည္းေကာင္း၊ keyboard မွ DOWN ARROW

ႏိွပ္၍လည္းေကာင္း ေရြးခ်ယ္အသံုးျပဳ ႏိုင္ပါသည္။

Justify options အတြက္ ေအာက္တြင္ ဥပမာ အခ်ိဳ႕ကုိ ေဖာ္ျပေပးထားပါသည္။
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Creating Single Line Text

Single line text objects မ်ားဖန္တီးရာတြင္ Text command ကုိအသံုးျပဳရပါသည္။ Text command စတင္ လိုက္သည္ႏွင့္ text style

န႕ဲ height ကုိျပေပးပါလိမ္႕မည္။ ျပီးလွ်င္ Start point သတ္မွတ္ေပးရန္ Prompted သြားပါလိမ္႕မည္။ ထို႕ေနာက္ text height နဲ႕

rotation angle ကိုဆက္လက္သတ္မွတ္ ေပးသြားရပါမည္။

Single line text ျဖင့္ Lines ေလးေၾကာင္းတြင္ text မ်ားထည့္လုိက္ျပီဆုိပါစို႕။ Line တစ္ေၾကာင္းခ်င္းစီတြင္ မတူညီ text properties

အမ်ိဳးမ်ိဳးျဖင့္ ေျပာင္းလဲအသံုးျပဳ သြားႏိုင္ပါသည္။ Single line text ကုိအကန္႕အသတ္ မရိွပဲ လြတ္လပ္စြာ ဖန္တီးႏုိင္ပါသည္။

Single line text objects မ်ားကို တစ္ခုနွင့္တစ္ခု ခ်ိတ္ဆက္၍လည္း အသုံုးျပဳသြားႏိုင္ပါသည္။ ဥပမာ အားျဖင့္ title block ထဲတြင္

single line text object အသံုးျပဳျပီး drafter ရ႕ဲအမည္ကုိ ေရးထည့္ကာ Drawing file ရ႕ဲ Author property ျဖင့္ Link ခ်ိတ္လုိက္ပါ။

ထို႕ေနာက္ အဆိုပါ drawing ကုိအျခား drafter တစ္ေယာက္က ယူျပီး Drawing file ရ႕ဲ Author property တြင္အမည္ေျပာင္းလိုက္မည္

ဆိုပါက ထုိ title block တြင္အသစ္ေျပာင္း လုိက္ေသာ အမည္ေျပာင္းလဲသြားမည္ကုိ ေတြ႕ရမည္။ ေအာက္တြင္ ေဖာ္ျပေပးထားေသာ

ပုံမ်ားသည္ Textcommand ကိုအသုံးျပဳျပီး ေရးဆြဲထားေသာ ပုံမ်ား ျဖစ္ပါသည္။ အဆိုပါ text မ်ားကို တစ္ခ်္ိန္တည္းတြင္ ဖန္တီး

ထားေသာ္လည္း၊ text တစ္ခုခ်င္းစီကို စိတ္ၾကိဳက္ edit လုပ္ႏိုင္ ပါသည္။
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Command Access

Single Line Text

Command Line: TEXT, DTEXT, DT

Ribbon: Annotate tab > Text panel > Single Line Text

Menu Bar: Draw > Text > Single Line Text

Command Options

Text command ကစတင္လိုက္သည္နွင့္ Justify နဲ႕ Style options မ်ားကို Right–click ႏိွပ္၍ shortcut menu မွလည္းေကာင္း၊

keyboard မွ DOWN ARROW ႏိွပ္၍လည္းေကာင္း ေရြးခ်ယ္အသံုးျပဳ ႏိုင္ပါသည္။

Justify: Justify Option သည္ Text အတြက္ justification သတ္မွတ္ရာတြင္ အသံုးျပဳရပါသည္။ Justify ကုိ select လုိက္သည္နွင့္

တစ္ျပိဳင္နက္တည္း ေအာက္ေဖာ္ျပပါ ပုံအတုိင္း options list က်လာသည္ကုိ ေတြ႕ရမည္ ျဖစ္သည္။
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Style: Style Option သည္ လက္ရိွအသံုးျပဳေနေသာ text အျပင္ အျခားေသာ text styles မ်ားကုိ ေရြးခ်ယ္ ရာတြင္ အသုံးျပဳရပါသည္။

Justification options အမ်ိဳးမ်ိဳးကုိ အသံုးျပဳျပီး ေရးဆြဲထားေသာ ေအာက္ေဖာ္ျပပါ ပုံကုိ ေလ့လာၾကည့္ပါ။

Procedure: Creating Single Line Text

Single line text အသံုးျပဳပုံကုိ ေအာက္တြင္ အဆင့္ဆင့္ ေဖာ္ျပေပးထားပါသည္။

၁) Text command ကိုစတင္လိုက္ပါ။

၂) Justification options ကုိ ေရြးခ်ယ္ရန္ အတြက္ drawing window တြင္ Right – click နိွပ္လုိက္ပါ။ Justify ကို click ျပီး၊

command line မွလည္းေကာင္း (သုိ႕မဟုတ္) Right–click ႏိွပ္၍ shortcut menu မွလည္းေကာင္း Justification options ကို select

လုပ္လိုက္ပါ။

၃) Text အတြက္ first point ကုိ သတ္မွတ္ေပးပါ။
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၄) မိမိတုိ႕ ေရးထည့္လိုေသာ text မ်ားရိုက္ထည့္ေပးလုိက္ပါ။

၅) Enter တစ္ၾကိမ္ႏိွပ္လုိက္သည္ႏွင့္ text objects မ်ား ဖန္တီးေပးျပီး၊ New line ကူးသြားမည္ ျဖစ္သည္။ Enter ကို ႏွစ္ၾကိမ္ဆက္

ႏွိပ္ပါက text command သည္ exit ျဖစ္သြားမည္။

Exercise: Create Single Line Text

ဤေလ့က်င့္ခန္း၌ Layout နဲ႕ model space အတြင္းမွ drawing မ်ားတြင္ Single line text မ်ားဖန္တီးသြား ရမည္ ျဖစ္သည္။

The completed exercise

၁) C_Create-Single-Line-Text.dwg ကိုဖြင့္လုိက္ပါ။

၂) Title block area အတြင္း ညာဖက္ေအာက္ေထာင့္ကို ေအာက္ေဖာ္ျပပါ ပုံအတုိင္း Zoom ခ်႕ဲလိုက္ပါ။
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၃) Single line text ကုိအသုံးျပဳျပီး၊ title block အတြင္းရိွ Checked By တြင္ ရိွေသာ အမည္ကို မိမိတုိ႕ အမည္မ်ား ေျပာင္းလဲ

ရိုက္ထည့္ရန္ -

 Single Line Text command ကုိစတင္လုိက္ပါ။

 Drawing window တြင္ Right – click နိွပ္ျပီး၊ Justify ကို Click ျပီး Right ကို select လိုက္ပါ။

 Text ၏ Justify ကို right justification သတ္မွတ္ေပးရန္ အတြက္ ေအာက္တြင္ျမွားျဖင့္ ညႊန္ျပေပး ထားေသာေနရာ၌ Click

လုိက္ပါ။

 Text size ကို default အတုိင္းသာ အသံုးျပဳရန္ Enter ႏိွပ္ပါ။

 Rotation angle ကို 0 အျဖစ္ default အတုိင္း အသုံးျပဳရန္ Enter ႏိွပ္ပါ။

 မိမိတုိ႕၏ နာမည္ကုိ ရိုက္ထည့္ျပီး Enter ႏွစ္ခ်က္ႏိွပ္လိုက္ပါ။

၄) Viewport Scale ကို Check ရန္ -

 Drawing တစ္ခုလံုးကို Zoom Extents လုပ္လုိက္ပါ။

 Command line blank အေနအထားျဖင့္ viewport (1) ကုိ select လုိက္ပါ။

 Viewport Scale ကို 1:100 (2) ထားလိုက္ပါ။
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 Viewport selection ကုိ Cancel ေပးရန္ Esc key ႏိွပ္လိုက္ပါ။

 Model space သုိ႕ေျပာင္းရန္ Model tab ကုိႏိွပ္လိုက္ပါ။

၆) Zoom Window command ကုိစတင္လုိက္ပါ။ ေအာက္တြင္ျမွားျဖင့္ ညႊန္ျပေပးထားသည့္အတိုင္း အမွတ္နွစ္မွတ္

သတ္မွတ္ေပးလိုက္ပါ။

၇) Layers panel မွ Make Object's Layer Current (1) ကို Click ျပီး၊ Corridor (2) text object ကုိ select လိုက္ပါ။
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၈) Status bar settings ကို Check ရန္ -

 Polar Tracking, Object Snap, Object Snap Tracking န႕ဲ Dynamic Input တုိ႕ကုိ turn on လိုက္ပါ။

 Object Snap တြင္ Right-click နိွပ္ျပီး Midpoint object snap mode ကို checked လုပ္လိုက္ပါ။

၉) Text panel တြင္ရိွေသာ text style list အတြင္းမွ Standard ကို select လိုက္ပါ။
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၁၀) Rectangular object အထက္တြင္ center text ထည့္ရန္ -

 Rectangular object ၏ဘယ္ဖက္ေအာက္ေထာင့္တြင္ ရိွေသာ "Corridor" စာလံုးကို အနီးကပ္ ျမင္ႏိုင္ေအာင္ Zoom in

လုိက္ပါ။

 Single Line Text command ကိုစတင္လုိက္ပါ။

 Drawing window တြင္ Right–click နိွပ္ျပီး၊ Justify ကုိ Click ျပီး Center ကို select လိုက္ပါ။

 Rectangular ၏ Midpoint တြင္ ေအာက္ေဖာ္ျပပါ ပုံအတိုင္း hover လုပ္ျပီး၊ Midpoint အမွတ္ကုိ ေတြ႕လွ်င္ Click လိုက္ပါ။

 Text height ကုိ 300 သတ္မွတ္ေပးလုိက္ပါ။

 Rotation angle ကို 0 သတ္မွတ္ေပးလိုက္ပါ။

 Kitchen ဟုရိုက္ထည့္ျပီး၊ Enter ႏွစ္ၾကိမ္ဆက္ ႏိွပ္လုိက္ပါ။

၁၁) Text ကို rectangle ၏အလယ္သို႕ ေနရာသတ္မွတ္ေပးရန္ -

 Single Line Text command ကိုစတင္လုိက္ပါ။

 Drawing window တြင္ Right – click နိွပ္ျပီး၊ Justify ကို Click ျပီး Middle ကုိ select လုိက္ပါ။

 Rectangle ၏ နီးစပ္ Lines ႏွစ္ေၾကာင္းမွ midpoints မ်ားတြင္ track လုပ္ျပီး၊ rectangle အလယ္ intersect ျဖစ္ေသာေနရာကုိ

click လိုက္ပါ။
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 Default heigh ျဖစ္ေသာ 300 ကုိသာ ဆက္လက္အသံုးျပဳရန္ Enter ႏိွပ္လိုက္ပါ။ Rotation angle ကုိလည္း default တန္ဖိုး 0

ကိုသာဆက္လက္ အသံုးျပဳရန္ အတြက္ Enter ႏိွပ္လုိက္ပါ။

 210 ဟုရိုက္ထည့္ျပီး Enter ႏွစ္ၾကိမ္ႏိွပ္လိုက္ပါ။

၁၂) အထက္တြင္ အသုံးျပဳခ႕ဲေသာ နည္းလမ္းမ်ားကုိ အသုံးျပဳျပီး ေအာက္ေဖာ္ျပပါ ပုံမ်ားအတိုင္း room မ်ားကို Label တပ္ေပးရန္ -

၁၃) Result ကိုၾကည့္ရန္ -

 Model space မွ drawing တစ္ခုလံုးကုိ ျမင္ႏိုင္ေအာင္ Zoom ခ်႕ဲလိုက္ပါ။

 Drawing layout တြင္ text ကုိၾကည့္ရန္ Layout tab ကုိနိွပ္လိုက္ပါ။

၁၄) Files အားလုံးကို မSave ပဲပိတ္လုိက္ပါ။
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Lesson: Editing Text

ဤသင္ခန္းစာတြင္ multiline န႕ဲ single line text နွစ္မ်ိဳးလံုး၌ Edit လုပ္ျခင္းကုိ ေလ့လာသြားရမည္ ျဖစ္ပါသည္။ Drawings

တိုင္းနီးပါးတြင္ text objects အနည္းငယ္ပါ၀င္ ေလ့ရိွၾကသည္။ ထုိ text မ်ားကုိ လ်င္လ်င္ျမန္ျမန္န႕ဲ ကၽြမ္းက်င္စြာ edit

လုပ္တတ္ရန္မွာလည္း အေရးပါလွသည္။ Text objects မ်ားကုိ Drawing အတြင္းတြင္ Copy လုပ္ျခင္း၊ Move လုပ္ျခင္းမ်ားကုိ

မၾကာခဏ ျပဳလုပ္ရတတ္သည္။ ထုိအခါမ်ိဳးတြင္ Editing Text သင္ခန္းစာကုိ ပိုင္ႏိုင္ထားေသာ ေလ့လာသူမ်ားအေနျဖင့္ အလြယ္တကူ

ျပဳလုပ္သြားႏိုင္မည္ ျဖစ္သည္။

ေအာက္တြင္ ေဖာ္ျပေပးထားေသာ ပုံသည္ Title block အတြင္းတြင္ text command ကုိအသံုးျပဳျပီး ေရးထားေသာ မွတ္ခ်က္

စာသားမ်ားကုိ အမွတ္စဥ္တပ္ျခင္းျဖင့္ Modify လုပ္ထားျခင္းျဖစ္သည္။

Objectives

ဤသင္ခန္းစာကို ေလ့လာျခင္း ျပီးစီးသြားပါက -

 နည္းလမ္းအမ်ိဳးမ်ိဳးျဖင့္ text မ်ားကုိ editing လုပ္တတ္ေစရန္။

Editing Text
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Text မ်ားကို Edit လုပ္ရာတြင္ ေအာက္ပါ Tools (၅) မ်ိဳးျဖင့္ ျပဳလုပ္သြားႏိုင္ပါသည္။ ၎တုိ႕မွာ -

 Multiline Text Editor ribbon

 In-place text editor

 Properties palette

 Quick Properties

Grips

Text မ်ားကုိ Editing လုပ္ရာတြင္ အလ်င္ျမန္ဆံုးေသာ နည္းလမ္းမွာ မိမိတုိ႕ Edit လုပ္လုိေသာ text ကုိ Double–click ေပးျပီး Editing

လုပ္ျခင္းျဖစ္ပါသည္။ အကယ္၍ multiline text object ကို Double–click ေပးလွ်င္ Multiline Text Editor သည္ Ribbon tab တြင္ In-

Place Text Editor နွင့္အတူ ေပၚလာမည္ ျဖစ္သည္။ single text object ကို Double–click ေပးလွ်င္ In-Place Text Editor သည္

Click လုပ္ေသာ ေနရာတြင္ပင္ ေပၚလာမည္ ျဖစ္ျပီး အလြယ္တကူ Editing လုပ္ႏိုင္ပါသည္။ Quick Properties (သုိ႕မဟုတ္) Properties

palette တို႕မွလည္း Text Properties မ်ားကုိ Editing လုပ္ႏိုင္ပါသည္။ Grips အသံုးျပဳ၍လည္း text ၏ တည္ေနရာႏွင့္ width

ကိုျပန္လည္ ျပင္ဆင္သတ္မွတ္ေပး ႏိုင္ပါသည္။ Text objects မ်ားကုိ select လိုက္လွ်င္ grips သည္ Active ျဖစ္လာမည္ ျဖစ္ျပီး၊

geomentry မ်ား Editing လုပ္သည့္အတုိင္း text objects မ်ားကိုလည္း ျပဳလုပ္သြား ႏိုင္ပါသည္။

Multiline Text Editor သည္ Ribbon tab တြင္ In-Place Text Editor နွင့္အတူေပၚလာေသာ ပုံျဖစ္ပါသည္။

Command Access
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Multiline Text Edit

Double-click Multiline Text

Command Line: MTEDIT, DDEDIT, ED

Ribbon: double-click Multiline Text Multiline Text tab > Text Editor panels

Menu Bar: Modify > Object > Text > Edit

Command Access

Single Line Text Edit

Double-click Single Line Text

Command Line: DDEDIT, ED

Menu Browser: Modify > Object > Text > Edit

Procedure: Editing Multiline Text

Multiline text မ်ား Editig လုပ္ျခင္းကုိ ေအာက္တြင္ အဆင့္ဆင့္ ေဖာ္ျပေပးထားပါသည္။

၁) Multiline text object ကုိ Double–click ႏိွပ္လိုက္ပါ။
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၂) In-place text editor (သို႕မဟုတ္) text မ်ားကုိ select လုပ္ကာ ribbon ေပၚရိွေသာ Options မ်ားအသုံးျပဳျခင္းျဖင့္ Text content

မ်ား editing လုပ္ပါ။

၃) Ribbon ေပၚတြင္ရိွေသာ Text Editor options ကုိအသုံးျပဳကာ Text မ်ားတြင္ in-place text editor မွတဆင့္ selected ထားေသာ

text မ်ား၌ insert symbols, line spacing, numbering, bullets နဲ႕ change paragraph justification စသည္တုိ႕ ျပဳလုပ္ႏိုင္ပါသည္။

၄) Editing လုပ္ျခင္းကုိ အဆုံးသတ္ရန္ Text Editor အျပင္ဖက္၌ Double–click ေပးလုိက္ပါ။

Editing MultilineText with the Quick Properties Palette

Text Objects မ်ားကုိ Editing လုပ္ႏိုင္ေသာ Option ေနာက္တစ္မ်ိဳးမွာ Quick Properties palette ျဖင့္ Editing လုပ္ျခင္း ျဖစ္ပါသည္။

Editing လုပ္လုိေသာ Objects မ်ားကို select ျပီး Quick Properties palette မွ text properties မ်ားကုိ ျပန္လည္ျပင္ဆင္

သတ္မွတ္ႏိုင္ပါသည္။

Quick Properties palette မွ text ၏ justification option ကုိ Middle center သို႕ေျပာင္းလဲေနေသာ ေအာက္ေဖာ္ျပပါ ဥပမာကုိ

ေလ့လာၾကည့္ပါ။
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Procedure: Editing Single Line Text

Single line text မ်ား editing လုပ္ပုံကုိ ေအာက္တြင္ အဆင့္ဆင့္ ေဖာ္ျပေပးထားပါသည္။

၁) Single line text ကို Double–click ႏိွပ္လိုက္ပါ။

၂) In-place text editor ကုိအသုံးျပဳျပီး၊ Line တစ္ခုခ်င္းမွ text မ်ားကို editing လုပ္သြားပါ။ Right–click ႏိွပ္၍ စာလုံးေပါင္း

သတ္မွတ္မ်ားကုိ စစ္ေဆးျခင္းႏွင့္ အမွားျပင္ဆင္ျခင္းတုိ႕ကို ျပဳလုပ္ႏိုင္ပါသည္။

၃) Editing လုပ္ျခင္း ျပီးဆုံးေစလုိလွ်င္ text editor အျပင္ဖက္တြင္ Double – click ႏိွပ္ပါ။

Editing Single Line Text with the Quick Properties Palette

Text Objects မ်ားကုိ Quick Properties palette မွလည္း Editing လုပ္ႏိုင္ပါသည္။ Editing လုပ္လိုေသာ Objects မ်ားကို select ျပီး

Quick Properties palette မွ text properties မ်ားကုိ ျပန္လည္ျပင္ဆင္ သတ္မွတ္ႏိုင္ပါသည္။
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Quick Properties palette မွ text ၏ rotation option တြင္ 30 ဒီဂရီ သုိ႕ေျပာင္းလေဲနေသာ ေအာက္ေဖာ္ျပပါ ဥပမာကုိ

ေလ့လာၾကည့္ပါ။

Exercise: Edit Text

ဤလက္ေတြ႕ ေလ့က်င့္ခန္းတြင္ single line text န႕ဲ multiline text တို႕၏ Properties မ်ားကို ျပင္ဆင္ ေျပာင္းလဲကာ numbered list

မ်ားဖန္တီးေပးရမည္။

The completed exercise

၁) M_Edit-Text.dwg ကိုဖြင့္လုိက္ပါ။

၂) Drawing အတြင္းမွ title block area ကုိ Zoom In လုပ္လိုက္ပါ။
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မွတ္ခ်က္။ ။ Text သည္ Left justified ျဖစ္ေနေသာေၾကာင့္ grips သည္ ဘယ္ဖက္ေအာက္ေထာင့္တြင္ ေဖာ္ေျပေပး ေနျခင္းျဖစ္သည္။

၄) Objects ကုိ select လိုက္ေသာအခါ Quick Properties palette ထြက္ေပၚလာျခင္း မရိွလွ်င္၊ Status bar မွ (သို႕မဟုတ္) Right–

click ႏိွပ္ကာ Shortcut menu မွတစ္ဆင့္ Quick Properties palette ကုိ display လုပ္ရန္ -

 Text ေအာက္မွ Contents field တြင္ %%uArbor ကုိ ရုိက္ေပးပါ။

မွတ္ခ်က္။ ။ Text ေအာက္တြင္ Underline ထည့္ရန္ ASCII characters ျဖင့္ သတ္မွတ္ေပးျခင္း ျဖစ္ပါသည္။ အကယ္၍ Multiline

ျဖစ္လွ်င္ အဆိုပါ Option ကို Ribbon tab တြင္ သြားေရာက္ ျဖည့္စြက္ႏိုင္ပါသည္။

 Justify list မွ Middle ကို select လိုက္ပါ။

 Height field တြင္ 10 ကုိရိုက္ထည့္ေပးပါ။

၅) Selection ကုိ clear လုပ္ရန္ Esc key ကိုႏိွပ္ပါ။ Text သည္ မူလ အေနထားနွင့္ မတူေတာ႕သည္ကို ေတြ႕ရမည္ ျဖစ္သည္။

၆) Title block အထက္ရိွ Notes မ်ားေရးထားေသာ ေနရာကုိ Zoom In လိုက္ပါ။
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၇) အဆုိပါ Notes text မ်ားကုိ Double–click ေပးလိုက္ပါ။ Text ၏ Formatting toolbar သည္ In- Place Text Editor ႏွင့္အတူ

ေပၚလာမည္ ျဖစ္သည္။ Line မ်ား၏ေရွ႕တြင္ ရိွျပီးသား နံပါတ္မ်ားကုိ delete လုပ္လုိက္ပါ။

၈) Notes text အားလုံးသည္ အေရာင္မိွန္သြားမည္ ျဖစ္သည္။ Ribbon တြင္ရိွေသာ Paragraph panel မွ Numbering ကုိ click

လုိက္ပါ။ ထုိ႕ေနာက္ Numbered ကုိ Select လိုက္ပါ။

Text မ်ားသည္ ေအာက္ေဖာ္ျပပါ ပုံအတိုင္း ေျပာင္းလသဲြားမည္ ျဖစ္သည္။
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၉) Cursor ကို Line သံုးေၾကာင္းေျမာက္ Line ၏အစတြင္ ထားလုိက္ပါ။ ျပီးလွ်င္ Tab key ကုိႏိွပ္လိုက္ပါ။

အဆိုပါ Line ၏ ေရွ႕တြင္ အလိုအေလ်ာက္ နံပါတ္တပ္ျပီးသား ျဖစ္သြားသည္ကုိ ေတြ႕ရမည္။

၁၀) Close panel မွ Text Editor ကုိ Close လိုက္ပါ။

၁၁) Drawing တစ္ခုလုံးျမင္ႏိုင္ေအာင္ Zoom Extents လုပ္လိုက္ပါ။

၁၂) Files အားလုံးကို မ Save ပဲပိတ္လိုက္ပါ။

Lesson: Using Text Styles

ဤသင္ခန္းစာတြင္ Text styles မ်ားေျပာင္းလဲထိန္းခ်ဳပ္ပုံကုိ ေလ့လာသြားရမည္ ျဖစ္သည္။

Designers မ်ားအေနျဖင့္ drawing မ်ားဖန္တီးရာတြင္ မိမိတုိ႕စိတ္ၾကိဳက္ Text styles မ်ားျဖင့္ ေရးဆြဖဲန္တီး ႏိုင္ပါသည္။

ေရးွဆြထဲားေသာ designs မ်ားမွ text ၏ styles မ်ားကုိ စိတ္ၾကိဳက္ ျပန္လည္ျပင္ဆင္ သတ္မွတ္ေပးႏိုင္ပါသည္။
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Objectives

ဤသင္ခန္းစာကို ေလ့လာျခင္း ျပီးစီးသြားပါက -

 Text styles မ်ား၏ အဓိက ရည္ရြယ္ခ်က္ကုိ ရွင္းရွင္းလင္းလင္း သိလာေစရန္။

 Text styles မ်ားဖန္တီးျပီး အသံုးျပဳတတ္လာေစရန္။

Text Styles

Drawing မ်ားတြင္ အသံုးျပဳထားေသာ default text မ်ားကုိ Text styles ျဖင့္ အလြယ္တကူ ျပဳျပင္ႏိုင္ပါသည္။ Text object တစ္ခုစီတြင္

font, height, width factor နဲ႕ oblique angle စသည့္ Properties မ်ားပါ၀င္ပါသည္။ Text styles ျဖင့္ အဆုိပါ properties မ်ားကို

မိမိတုိ႕စိတ္ၾကိဳက္ ျပန္လည္ ျပင္ဆင္သတ္မွတ္ သြားႏိုင္ပါသည္။

Text styles ေျပာင္းလဲ ထားျခင္းေၾကာင့္ drawing တြင္ အက်ိဳးသက္ေရာက္မွဳ႕ ရိွလာသည္ကုိ ေအာက္ေဖာ္ျပပါ ပုံတြင္ ေလ့လာၾကည့္ပါ။

Text styles ေျပာင္းလထဲားျခင္းေၾကာင့္ ညာဖက္ပုံ၏ Text သည္ပိုမိုေသးငယ္ သြားျပီး Objects ျဖင့္ အံ၀င္ဂြင္က် ျဖစ္ေနသည္ကုိ

ေတြ႕ရသည္။
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Text Styles Defined

Text styles သည္ drawing အတြင္းတြင္ text styles မ်ားျပင္ဆင္ သတ္မွတ္လိုေသာ အခါ အသုံးျပဳေလ့ရိွပါသည္။ Drawing

တစ္ခုအတြင္းတြင္ text styles အမ်ိဳးမ်ိဳး အသုံးျပဳ၍လည္း text obects မ်ားဖန္တီး ႏိုင္ပါသည္။ ဥပမာ အားျဖင့္ dimension

တြင္အသုံးျပဳမည့္ text style သည္ ပုံစံတစ္မ်ိဳး၊ view labels အတြက္က တစ္မ်ိဳး၊ title blocks အတြက္ကတစ္မ်ိဳး စသည္ျဖင့္ text

styles မ်ား တစ္မ်ိဳးစီ ေျပာင္းလဲ အသုံးျပဳ ႏိုင္ပါသည္။

Creating and Using Text Styles

Style command ျဖင့္ text styles မ်ားကို စိတ္ၾကိဳက္ ျပင္ဆင္သတ္မွတ္ ေပးႏိုင္ပါသည္။ By default အရ drawings မ်ားတြင္

အသုံးျပဳေနေသာ text styles ႏွစ္မ်ိဳးရိွပါသည္။ ၎တုိ႕မွာ Standard အမည္ရိွ text style နွင့္ Annotative အမည္ရိွ text style တုိ႕ပဲ

ျဖစ္ပါသည္။ Standard အမည္ရိွ text style မွာ New drawings အားလံုးအတြက္ အသုံးျပဳေနေသာ text style ျဖစ္ပါသည္။

Creating and Using Text Styles

Drawing ရိွ Objects မ်ားကို organize လုပ္ျပီး Layer တြင္ group အလိုက္ထားသက႕ဲသို႕၊ text styles မ်ားကုိလည္း style အလိုက္

organize လုပ္ျပီး group ခဲြထားႏိုင္ပါသည္။ Text styles ဖန္တီးရန္အတြက္ Text Style dialog box ကုိအသုံးျပဳပါမည္။

လက္ရိွအသံုးျပဳေနေသာ text style မွ အျခားေသာ text style သုိ႕ေျပာင္း လုိလွ်င္၊ Text panel တြင္ရိွေသာ List မွ Styles မ်ားကုိ

select ႏိုင္ပါသည္။ Layer Control list မွ Layer မ်ား ေျပာင္းသက႕ဲသုိ႕ လုပ္ေဆာင္ခ်က္ျခင္း တူညီပါသည္။ Text style ကုိ assign

လုပ္ရန္ အတြက္ Text ကို selected ျပီးပါက List မွ မိမိတုိ႕ ေျပာင္းလိုေသာ text style ကို click ရပါမည္။
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Command Access

Style

Command Line: STYLE, ST

Ribbon: Annotate tab > Text panel > Text Style

Menu Bar: Format > Text Style

Text Style Dialog Box

Text styles မ်ားကုိ manage လုပ္ရာတြင္ Text Style dialog box ကိုအသုံးျပဳ သြားရပါမည္။
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လက္ရိွ အသုံးျပေနေသာ text Styles ကိုေဖာ္ျပေပးေသာ area ျဖစ္ပါသည္။ Style ကုိ selected လုပ္ျပီးပါက Edit (သို႕မဟုတ္)

Rename ေပးခ်င္းတုိ႕ ျပဳလုပ္ႏိုင္ပါသည္။

မိမိတုိ႕ အသံုးျပဳမည့္ Font အမ်ိဳးအစားကုိ Font name list မွ ေရြးခ်ယ္ႏိုင္ပါသည္။ လိုအပ္လွ်င္ Bold (သုိ႕မဟုတ္) Italic

တို႕ကိုလည္း ေရြးခ်ယ္ႏိုင္ပါသည္။

Text ၏ Size ကိုသတ္မွတ္ေပးရသည့္ အပိုင္းျဖစ္ပါသည္။ အကယ္၍ မိမိတို႕ အသုံးျပဳမည့္ text ကို Annotative text size လုပ္မည္

ဆိုပါက Height field တြင္ Paper Text Height ကို ေျပာင္းေပးရပါမည္။ Layout Viewport တြင္ မိမိတုိ႕ ျမင္ေတြ႕လိုေသာ အရြယ္အစား

Paper Text Height ကုိရိုက္ထည့္ေပးရပါမည္။

မိမိတုိ႕ အသုံးျပဳမည့္ text တြင္ Width Factor န႕ဲ Oblique Angle တို႕ထည့္သြင္း သတ္မွတ္ေပးရပါမည္။ Width Factor တန္ဖိုး 1

သည္ သာမန္ တန္ဖိုးျဖစ္ျပီး၊ 1 ထက္ငယ္လွ်င္ Text Width သည္က်ဥ္းေျမာင္း သြားမည္ျဖစ္ကာ၊ 1ထက္ေက်ာ္သြားပါက Text Width

သည္ က်ယ္သြားမည္ ျဖစ္သည္။

Annotative Property
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Text height ကုိ Drawing layout တြင္ display ေသာ size ႏွင့္ Plot ေသာ size မ်ားကို တူညီေစလုိလွ်င္ Annotative Style (1)

(သုိ႕မဟုတ္) Annotative property (2) တို႕ကို assign လုပ္ရပါမည္။ အကယ္၍ Instance န႕ဲ isometric view ဆိုလွ်င္ text objects

မ်ားကို ေရျပင္ညီအတုိင္း display ေစရန္ Match the text orientation to the layout (3) လုပ္ႏိုင္ပါသည္။

Annotative ကုိ selected ျပီးေသာ အခ်ိန္တြင္ Height property သည္ Paper Text Height (4) သုိ႕ေျပာင္း သြားမည္ ျဖစ္သည္။ 0

ထက္ၾကီးေသာ တန္ဖိုးတစ္ခုကုိ ရိုက္ထည့္ေပးလုိက္သည္နွင့္ viewport အတြင္းရိွ text Scaleသည္ drawing layout အတြင္းရိွ paper

height size အတုိင္း အလိုအေလ်ာက္ ေျပာင္းသြားမည္ ျဖစ္သည္။

Example of Text Oriented to Layout

ေအာက္တြင္ေဖာ္ျပ ေပးထားေသာ ပုံႏွစ္ပုံသည္ View တစ္မ်ိဳးစီျဖင့္ Layout တြင္ display ထားေသာ ပုံျဖစ္ပါသည္။ ပထမ View မွ text

သည္ orientation အတိုင္းဖန္တီးထားေသာ Plan view တစ္ခု ျဖစ္ပါသည္။ ဒုတိယပုံမွ View သည္ Isometric view

သို႕ေျပာင္းထားေသာ View ျဖစ္ေသာ္လည္း၊ text သည္ orientation အတိုင္း Layout တြင္ က်န္ရိွေနေသာ View ျဖစ္ပါသည္။

Plan view Isometric view
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Procedure: Creating and Using Text Styles

Text styles အသံုးျပဳပုံကုိ ေအာက္တြင္အဆင့္ဆင့္ ေဖာ္ျပေပးထား ပါသည္။

၁) Style command ကုိ စတင္လိုက္ပါ။

၂) New (1) ကုိ select ျပီး New Text Style Name (2) ရိုက္ထည့္ေပးကာ Ok ကို click လုိက္ပါ။

၃) အမည္ေပး သတ္မွတ္ထားေသာ New style (1) ကို select ျပီး၊ Font name (2)၊ Height (3) တုိ႕ကုိ assign လုပ္ကာ Apply (4)

ႏိွပ္ျပီးေနာက္၊ လက္ရိွအသံုးျပဳရန္ အတြက္ Set Current (5) ကုိ click လိုက္ပါ။
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၄) Text command ကိုစတင္လိုက္ပါ။

၅) Text style ကို တစ္ခုမွ အျခားေသာ style တစ္သုိ႕ေျပာင္းလဲ အသုံးျပဳရန္ List မွေရြးခ်ယ္ေပးရပါသည္။

၆) ဖန္တီးျပီးသား text objects မ်ားကို text style ေျပာင္းလဲေပးရန္ -

 Command line blank အေနအထားျဖင့္၊ text objects ကုိ select ေပးလုိက္ပါ။

 List မွ text style ကုိ select ေပးပါ။

 Text object ကုိ deselect လုပ္ရန္ Esc key ကုိနိွပ္ပါ။
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Exercise: Use Text Styles

ဤလက္ေတြ႕ ေလ့က်င့္ခန္းတြင္ Drawing အတြင္းမွ text အားလုံးကို Standard text style အျဖစ္သုိ႕ ေျပာင္းလဲ ေပးသြားရမည္။

ထို႕ေနာက္ New text styles ဖန္တီးကာ text objects မ်ားကို ဖန္တီးထားေသာ New text styles အျဖစ္ assign လုပ္ေပးရပါမည္။

The completed exercise

၁) C_Text-Styles.dwg ကုိဖြင့္လိုက္ပါ။

၂) Zoom command ကိုအသုံးျပဳျပီး၊ drawing အတြင္းမွ text မ်ားအားလုံးကို ျမင္ႏိုင္သည့္ အေနထားသုိ႕ ေရာက္ေအာင္ Zoom

ခ်ဲ႕လုိက္ပါ။

၃) Fonts မ်ားကို Standard style သို႕ေျပာင္းရန္ -

 Text panel မွ Text Style ကုိ click လိုက္ပါ။

 Text Style dialog box တြင္ရိွေသာ Font Name list မွ Arial ကို select လိုက္ပါ။



“Workgroup” AotoCAD & 3ds Max Job Training Center မွ ပညာဒါန အခမ့ဲ ျဖန္႔ေ၀သည္။

( ဤစာအုပ္ကုိ ေငြေၾကးျဖင့္ ျပန္လည္ေရာင္းခ် ခြင့္မျပဳပါ )

ေအာင္ေဇာ္လတ္ {(Master of Engineering in Science and Production Engineering) Moscow State University Of Railway Engineering}

ဘာသာျပန္ ေရးသား ျပဳစုသည္။

“Workgroup “ AutoCAD & 3ds Max Training Center, International Computer Driving Licence Approved Test Center,
Rm- 403, Excel Tower, Yangon, Myanmar.

Ph: 951 559377 Ext: 6413 or 6403, Email – infor@workgroupweb.com

94

 Tip: Arial font ကိုရွာရာတြင္ Scroll ကိုဆြဲေနစရာ မလုိပဲ field တြင္ A စာလံုးကို ရိုက္ထည့္ျပီး အလြယ္တူ လ်င္ျမန္စြာ

ေရြးခ်ယ္ႏိုင္ပါသည္။

 Height အတြက္ 0 ကုိေရြးခ်ယ္ပါ။

 Apply ေပးလိုက္ပါ။

 Close ကုိ click လိုက္ပါ။

၄) Drawing အတြင္းမွ text မ်ားကို ၾကည့္ၾကည့္လိုက္ပါ။ Text အားလုံးသည္ modified style ျဖစ္ေနသည္ကုိ ေတြ႕ရမည္။

၅) Drawing တစ္ခုလံုး ျမင္ႏိုင္ေအာင္ Zoom Extents လုပ္လုိက္ပါ။

၆) Drawing အတြင္းတြင္ အသုံးျပဳရန္ text style အသစ္ကို ဖန္တီးရန္ -

 Text Style command ကုိစတင္လုိက္ပါ။

 Text Style dialog box တြင္ New ကုိ click ပါ။

 New Text Style dialog box တြင္ MT-5-Title ကုိုရိုက္ထည့္လိုက္ပါ။

 Ok ကုိ Click လိုက္ပါ။

 Font Name list မွ Technic ကို select လိုက္ပါ။

 Height အတြက္ 8 ကုိရိုက္ထည့္ေပးလုိက္ပါ။

 Apply ကို Click ပါ။

 New ကို click ပါ။

 New Text Style dialog box တြင္ ViewLabel ကုိရိုက္ထည့္ပါ။
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 Ok ကုိ click ပါ။

 Height အတြက္ 5 ကုိရိုက္ထည့္ေပးလုိက္ပါ။

 Apply ကို Click ပါ။

 Close ကုိ click လိုက္ပါ။

၇) Main Floor ဆုိေသာ lable ႏွင့္ View ေအာက္နားတြင္ ရိွေသာ number tag ကုိ select လုပ္ပါ။

၈) Text panel တြင္ရိွေသာText Style list မွ ViewLabel ကုိ select လုိက္ပါ။

၉) Selection ကုိ Clear လုပ္ရန္ Esc key ကုိ ႏိွပ္ပါ။ New text style သည္ view label text အျဖစ္သုိ႕ assigned ျဖစ္သြားမည္။

၁၀) Title block text ၾကည့္ရန္၊ drawing အတြင္းမွ View ကုိေအာက္တြင္ ေဖာ္ျပေပးထားေသာ ပုံအတုိင္း ျပင္လုိက္ပါ။

၁၁) Text style ကုိေျပာင္းရန္ -

 Text panel တြင္ရိွေသာ Text Styles list မွ MT-5-Title ကုိ select လုိက္ပါ။
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 Selection ကုိ Clear လုပ္ရန္ Esc key ႏိွပ္ပါ။

 New text style သည္ selected text တြင္ applied ျဖစ္သြားမည္။

၁၂) Files အားလုံးကို မ Save ပဲပိတ္လိုက္ပါ။

Challenge Exercise: Architectural

ဤသင္ခန္းစာတြင္ အထက္၌ ေလ့လာျပီးခ႕ဲေသာ text style မ်ားဖန္တီးျခင္းနွင့္ မိမိတုိ႕၏ Floor plan ကို annotation add ျခင္းတုိ႕ကုိ

လက္ေတြ႕ ေလ့က်င့္လုပ္ေဆာင္သြားရမည္ ျဖစ္သည္။
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The completed exercise

Metric Units

၁) M_ARCH-Challenge- CHP07.dwg ကိုဖြင့္လုိက္ပါ။

၂) Initial settings ျပဳလုပ္ရန္ -

 Model Space သုိ႕ျပန္သြားရန္ Model tab ကုိႏိွပ္ပါ။

 Annotation layer ကုိ current layer အျဖစ္ ေျပာင္းလိုက္ပါ။

၃) ေအာက္ပါ characteristics မ်ားျဖင့္ New text layer ျပဳလုပ္ရန္ -

 Style Name: Labels

 Font Name: Arial

 Height: 0

 Width Factor: 0.9000

၄) 300 mm အရွည္ရိွေသာ အခန္း label ႏွင့္ အခန္း၏ ID နံပါတ္တုိ႕ကို ေအာက္ေဖာ္ျပပါ ပုံအတုိင္း တပ္ေပးရန္ -

 221 မွ 224 အထိ - SLEEPING QUARTERS

 201 - READY ROOM

 202 & 204 - LOCKER ROOM

 203 - EXERCISE ROOM

 205 - DINING ROOM

 206 - KITCHEN

 207 - MEN'S TOILET ROOM

 208 - WOMEN'S TOILET ROOM
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၅) Drawing ကုိ Save ျပီး ပိတ္လိုက္ပါ။

Imperial Units

၁) I_ARCH-Challenge- CHP07.dwg ကုိဖြင့္လိုက္ပါ။

၂) Initial settings ျပဳလုပ္ရန္ -

 Model Space သို႕ျပန္သြားရန္ Model tab ကိုႏိွပ္ပါ။

 Annotation layer ကုိ current layer အျဖစ္ ေျပာင္းလုိက္ပါ။

၃) ေအာက္ပါ characteristics မ်ားျဖင့္ New text layer ျပဳလုပ္ရန္ -

 Style Name: Labels

 Font Name: Arial

 Height: 0

 Width Factor: 0.9000

၄) 1’ အရွည္ရိွေသာ အခန္း label ႏွင့္ အခန္း၏ ID နံပါတ္တုိ႕ကို ေအာက္ေဖာ္ျပပါ ပုံအတုိင္း တပ္ေပးရန္ -

 221 မွ 224 အထိ - SLEEPING QUARTERS

 201 - READY ROOM
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 202 & 204 - LOCKER ROOM

 203 - EXERCISE ROOM

 205 - DINING ROOM

 206 - KITCHEN

 207 - MEN'S TOILET ROOM

 208 - WOMEN'S TOILET ROOM

၅) Drawing ကုိ Save ျပီး ပိတ္လိုက္ပါ။

Challenge Exercise: Mechanical

ဤသင္ခန္းစာတြင္ အထက္၌ ေလ့လာျပီးခ႕ဲေသာ annotation နဲ႕ပတ္သက္ျပီး drawing တြင္ annotation add ျခင္းကုိ လက္ေတြ႕

ေလ့က်င့္လုပ္ေဆာင္ သြားရမည္ ျဖစ္သည္။

မွတ္ခ်က္။ ။ ေအာက္ေဖာ္ျပပါ ပုံအခ်ိဳ႕တြင္ annotation မ်ား လုိအပ္ေနပါသည္။
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The completed exercise

၁) M_ARCH-Challenge- CHP07.dwg ကိုဖြင့္လိုက္ပါ။

၂) Initial settings ျပဳလုပ္ရန္ -

 Model Space သို႕ျပန္သြားရန္ Model tab ကိုႏိွပ္ပါ။

 Annotation layer ကုိ current layer အျဖစ္ ေျပာင္းလုိက္ပါ။

၃) ေအာက္ပါ characteristics မ်ားျဖင့္ New text layer ျပဳလုပ္ရန္ -

 Style Name: Labels

 Font Name: Arial

 Height: 0

 Width Factor: 0.9000

၄) ေအာက္ေဖာ္ျပပါ ပုံ၌ 8.0 mm ရွည္ေသာ View label တစ္ခုကုိ adding လုပ္ျခင္းျဖင့္ Drawing view မ်ားကုိ Annotate လုပ္ရန္ -

မွတ္ခ်က္။ ။ ေအာက္ေဖာ္ျပပါ ပုံတြင္ ျမွားျဖင့္ညႊန္ျပထားေသာ ဘယ္ဖက္Outfeed Side တြင္ Height မွာ 4.0mm သာရိွရပါမည္။
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၅) More View –
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၆) Files အားလံုးကို Save ျပီး ပိတ္လိုက္ပါ။

Chapter Summary

Annotation commands ကိုအသုံးျပဳျပီး၊ drawing အတြင္းတြင္ annotations မ်ားကုိ လိုအပ္သလို edit လုပ္ႏိုင္လာမည္။

ဤသင္ခန္းစာကို ေလ့လာျခင္း ျပီးစီးသြားပါက -

 Mtext command ကုိအသုံးျပဳျပီး၊ multiline text မ်ားကုိဖန္တီးတတ္လာမည္။

 Single line text မ်ားဖန္တီးတတ္လာမည္

 Text styles မ်ားကုိ Manage လုပ္တတ္လာမည္။
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CHAPTER 8: Dimensioning

Drawings မ်ားတြင္ မိမိတုိ႕ ဖန္တီးထားေသာ Objects မ်ား၏ အရြယ္အစား၊ အကြာအေ၀း စသည္တို႕ကို dimension ျဖင့္ တုိင္းတာ

သတ္မွတ္ႏိုင္ပါသည္။ ဤသင္ခန္းစာတြင္ typical design environment ၌အသံုးျပဳမည့္ dimensions မ်ားကုိ create, edit န႕ဲ manage

လုပ္ျခင္းတို႕ကို ေလ့လာသြားရမည္ ျဖစ္ပါသည္။

Objectives
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ဤသင္ခန္းစာကုိ ေလ့လာျခင္း ျပီးစီးသြားပါက -

 Dimensions ဖန္တီးတတ္လာေစရန္။

 Dimension style ကိုအသံုးျပဳ၍ dimensions မ်ားကို manage လုပ္တတ္လာေစရန္။

 Multileader styles န႕ဲ Multileaders မ်ားကို creat ျခင္းနွင့္ edit လုပ္ျခင္းတုိ႕ကုိ ျပဳလုပ္တတ္လာ ေစရန္။

 မတူညီေသာ commands မ်ားအသံုးျပဳျပီး dimensions မ်ား edit လုပ္ျခင္း နည္းလမ္းကုိ နားလည္ သေဘာေပါက္ လာေစရန္။

Lesson: Creating Dimensions

ဤသင္ခန္းစာတြင္ အမ်ိဳးမ်ိဳးေသာ dimensions commands မ်ားအသုံးျပဳ၍ drawings မ်ားတြင္ dimensions ထည့္ျခင္းကုိ

ေလ့လာသြားရမည္ ျဖစ္သည္။ Dimension သည္ elements မ်ား၏ annotation အတြက္ မရိွမျဖစ္ လုိအပ္ေသာ command

တစ္မ်ိဳးျဖစ္သည္။ Dimensions မ်ားသည္ drawings မ်ား၏ အတိုင္းအတာမ်ားကုိ ေဖာ္ျပ ေပးသည္ကုိ ေအာက္ေဖာ္ျပပါပုံတြင္

ေလ့လာၾကည့္ပါ။

Objectives

ဤသင္ခန္းစာကို ေလ့လာျခင္း ျပီးစီးသြားပါက -

 Line objects မ်ားေပၚတြင္ မတူညီေသာ dimensions မ်ားဖန္တီးတတ္လာေစရန္။

 Curved objects မ်ားေပၚတြင္ မတူညီေသာ dimensions မ်ားဖန္တီးတတ္လာေစရန္။

Creating Dimensions on Linear Objects
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Drawing အတြင္းမွ objects မ်ား၏ dimensions ကုိ မ်ဥ္းေျဖာင့္အတိုင္း တုိင္းတာေပးျခင္းကို ေလ့လာသြား ရမည္ ျဖစ္ပါသည္။ Object

snaps ကိုမွန္ကန္စြာ အသုံးျပဳတတ္မွ သာလွ်င္ မိမိတုိ႕ ဖန္တီးထားေသာ drawing အတြင္းက objects မ်ား၏ dimensions ကို

အတိအက် သိရိွႏိုင္မည္ ျဖစ္ပါသည္။

Dimension commands သည္ Ribbon ၏ Annotate tab တြင္တည္ရိွပါသည္။ Command ကုိေခၚျပီးလွ်င္ Command line မွ

ေရွ႕ဆက္လုပ္ေဆာင္ရမည့္ ညႊန္ၾကားခ်က္မ်ား Prompted လာေပးသည္ကို အထူးသတိျပဳ ဖတ္ရန္ လုိအပ္သည္။

ေအာက္တြင္ေဖာ္ျပေပးထားေသာ ပုံသည္ linear objects မ်ားအတြက္ အမ်ိဳးမ်ိဳးေသာ dimensions ျဖစ္ပါသည္။

Procedure: Creating a Linear Dimension
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Horizontal (သို႕မဟုတ္) vertical Linear dimensions မ်ားဖန္တီးရန္ အတြက္ ေအာက္ေဖာ္ျပပါ command မ်ားကို

အသုံးျပဳသြားရပါမည္။

Command Line: DIMLINEAR, DIMLIN

Ribbon: Annotate tab > Dimensions panel > Linear

Linear dimensions မ်ားဖန္တီးပုံကုိ ေအာက္တြင္အဆင့္ဆင့္ ေဖာ္ျပေပးထားပါသည္။

၁) Dimlinear command ကိုစတင္လိုက္ပါ။

၂) Object ကုိ select လုပ္ရန္ အတြက္ Enter ႏိွပ္ပါ (သို႕မဟုတ္) objects snap ကုိအသံုးျပဳျပီး မိမိတုိ႕ တုိင္းတာလို လုိေသာ Line

object ၏ စမွတ္ (1) ကုိ clickျပီး၊ ဆံုးမွတ္ (2) ကုိ ထပ္မံ click ေပးလုိက္ပါ။

၃) Dimension ကုိေနရာသတ္မွတ္ရန္ (3) ကို click လုိက္ပါ။

Practice Exercise: Linear Dimensions

ဤလက္ေတြ႕ ေလ့က်င့္ခန္းတြင္ ေအာက္ေဖာ္ျပပါ ပုံအတုိင္း object တြင္ linear dimensions မ်ားဖန္တီးေပး သြားရမည္ ျဖစ္သည္။
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၁) Dimensions ထည့္ရန္ Object ေရးဆြဲပါ -

 ေအာက္တြင္ေဖာ္ျပ ေပးထားသည့္ အတိုင္း rectangle တစ္ခုကို ေရးဆြဲလုိက္ပါ။ (နွစ္သက္ရာ အရြယ္စား)

 Rectangle ကို stretch လုပ္လုိပါက Grips တစ္ခုကုိ select ျပီး လုပ္ႏိုင္ပါသည္။

 Object ကို deselect လုပ္ရန္ Esc key ႏိွပ္ပါ။

၂) Object ေပၚရိွ အမွတ္နွစ္မွတ္ကုိ select ျခင္းျဖင့္ Linear dimension ဖန္တီးရန္ --

 Linear dimension ကုိစတင္လိုက္ပါ။

 Object snap ကုိအသုံးျပဳျပီး first extension line origin အတြက္ object ၏ first point (1) ကို select လိုက္ပါ။

 ျပီးလွ်င္ second extension line origin အတြက္ second point (2) ကုိ သတ္မွတ္ေပးလိုက္ပါ။

 ေအာက္ေဖာ္ျပပါ ပုံအတုိင္း dimension line တည္ေနရာ (3) ကုိသတ္မွတ္ေပး လိုက္ပါ။
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၃) Object ကို selecting လုပ္ျခင္းျဖင့္ Linear dimension မ်ားဖန္တီးရန္ -

 Linear dimension ကုိစတင္လိုက္ပါ။

 Object ကို select ရန္ Enter ႏိွပ္ပါ။

 Object ၏ တစ္ေနရာရာ (1) ကုိ click လိုက္ပါ။

 Dimension အတြက္ ေနရာသတ္မွတ္ေပးရန္ Cursor ကုိ drag ျပီး ႏွစ္သက္ရာ ေနရာတြင္ (2) click လိုက္ပါ။

 Linear dimension command ကုိ ျပန္ေခၚလုိက္ပါ။

 Line (3) နဲ႕ (4) ကုိလည္း အထက္ပါ နည္းအတိုင္း dimension ဖန္တီးေပးပါ။

Procedure: Creating an Aligned Dimension

Object (သုိ႕မဟုတ္) အမွတ္ႏွစ္မွတ္တုိ႕တြင္ aligned dimension ဖန္တီးရန္ ေအာက္ေဖာ္ျပပါ Command ကိုအသံုးျပဳ သြားရမည္

ျဖစ္သည္။
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Command Line: DIMALIGNED

Ribbon: Annotate tab > Dimensions panel > Align

မွတ္ခ်က္။ ။ Dimension list မွ မိမိတို႕ selected ျပီးေသာ dimension type ၏ icon သည္ Dimensions panel တြင္

ေဖာ္ျပေပးေနမည္ ျဖစ္သည္။

Aligned dimension အသံုးျပဳပုံကို ေအာက္တြင္ အဆင့္ဆင့္ ေဖာ္ျပေပးထားပါသည္။

၁) Dimaligned command ကုိ စတင္လုိက္ပါ။

၂) Object ကို select လုပ္ရန္ အတြက္ Enter ႏိွပ္ပါ (သုိ႕မဟုတ္) objects snap ကိုအသံုးျပဳျပီး first extension line origin အတြက္

မိမိတုိ႕ တုိင္းတာလို လိုေသာ Line object ၏ စမွတ္ (1) ကုိ clickျပီး၊ second extension line origin အတြက္ ဆံုးမွတ္ (2) ကို ထပ္မံ

click ေပးလိုက္ပါ။

၃) Dimension ကုိေနရာသတ္မွတ္ရန္ (3) ကို click လုိက္ပါ။
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Practice Exercise: Aligned Dimensions

ဤလက္ေတြ႕ ေလ့က်င့္ခန္းတြင္ ေအာက္ေဖာ္ျပပါ ပုံအတုိင္း object တြင္ aligned dimension မ်ားဖန္တီးေပး သြားရမည္ ျဖစ္သည္။

၁) Dimensions ထည့္ရန္ Object ေရးဆြဲပါ -

 ေအာက္တြင္ေဖာ္ျပ ေပးထားသည့္ အတိုင္း rectangle တစ္ခုကို ေရးဆြဲလုိက္ပါ။ (နွစ္သက္ရာ အရြယ္စား)

 Rectangle ကို stretch လုပ္လုိပါက Grips တစ္ခုကုိ select ျပီး လုပ္ႏိုင္ပါသည္။

 Object ကို deselect လုပ္ရန္ Esc key ႏိွပ္ပါ။

၂) Object ေပၚရိွ အမွတ္နွစ္မွတ္ကုိ select ျခင္းျဖင့္ Aligned dimension ဖန္တီးရန္ -

 Aligned dimension ကုိစတင္လုိက္ပါ။



“Workgroup” AotoCAD & 3ds Max Job Training Center မွ ပညာဒါန အခမ့ဲ ျဖန္႔ေ၀သည္။

( ဤစာအုပ္ကုိ ေငြေၾကးျဖင့္ ျပန္လည္ေရာင္းခ် ခြင့္မျပဳပါ )

ေအာင္ေဇာ္လတ္ {(Master of Engineering in Science and Production Engineering) Moscow State University Of Railway Engineering}

ဘာသာျပန္ ေရးသား ျပဳစုသည္။

“Workgroup “ AutoCAD & 3ds Max Training Center, International Computer Driving Licence Approved Test Center,
Rm- 403, Excel Tower, Yangon, Myanmar.

Ph: 951 559377 Ext: 6413 or 6403, Email – infor@workgroupweb.com

112

 Object snap ကုိအသုံးျပဳျပီး first extension line origin အတြက္ object ၏ first point (1) ကို select လိုက္ပါ။

 ျပီးလွ်င္ second extension line origin အတြက္ second point (2) ကုိ သတ္မွတ္ေပးလိုက္ပါ။

 ေအာက္ေဖာ္ျပပါ ပုံအတုိင္း dimension line တည္ေနရာ (3) ကုိသတ္မွတ္ေပးလိုက္ပါ။

၃) Object ကို selecting လုပ္ျခင္းျဖင့္ Aligned dimension မ်ားဖန္တီးရန္ -

 Aligned dimension ကုိစတင္လုိက္ပါ။

 Object ကို select ရန္ Enter ႏိွပ္ပါ။

 Object ၏ တစ္ေနရာရာ (1) ကုိ click လိုက္ပါ။

 Dimension အတြက္ ေနရာသတ္မွတ္ေပးရန္ Cursor ကုိ drag ျပီး ႏွစ္သက္ရာ ေနရာတြင္ (2) click လိုက္ပါ။

 Linear dimension command ကုိ ျပန္ေခၚလုိက္ပါ။

 Line (3) ကိုလည္း အထက္ပါ နည္းအတုိင္း dimension ဖန္တီးေပးပါ။
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Procedure: Creating an Angular Dimension

Lines ႏွစ္ေၾကာင္း အၾကားတြင္ angular dimension ဖန္တီးရန္ အတြက္ ေအာက္ေဖာ္ျပပါ command ကိုအသံုးျပဳ သြားရမည္ပါမည္။

Angular dimension ကို circle တြင္ရိွေသာ အမွတ္နွစ္မွတ္၏ angle, arc တြင္ရိွေသာ အမွတ္နွစ္မွတ္၏ angle ႏွင့္

အမွတ္သုံးမွတ္ၾကားရိွ angle တို႕ကို တုိင္းတာရာတြင္လည္း အသံုးျပဳနိုင္ပါသည္။

Command Line: DIMANGULAR, DIMANG

Ribbon: Annotate tab > Dimensions panel > Angular

မွတ္ခ်က္။ ။ Dimension list မွ မိမိတို႕ selected ျပီးေသာ dimension type ၏ icon သည္ Dimensions panel တြင္

ေဖာ္ျပေပးေနမည္ ျဖစ္သည္။

Angular dimension ဖန္တီးပုံကို ေအာက္တြင္အဆင့္ဆင့္ ေဖာ္ျပေပးထားပါသည္။

၁) Dimangular command ကိုစတင္လိုက္ပါ။

၂) ပထမ Line (1) ကို select လုိက္ပါ။

၃) ဒုတိယ Line (2) ကို select လုိက္ပါ။



“Workgroup” AotoCAD & 3ds Max Job Training Center မွ ပညာဒါန အခမ့ဲ ျဖန္႔ေ၀သည္။

( ဤစာအုပ္ကုိ ေငြေၾကးျဖင့္ ျပန္လည္ေရာင္းခ် ခြင့္မျပဳပါ )

ေအာင္ေဇာ္လတ္ {(Master of Engineering in Science and Production Engineering) Moscow State University Of Railway Engineering}

ဘာသာျပန္ ေရးသား ျပဳစုသည္။

“Workgroup “ AutoCAD & 3ds Max Training Center, International Computer Driving Licence Approved Test Center,
Rm- 403, Excel Tower, Yangon, Myanmar.

Ph: 951 559377 Ext: 6413 or 6403, Email – infor@workgroupweb.com

114

၄) Dimension ကုိေနရာသတ္မွတ္ရန္ (3) ကုိ click လိုက္ပါ။

Practice Exercise: Angular Dimensions

ဤလက္ေတြ႕ ေလ့က်င့္ခန္းတြင္ ေအာက္ေဖာ္ျပပါ ပုံအတုိင္း object တြင္ Angular dimension မ်ားဖန္တီးေပး သြားရမည္ ျဖစ္သည္။

၁) Dimensions ထည့္ရန္ Object ေရးဆြဲပါ -

 ေအာက္တြင္ေဖာ္ျပ ေပးထားသည့္ အတိုင္း rectangle တစ္ခုကို ေရးဆြဲလုိက္ပါ။ (နွစ္သက္ရာ အရြယ္စား)

 Rectangle ကို stretch လုပ္လုိပါက Grips တစ္ခုကုိ select ျပီး လုပ္ႏိုင္ပါသည္။

 Object ကို deselect လုပ္ရန္ Esc key ႏိွပ္ပါ။

၂) Object ေပၚရိွ အမွတ္နွစ္မွတ္ကုိ select ျခင္းျဖင့္ Angular dimension ဖန္တီးရန္ -

 Angular dimension ကုိစတင္လိုက္ပါ။
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 Object snap ကုိအသုံးျပဳျပီး first extension line origin အတြက္ object ၏ first point (1) ကို select လိုက္ပါ။

 ျပီးလွ်င္ second extension line origin အတြက္ second point (2) ကုိ သတ္မွတ္ေပးလိုက္ပါ။

 ေအာက္ေဖာ္ျပပါ ပုံအတုိင္း dimension arc line တည္ေနရာ (3) ကိုသတ္မွတ္ေပးလိုက္ပါ။

မွတ္ခ်က္။ ။ Arc dimension ကိုအတြင္းေရာ အျပင္ပါ drag လုပ္ႏိုင္ပါသည္။

၃) က်န္ရိွေနေသးေသာ angles မ်ားကိုလည္း dimension ဆက္လက္ ထည့္ေပးပါ။

Procedure: Creating Baseline Dimensions

Baseline dimensions ကုိဖန္တီးရန္ အတြက္ ေအာက္ေဖာ္ျပပါ command မ်ားကုိ အသံုးျပဳ သြားရမည္။ Baseline dimensions

ကိုအသံုးျပဳရန္ အတြက္ ပထမဆုံးအေနနဲ႕ Linear, Aligned (သုိ႕မဟုတ္) Angular dimensions မ်ားထဲမွ တစ္ခုခုကို ဖန္တီးထားရမည္

ျဖစ္ပါသည္။ Default အရ Baseline dimensions သည္ေနာက္ဆံုး selected ခ႕ဲေသာ dimensions ကေန ျပန္လည္စတင္

မည္ျဖစ္သည္။
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Command Line: DIMBASELINE, DIMBASE

Ribbon: Annotate tab > Dimensions panel > Baseline

Baseline dimensions ဖန္တီးပုံကုိ ေအာက္တြင္ အဆင့္ဆင့္ ေဖာ္ျပေပးထားပါသည္။

၁) Baseline dimensions ကိုစတင္ျပီး Baseline dimensions မ်ားဖန္တီး အသံုးျပဳရန္။

မွတ္ခ်က္။ ။ Baseline dimensions ကိုစတင္ လုိက္သည္ႏွင့္ command line က select dimension base ကုိ Prompted

ေပးပါလိမ္႕မည္။ သို႕ေသာ္ By default အရ Baseline dimensions ကိုအသံုးျပဳမီ Linear, Aligned (သို႕မဟုတ္) Angular dimensions

မ်ားထဲမွ တစ္ခုခုကို အသံုးျပဳ သြားရမည္ျဖစ္သည္။

၂) Baseline dimensions ကုိအသုံးျပဳရန္ အတြက္ Linear dimension ကိုစတင္ျပီး first extension line origin အတြက္ Point (1) နဲ႕

second extension line origin အတြက္ Point(2) ေအာက္ေဖာ္ျပပါ ပုံအတိုင္း သတ္မွတ္ ေပးလုိက္ပါ။

မွတ္ခ်က္။ ။ Baseline dimensions အတြက္ basepoint သည္ Point (1) ျဖစ္သြားမည္။

၃) Dimension ကုိေနရာသတ္မွတ္ရန္ (3) ကို click လုိက္ပါ။

၄) Dimbaseline command ကုိစတင္ျပီး ေနာက္တစ္မွတ္ (4) ကုိ select လိုက္ပါ။

၅) Points (5 နဲ႕ 6) ကုိထပ္မံ၍ select လုိက္ပါ။ ဆက္လက္ျပီး မိမိတို႕ လုိအပ္သေလာက္ select သြားႏိုင္ပါသည္။
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၆) Baseline command ျပီးစီးေၾကာင္း အတည္ျပဳရန္ Enter ႏိွပ္ပါ။

Practice Exercise: Baseline Dimensions

ဤလက္ေတြ႕ ေလ့က်င့္ခန္းတြင္ ေအာက္ေဖာ္ျပပါ ပုံအတုိင္း object တြင္ Baseline dimensions မ်ားဖန္တီးေပး သြားရမည္ ျဖစ္သည္။

၁) Linear dimension command ကိုအသုံးျပဳျပီး Baseline dimensions မ်ားဖန္တီးရန္ -

 Linear dimension ကုိစတင္လိုက္ပါ။

 First extension line origin အတြက္ First Point (1) ကို သတ္မွတ္ေပးလိုက္ပါ။

 Second extension line origin အတြက္ Second Point (2) ကုိ သတ္မွတ္ေပးပါ။

 Dimensions ေနရာကို သတ္မွတ္ေပး လိုက္ပါ။
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မွတ္ခ်က္။ ။ Baseline dimensions အတြက္ basepoint သည္ First point ျဖစ္သြားမည္။

၂) Baseline dimensions မ်ား Add ရန္ -

 Baseline command ျဖင့္ ဆက္လက္လုပ္ေဆာင္ သြားရမည္ ျဖစ္သည္။

 Basepoint ကေန ေအာက္ေဖာ္ျပပါ ပုံအတိုင္း အမွတ္ (1) (2) န႕ဲ (3) Lines မ်ားတြင္ အမွတ္မ်ား သတ္မွတ္ျပီး Baseline

dimensions မ်ား Add သြားပါ။

 Command ျပီးစီးေၾကာင္း အတည္ျပဳေပးရန္ Enter ႏိွပ္ပါ။

Procedure: Creating Continuous Dimensions
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Linear, Aligned (သုိ႕မဟုတ္) Angular dimension တုိ႕ကုိ အေျခခံကာ ေအာက္ေဖာ္ျပပါ command အသံုးျပဳျပီး Continuous

Dimensions မ်ားကုိ ဖန္တီးသြားမည္။ Continuous Dimensions သည္မိမိတို႕ ေနာက္ဆုံး ဖန္တီးခ႕ဲေသာ အမွတ္မွ စတင္ျပီး

Dimensions မ်ားကို ဖန္တီးေပးသြားမည္ ျဖစ္သည္။

Command Line: DIMCONTINUE, DIMCONT

Ribbon: Annotate tab > Dimensions panel > Continuous

Continuous Dimensions မ်ားဖန္တီးပုံကို ေအာက္တြင္ အဆင့္ဆင့္ ေဖာ္ျပေပး ထားပါသည္။

၁) Baseline dimensions ကိုစတင္ျပီး Baseline dimensions မ်ားဖန္တီး အသံုးျပဳရန္။

မွတ္ခ်က္။ ။ Continuous Dimensions ကိုစတင္ လိုက္သည္ႏွင့္ command line က select dimension base ကို Prompted

ေပးပါလိမ္႕မည္။ သို႕ေသာ္ By default အရ Continuous Dimensions ကုိအသုံးျပဳမီ Linear, Aligned (သို႕မဟုတ္) Angular

dimensions မ်ားထဲမွ တစ္ခုခုကို အသုံးျပဳ သြားရမည္ျဖစ္သည္။

၂) Continuous Dimensions ကုိအသံုးျပဳရန္ အတြက္ Linear dimension ကိုစတင္လိုက္ပါ။ ထို႕ေနာက္ object snap အသံုးျပဳျပီး first

extension line origin အတြက္ Point (1) နဲ႕ second extension line origin အတြက္ Point(2) ေအာက္ေဖာ္ျပပါ ပုံအတုိင္း

သတ္မွတ္ေပးလိုက္ပါ။

၃) ေအာက္ေဖာ္ျပပါ ပုံအတုိင္း dimension တည္ေနရာ (3) ကုိသတ္မွတ္ေပး လိုက္ပါ။

၄) Dimcontinuous command ကုိစတင္လုိက္ပါ။ ထပ္မံျပီး Point (4) ကုိ select ေပးလုိက္ပါ။

၅) Object snap ကုိအသုံးျပဳျပီး Points (5 နဲ႕ 6) ကိုထပ္မံ၍ select လိုက္ပါ။ ဆက္လက္ျပီး မိမိတို႕ လိုအပ္သေလာက္ select

သြားႏိုင္ပါသည္။
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Practice Exercise: Continuous Dimensions

ဤလက္ေတြ႕ ေလ့က်င့္ခန္းတြင္ ေအာက္ေဖာ္ျပပါ ပုံအတိုင္း object တြင္ Continuous Dimensions မ်ား ဖန္တီးေပး သြားရမည္

ျဖစ္သည္။

၁) Linear dimension command ကိုအသုံးျပဳျပီး Base dimensions ဖန္တီးရန္ -

 Linear dimension ကုိစတင္လိုက္ပါ။

 First extension line origin အတြက္ First Point (1) ကို သတ္မွတ္ေပးလိုက္ပါ။

 Second extension line origin အတြက္ Second Point (2) ကုိ သတ္မွတ္ေပးပါ။

 Dimensions ေနရာကို သတ္မွတ္ေပး လိုက္ပါ။
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၂) Continuous Dimensions မ်ား Add ရန္ -

 Continuous Dimensions ကုိစတင္လုိက္ပါ။

 ထပ္မံ၍ dimensions မ်ား add ရန္အတြက္ Point (1) နဲ႕ Point (2) ကိုသတ္မွတ္ေပးလိုက္ပါ။

 Command ကုိျပီးေျမာက္ေၾကာင္း အတည္ျပဳရန္ Enter ႏွစ္ၾကိမ္ဆက္ ႏိွပ္ပါ။

မွတ္ခ်က္။ ။ မိမိတို႕ ေနာက္ဆံုး dimensions မ်ားကုိ add ခဲ႕ေသာ ေနရာမွ စတင္ျပီး dimensions မ်ား add လိုလွ်င္ Continuous

Dimensions ကုိ အသုံးျပဳရပါမည္။

Creating Dimensions on Curved Objects

Commands မ်ားအသုံးျပဳျပီး Drawing အတြင္းမွ curved objects မ်ားေပၚတြင္ dimensions မ်ားဖန္တီး သြားရမည္။ Command line မွ

Prompted ေပးေသာ guides မ်ားကုိ အထူးသတိထား ဖတ္သြားရန္ လုိအပ္ေပသည္။ Dimensions panel တြင္ရိွေသာ dimensions list

မွ အဆိုပါ dimensions မ်ားကို select ျပီးအသုံးျပဳ ႏိုင္ပါသည္။
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ေအာက္တြင္ ေဖာ္ျပေပးထားေသာ ပုံတြင္ Curved object ၌ အသံုးျပဳထားေသာ dimensions မ်ားကိုေလ့လာၾကည့္ပါ။

Procedure: Creating an Arc Length Dimension
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ေအာက္ပါ command ကုိအသံုးျပဳျပီး Arc ရဲ႕ Length ကုိ dimension တပ္ေပးရပါမည္။

Command Line: DIMARC

Ribbon: Annotate tab > Dimensions panel > Arc Length

Arc length dimension ဖန္တီးပုံကုိ ေအာက္တြင္ အဆင့္ဆင့္ ေဖာ္ျပေပးထားပါသည္။

၁) Dimarc dimension command ကုိစတင္လုိက္ပါ။

၂) Arc (1) ကို select ပါ။

၃) Arc length dimension (2) ကုိေနရာသတ္မွတ္ေပးရန္ Click ပါ။

Practice Exercise: Arc Length Dimensions

ဤလက္ေတြ႕ ေလ့က်င့္ခန္းတြင္ Arc မ်ားကို ေအာက္ေဖာ္ျပပါ ပုံမ်ား အတုိင္း ဖန္တီးလုိက္ပါ။ ထုိ႕ေနာက္ Arc Length command

ကိုအသံုးျပဳျပီး Arc မ်ားတြင္ dimension တပ္ေပးရမည္။
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၁) ေရးဆြဲျပီးထားေသာ Arc တြင္ Arc Length dimensions မ်ားတပ္ရန္ -

 Arc Length command ကုိစတင္လုိက္ပါ။

 Arc (1) ကုိ select လိုက္ပါ။

 Arc length dimension (2) ကို တည္ေနရာ သတ္မွတ္ေပးပါ။

၂) Arc Length command ကုိ repeat လုပ္ျပီး က်န္ရိွေနေသးေသာ Arcs မ်ားကုိပါ dimensions တပ္ေပးပါ။
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မွတ္ခ်က္။ ။ Arc length သေကၤတ မ်ားျဖစ္သည့္ dimension text မ်ားကုိ စိတ္ၾကိဳက္ ျပဳျပင္ႏိုင္ပါသည္။ DIMSTYLE command

ကိုအသံုးျပဳျပီး Dimension style manager ကိုေခၚျပီး Modify> Symbols and Arrows > Arc Length Symbol ကုိ select ျပီး

စိတ္ၾကိဳက္ျပဳျပင္ႏိုင္ပါသည္။

Procedure: Creating a Radius Dimension

Circle (သုိ႕မဟုတ္) arc တြင္ dimensions မ်ား ဖန္တီးရန္ ေအာက္တြင္ ေဖာ္ျပထားေသာ command ကုိအသံုးျပဳ သြားရမည္ ျဖစ္သည္။

Command Line: DIMRADIUS, DIMRAD, DRA

Ribbon: Annotate tab > Dimensions panel > Radius
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Radius dimension ဖန္တီးပုံကို ေအာက္တြင္ အဆင့္ဆင့္ ေဖာ္ျပေပးထားပါသည္။

၁) Dimradius command ကုိစတင္လုိက္ပါ။

၂) Arc (သုိ႕မဟုတ္) circle (1) ကုိ select ပါ။

၃) Dimension (2) ကုိ ေနရာသတ္မွတ္ ေပးလုိက္ပါ။

Practice Exercise: Radius Dimensions

ဤလက္ေတြ႕ ေလ့က်င့္ခန္းတြင္ Radius Dimension ကုိအသံုးျပျပဳျပီး လက္ေတြ႕ ေလ့က်င့္သြားရမည္ ျဖစ္ပါသည္။ ပထမဆုံးအေနနဲ႕

ေအာက္တြင္ ေဖာ္ျပေပးထားေသာ ပုံအတုိင္း ေရးဆြဲသြားရပါမည္။



“Workgroup” AotoCAD & 3ds Max Job Training Center မွ ပညာဒါန အခမ့ဲ ျဖန္႔ေ၀သည္။

( ဤစာအုပ္ကုိ ေငြေၾကးျဖင့္ ျပန္လည္ေရာင္းခ် ခြင့္မျပဳပါ )

ေအာင္ေဇာ္လတ္ {(Master of Engineering in Science and Production Engineering) Moscow State University Of Railway Engineering}

ဘာသာျပန္ ေရးသား ျပဳစုသည္။
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၁) Object တြင္ dimensions မ်ားဖန္တီးရန္ -

 Rectangle ေရးဆြဲလိုက္ပါ။

 Fillet command ကုိေခၚျပီး၊ radius ကို .25 (သို႕မဟုတ္) .5 fillet လုပ္လုိက္ပါ။

 Rectangle ၏ ေထာင့္ေလးေထာင့္ စလံုးကုိ Fillet လုပ္ရန္ Fillet command ၏ Polyline option ကုိအသံုးျပဳပါ။

 Offset command ကိုေခၚလိုက္ပါ။

 Offset distance ကုိ.15 သတ္မွတ္ေပးလိုက္ပါ။

 Polyline ကို offset လုပ္ပါ။

၂) အျပင္ Fillet တြင္ dimension ဖန္တီးရန္ -

 Radius command ကုိ ေခၚလုိက္ပါ။

 Arc (1) တြင္ Click လုိက္ပါ။

 Dimension line တည္ေနရာ(2) ကုိ သတ္မွတ္ေပးလိုက္ပါ။

၃) Radius command ကုိ repeat လုပ္ျပီး အတြင္းပိုင္းတြင္ ရိွေသာ radius တြင္လည္း dimension ဖန္တီးလိုက္ပါ။



“Workgroup” AotoCAD & 3ds Max Job Training Center မွ ပညာဒါန အခမ့ဲ ျဖန္႔ေ၀သည္။

( ဤစာအုပ္ကုိ ေငြေၾကးျဖင့္ ျပန္လည္ေရာင္းခ် ခြင့္မျပဳပါ )

ေအာင္ေဇာ္လတ္ {(Master of Engineering in Science and Production Engineering) Moscow State University Of Railway Engineering}

ဘာသာျပန္ ေရးသား ျပဳစုသည္။

“Workgroup “ AutoCAD & 3ds Max Training Center, International Computer Driving Licence Approved Test Center,
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Procedure: Creating a Jogged Radius Dimension

Center origin point ကေန အေျခတည္ျပီး Radius Dimension ကို ေနရာသတ္မွတ္ေပးရန္ ေအာက္ေဖာ္ျပပါ

command ကိုအသုံးျပဳရမည္ျဖစ္သည္။ ထုိသို႕ ေနရာသတ္မွတ္ေပးျပီး dimension ဖန္တီးျခင္းကုိ jogged radial dimension

ဖန္တီးျခင္းဟု ေခၚပါသည္။

Command Line: DIMJOGGED

Ribbon: Annotate tab > Dimensions panel > Jogged



“Workgroup” AotoCAD & 3ds Max Job Training Center မွ ပညာဒါန အခမ့ဲ ျဖန္႔ေ၀သည္။

( ဤစာအုပ္ကုိ ေငြေၾကးျဖင့္ ျပန္လည္ေရာင္းခ် ခြင့္မျပဳပါ )

ေအာင္ေဇာ္လတ္ {(Master of Engineering in Science and Production Engineering) Moscow State University Of Railway Engineering}

ဘာသာျပန္ ေရးသား ျပဳစုသည္။

“Workgroup “ AutoCAD & 3ds Max Training Center, International Computer Driving Licence Approved Test Center,
Rm- 403, Excel Tower, Yangon, Myanmar.
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Jogged radial dimension ဖန္တီးပုံကုိ ေအာက္တြင္ အဆင့္ဆင့္ ေဖာ္ျပေပးထား ပါသည္။

၁) Dimjogged command ကုိစတင္လုိက္ပါ။

၂) Arc (သုိ႕မဟုတ္) circle (1) ကုိ select လုိက္ပါ။

၃) Center တည္ေနရာ (2) ကိုသတ္မွတ္ေပးပါ။

၄) Dimension line တည္ေနရာ (3) ကိုသတ္မွတ္ေပးပါ။

၅) Jog တည္ေနရာ (4) ကိုသတ္မွတ္ေပးလိုက္ပါ။



“Workgroup” AotoCAD & 3ds Max Job Training Center မွ ပညာဒါန အခမ့ဲ ျဖန္႔ေ၀သည္။

( ဤစာအုပ္ကုိ ေငြေၾကးျဖင့္ ျပန္လည္ေရာင္းခ် ခြင့္မျပဳပါ )

ေအာင္ေဇာ္လတ္ {(Master of Engineering in Science and Production Engineering) Moscow State University Of Railway Engineering}

ဘာသာျပန္ ေရးသား ျပဳစုသည္။

“Workgroup “ AutoCAD & 3ds Max Training Center, International Computer Driving Licence Approved Test Center,
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Practice Exercise: Jogged Radius Dimensions

ဤလက္ေတြ႕ေလ့က်င့္ခန္းတြင္ Arc တစ္ခုကုိ ေရးဆြဲကာ Jogged radius dimension command ကိုအသံုးျပဳ သြားရမည္ ျဖစ္သည္။

၁) Arc ကုိေရးဆြဲလိုက္ပါ။

၂) Jogged radius ဖန္တီးရန္ -

 DIMJOGGED ကုိရိုက္ထည့္ျပီး Enter ႏိွပ္ပါ။

 Arc (1) ကုိ select လုပ္ပါ။

 Center point တည္ေနရာ (2) ကိုသတ္မွတ္ေပးပါ။

 Dimension line တည္ေနရာကို (3) ကုိသတ္မွတ္ေပးပါ။

 Jog တည္ေနရာကို သတ္မွတ္ေပးပါ။

Procedure: Creating a Diameter Dimension

Circle (သုိ႕မဟုတ္) arc ၏ diameter ေအာက္ေဖာ္ျပပါ command အသံုးျပဳျပီး dimensions မ်ားဖန္တီးေပးရမည္။



“Workgroup” AotoCAD & 3ds Max Job Training Center မွ ပညာဒါန အခမ့ဲ ျဖန္႔ေ၀သည္။

( ဤစာအုပ္ကုိ ေငြေၾကးျဖင့္ ျပန္လည္ေရာင္းခ် ခြင့္မျပဳပါ )

ေအာင္ေဇာ္လတ္ {(Master of Engineering in Science and Production Engineering) Moscow State University Of Railway Engineering}

ဘာသာျပန္ ေရးသား ျပဳစုသည္။

“Workgroup “ AutoCAD & 3ds Max Training Center, International Computer Driving Licence Approved Test Center,
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Command Line: DIMDIAMETER, DIMDIA

Ribbon: Annotate tab > Dimensions panel > Baseline

Diameter dimension ဖန္တီးပုံကုိ ေအာက္တြင္ အဆင့္ဆင့္ ေဖာ္ျပေပးထားပါသည္။

၁) Dimdiameter command ကုိစတင္လုိက္ပါ။

၂) Arc (သုိ႕မဟုတ္) circle (1) ကုိ select လုိက္ပါ။

၃) Dimension တည္ေနရာ (2) ကိုသတ္မွတ္ေပးပါ။



“Workgroup” AotoCAD & 3ds Max Job Training Center မွ ပညာဒါန အခမ့ဲ ျဖန္႔ေ၀သည္။

( ဤစာအုပ္ကုိ ေငြေၾကးျဖင့္ ျပန္လည္ေရာင္းခ် ခြင့္မျပဳပါ )

ေအာင္ေဇာ္လတ္ {(Master of Engineering in Science and Production Engineering) Moscow State University Of Railway Engineering}

ဘာသာျပန္ ေရးသား ျပဳစုသည္။

“Workgroup “ AutoCAD & 3ds Max Training Center, International Computer Driving Licence Approved Test Center,
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Practice Exercise: Diameter Dimensions

ဤလက္ေတြ႕ေလ့က်င့္ခန္းတြင္ Circles မ်ားဖန္တီးျပီး diameter dimension command ကိုအသံုးျပဳ သြားရမည္ ျဖစ္သည္။

၁) Circles မ်ားတြင္ diameter dimensions မ်ားဖန္တီးေပးရန္ -

 Diameter dimension command ကုိစတင္လုိက္ပါ။

 Circle (1) ကုိ select လုိက္ပါ။

 Dimension line တည္ေနရာ (2) ကိုသတ္မွတ္ေပးလိုက္ပါ။

၂) Diameter command ကုိအသံုးျပဳ က်န္ရိွေနေသးေသာ Circles မ်ားကုိလည္း dimensions ဖန္တီးေပးပါ။



“Workgroup” AotoCAD & 3ds Max Job Training Center မွ ပညာဒါန အခမ့ဲ ျဖန္႔ေ၀သည္။

( ဤစာအုပ္ကုိ ေငြေၾကးျဖင့္ ျပန္လည္ေရာင္းခ် ခြင့္မျပဳပါ )

ေအာင္ေဇာ္လတ္ {(Master of Engineering in Science and Production Engineering) Moscow State University Of Railway Engineering}

ဘာသာျပန္ ေရးသား ျပဳစုသည္။

“Workgroup “ AutoCAD & 3ds Max Training Center, International Computer Driving Licence Approved Test Center,
Rm- 403, Excel Tower, Yangon, Myanmar.
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133

Procedure: Creating Center Marks

Center mark ဖန္တီးေပးရန္ ေအာက္ေဖာ္ျပပါ command ကုိအသုံးအျပဳရပါမည္။

Command Line: DIMCENTER

Ribbon: Annotate tab > extended Dimensions panel > Center Mark

မွတ္ခ်က္။ ။ DIMCEN ကုိရိုက္ထည့္ျပီး Center Marks အရြယ္အစားမ်ားကုိ ေျပာင္းလဲႏိုင္ပါသည္။

Center Marks ဖန္တီးပုံကုိ ေအာက္တြင္ အဆင့္ဆင့္ ေဖာ္ျပေပးထားပါသည္။

၁) DIMCENTER command ကိုစတင္လိုက္ပါ။

၂) Arc or circle (1) ကုိ select လုိက္ပါ။



“Workgroup” AotoCAD & 3ds Max Job Training Center မွ ပညာဒါန အခမ့ဲ ျဖန္႔ေ၀သည္။

( ဤစာအုပ္ကုိ ေငြေၾကးျဖင့္ ျပန္လည္ေရာင္းခ် ခြင့္မျပဳပါ )

ေအာင္ေဇာ္လတ္ {(Master of Engineering in Science and Production Engineering) Moscow State University Of Railway Engineering}

ဘာသာျပန္ ေရးသား ျပဳစုသည္။

“Workgroup “ AutoCAD & 3ds Max Training Center, International Computer Driving Licence Approved Test Center,
Rm- 403, Excel Tower, Yangon, Myanmar.
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Practice Exercise: Create Center Marks

ဤလက္ေတြ႕ေလ့က်င့္ခန္းတြင္ Circles န႕ဲ Arcs မ်ားဖန္တီးျပီး၊ ထုိObjects တစ္ခုခ်င္းစီတြင္ Center Mark ဖန္တီး ေပးသြားရမည္။

၁) Circles န႕ဲ arcs မ်ားေရးဆြဲလိုက္ပါ။

၂) Circles န႕ဲ arcs မ်ားတြင္ Center Marks မ်ား ဖန္တီးရန္ -

 Center Mark dimension command ကုိစတင္လုိက္ပါ။

 Circle နဲ႕ arc ကုိ select လိုက္ပါ။

 Center Mark dimension command ကုိ repeat လုပ္ျပီး၊ အျခားေသာ Objects မ်ားကိုလည္း Center Marks

မ်ားဖန္တီးေပးလုိက္ပါ။



“Workgroup” AotoCAD & 3ds Max Job Training Center မွ ပညာဒါန အခမ့ဲ ျဖန္႔ေ၀သည္။

( ဤစာအုပ္ကုိ ေငြေၾကးျဖင့္ ျပန္လည္ေရာင္းခ် ခြင့္မျပဳပါ )

ေအာင္ေဇာ္လတ္ {(Master of Engineering in Science and Production Engineering) Moscow State University Of Railway Engineering}

ဘာသာျပန္ ေရးသား ျပဳစုသည္။

“Workgroup “ AutoCAD & 3ds Max Training Center, International Computer Driving Licence Approved Test Center,
Rm- 403, Excel Tower, Yangon, Myanmar.

Ph: 951 559377 Ext: 6413 or 6403, Email – infor@workgroupweb.com
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မွတ္ခ်က္။ ။ ေပၚလာေသာ Center Mark ၏အရြယ္အစားမ်ားကို DIMSTYLE command အသုံးျပဳျပီး စိတ္ၾကိဳက္ ျပဳျပင္ႏိုင္ပါသည္။

(select: Modify > Symbols and Arrows > Center Marks)

Enhancing Dimensions

Drawing အတြင္းရိွ Objects မ်ားတြင္ dimensions မ်ားဖန္တီးရာတြင္၊ မိမိတို႕ လိုအပ္ေသာ drawing ပုံစံရရိွရန္ additional tools

တစ္ခ်ိဳ႕ကို အသုံးျပဳရန္ လုိအပ္ပါသည္။ command prompts မွ guide ကုိအေသအခ်ာ ဖတ္ျပီး၊ guide line အတုိင္း

လိုက္လံလုပ္ေဆာင္သြားရန္မွာ လြန္စြာမွ အေရးပါလွပါသည္။

Dimensions မ်ားကို enhanced ထားေသာ ေအာက္ေဖာ္ျပပါ ပုံကုိေလ့လာၾကည့္ပါ။



“Workgroup” AotoCAD & 3ds Max Job Training Center မွ ပညာဒါန အခမ့ဲ ျဖန္႔ေ၀သည္။

( ဤစာအုပ္ကုိ ေငြေၾကးျဖင့္ ျပန္လည္ေရာင္းခ် ခြင့္မျပဳပါ )

ေအာင္ေဇာ္လတ္ {(Master of Engineering in Science and Production Engineering) Moscow State University Of Railway Engineering}

ဘာသာျပန္ ေရးသား ျပဳစုသည္။

“Workgroup “ AutoCAD & 3ds Max Training Center, International Computer Driving Licence Approved Test Center,
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Procedure: Placing a String of Quick Dimensions

Dimensions မ်ားကို semi-automated string ဖန္တီးရန္အတြက္ ေအာက္တြင္ေဖာ္ျပ ေပးထားေသာ command

ကိုအသံုးျပဳသြားရမည္။

Command Line: QDIM

Ribbon: Annotate tab > Dimensions panel > Quick Dimension

Quick Dimension command အသံုးျပဳပုံကုိ ေအာက္တြင္ အဆင့္ဆင့္ ေဖာ္ျပေပးထားပါသည္။ အဆုိပါ command သည္ model

space dimensioning တြင္သာ အလုပ္လုပ္ပါသည္။
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၁) Qdim command ကိုစတင္လိုက္ပါ။

၂) Standard selection methods ကုိအသံုးျပဳျပီး၊ dimensions ဖန္တီးရန္ gementry ကို select လုပ္ပါ။

၃) Default အရ continuous dimensions သည္ preview ျဖစ္သြားမည္။ Drawing အတြင္း တစ္ေနရာရာတြင္ Right-click ႏိွပ္ျပီး၊

dimension types (သို႕မဟုတ္) options ကို select ပါ။ ေရြးခ်ယ္ႏိုင္ေသာ command မ်ားမွာ ( Continuous, Staggered,

Baseline,Ordinate, Radius, Diameter, Datumpoint, Edit, န႕ဲ Settings) မ်ားျဖစ္ပါသည္။

၄) Dimensions ေနရာသတ္မွတ္ေပးရန္ click ပါ။

 Dimensions မ်ားဖန္တီးျပီး ျဖစ္သြားလိမ္႕မည္။



“Workgroup” AotoCAD & 3ds Max Job Training Center မွ ပညာဒါန အခမ့ဲ ျဖန္႔ေ၀သည္။

( ဤစာအုပ္ကုိ ေငြေၾကးျဖင့္ ျပန္လည္ေရာင္းခ် ခြင့္မျပဳပါ )
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Procedure: Ordinate Dimensions

Ordinate dimensions ဖန္တီးရန္ ေအာက္ေဖာ္ျပပါ command ကိုအသုံးျပဳသြားရမည္။

Command Line: DIMORDINATE, DIMORD

Ribbon: Annotate tab > Dimensions panel > Ordinate
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Ordinate dimensions ဖန္တီးပုံကုိ ေအာက္တြင္ အဆင့္ဆင့္ ေဖာ္ျပေပးထားပါသည္။ Ordinate dimensions ျဖင့္ dimensions

မ်ားဖန္တီးရန္၊ Users မ်ားအေနျဖင့္ Origin point ကိုအရင္ဆံုး ေျပာင္းေပးရပါမည္။

၁) UCS ဟုရိုက္ထည့္ျပီး Enter ႏိွပ္ပါ။ Ordinate dimensions ဖန္တီးရန္အတြက္ Object ေပၚတြင္ origin point သတ္မွတ္ေပးပါ။

Selection ကုိလက္ခံရန္ Enter ႏိွပ္ပါ။

၂) Dimordinate command ကုိစတင္လိုက္ပါ။

၃) Object snap ကိုအသုံးျပဳျပီး၊ feature တည္ေနရာ (2) ကုိသတ္မွတ္ေပးပါ။ ျပီးလွ်င္ leader endpoint (3) ကုိ သတ္မွတ္ေပးပါ။

၄) Dimordinate ကို repeat လုပ္ပါ။ ထပ္မံ၍ feature တည္ေနရာန႕ဲ leader endpoint ကိုသတ္မွတ္ေပးပါ။ UCS origin ကို World

သို႕ျပန္ေရြ႕လိုက္ပါ။
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မွတ္ခ်က္။ ။ Ordinate option နွင့္အတူ Quick Dimension command ကိုအသုံးျပဳႏိုင္ျပီ ျဖစ္သည္။

Procedure: Breaking Dimensions

Lines မ်ား အစြန္းတစ္ဖက္ခ်င္းစီ ထပ္ေနေသာ ေနရာတြင္ Break dimension (သို႕မဟုတ္) extension lines လုပ္ရန္ ေအာက္ပါ

command ကိုအသုံးျပဳသြားရမည္ ျဖစ္သည္။

Command Line: DIMBREAK

Ribbon: Annotate tab > Dimensions panel > Break
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ေအာင္ေဇာ္လတ္ {(Master of Engineering in Science and Production Engineering) Moscow State University Of Railway Engineering}

ဘာသာျပန္ ေရးသား ျပဳစုသည္။

“Workgroup “ AutoCAD & 3ds Max Training Center, International Computer Driving Licence Approved Test Center,
Rm- 403, Excel Tower, Yangon, Myanmar.

Ph: 951 559377 Ext: 6413 or 6403, Email – infor@workgroupweb.com

141

Break dimension အသုံးျပဳပုံကုိ ေအာက္တြင္အဆင့္ဆင့္ ေဖာ္ျပေပးထားပါသည္။

၁) Dimbreak command ကိုစတင္လိုက္ပါ။

၂) Dimension ကုိ break (1) ရန္ select ပါ။

မွတ္ခ်က္။ ။ Multiple dimension break ရန္ Multiple option ကုိအသုံးျပဳႏိုင္ပါသည္။

၃) Dimension (2) ကုိ break ရန္ Object ကို select ျပီး၊ Enter ႏိွပ္ပါ။

မွတ္ခ်က္။ ။ Dimension ကုိ automatically break ရန္ Enter ႏိွပ္ပါ။

Procedure: Creating Jogged Linear Dimensions
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Jog line ကေန dimension line သုိ႕ add ရန္ ေအာက္ပါ command ကိုအသံုးျပဳရပါမည္။

Command Line: DIMJOGLINE

Ribbon: Annotate tab > Dimensions panel > Jog Line

Jog line ကေန dimension line သုိ႕ add ပုံကို ေအာက္တြင္အဆင့္ဆင့္ ေဖာ္ျပေပးထားပါသည္။

၁) အမွတ္ႏွစ္မွတ္ အၾကားတြင္ linear dimension ဖန္တီးျပီး၊ ထုိ dimension တြင္ ေဖာ္ျပသြားမည့္ တန္ဖိုးမ်ားကို မိမိတို႕

စိတ္ၾကိဳက္တန္ဖိုးမ်ား ရိုက္ထည့္ေပးႏိုင္ပါသည္။

၂) Dimjogline command စတင္လိုက္ျပီး၊ linear dimension ကုိ select လုိက္ပါ။

၃) Dimension ေပၚတြင္ Jogline symbol ထည့္ရန္ အမွတ္သတ္မွတ္ေပးပါ။
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Procedure: Spacing Dimensions

Parallel linear dimensions အၾကားတြင္ space ျပင္ဆင္ သတ္မွတ္ေပးရန္ ေအာက္ပါ command ကုိအသုံးျပဳ ရပါမည္။

Command Line: DIMSPACE

Ribbon: Annotate tab > Dimensions panel > Adjust Space

Parallel linear dimensions အၾကားတြင္ space ျပင္ဆင္ သတ္မွတ္ေပးျခင္းကို ေအာက္တြင္ အဆင့္ဆင့္ ေဖာ္ျပေပးထား ပါသည္။

၁) Dimspace command ကုိစတင္ျပီး၊ base dimension ကို select ပါ။

၂) Base dimension ကေန space လုပ္ရန္ dimension ကို select ျပီး၊ Enter ႏိွပ္ပါ။
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၃) Dimensions တြင္ spacing လုပ္ရန္ အတြက္ တန္ဖိုးရိုက္ထည့္ေပးပါ (သို႕မဟုတ္) automatic method ကုိအသံုးျပဳရန္ Enter ႏိွပ္ပါ။

Procedure: Adding Tolerances

Drawing ထတဲြင္ dimension Tolerance မ်ား add ရန္ေအာက္ပါ command ကုိအသုံးျပဳသြားရပါမည္။

Command Line: TOLERANCE, TOL

Ribbon: Annotate tab > Dimensions panel > Tolerance

Drawing ထတဲြင္ dimension Tolerance မ်ား add ပုံကုိ ေအာက္တြင္ အဆင့္ဆင့္ ေဖာ္ျပေပးထားပါသည္။

၁) Tolerance command ကုိစတင္လုိက္ပါ။
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၂) Geometric Tolerance dialog box မွ မိမိတို႕ နွစ္သက္ေသာ Symbol, Tolerance န႕ဲ Datum ကုိ select လုပ္ပါ။ Ok ကုိ Click

လုပ္ပါ။

၃) Drawing မ်ားတြင္ Tolerance အတြက္ ေနရာသတ္မွတ္ေပးပါ။

Procedure: Inspecting Dimensions

Selected dimension တြင္ inspection label add ရန္ ေအာက္ေဖာ္ျပပါ command ကိုအသံုးျပဳရပါမည္။

Command Line: DIMINSPECT

Ribbon: Annotate tab > Dimensions panel > Inspect

Inspection label ဖန္တီးပုံကို ေအာက္တြင္အဆင့္ဆင့္ ေဖာ္ျပေပးထားပါသည္။
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၁) Diminspect command ကုိစတင္လုိက္ပါ။

၂) Inspection Dimension dialog box မွ Shape န႕ဲ Label (သို႕မဟုတ္) Inspection rate ကုိ select ပါ။

၃) Dimension(s) ကုိ select ျပီး၊ Ok ႏိွပ္ပါ။

Exercise: Create Dimensions

ဤလက္ေတြ႕ ေလ့က်င့္ခန္းတြင္ dimension commands မ်ားအသုံးျပဳျပီး၊ ေအာက္ေဖာ္ျပပါ ပုံတြင္ dimensions မ်ား ဖန္တီးေပးရမည္

ျဖစ္သည္။
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The completed exercise

၁) M_Create-Dimensions.dwg ကုိဖြင့္ပါ။

၂) Linear dimension ဖန္တီးရန္ -

 Dimensions panel က Linear ကုိ click လိုက္ပါ။

 ေအာက္တြင္ ေဖာ္ျပေပးထားေသာ ပုံအတုိင္း dimension တည္ေနရာအတြက္ အမွတ္မ်ား သတ္မွတ္ ေပးပါ။

၃) Linear Dimension command ကုိ repeat လုပ္ျပီး ေအာက္တြင္ ေဖာ္ျပေပးထားေသာ ပုံအတုိင္း dimensions မ်ားဖန္တီးေပးပါ။
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၄) Dimension spacing ကို correct လုပ္ရန္ -

 Dimensions panel က Dimspace ကုိ click ပါ။

 Base အတြက္ အတြင္းဆံုးက Dimension ကုိ select လုပ္ပါ။

 ေအာက္ေျခမွ ထိပ္ဆုံးအထိ က်န္ရိွေနေသးေသာ dimensions (၃) ခုကိုလည္း Click လုိက္ပါ။

 Enter ႏိွပ္ပါ။ Auto spacing ကိုလက္ခံရန္ Enter ကိုထပ္တစ္ၾကိမ္ ႏိွပ္ပါ။

 Dimensions မ်ားသည္ တူညီေသာ spaced ျဖစ္သြားမည္ ျဖစ္သည္။
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၅) Aligned dimension ဖန္တီးရန္ -

 Dimensions panel က Aligned ကို click ပါ။

 ေအာက္တြင္ေဖာ္ျပ ထားေသာ ပုံအတိုင္း point (1) ကုိ select ပါ။

 Point (2) ကို select ပါ။

 ေအာက္တြင္ေဖာ္ျပ ထားေသာ ပုံအတိုင္း dimension ကိုေနရာသတ္မွတ္ေပးပါ။

၆) Radial dimension ဖန္တီးရန္ -

 Dimensions panel က Radius ကို click ပါ။
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 Arc အပိုင္းကုိ select ျပီး၊ dimension ကို ေအာက္တြင္ေဖာ္ျပ ေပးထားေသာ ပုံအတုိင္း ေနရာသတ္မွတ္ေပးပါ။

၇) Jogged dimension ဖန္တီးရန္ -

 Dimensions panel က Jogged ကုိ click ပါ။

 Point (1) ေနရာက Arc ကုိ select ပါ။

 Center တည္ေနရာ အတြက္ Point (2) တြင္ သတ္မွတ္ေပးလုိက္ပါ။

 Dimension line တည္ေနရာအတြက္ Point (3) ေနရာတြင္ သတ္မွတ္ေပးလိုက္ပါ။

 Jog တည္ေနရာအတြက္ Point (4) ေနရာတြင္ သတ္မွတ္ေပးလိုက္ပါ။

၈) Diameter dimension ဖန္တီးရန္ -

 Dimensions panel က Diameter ကုိ click ပါ။

 Circle ပါ၀င္ေသာ အပိုင္း (1) ကို select ကာ၊ ေအာက္တြင္ ေဖာ္ျပေပးထားသည့္ ပုံအတိုင္း dimension အတြက္ ေနရာကို (2)

တြင္သတ္မွတ္ေပးပါ။
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၉) Angular dimension ဖန္တီးရန္ -

 Dimensions panel က Angular ကို click ပါ။

 Point (1) က Line ကို select ပါ။

 Point (2) က Line ကိုလည္း select လုိက္ပါ။

 ေအာက္တြင္ ေဖာ္ျပေပးထားေသာ ပုံအတုိင္း dimension ကုိေနရာသတ္မွတ္ေပးပါ။

၁၀) Linear dimension ဖန္တီးရန္ -

 Dimensions panel က Linear ကုိ click ပါ။

 Point (1) ကို select ပါ။

 Point (2) ကိုလည္း select လုိက္ပါ။

 ေအာက္တြင္ ေဖာ္ျပေပးထားေသာ ပုံအတုိင္း dimension ကုိေနရာသတ္မွတ္ေပးပါ။



“Workgroup” AotoCAD & 3ds Max Job Training Center မွ ပညာဒါန အခမ့ဲ ျဖန္႔ေ၀သည္။

( ဤစာအုပ္ကုိ ေငြေၾကးျဖင့္ ျပန္လည္ေရာင္းခ် ခြင့္မျပဳပါ )

ေအာင္ေဇာ္လတ္ {(Master of Engineering in Science and Production Engineering) Moscow State University Of Railway Engineering}

ဘာသာျပန္ ေရးသား ျပဳစုသည္။

“Workgroup “ AutoCAD & 3ds Max Training Center, International Computer Driving Licence Approved Test Center,
Rm- 403, Excel Tower, Yangon, Myanmar.

Ph: 951 559377 Ext: 6413 or 6403, Email – infor@workgroupweb.com

152

၁၁) ဘယ္ဖက္တြင္ continuous dimensions ဖန္တီးရန္ -

 Dimensions panel က Continue ကုိ click ပါ။

 ေနာက္ဆုံး ဖန္တီးခ႕ဲေသာ dimension ေနရာမွစတင္ျပီး continuous dimensions ကိုစတင္အသုံးျပဳ ႏိုင္မည္ ျဖစ္သည္။

 ေအာက္တြင္ေဖာ္ျပထားေသာ ပုံမွ point (1), point (2) န႕ဲ point (3) ကုိ select ပါ။

 Continuous dimensions ကို ျပီးဆံုးေၾကာင္း အတည္ျပဳရန္ Enter ႏိွပ္ပါ။

 Dimensioning ကို exit ေပးရန္ Enter ႏိွပ္ပါ။
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၁၂) Linear dimension ကုိဖန္တီးရန္ -

 Dimensions panel က Linear ကုိ click ပါ။

 Point (1) ကို select ပါ။

 Point (2) ကိုလည္း select လုိက္ပါ။

 ေအာက္တြင္ ေဖာ္ျပေပးထားေသာ ပုံအတုိင္း dimension ကုိေနရာသတ္မွတ္ေပးပါ။

၁၃) Baseline dimensions ဖန္တီးရန္ -

 Dimension toolbar ေပၚမွာ Baseline ကုိ click ပါ။

 ေနာက္ဆုံး ဖန္တီးခ႕ဲေသာ dimension ေနရာမွစတင္ျပီး Baseline dimensions ကုိစတင္အသံုးျပဳ ႏိုင္မည္ ျဖစ္သည္။

 ေအာက္တြင္ ေဖာ္ျပထားေသာ ပုံမွ point (1), point (2), point (3) နဲ႕ point (4) ကို select ပါ။

 Baseline command ကိုျပီးစီးေၾကာင္း အတည္ျပဳရန္ Enter ႏိွပ္ပါ။

 Dimension command ျပီးစီးေၾကာင္း အတည္ျပဳရန္ Enter ႏိွပ္ပါ။
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၁၄) အစြန္းခ်င္း ထပ္ေနေသာ extension line ကုိ Clean up လုပ္ရန္ -

 Dimensions panel က Dimbreak ကို click ပါ။

 Right-click ႏိွပ္ျပီး Multiple ကုိ Click ပါ။

 ေအာက္တြင္ေဖာ္ျပ ေပးထားေသာ ပုံအတုိင္း Extension line 1 န႕ဲ 2 ၏ဘယ္ဖက္အဆံုးကုိ select ပါ။

 Right-click ႏိွပ္ျပီး Break ကုိ click ပါ။

၁၅) Drawing ကို Zoom Extents လုပ္ပါ။
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၁၆) Files အားလုံးကို မ Save ပဲပိတ္လိုက္ပါ။

Lesson: Using Dimension Styles

ဤသင္ခန္းစာတြင္ dimension styles ျပဳျပင္ပုံ၊ dimension styles ဖန္တီးပုံတုိ႕ကုိ ရွင္းလင္းသြားမည္ ျဖစ္သည္။ Drawing အတြင္းက

dimension styles မ်ားကုိ ျပင္ဆင္သတ္မွတ္ပုံသည္ text styles မ်ားျပင္ဆင္သတ္မွတ္နွင့္ သေဘာတရာျခင္း ဆင္တူျဖစ္ပါသည္။

ေအာက္ေဖာ္ျပပါ ပုံတြင္ styles တစ္မ်ိဳးစီျဖင့္ အသံုးျပဳထားေသာ dimensions နွစ္ခုကို ေလ့လာၾကည့္ပါ။

မွတ္ခ်က္။ ။ ျမွားဦးမ်ားႏွင့္ Units ေဖာ္ျပပုံတို႕ ကြဲျပားေနသည္ကို ေတြ႕ရမည္။

Objectives

ဤသင္ခန္းစာကို ေလ့လာျခင္း ျပီးစီးသြားပါက -

 Dimension styles မ်ားျပင္ဆင္ျပီး အသံုးျပဳပုံတို႕ကို နားလည္လာေစရန္။

 မိမိတုိ႕ အသုံးျပဳမည့္ dimension styles မ်ားကို အသံုးျပဳလိုသည့္ ပုံစံမ်ိဳးရေအာင္ ျပင္ဆင္ပုံတို႕ကို နားလည္ သေဘာေပါက္

လာေစရန္။

About Dimension Styles

မိမိတုိ႕ အသုံးျပဳလုိေသာ dimension ပုံစံမ်ိဳး ရလာေအာင္ dimension styles မ်ားကုိ ထိန္းခ်ဳပ္ျပဳျပင္ႏိုင္ပါသည္။ Dimension object

တိုင္းတြင္ extension lines, arrows (သုိ႕မဟုတ္) symbols, text နဲ႕ tolerances က႕ဲသုိ႕ေသာ Features မ်ားကုိယ္စီပါ၀င္ပါသည္။

Dimension styles တြင္ arrowhead ကုိ အကန္႕အသတ္ျဖင့္ သတ္မွတ္ အသုံးျပဳရမည့္ အေျခအေနတြင္ Dimension styles

ကိုလြယ္ကူစြာ သတ္မွတ္အသံုးျပဳ ႏိုင္ပါသည္။

ေအာက္တြင္ေဖာ္ျပထားေသာ ပုံမွ dimension styles မ်ားကုိ dimension feautures မ်ားအသံုးျပဳျပီး စိတ္ၾကိဳက္ ျပင္ဆင္

သတ္မွတ္ႏိုင္ပါသည္။
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Definition of Dimension Styles

Dimension Styles ဆုိသည္မွာ dimension settings ၏အဖြဲ႕အစည္း တစ္ခုျဖစ္သလုိ၊ ေပၚလာမည့္ dimension မ်ားကုိ

ထိန္းခ်ဳပ္ျခင္းပင္ ျဖစ္သည္။ Drawing တစ္ခုတည္းတြင္ dimension styles အမ်ိဳးမ်ိဳးကို အသံုးျပဳသြား ႏိုင္ပါသည္။

Annotative Property

Multiple viewports က viewport တစ္ခုခ်င္းစီတြင္ မတူညီေသာ Scale မ်ားျဖင့္ Plotted တစ္ခုတည္း၌ display ခ်င္လုပ္ခ်င္လွ်င္

Annotative property ကုိ assign လုပ္ရပါမည္။ Dimension style ကို Annotative လုပ္ရန္ New Dimension Style (သို႕မဟုတ္)

Modify Dimension Style dialog boxes မွ Fit tab ေပၚရိွ Annotative option ကို select လုပ္ရပါမည္။

Dimension Style Facts

Drawing တိုင္းတြင္ အနည္းဆံုး dimension တစ္ခုပါရိွေနရမည္။ သုိ႕ေသာ္ မိမိတို႕ အေနျဖင့္ multiple dimension styles

ကိုဖန္တီးႏိုင္ပါသည္။

New imperial unit drawing တိုင္းတြင္ Standard ဟုေခၚတြင္ေသာ dimension style ႏွင့္ Annotative ဟုေခၚတြင္ေသာ အျခား

dimension style မ်ားပါ၀င္ပါသည္။ Standard ဟုေခၚတြင္ေသာ dimension style သည္ current dimension style ျဖစ္ပါသည္။
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New metric unit drawing တုိင္းတြင္ ISO-25 ဟုေခၚတြင္ေသာ dimension style ႏွင့္ Annotative ဟုေခၚတြင္ေသာ အျခား

dimension style မ်ားပါ၀င္ပါသည္။ ISO-25 ဟုေခၚတြင္ေသာ dimension style သည္ current dimension style ျဖစ္ပါသည္။

Example of Dimension Styles

Dimension style အျဖစ္ arrow ၏ type နဲ႕ size မ်ားသတ္မွတ္ေပးျခင္း၊ dimension text တြင္ text အစား ထိုးျခင္းန႕ဲ text size

မ်ားသတ္မွတ္ျခင္း နဲ႕ အျခားေသာ လုပ္ေဆာင္ခ်က္မ်ားကုိလည္း ေအာက္ေဖာ္ျပပါ ပုံအတုိင္း လုပ္ေဆာင္ ႏိုင္ပါသည္။

Creating and Modifying Dimension Styles

Dimension styles မ်ားကုိ create န႕ဲ manage လုပ္ရာတြင္ Dimension Style command ကိုအသံုးျပဳရပါမည္။ Drawing တစ္ခုစီတြင္

multiple dimension styles မ်ားဖန္တီးႏိုင္ပါသည္။
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Command Access

Dimension Style

Command Line: DIMSTYLE

Ribbon: Annotate tab > Dimensions panel > Dimension Style

Menu Bar: Format > Dimension Style

Dimension Style Manager

Dimension Style Manager တြင္ drawing ၌ ဖန္တီးႏိုင္ေသာ dimension styles အားလံုးကုိ ေဖာ္ျပေပးမည္ ျဖစ္သည္။ Dimension

Style Manager မွ New dimension style, Modify an existing style, Override a style Compare styles (သို႕မဟုတ္) set a style

Current Options မ်ားကုိ ေရြးခ်ယ္ႏိုင္ပါသည္။
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Create New Dimension Style Dialog Box

Dimension Style Manager တြင္ New Dimension Style Dialog box ကုိ access လုပ္ရန္ New (1) ကုိ select ပါ။ List (3) မွ

existing dimension style ေပၚမူတည္ျပီး new style name (2) ရိုက္ထည့္ေပးပါ။ New dimension style ကုိသာမန္အားျဖင့္ all

dimensions (4) အတြက္ အသုံးျပဳပါသည္။ (သုိ႕မဟုတ္) Dimension type (5) သတ္မွတ္ရာတြင္ style ကုိ ကုိယ္တုိင္ဖန္တီးျပီး

သတ္မွတ္ႏိုင္ပါသည္။ Drawing Layout တြင္ multiple viewports ကို display ထားေသာအခ်ိန္၌ dimension size

ကိုတစ္သတ္မတ္တည္း ျဖစ္ေနေစလုိလွ်င္ Annotative (6) ကို Check ရပါမည္။
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New Dimension Style Dialog Box - Lines Tab

Dimension န႕ဲ extension lines ၏ Properties ကိုျပင္ဆင္ သတ္မွတ္ရာတြင္ Lines tab ကုိအသုံးျပဳရပါမည္။ Preview window

ကမိမိတို႕ ျပဳျပင္ေျပာင္းလလုိဲက္ေသာ Effect ကို display ေပးပါလိမ္႕မည္။
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New Dimension Style Dialog Box - Symbols and Arrows Tab

Arrowheads, center mark ရဲ႕ features, dimension break size, arc length symbol ရ႕ဲတည္ေနရာ၊ radius jog angle နဲ႕ linear

jog dimension height တို႕ကို ျပဳျပင္ရာတြင္ Symbols and Arrows tab ကိုအသံုးျပဳ ရပါမည္။
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New Dimension Style Dialog Box - Text Tab

Text appearance, text placement န႕ဲ text alignment options မ်ားကုိ ျပဳျပင္ရာတြင္ text tab ကိုအသံုးျပဳရ ပါမည္။ Dimension မွ

text styles မ်ားသတ္မွတ္ျခင္း၊ text ၏ alignment မ်ားကုိ ျပင္ဆင္သတ္မွတ္ျခင္း၊ vertical နဲ႕ horizontal dimensions တုိ႕တြင္

အသုံးျပဳမည့္ text ကိုျပင္ဆင္သတ္မွတ္ျခင္း အားလုံးကို text tab မွျပဳလုပ္ႏိုင္ ပါသည္။

New Dimension Style Dialog Box - Fit Tab

Dimension features ရ႕ဲ Scale အားလုံးကုိျပဳျပင္ရာတြင္ Fit tab ကိုအသုံးျပဳႏိုင္ပါသည္။ အကယ္၍ Annotative dimension style ကုိ

selected ျပီးပါက၊ ၎ေနရာတြင္ အညဳိေရာင္ ျဖစ္ေနမည္ ျဖစ္သည္။
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New Dimension Style Dialog Box - Primary Units Tab

Dimension တြင္ Scale ကုိ primary units ျဖင့္ ေဖာ္ျပေပးရန္ Primary Units tab ကိုအသံုးျပဳရပါမည္။ Linear န႕ဲ angular

dimensions အတြက္ Unit format မ်ားျပင္ဆင္ႏိုင္ျခင္း၊ precision settings ျပင္ဆင္ျခင္း၊ full scale ျဖင့္ေရးဆြဲထားျခင္း မရိွသည့္

drawing တြင္ အသုံးျပဳမည့္ dimensioning အတြက္ Scale factor ကုိျပဳျပင္ျခင္း တို႕ကိုလည္း ျပဳလုပ္သြားႏိုင္ပါသည္။
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New Dimension Style Dialog Box - Alternate Units Tab

Metric န႕ဲ imperial စသည့္ နွစ္မ်ိဳးစလံုးေသာ အတုိင္းအတာ Units ကို ေဖာ္ျပလိုေသာအခါ Alternate units ကိုအသံုးျပဳ သြားရပါမည္။

မိမိတုိ႕၏ dimensions မ်ားတြင္ alternate units format ပုံစံျဖင့္ ေဖာ္ျပလုိလွ်င္ Alternate Units tab တြင္ျပဳျပင္ႏိုင္ပါသည္။ Alternate

units ကုိေဖာ္ျပလုိလွ်င္ Display Alternate Units option ကို turn on လုပ္ေပးရပါမည္။

Default အရ Standard န႕ဲ ISO-25 dimension styles တြင္ Display alternate units option သည္ turn off ျဖစ္ေနမည္။

New Dimension Style Dialog Box - Tolerances Tab

မိမိတုိ႕၏ dimension တြင္ tolerances မ်ား add ရန္အတြက္ Tolerances tab ကုိအသံုးျပဳရပါမည္။ မိမိတို႕ dimension တြင္

tolerances မ်ား add လိုက္ျခင္းအားျဖင့္ features မ်ား၏ အတုိင္းအတာ Scale တစ္ခုျခင္းစီကုိ ကြဲကြဲျပားျပား သိရိွလာႏိုင္မည္

ျဖစ္သည္။

Method မ်ားေရြးခ်ယ္ျခင္း, tolerance precision မ်ားသတ္မွတ္ျခင္း, upper န႕ဲ lower values မ်ားေရြးခ်ယ္ျခင္း, tolerance text

height ရ႕ဲ scale ကုိျပင္ဆင္သတ္မွတ္ျခင္း, vertical position သုိ႕ေျပာင္းလျဲခင္း န႕ဲ zero suppression ကိုထိန္းခ်ဳပ္ျခင္း စသည္တုိ႕ကို

ျပဳလုပ္ႏိုင္ပါသည္။
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Procedure: Creating and Modifying Dimension Styles

Dimension styles မ်ားကုိ creating နဲ႕ modifying လုပ္ပုံကို ေအာက္တြင္အဆင့္ဆင့္ ေဖာ္ျပေပးထားပါသည္။

၁) Dimension Style command ကုိစတင္လုိက္ပါ။

၂) Dimension Style Manager မွ New (သုိ႕မဟုတ္) Modify ကုိ Click လိုက္ပါ။

၃) New dimension style အတြက္ name ကုိရိုက္ထည့္ေပးျပီး၊ Continue ကို Click လုိက္ပါ။ Dimension style ကို modifying

လုပ္ျပီးလွ်င္ ေနာက္တစ္ဆင့္ သြားပါမည္။

၄) Modify Dimension Style dialog box တြင္မိမိတို႕ ျပင္ဆင္မည့္ features ေပၚတြင္မူတည္ျပီး appropriate tabs ကုိ select လုပ္ပါ။

လုိအပ္ေသာ dimension style options ကို select ျပီး Ok ႏိွပ္ပါ။

၅) Dimension Style Manager မွ Close ကုိ click ပါ။
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Exercise: Modify a Dimension Style

ဤသင္ခန္းစာတြင္ Sheet ေပၚ၌ dimensions မ်ားမွန္မွန္ကန္ကန္ ေပၚလာႏိုင္ေအာင္ existing dimension style ကုိ Modify

လုပ္သြားရပါမည္။ ျပီးလွ်င္ architectural ticks instead of arrows နဲ႕ alternate units တို႕ ေဖာ္ျပေပးႏိုင္ေအာင္

ျပဳျပင္ေပးသြားရပါမည္။

The completed exercise

၁) M_Dimension-Styles.dwg ကိုဖြင့္လုိက္ပါ။

မွတ္ခ်က္။ ။ Floor plan ၏ Objects မ်ားတြင္ ရိွေသာ အနီေရာင္မ်ဥ္းမ်ားသည္ dimensions မ်ားျဖစ္ပါသည္။ သို႕ေသာ္ annotative

scale တြင္ dimension text ကို current အျဖစ္ေျပာင္းလဲ ထားျခင္း မရိွေသာေၾကာင့္ text မ်ားကုိ မျမင္ေတြ႕ရျခင္းျဖစ္သည္။
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၂) Model space သုိ႕ေျပာင္း Status bar တြင္ရိွေသာ Paper buttom ကုိ click ပါ။

၃) Current dimension style ရ႕ဲ arrowhead ကုိ modify လုပ္ရန္ -

 Ribbon မွ Annotate tab ကို select လုပ္ပါ။ Dimensions panel မွ Dimension style ကို click လုပ္ပါ။ Current dimension

style မွာ ISO-25 ျဖစ္ပါသည္။

 Dimension Style Manager မွ Modify ကို click ပါ။

 Modify Dimension Style dialog box က Symbols and Arrows tab ကုိနိွပ္ျပီး Arrowheads ေအာက္၌ရိွေသာ First list က

Architectural Tick ကုိ select လုပ္လိုက္ပါ။

မွတ္ခ်က္။ ။ Second arrowhead သည္လည္း အလိုအေလ်ာက္ First list တြင္ selected ထားေသာ arrowhead သို႕

ေျပာင္းသြားပါလိမ္႕မည္။

၄) Current dimension style ရ႕ဲ text style setting ကုိ ေျပာင္းရန္ -

 Text tab ကုိ click ပါ။

 Text style list မွ TECH ကုိ select ပါ။

မွတ္ခ်က္။ ။ Dimension အတြက္ text height ကုိ 2.5 ဟု သတ္မွတ္ေပးလိုက္ပါ။
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၅) Dimension style ကို annotative အျဖစ္သုိ႕ modify လုပ္ရန္ -

 Fit tab ကို click ပါ။

 Scale for Dimension Features ေအာက္က Annotative ကုိ Click ပါ။

 Ok ကုိ click ပါ။

၆) Dimension Style Manager မွ Close ကုိ click ပါ။

၇) Model space annotation scale ကုိျပင္ဆင္သတ္မွတ္ရန္ -

 Status bar တြင္ရိွေသာ Annotation Scale list မွ 1:50 ကို click ပါ။

၈) New annotation scale ကုိ dimensions update လုပ္ရန္ -

 Dimensions panel မွ Dimension Update ကုိ click ပါ။

 All ဟုရိုက္ထည့္ပါ။

 Selection ျပီးေျမာက္ေၾကာင္း အတည္ျပဳရန္ Enter ႏိွပ္ပါ။

 Enter ထပ္ႏိွပ္ပါ။

မွတ္ခ်က္။ ။ ေျပာင္းလုိက္ေသာ Annotation scale သည္ Drawing အတြင္းမွ dimensions မ်ားေပၚတါင္ effect ျဖစ္သြားမည္ကုိ

ေတြ႕ရမည္။

၉) Alternate units ျဖင့္ ေဖာ္ျပေပးေသာ dimension style သုိ႕ေျပာင္းလဲေပးရန္ -

 Dimensions panel မွ Dimension style ကို click လုပ္ပါ။

 Dimension Style Manager ကModify click ပါ။

 Modify Dimension Style dialog box က Alternate Units tab တြင္ရိွေသာ Display Alternate Units ကုိ click ပါ။

 Unit Format list က Architectural Stacked ကို select လုပ္ပါ။
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၁၀) Placement ေအာက္က Below Primary Value ကို select ျပီး Ok ကို click ပါ။

၁၁) Dimension Style Manager dialog box ကုိ exit လုပ္ရန္ Close ကုိ click ပါ။

၁၂) Layout annotative scale ကို Update လုပ္ရန္ -

 Drawing layout ကုိျပန္သြားရန္ layout tab ကုိ click ပါ။

 Viewport border ကုိ select လုပ္ရန္ click ပါ။

 Status bar တြင္ရိွေသာ Annotation Scale list က 1:50 ကို Click ပါ။

 Viewport ကို lock ရန္ Status bar တြင္ရိွေသာ VP Scale ကို Click ပါ။
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 Dimensions သည္ သက္ဆိုင္ရာ Objects မ်ား၏ အရြယ္အစားမ်ားကို မွန္မွန္ကန္ကန္ ေဖာ္ျပေပးျပီး Sheet န႕ဲ viewport

တြင္ display လာပါလိမ္႕မည္။

၁၃) Drawing ကို Zoom Extents လုပ္ေပးပါ။

၁၄) Files အားလုံးကို မ Save ပဲပိတ္လိုက္ပါ။

Lesson: Using Multileaders

ဤသင္ခန္းစာတြင္ multileaders, multileader styles နဲ႕ drawing အတြင္းတြင္ select ျပီးအသံုးျပဳႏိုင္ေသာ multileaders options

မ်ားအေၾကာင္းကုိ ေလ့လာသြားရမည္ ျဖစ္သည္။ Leader-based annotation အတြက္ multileader ကုိအသံုးျပဳသြားရမည္ ျဖစ္သည္။

Learder သည္လည္း အေရးပါေသာ command တစ္ခုျဖစ္ပါသည္။ အဘယ့္ေၾကာင့္ဆုိေသာ္ geomentry ေပၚက features မ်ားကုိ

notes, balloon callouts န႕ဲ အျခားေသာ Objects မ်ားျဖင့္ connect လုပ္ႏိုင္ပါသည္။

Multileader objects ကို balloon callouts အျဖစ္ အသံုးျပဳထားေသာ ေအာက္ေဖာ္ျပပါ ပုံကုိ ေလ့လာၾကည့္ပါ။
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Objectives

ဤသင္ခန္းစာကို ေလ့လာျခင္း ျပီးစီးသြားပါက -

 Multileaders ကုိ ေဖာ္ျပတတ္ေစရန္။

 Multileader styles ကုိေဖာ္ျပတတ္လာေစရန္။

 Multileaders ကုိ Creat ျခင္း၊ Editing လုပ္ျခင္းတို႕ကို နားလည္လာေစရန္။

About Multileaders

Object တစ္ခုခ်င္းစီကုိ leader-based annotation objects အျဖစ္ သင့္တင့္ ေလ်ာက္ပတ္စြာ ဖန္တီးရာတြင္ multileaders

ကိုအသံုးျပဳရပါမည္။ Single Objects မ်ားကုိ တူညီေသာ Properties သတ္မွတ္ေပးျပီး dimension တစ္ခုတည္းျဖင့္ ေဖာ္ျပေပးရာတြင္

multileaders ကုိအသုံးျပဳပါသည္။

Definition of a Multileader

Leader သည္ arrow, a leader line, a landing, text object ပုံစံမ်ားန႕ဲ အျခားေသာ objects မ်ားပါ၀င္သည့္ annotation ျဖစ္ပါသည္။

Multileader object မ်ားကို select လုိက္သည္ႏွင့္ object ေပၚရိွ Point တြင္ Grips မ်ား display လာပါလိမ္႕မည္။ ထို Point ရိွ Grips ကုိ

select ျပီး၊ Point ကို edit လုပ္ျခင္း၊ ေနရာေျပာင္းျခင္း စသည္တို႕ကို စိတ္ၾကိဳက္ ျပဳျပင္သြားႏိုင္ပါသည္။

Multileader ကို Double–click ႏိွပ္ လိုက္မည္ဆွိုလွ်င္ Properties palette က multileader object တြင္ သတ္မွတ္ ေပးထားေသာ

Properties မ်ားကုိ ေဖာ္ျပေပးပါလိမ္႕မည္။
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Selected ထားေသာ multileader object.

Multileader grips.

Properties palette တြင္ Multileader object type ကို select လုပ္ျခင္း။

Multileader objects ၏ Properties ကုိသတ္မွတ္ေပးျခင္း။

Multileader objects ၏ Properties ကုိသတ္မွတ္ေပးျခင္း။

Example of Multileaders

Drawing အတြင္းရိွ မတူညီေသာ ဧရိယာေျခာက္ခုကုိ multileader objects နွစ္ခုျဖင့္ အသံုးျပဳျပ ထားသည္ေသာ ေအာက္ေဖာ္ျပပါ ပုံကုိ

ေလ့လာၾကည့္ပါ။ ထုိ multileader objects မ်ားကို ျပန္လည္ျပင္ဆင္လိုလွ်င္လည္း လြယ္ကူစြာပင္ ျပင္ဆင္သြားႏိုင္ပါသည္။



“Workgroup” AotoCAD & 3ds Max Job Training Center မွ ပညာဒါန အခမ့ဲ ျဖန္႔ေ၀သည္။

( ဤစာအုပ္ကုိ ေငြေၾကးျဖင့္ ျပန္လည္ေရာင္းခ် ခြင့္မျပဳပါ )

ေအာင္ေဇာ္လတ္ {(Master of Engineering in Science and Production Engineering) Moscow State University Of Railway Engineering}

ဘာသာျပန္ ေရးသား ျပဳစုသည္။

“Workgroup “ AutoCAD & 3ds Max Training Center, International Computer Driving Licence Approved Test Center,
Rm- 403, Excel Tower, Yangon, Myanmar.

Ph: 951 559377 Ext: 6413 or 6403, Email – infor@workgroupweb.com

173

About Multileader Styles

Current multileader style ရိွ Multileader objects မွ elements တစ္ခုခ်င္းစီ၏ Properties အတိုင္း ေဖာ္ေျပေပးျခင္း ျဖစ္သည္။

ေအာက္တြင္ အဓိက categories သုံးခုျဖင့္ စုဖြဲ႕ထားေသာ Multileader objects ကုိေလ့လာၾကည့္ပါ။

Leader Format properties သည္ arrowhead ရ႕ဲ type နဲ႕ size ျပင္ဆင္သတ္မွတ္ ရာတြင္ အေထာက္အကူ ျပဳပါသည္။
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Leader Structure properties သည္ leader line ေပၚမွ segment angles, landing settings နဲ႕ annotative property စသည့္

တို႕ကို ျပင္ဆင္ သတ္မွတ္ရာတြင္ အေထာက္အကူ ျပဳပါသည္။

Content properties တြင္ leader ႏွင့္တြဲမည့္ Content အမ်ိဳးအစားကို ေရြးခ်ယ္ သတ္မွတ္ရာတြင္ အေထာက္အကူ ျပဳပါသည္။

Command Access

Multileader Style

Command Line: MLEADERSTYLE

Ribbon: Annotate tab > Leaders panel > Multileader Style Manager

Menu Bar: Format > Multileader Style

Multileader Style Manager

Multileader styles မ်ားကုိ edit ႏွင့္ manage လုပ္ရန္ Multileader Style Manager ကိုအသံုးျပဳရပါမည္။ Dialog box နဲ႕ options

သည္ Dimension Style Manager အတိုင္းထပ္တူနီးပါး အလုပ္လုပ္ပုံတူပါသည္။ Dialog box ကုိအသံုးျပဳျပီး create, edit, delete နဲ႕

set current multileader styles တို႕ကိုျပဳလုပ္ႏိုင္ပါသည္။
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Modify Multileader Style

Multileader style ၏ properties မ်ားကို edit လုပ္ရန္ Modify Multileader Style dialog box ကိုအသံုးျပဳရပါ မည္။ Style properties

ကို properties ၏ types မ်ားျပင္ဆင္ သတ္မွတ္ႏိုင္သည့္ tabs သံုးခုျဖင့္ ဖြဲ႕စည္းထားပါသည္။
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Multileader Content Types

Multileader objects မ်ားအတြက္ ကြဲျပားျခားနားေသာ content types သံုးမ်ိဳးကုိ အသုံးျပဳျပီး ျပင္ဆင္သတ္မွတ္ ႏိုင္ပါသည္။ Modify

Multileader Style dialog box တြင္ရိွေသာ Content tab မွ ေအာက္ေဖာ္ျပပါ သံုးမ်ိဳးကို select ႏိုင္ပါသည္။

Block Mtext None

Default block အျဖစ္ Mtext object ပါ၀င္သည့္ leader တစ္ခုတည္း ပါ၀င္ေသာ

circle, slot န႕ဲ triangle default multileader type multileader object ျဖစ္ပါသည္။

တို႕ကိုအသံုးျပဳ ႏိုင္ပါသည္။ ျဖစ္ပါသည္။

Own block မ်ားျပဳလုပ္၍လည္း

အသုံးျပဳႏိုင္ပါသည္။

Using Multileaders

Multileaders ကုိအသံုးျပဳျပီး task တစ္ခ်ိဳ႕ကို ေျဖရွင္းပါ။ ထုိ task တြင္ Multileader styles ကုိ creating နဲ႕ managing လုပ္ျခင္း,

placing multileaders, adding leaders, multileaders ကို aligning န႕ဲ collecting လုပ္ျခင္းတုိ႕ ပါ၀င္ပါသည္။
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Multileaders Ribbon Panel

Multileaders မ်ား creating န႕ဲ editing လုပ္ရန္အတြက္ အသံုးျပဳသြားရမည့္ tools မ်ားကို Multileaders panel မွ access

လုပ္ရပါမည္။ Multileaders styles list မွ မိမိတုိ႕ ျပဳမည့္ multileader style ကုိ active လုပ္ႏိုင္သလုိ၊ Panel တြင္လည္း အသံုးျပဳမည့္

command ကို access လုပ္ရန္အတြက္ standard buttom မ်ားပါ၀င္ပါသည္။ Selected လုပ္ထားေသာ Multileaders objects မ်ား၏

style ကို ေျပာင္းလဲလိုေသာ အေျခအေန မ်ိဳးတြင္လည္း List ကိုအသုံးႏိုင္ပါသည္။

Leader panel ေပၚမွ Annotate tab ထဲတြင္ ေအာက္ေဖာ္ျပပါ commands မ်ားကုိ ေတြ႕ႏိုင္ပါသည္။

Icon Command Description

Multileader Single multileader object ဖန္တီးျခင္း။

Add Leader Existing multileader objects သို႕ leader lines မ်ား add ျခင္း။
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Remove Leader Existing multileader objects မွ leader lines မ်ားကို remove လုပ္ျခင္း။

Align Multileaders Drawing အတြင္းမွ multileaders မ်ားကို horizontally or vertically သုိ႕

Aligns လုပ္ျခင္း။

Collect Multileaders Multiple multileaders မ်ားကို Collects လုပ္ျပီး၊ ၎တို႕ကို multiple

Content elements မ်ားနွင့္အတူ single multileader အတြင္းသို႕ ေပါင္းစည္း

ျခင္း။

Process: Using Multileaders

Multileaders အသံုးျပဳပုံကို ေအာက္တြင္အဆင့္ဆင့္ ေဖာ္ျပေပးထားပါသည္။

၁) မိမိတို႕ အသံုးျပဳလိုေသာ Multileaders style ကုိ ဖန္တီးပါမည္။ မိမိတုိ႕ လုိအပ္ေသာ ပုံစံတြင္ မူတည္ျပီး New style ကုိသြားျပီး

(သုိ႕မဟုတ္) Existing style ကိုပဲ editing လုပ္ျပီး အသုံးျပဳ နိုင္ပါသည္။ နဂို Product တြင္ မူရင္း styles နွစ္မ်ိဳးပါ၀င္ျပီးသား ျဖစ္ပါသည္။

၎တို႕ နွစ္မ်ိဳးကိုပဲ မူရင္းအတုိင္း အသုံးျပဳသြား ႏိုင္သလို၊ editing လုပ္၍လည္း အသံုးျပဳသြား ႏိုင္ပါသည္။

၂) Multileaders ဖန္တီးရာတြင္ Mleader command ကုိလည္း အသံုးျပဳႏိုင္ပါသည္။



“Workgroup” AotoCAD & 3ds Max Job Training Center မွ ပညာဒါန အခမ့ဲ ျဖန္႔ေ၀သည္။

( ဤစာအုပ္ကုိ ေငြေၾကးျဖင့္ ျပန္လည္ေရာင္းခ် ခြင့္မျပဳပါ )

ေအာင္ေဇာ္လတ္ {(Master of Engineering in Science and Production Engineering) Moscow State University Of Railway Engineering}

ဘာသာျပန္ ေရးသား ျပဳစုသည္။

“Workgroup “ AutoCAD & 3ds Max Training Center, International Computer Driving Licence Approved Test Center,
Rm- 403, Excel Tower, Yangon, Myanmar.

Ph: 951 559377 Ext: 6413 or 6403, Email – infor@workgroupweb.com

179

၃) Add Leader (သုိ႕မဟုတ္) Remove Leader tools ကုိအသံုးျပဳျပီး existing multileaders မ်ားကုိ modify လုပ္ႏိုင္ပါသည္။

၄) Align Multileaders နဲ႕ Collect Multileader tools တို႕ကိုအသုံးျပဳျပီး drawing အတြင္းသုိ႕ ေပၚလာမည္ multileaders ကုိ modify

လုပ္ႏိုင္ပါသည္။

Exercise: Use Multileaders

ဤလက္ေတြ႕ ေလ့က်င့္ခန္းတြင္ multileader style ဖန္တီးျပီး Exploded view drawing သုိ႕ callouts မ်ား add ျခင္းကုိ လက္ေတြ႕

ေလ့က်င့္သြားရမည္ ျဖစ္သည္။ Options အမ်ိဳးမ်ိဳးကုိ အသုံးျပဳျပီး၊ drawing အတြင္းသုိ႕ multileaders မ်ား add သြားရမည္ ျဖစ္သည္။
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The completed exercise

၁) c_Front-Pump-Assembly.dwg ကိုဖြင့္ပါ။

၂) New multileader style ဖန္တီးရန္ -

 Leaders panel မွ Multileader Style Manager dialog box launcher ကုိ click ပါ။

 Multileader Style Manager dialog box မွ New ကို click ပါ။

 Create New Multileader Style dialog box တြင္ New Style Name အတြက္ Balloon_Callout ဟု ရိုက္ထည့္ေပးျပီး

Continue ကို click ပါ။
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၃) Content type ကို assign လုပ္ရန္ -

 Content tab ကို click ပါ။

 Multileader Type တြင္ရိွေသာ list မွ Block ကို select လုပ္လုိက္ပါ။

 Block Options ေအာက္တြင္ရိွေသာ list မွ Circle ကို select လုပ္ပါ။ ျပီးလွ်င္ Ok ကိုႏိွပ္ပါ။

၄) Multileader Style Manager မွ Balloon_Callout ကို current multileader style ဟုတ္မဟုတ္ စစ္ေဆးေပး ပါ။ Close ကုိ click

လုိက္ပါ။

၅) Object Snap Settings တြင္ Endpoint, Midpoint နဲ႕ Intersection snap modes ကုိ selected ထားျခင္း ရိွ/မရိွကုိ စစ္ေဆးပါ။ (

Selected ထားရပါမည္။)
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၆) Multileader ထည့္ေပးရန္ -

 Leaders panel ေပၚမွ Multileader ကို click ပါ။

 Object Snap ကုိအသုံးျပဳျပီး line ထိပ္တြင္ရိွေသာ keyway (1) ၏ Midpoint ကို select ပါ။

 Cursor ကို pulley ၏ အထက္သုိ႕ ေရြ႕ျပီး၊ ျမွားျဖင့္ ျပထားေသာ အမွတ္(2) တြင္ click ပါ။

 Command line ကုိအာရုံစိုက္ျပီး ၾကည့္ပါ။ Block အတြက္ assigned ျပီး ျဖစ္သြားပါလိမ္႕မည္။ 1 (3) ကုိရိုက္ထည့္ ေပးပါ။

၇) အထက္တြင္ ေဖာ္ျပခ႕ဲေသာ အဆင့္အတုိင္း pulley န႕ဲ seal တြင္လည္း ေအာက္ေဖာ္ျပပါ ပုံအတုိင္း multileader ထည့္ေပးပါ။ Pulley

အတြက္ 2 ကုိရုိက္ထည့္ေပးျပီး၊ Seal အတြင္ 3 ကုိရိုက္ထည့္ေပးပါ။
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၈) Multileaders ကို align လုပ္ေပးရန္ -

 Leaders panel ေပၚမွ Align ကို click ပါ။

 Cross window ကိုအသံုးျပဳျပီး multileaders သံုးခုလံုးကုိ select လိုက္ပါ။ ျပီးလွ်င္ Enter ႏိွပ္ပါ။

 Shortcut menu ကို access လုပ္ရန္ Right – click ႏိွပ္ပါ။ Options ကို click ပါ။Distribute ကုိလည္း click လုိက္ပါ။

 အျမင့္ဆုံးေသာ multileader (1) ရဲ႕ Point ကုိ select ေပးပါ။

 Cursor ကုိ Polar Tracking ျဖင့္ ေရျပင္ညီအတိုင္း (2) ကုိပါေအာင္ တစ္ေျဖာင့္တည္း move လုိက္ပါ။ ေရျပင္ညီအတုိင္း

တစ္ေျဖာင့္တည္း move ျပီး select မည္ျဖစ္ေသာေၾကာင့္ object snap ကုိအသုံးျပဳရန္ မလုိအပ္ေပ။
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 Multileaders ကုိ align လုပ္ရန္ click ပါ။

၉) ေအာက္တြင္ ေဖာ္ျပေပးထားေသာ Bearing တြင္ multileader တပ္ေပးမည္။ 5 ကုိရိုက္ထည့္ လုိက္ပါ။
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၁၀) Existing multileader တြင္ multileader add ရန္ -

 Leaders panel ေပၚမွ Leader ကို click ပါ။

 Number 5 multileader ကို select လိုက္ပါ။

 Second leader arrowhead ၏တည္ေနရာအတြက္ shaft ၏အဆံုးတြင္ ရိွေသာ bearing ကုိ select လုိက္ပါ။ Enter ႏိွပ္ပါ။

၁၁) Front pump housing သုိ႕ multileaders 4, 8 န႕ဲ 9 ကို addပါ။
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၁၂) Multileaders ကုိ collect လုပ္ရန္ -

 Leaders panel ေပၚမွ Collect ကို click ပါ။

 Multileaders 4, 8 န႕ဲ 9 တုိ႕ကို တစ္ခုခ်င္းစီ သီးသန္႕ select လုိက္ပါ။ Enter ႏိွပ္ပါ။

 Horizontal သည္ current option ဟုတ္မဟုတ္ Command line တြင္ၾကည့္ရႈ႕စစ္ေဆးေပးပါ။ မဟုတ္ခ႕ဲလွ်င္ Right –

click ႏိွပ္ျပီး ေပၚလာေသာ shortcut menu မွ၎အား select ေပးပါ။

 Collected multileaders မ်ားကုိတပ္ေပးရန္ Click လိုက္ပါ။

၁၃) Content ကုိသတ္မွတ္ေပးရင္း multileaders add ရန္ -

 Leaders panel ေပၚမွ Multileader ကို click ပါ။

 Right-click ႏိွပ္ျပီး Options ကုိ click ပါ။
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 Content type ကို select ပါ။

 Number 5 callout ၏ ေအာက္နားတြင္ Click လုိက္ပါ။ 6 ကုိရိုက္ထည့္ေပးလုိက္ပါ။

 Arrowhead ကို multileader ၏ shaft တြင္တပ္ေပးလုိက္ပါ။

၁၄) Landing ကုိသတ္မွတ္ေပးရင္း multileaders add ရန္ -

 Leaders panel ေပၚမွ Multileader ကို click ျပီး L ဟုရိုက္ထည့္ကာ Enter ႏိွပ္လုိက္ပါ။

 Callout တည္ေနရာ သတ္မွတ္ေပးရန္ rear housing ၏ဘယ္ဖက္တြင္ ရိွေသာ အမွတ္ကုိ Click လိုက္ပါ။

 Arrowhead ကိုေနရာသတ္မွတ္ေပးရန္ rear housing ကို click လုိက္ပါ။ 7 ရိုက္ထည့္ေပးပါ။

၁၅) Exploded view အတြင္းမွ ေနာက္ဆုံး အပိုင္းကုိ multileader add ရန္ မိမိတုိ႕ နွစ္သက္ေသာ Options ကုိေရြးခ်ယ္ အသံုးျပဳပါ။ 3

ရိုက္ထည့္ေပးပါ။
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၁၆) Files အားလုံးကို မ Save ပဲပိတ္လိုက္ပါ။

Lesson: Editing Dimensions

ဤသင္ခန္းစာတြင္ dimensions မ်ားကုိ edit လုပ္ပုံနွင့္ dimensions text မ်ား edit လုပ္ပုံကုိ ေလ့လာသြားရမည္ ျဖစ္ပါသည္။ Drawing

မ်ားတြင္ မိမိတို႕ အသံုးျပဳလိုေသာ dimension style မ်ိဳးရေအာင္ ျပဳလုပ္ေသာ နည္းလမ္းလည္း ျဖစ္ပါသည္။

Continuous dimensions ကို grips အသုံးျပဳျပီး ေနရာေရြ႕ထားေသာ ေအာက္ေဖာ္ျပပါ ပုံကုိေလ့လာၾကည့္ပါ။

Objectives

ဤသင္ခန္းစာကို ေလ့လာျခင္း ျပီးစီးသြားပါက -

 Grips , Dimedit နဲ႕ Dimtedit commands မ်ားအသုံးျပဳျပီး dimensions မ်ားကို edit လုပ္တတ္ေစရန္။
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Editing Dimensions

Dimension text အတိုင္းအတာမ်ားကုိ Dimedit command အသုံးျပဳျပီး edit လုပ္ႏိုင္ပါသည္။ Dimedit command ကိုပဲ အသုံးျပဳျပီး

dimension text ၏ တည္ေနရာမ်ားကို edit လုပ္ႏိုင္ပါသည္။ Selected ထားေသာ dimension တြင္ Right – click ႏိွပ္ကာ Quick

Properties (သုိ႕မဟုတ္) Properties palette မွ dimension ကို edit လုပ္ႏိုင္ပါသည္။

Properties palette မွ dimension style ကို editing လုပ္မည္ဆိုလွ်င္ dimension text မ်ားကိုပင္ edit လုပ္ႏိုင္ပါသည္။

Command Access

Dimension Edit - Edit Text

Command Line: DDEDIT

Pointing Device: Double-click a text object.

Dimension Edit - Justify Text

Command Line: DIMTEDIT

Dimension Edit - Justify Text
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Ribbon: Annotate tab > extended Dimensions panel > Text Angle (1), Left Justify (2), Center Justify (3), Right Justify

(4)

Dimension Edit - Oblique Angle

Command Line: DIMEDIT

Command line မွရိုက္ထည့္ အသံုးျပဳလွ်င္ Home, New, နဲ႕ Rotate တို႕သည္လည္း DIMEDIT options မ်ား ျဖစ္ၾကပါသည္။

Ribbon: Annotate tab > extended Dimensions panel > Oblique

Procedure: Adding Text to a Dimension with DDEDIT

Dimedit command ကုိအသုံးျပဳျပီး dimension တြင္ text မ်ား add ပုံကုိ ေအာက္တြင္အဆင့္ဆင့္ ေဖာ္ျပေပးထား ပါသည္။

၁) DDEDIT command ကုိစတင္ရန္ command line တြင္ ddedit ကုိရိုက္ထည့္ေပးလိုက္ပါ။

၂) Edit လုပ္ရန္ dimension text ကုိ select လုပ္ပါ။

၃) In-Place Text Editor ေပၚလာပါလိမ္႕မည္။ အေရာင္မိွန္ျဖင့္ ျပေသာ တန္ဖိုးမ်ားသည္ လက္ရိွ dimension နဲ႕

ပတ္သက္ဆက္ႏြယ္တဲ႕ dimension တန္ဖိုး အစစ္အမွန္ပင္ ျဖစ္ပါသည္။ Dimension (1) ကို click ျပီးေသာ အခါတြင္ additional

notations (2) ကိုရိုက္ထည့္ေပးပါ။
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၄) Exit ေပးရန္ Text Editor အျပင္ဖက္တြင္ Click လုိက္ပါ။

Procedure: Justifying Dimension Text with DIMTEDIT

Dimtedit command ကိုအသံုးျပဳျပီး dimension ေပၚတြင္ justify text လုပ္ပုံကုိ ေအာက္တြင္ အဆင့္ဆင့္ ေဖာ္ျပ ေပးထားပါသည္။

၁) Click Annotate tab > Dimension panel > Dimensions drop-down > Left Justify (1).
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၂) Dimension (2) ကုိ select ပါ။

၃) Text သည္ justified (3) သြားမည္ ျဖစ္သည္။

Procedure: Creating an Oblique Dimension Angle with DIMEDIT

Dimedit command ကုိအသုံုးျပဳျပီး dimension ကုိ oblique angle ေပးပုံကုိေအာက္တြင္ အဆင့္ဆင့္ ေဖာ္ျပေပး ထားပါသည္။

၁) On the ribbon, click Annotate tab > Dimensions panel > Dimensions drop-down > Oblique (1).

၂) Dimension (2) ကုိ select ျပီး Enter ႏိွပ္ပါ။
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၃) Oblique angle ကိုရိုက္ထည့္ေပးပါ။ (ဥပမာအားျဖင့္ - .80)

Exercise: Edit Dimensions

ဤလက္ေတြ႕ေလ့က်င့္ခန္းတြင္ default dimension တန္ဖိုးအသံုးျပဳျပီး text မ်ား addျခင္း၊ diameter dimensions အတြက္ new

dimension substyle မ်ားဖန္တီးျခင္း စသည္တုိ႕ကို ေလ့က်င့္သြားရမည္ ျဖစ္သည္။



“Workgroup” AotoCAD & 3ds Max Job Training Center မွ ပညာဒါန အခမ့ဲ ျဖန္႔ေ၀သည္။

( ဤစာအုပ္ကုိ ေငြေၾကးျဖင့္ ျပန္လည္ေရာင္းခ် ခြင့္မျပဳပါ )

ေအာင္ေဇာ္လတ္ {(Master of Engineering in Science and Production Engineering) Moscow State University Of Railway Engineering}

ဘာသာျပန္ ေရးသား ျပဳစုသည္။
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The completed exercise

၁) M_Edit-Dimensions.dwg ကိုဖြင့္လုိက္ပါ။

၂) Grip ကုိအသုံးျပဳျပီး dimensions ၏ string ကုိ editing လုပ္ရန္ -

 Drawing ရ႕ဲ ဘယ္ဖက္ view တြင္ရိွေသာ continuous dimensions ၏ string ကုိ select လုပ္ပါ။

 Shift ကုိႏိွပ္ထားျပီး grips ငါးခုျဖစ္သည့္ (1), (2), (3), (4), and (5) ကုိ select လိုက္ပါ။ ထိုအခါ ထုိgrips မ်ားသည္

အနီေရာင္သုိ႕ေျပာင္းသြားမည္ ျဖစ္သည္။

 Selected ထားေသာ grips (6) click ျပီး၊ dimension ကုိ ဘယ္ဖက္သုိ႕ drag လုိက္ပါ။

 Selection ကုိ clear လုပ္ရန္ Esc key ကို ႏိွပ္ပါ။



“Workgroup” AotoCAD & 3ds Max Job Training Center မွ ပညာဒါန အခမ့ဲ ျဖန္႔ေ၀သည္။

( ဤစာအုပ္ကုိ ေငြေၾကးျဖင့္ ျပန္လည္ေရာင္းခ် ခြင့္မျပဳပါ )

ေအာင္ေဇာ္လတ္ {(Master of Engineering in Science and Production Engineering) Moscow State University Of Railway Engineering}

ဘာသာျပန္ ေရးသား ျပဳစုသည္။

“Workgroup “ AutoCAD & 3ds Max Training Center, International Computer Driving Licence Approved Test Center,
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၃) Dimension text ကို right justify Dimtedit command ျဖင့္ေနရာ ေရြ႕ေပးရန္ -

 Cmmand line တြင္ dimtedit ကုိရိုက္ထည့္ပါ။

 29mm ျပထားေသာ linear dimension (1) ကုိ select ပါ။

 Drawing အတြင္းတြင္ Right – click ႏိွပ္ပါ။ Justification အတြက္ Right ကို select ပါ။

 အထက္ပါ အဆင့္အတုိင္း 35 mm linear dimension ကိုပါ select လိုက္ပါ။

 Dimension သည္ေအာက္ေဖာ္ျပပါ အတိုင္းေဖာ္ျပေပးပါလိမ္႕မည္။



“Workgroup” AotoCAD & 3ds Max Job Training Center မွ ပညာဒါန အခမ့ဲ ျဖန္႔ေ၀သည္။

( ဤစာအုပ္ကုိ ေငြေၾကးျဖင့္ ျပန္လည္ေရာင္းခ် ခြင့္မျပဳပါ )

ေအာင္ေဇာ္လတ္ {(Master of Engineering in Science and Production Engineering) Moscow State University Of Railway Engineering}

ဘာသာျပန္ ေရးသား ျပဳစုသည္။

“Workgroup “ AutoCAD & 3ds Max Training Center, International Computer Driving Licence Approved Test Center,
Rm- 403, Excel Tower, Yangon, Myanmar.
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၄) Grips ျဖင့္ dimension text ကုိ ေနရာျပန္လည္ သတ္မွတ္ေပးရန္ -

 Jogged radial dimension ကုိ select ပါ။

 Grip (1) ကို select ျပီး၊ ေအာက္ပုံတြင္ ေဖာ္ျပေပးထားသည့္ အတုိင္း (2) ေနရာသုိ႕ ေရြ႕လိုက္ပါ။

 Selection ကုိ clear လုပ္ရန္ Esc key ကိုနိွပ္ပါ။

၅) Dimension ၏ arrow ကုိ flip လုပ္ရန္ -

 ဘယ္ဖက္အေပၚေထာင့္ အပိုင္းတြင္ ရိွေသာ radial dimension ကုိ select ပါ။

 Drawing တြင္ Right – click နိွပ္ျပီး Flip Arrow ကို select ပါ။

 ထိုအခါ arrow သည္ radius ၏အတြင္းပိုင္းသုိ႕ ေရာက္သြားမည္ ျဖစ္သည္။

၆) ဘယ္ဖက္ေအာက္ေထာင့္ အပိုင္းတြင္ရိွေသာ diameter dimension view ကိုျမင္ႏိုင္ေအာင္ Zoom ျပင္လုိက္ပါ။



“Workgroup” AotoCAD & 3ds Max Job Training Center မွ ပညာဒါန အခမ့ဲ ျဖန္႔ေ၀သည္။

( ဤစာအုပ္ကုိ ေငြေၾကးျဖင့္ ျပန္လည္ေရာင္းခ် ခြင့္မျပဳပါ )

ေအာင္ေဇာ္လတ္ {(Master of Engineering in Science and Production Engineering) Moscow State University Of Railway Engineering}

ဘာသာျပန္ ေရးသား ျပဳစုသည္။

“Workgroup “ AutoCAD & 3ds Max Training Center, International Computer Driving Licence Approved Test Center,
Rm- 403, Excel Tower, Yangon, Myanmar.
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၇) Diameter dimension substyle ကိုဖန္တီးရန္ -

 On the Annotate tab, click Dimensions panel > Dimension, Dimension Style.

 Dimension Style Manager က New ကုိ click ပါ။

 Create New Dimension Style dialog box တြင္ရိွေသာ Use For list မွ Diameter Dimensions ကို select ပါ။

 Continue ကုိ Click လိုက္ပါ။

၈) Substyle အတြက္ text alignment သတ္မွတ္ေပးရန္ -

 New Dimension Style dialog box တြင္ရိွေသာ Text tab ကုိ click ျပီး Text Alignment ေအာက္တြင္ ရွိေသာ ISO

Standard ကုိ select လုိက္ပါ။



“Workgroup” AotoCAD & 3ds Max Job Training Center မွ ပညာဒါန အခမ့ဲ ျဖန္႔ေ၀သည္။

( ဤစာအုပ္ကုိ ေငြေၾကးျဖင့္ ျပန္လည္ေရာင္းခ် ခြင့္မျပဳပါ )

ေအာင္ေဇာ္လတ္ {(Master of Engineering in Science and Production Engineering) Moscow State University Of Railway Engineering}

ဘာသာျပန္ ေရးသား ျပဳစုသည္။

“Workgroup “ AutoCAD & 3ds Max Training Center, International Computer Driving Licence Approved Test Center,
Rm- 403, Excel Tower, Yangon, Myanmar.

Ph: 951 559377 Ext: 6413 or 6403, Email – infor@workgroupweb.com

198

 Ok ကုိ Click ပါ။

 New dimension substyle သည္ ISO-25 dimension style ေအာက္သုိ႕ေရာက္လာမည္ ျဖစ္သည္။

၉) Dimension Style Manager ကုိ exit ေပးရန္ Close ကို Click လုိက္ပါ။ New dimension substyle တြင္ျပင္ဆင္ခ႕ဲသည့္ အတုိင္း

dimension တန္ဖိုးသည္ ေရျပင္ညီ အတိုင္းျဖစ္သြားမည္။

၁၀) Files အားလုံးကို မ Save ပဲပိတ္လိုက္ပါ။

Challenge Exercise: Architectural

ဤလက္ေတြ႕ ေလ့က်င့္ခန္းတြင္ အထက္၌ ေလ့လာခ႕ဲျပီး သည့္အတုိင္း dimension styles မ်ားဖန္တီးကာ၊ Floor plan သို႕

dimensions မ်ား add ျခင္း အပုိင္းကုိ လက္ေတြ႕ ေလ့က်င့္သြားရမည္ ျဖစ္ပါသည္။



“Workgroup” AotoCAD & 3ds Max Job Training Center မွ ပညာဒါန အခမ့ဲ ျဖန္႔ေ၀သည္။

( ဤစာအုပ္ကုိ ေငြေၾကးျဖင့္ ျပန္လည္ေရာင္းခ် ခြင့္မျပဳပါ )

ေအာင္ေဇာ္လတ္ {(Master of Engineering in Science and Production Engineering) Moscow State University Of Railway Engineering}

ဘာသာျပန္ ေရးသား ျပဳစုသည္။
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The completed exercise

Metric Units

၁) M_ARCH-Challenge-CHP08.dwg ကုိဖြင့္လိုက္ပါ။

၂) Dimension ကုိ current Layer အျဖစ္သို႕ သတ္မွတ္ေပးလိုက္ပါ။

၃) ေအာက္တြင္ေဖာ္ျပေပးထားေသာ setting အတုိင္း Architecture အမည္ရိွေသာ new dimension style ဖန္တီးရန္ -

 Arrowheads = Architectural tick

 Arrow size = 3

 Text Style = Labels

 Text height = 3

 Text Alignment = Horizontal

 Overall Dimension Scale = 60

 Primary Unit Precision = 0



“Workgroup” AotoCAD & 3ds Max Job Training Center မွ ပညာဒါန အခမ့ဲ ျဖန္႔ေ၀သည္။

( ဤစာအုပ္ကုိ ေငြေၾကးျဖင့္ ျပန္လည္ေရာင္းခ် ခြင့္မျပဳပါ )

ေအာင္ေဇာ္လတ္ {(Master of Engineering in Science and Production Engineering) Moscow State University Of Railway Engineering}

ဘာသာျပန္ ေရးသား ျပဳစုသည္။
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Ph: 951 559377 Ext: 6413 or 6403, Email – infor@workgroupweb.com

200

၄) Walls မ်ား၏ Length ကုိ ေဖာ္ျပေပးေသာ dimensions မ်ားကို လက္ရိွ Layer ျဖင့္ Floor plan သို႕ ေအာက္ေဖာ္ျပပါ ပုံအတုိင္း add

ေပးပါ။

၅) Save ျပီး Close လုိက္ပါ။

Imperial Units

၁) I_ARCH-Challenge-CHP08.dwg ကုိဖြင့္လိုက္ပါ။

၂) Dimension ကုိ current Layer အျဖစ္သုိ႕ သတ္မွတ္ေပးလိုက္ပါ။

၃) ေအာက္တြင္ေဖာ္ျပေပးထားေသာ setting အတုိင္း Architecture အမည္ရိွေသာ new dimension style ဖန္တီးရန္ -

 Arrowheads = Architectural tick



“Workgroup” AotoCAD & 3ds Max Job Training Center မွ ပညာဒါန အခမ့ဲ ျဖန္႔ေ၀သည္။

( ဤစာအုပ္ကုိ ေငြေၾကးျဖင့္ ျပန္လည္ေရာင္းခ် ခြင့္မျပဳပါ )

ေအာင္ေဇာ္လတ္ {(Master of Engineering in Science and Production Engineering) Moscow State University Of Railway Engineering}

ဘာသာျပန္ ေရးသား ျပဳစုသည္။
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 Text Style = Labels

 Text height = 1/8 (.125)

 Text Alignment = Horizontal

 Overall dimension scale = 38.4

 Unit format = Architectural

 Primary Unit Precision = 0'-0"

၄) Walls မ်ား၏ Length ကုိ ေဖာ္ျပေပးေသာ dimensions မ်ားကို လက္ရိွ Layer ျဖင့္ Floor plan သို႕ ေအာက္ေဖာ္ျပပါ ပုံအတုိင္း add

ေပးပါ။

၅) Save ျပီး Close လုိက္ပါ။

Challenge Exercise: Mechanical



“Workgroup” AotoCAD & 3ds Max Job Training Center မွ ပညာဒါန အခမ့ဲ ျဖန္႔ေ၀သည္။

( ဤစာအုပ္ကုိ ေငြေၾကးျဖင့္ ျပန္လည္ေရာင္းခ် ခြင့္မျပဳပါ )

ေအာင္ေဇာ္လတ္ {(Master of Engineering in Science and Production Engineering) Moscow State University Of Railway Engineering}

ဘာသာျပန္ ေရးသား ျပဳစုသည္။
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ဤလက္ေတြ႕ ေလ့က်င့္ခန္းတြင္ အထက္၌ ေလ့လာခ႕ဲျပီးေသာ dimensions မ်ား add ျခင္းသင္ခန္းစာကုိ အသုံးျပဳျပီး

ေအာက္ေဖာ္ျပပါပုံတြင္ dimensions မ်ားadd ျခင္းအပိုင္းကုိ လက္ေတြ႕ ေလ့က်င့္သြားရမည္ ျဖစ္ပါ သည္။

The completed exercise

၁) M_ARCH-Challenge-CHP08.dwg ကုိဖြင့္လိုက္ပါ။

၂) Dimension ကုိ current Layer အျဖစ္သုိ႕ သတ္မွတ္ေပးလိုက္ပါ။

၃) ေအာက္တြင္ေဖာ္ျပေပးထားေသာ setting အတုိင္း Mech-2 အမည္ ရိွေသာ new dimension style ဖန္တီးရန္ -

 Arrow size = 2

 Center Marks = None

 Text Style = Labels

 Text height = 2

 Overall dimension scale = 2

 Primary Unit Precision = 0.0

၄) Diameter နဲ႕ Radial dimensions အတြက္ dimension substyles နွစ္ခုကို ဖန္တီးျပီး၊ အဆိုပါ substyles အတြက္ Text

Alignment ကုိ ISO Standard အျဖစ္သတ္မွတ္ေပးလိုက္ပါ။



“Workgroup” AotoCAD & 3ds Max Job Training Center မွ ပညာဒါန အခမ့ဲ ျဖန္႔ေ၀သည္။

( ဤစာအုပ္ကုိ ေငြေၾကးျဖင့္ ျပန္လည္ေရာင္းခ် ခြင့္မျပဳပါ )

ေအာင္ေဇာ္လတ္ {(Master of Engineering in Science and Production Engineering) Moscow State University Of Railway Engineering}

ဘာသာျပန္ ေရးသား ျပဳစုသည္။
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၅) ေအာက္တြင္ေဖာ္ျပေပးထားေသာ view သို႕ dimensions မ်ား add ေပးလိုက္ပါ။



“Workgroup” AotoCAD & 3ds Max Job Training Center မွ ပညာဒါန အခမ့ဲ ျဖန္႔ေ၀သည္။

( ဤစာအုပ္ကုိ ေငြေၾကးျဖင့္ ျပန္လည္ေရာင္းခ် ခြင့္မျပဳပါ )

ေအာင္ေဇာ္လတ္ {(Master of Engineering in Science and Production Engineering) Moscow State University Of Railway Engineering}

ဘာသာျပန္ ေရးသား ျပဳစုသည္။
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၆) အျခားေသာ Views မ်ား။

၇) Save ျပီး Files အားလုံးကို Close လုိက္ပါ။

Chapter Summary
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Drawings မ်ားတြင္ မိမိတုိ႕ ဖန္တီးထားေသာ Objects မ်ား၏ အရြယ္အစား၊ အကြာအေ၀း စသည္တို႕ကို dimension ျဖင့္ တုိင္းတာ

သတ္မွတ္ႏိုင္ပါသည္။ Dimedit, Dimtedit န႕ဲ Ddedit commands မ်ားအသံုးျပဳျပီး dimensions န႕ဲ dimension text မ်ားကုိ modify

လုပ္ႏိုင္ပါသည္။ Dimensions မ်ား၏ Properties မ်ားကို Properties palette မွလည္း modify လုပ္ႏိုင္ျပီး၊ grip ကို အသံုးျပဳ၍လည္း

dimension မ်ားကုိ ေနရာေရြ႕ျခင္း စသည္တုိ႕ျပဳလုပ္သြား ႏိုင္ပါသည္။

ဤသင္ခန္းစာကုိ ေလ့လာျခင္း ျပီးစီးသြားပါက -

 Dimensions ဖန္တီးတတ္လာမည္။

 Dimension style ကုိအသံုးျပဳ၍ dimensions မ်ားကုိ manage လုပ္တတ္လာမည္။

 Multileader styles န႕ဲ Multileaders မ်ားကုိ creat ျခင္းနွင့္ edit လုပ္ျခင္းတုိ႕ကုိ ျပဳလုပ္တတ္လာမည္။

 မတူညီေသာ commands မ်ားအသံုးျပဳျပီး dimensions မ်ား edit လုပ္ျခင္း နည္းလမ္းကို နားလည္ သေဘာေပါက္ လာမည္။

CHAPTER : 9 Hatching Objects

ဤသင္ခန္းစာတြင္ Drawings မ်ားကုိ ရုပ္လံုးၾကြလာေစရန္ Hatch patterns and gradient fills မ်ား အသုံးျပဳျခင္းကုိ ေလ့လာသြား

ရမည္ ျဖစ္ပါသည္။ Hatch patterns and gradient fills တို႕ကို ဖန္တီးျပီးေသာ အခါတြင္လည္း၊ တူညီ ေသာနည္းလမ္းမ်ားျဖင့္ Edit

လုပ္သြားႏိုင္ပါသည္။

Objectives

ဤသင္ခန္းစာကို ေလ့လာျခင္း ျပီးစီးသြားပါက -
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 Drawing အတြင္းမွ Objects မ်ားတြင္ Hatch patterns and gradient fills မ်ားဖန္တီးတတ္ လာေစရန္။

 Drawing အတြင္းမွ ဖန္တီးျပီးေသာ Hatch patterns and gradient fills မ်ားကုိ လိုအပ္သလုိ edit လုပ္တတ္ လာေစရန္။

Lesson: Hatching Objects

ဤသင္ခန္းစာတြင္ drawing အတြင္းက objects မ်ားကို Hatch and Gradient commands မ်ား အသုံးျပဳျပီး hatch and fill

လုပ္ျခင္းကို တင္ျပသြားမည္ ျဖစ္ပါသည္။ ေအာက္တြင္ ေဖာ္ျပေပးထားေသာ ပုံကုိ ေလ့လာၾကည့္ပါ။ အိမ္ေခါင္မိုးအတြက္ roof tile hatch

pattern ကုိအသုံးျပဳထားျပီး၊ အိမ္နံရံအတြက္ brick pattern ကိုအသံုးျပဳျပီး ပုံေဖာ္ထားေပးသလို၊ ေနာက္ခံ background ကုိလည္း

gradient fills နွစ္မ်ိဳးျဖင့္ အေရာင္တင္ ထားေပးသည္ကုိ ေတြ႕ရမည္။ Hatching ကုိ construction, steelwork (သုိ႕မဟုတ္) road

design ႏွင့္အျခားေသာ designs မ်ားတြင္ အသံုးျပဳႏိုင္ပါသည္။ နဂိုမူရင္း software တြင္ပါေသာ Hatch patterns မ်ားအျပင္

ကိုယ္တုိင္ဖန္တီး၍ လည္းအသုံးျပဳသြား ႏိုင္ပါသည္။

Objectives

ဤသင္ခန္းစာကို ေလ့လာျခင္း ျပီးစီးသြားပါက -

 Hatch and fill patterns တုိ႕၏ characteristics ကုိသိရိွလာေစရန္။

 Hatch patterns မ်ား၏ ဆက္စပ္ခ်က္မ်ားကို သိရိွနားလည္လာေစရန္။

 Hatch and fill patterns တုိ႕ကုိ ဖန္တီးတတ္လာေစရန္။
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Introduction to Hatch Patterns and Gradient Fills

Designers မ်ားအေနျဖင့္ မိမိတို႕ ဖန္တီးလိုက္ေသာ drawings မ်ားတြင္ materials, special regions (သို႕မဟုတ္) textures တို႕အစား

ရုပ္လံုးၾကြ လာေအာင္ ကုိယ္စားျပဳ ေဖာ္ျပေပးသည့္ patterns မ်ား add ခ်င္ေနေပ လိမ္႕မည္။ ထိုသုိ႕ add လိုလွ်င္ Hatch and Gradient

patterns မွ solids, gradients, ႏွစ္သက္ရာ hatch patterns မ်ား ေရြးခ်ယ္၍ လည္းေကာင္း (သုိ႕မဟုတ္) မိမိတုိ႕ အသုံးျပဳလုိေသာ

hatch patterns ပုံစံမ်ား စိတ္ၾကိဳက္ ဖန္တီး၍ လည္းေကာင္း အသံုးျပဳ နိုင္ပါသည္။

Definition of Hatch and Fill Boundaries

Hatch patterns မ်ားသည္ drawing အတြင္းမွ materials, special regions န႕ဲ textures တို႕အစား ကုိယ္စားျပဳ ေဖာ္ျပေပးသည့္

graphical elements မ်ားျဖစ္ပါသည္။ Area မ်ားသတ္မွတ္ရာတြင္ Patterns မ်ားအသံုးျပဳႏိုင္ သည့္အျပင္ gradient (သုိ႕မဟုတ္) solid

fill မ်ားကိုလည္း အသုံးျပဳႏိုင္ပါသည္။ Hatch command ကုိအသုံးျပဳျပီး area အပိုင္းလုိက္ ကြဲကြဲျပားျပား သိလာေစရန္ hatch patterns

and gradients မ်ားအသုံးျပဳထားေသာ ေအာက္ေဖာ္ျပပါ ပုံကုိ ေလ့လာၾကည့္ပါ။ ပုံတြင္ selected ထားေသာေၾကာင့္

အေရာင္မိွန္ေနေသာ အိမ္နံရံကုိ pattern ျဖင့္ဖန္တီးထားျခင္း ျဖစ္ပါသည္။
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Hatch Boundaries

Drawing အတြင္းရိွ မိမိတုိ႕ hatching လုပ္လုိေသာ area ကုိ click လိုက္လွ်င္ drawing အတြင္း boundaries တြင္ Hatch and

Gradient dialog box ၌သတ္မွတ္ခဲ႕သည့္ hatch pattern ပုံစံေပၚမူတည္ျပီး hatch ကုိမည္သုိ႕ ေနရာသတ္မွတ္ရမည္ကုိ

အလုိအေလ်ာက္ determine လုပ္ရန္ ခ်င့္ခ်ိန္ေပးသြားပါလိမ္႕မည္။

အကယ္၍ hatch boundary က determine မလုပ္ခ႕ဲလွ်င္ drawing အတြင္းရိွ area ၏ အတြင္းပိုင္းေထာင့္ မ်ားသည္ အနားပိတ္

ျဖစ္မေနေသာေၾကာင့္ ျဖစ္ေပလိမ္႕မည္။ Hatch boundary အတြင္းမွ boundary ၏ end point မ်ားတစ္ခုနွင့္တစ္ခု ခ်ိတ္မေနပဲ

ကြာဟေနေသာ ေနရာကို အနီေရာင္ circle ျဖင့္ displayed ေပးထားမည္။
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Hatch command ျပီးဆံုးသြားေသာ္လည္း အဆိုပါ အနီေရာင္ circles မ်ားသည္ လက္ရိွေနရာတြင္ပင္ က်န္ရိွေနမည္ ျဖစ္သည္။

Hatching လုပ္ရန္အတြက္ အျခားေသာ အတြင္းေထာင့္မ်ားကို select ေသာအခါမွ ေပ်ာက္ကြယ္သြားမည္ ျဖစ္သည္။ (သို႕မဟုတ္)

Redraw, Regen (သုိ႕မဟုတ္) Regenall commands မ်ားအသံုး ျပဳေသာအခါတြင္လည္း ေပ်ာက္ကြယ္သြားေပလိမ္႕မည္။

Example of Hatch and Fill Patterns

Hatch patterns and fills ကုိအသံုးျပဳျခင္းသည္ area တစ္ခုကုိ အေရာင္ျခယ္သက႕ဲသို႕ပင္ ျဖစ္သည္။ ဥပမာ အားျဖင့္ ပင္လယ္အတြက္

ဆိုလွ်င္ မိမိတို႕ အေနျဖင့္ အျပာေရာင္ကို ေရြးခ်ယ္ သြားရမည္ျဖစ္သည္။ အျပာေရာင္သည္ ေရကုိကိုယ္စားျပဳ ပါသည္။ သို႕ေသာ္ hatch

and fill ျဖင့္ အသံုးျပဳလွ်င္ အနီးစပ္ဆံုး အေရာင္န႕ဲ waves (သုိ႕မဟုတ္) ripples က႕ဲသို႕ေသာ patterns န႕ဲ textures မ်ားကုိ အသုံးျပဳ

ႏိုင္ပါသည္။ အေဆာက္ အဦး၏ ေရွ႕မ်က္နွာစာတြင္ အသုံးျပဳထားေသာ brick color အတြက္ အနီးစပ္ဆံုးအေရာင္ကို သဘာ၀က်က်

ေရြးခ်ယ္ အသုံးျပဳထားေသာေၾကာင့္ အုတ္နံရံမွာ အစစ္အမွန္ကဲ႕သို႕ ျမင္ေတြ႕ေနရေသာ ေအာက္ေဖာ္ျပပါပုံကုိ ေလ့လာၾကည့္ပါ။

Associative Hatch Patterns
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Default အရ hatch patterns သည္ ၎တုိ႕အား fill ထားေသာ space ျဖင့္ဆက္စပ္ေနပါသည္။ ဆုိလိုရင္းမွာ hatched ထားေသာ

object ကုိ edited လုပ္ျပီးသြားလွ်င္ အဆုိပါ hatch သည္ New shape ျဖစ္သြားမည္။

Removing Associativity

Hatch ကို object (သို႕မဟုတ္) area ျဖင့္ဆက္စပ္မွဳ႕ မရိွေအာင္ elect လုပ္ႏိုင္ပါသည္။ ထိုသုိ႕ ျပဳလုပ္လုိလွ်င္ Hatch and Gradient

dialog box မွ Options ေအာက္ရိွ Associative option ကုိ clear လုပ္လိုက္ပါ။

Nonassociative Hatch Patterns

Gap Tolerance feature ျဖင့္ Hatches မ်ားလုပ္ျခင္းသည္ nonassociative ျဖစ္ပါသည္။ ဆုိလိုရင္းမွာ အနား မပိတ္သည့္ area

ပါ၀င္ေသာ hatch ကို modify လုပ္ျပီးပါက၊ ၎ကို rehatch ျပန္လုပ္ေပးရန္ လိုအပ္ပါသည္။

Gap Tolerance feature ေသာအခါ ေနာက္ဆက္တြလဲုပ္ထားေသာ hatches အားလုံးသည္လည္း nonassociative ပင္ျဖစ္ပါသည္။

ဆက္စပ္မွဳ႕ ရိွသည့္ hatches မ်ားျပန္လုပ္ေပးရန္ Hatch and Gradient dialog box မွ Options ေအာက္ရိွ Associative ကို select

လုပ္ရပါမည္။

Creating Hatched Objects

Hatch command ကုိအသုံးျပဳကာ drawing အတြင္းမွ selected ထားေသာ area အတြင္းသို႕ patterns, colors (သို႕မဟုတ္)

gradients မ်ားျဖင့္ fill ႏိုင္ပါသည္။ Drawing အတြင္းရိွ point ေပၚတြင္ (သို႕မဟုတ္) object တြင္ boundaries based သတ္မွတ္၍ ထုိ

area တြင္ fill လုပ္ႏိုင္ပါသည္။ Hatch command ကုိစတင္လုိက္သည္ႏွင့္ Hatch and Gradient dialog box ေပၚလာမည္ ျဖစ္သည္။

ထို dialog box ကုိအသံုးျပီး hatch အတြက္ type and pattern ကုိ select ပါ။ ထုိ႕ေနာက္ angle, scale န႕ဲ hatch origin တုိ႕ကို

စိတ္ၾကိဳက္ သတ္မွတ္ျပီး၊ မိမိတုိ႕ hatching လုပ္မည့္ boundaries ကိုသတ္မွတ္ပါ။
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Hatch properties မ်ားနွင့္ hatch boundaries ကုိျပင္ဆင္ သတ္မွတ္ျပီးေသာအခါ Preview button ကုိ အသုံးျပဳျပီိး၊ hatch pattern

ကို အတည္ျပဳ မဖန္တီးခင္ မိမိတို႕ သေဘာေတြ႕မေတြ႕ မစမ္းသေဘာမ်ိဳး ၾကည့္ရႈ႕ စစ္ေဆးႏိုင္ပါသည္။

Objects တစ္ခုတည္းကုိ hatch and gradient နွစ္မ်ိဳးအသံုးျပဳျပီး View ႏွစ္မ်ိဳးျဖင့္ ဖန္တီး ေဖာ္ျပေပးထားေသာ ေအာက္ပါပုံကုိ

ေလ့လာၾကည့္ပါ။

Command Access

Hatch

Command Line: HATCH, H

Ribbon: Home tab > Draw panel > Hatch

Hatch and Gradient Dialog Box: Hatch Tab

Advanced hatching options မ်ားကို access လုပ္ရန္ Hatch and Gradient dialog boxes ၏ညာဖက္ ေအာက္ေထာင့္တြင္ ရိွေသာ

arrow ကို click ပါ။
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Type and Pattern

Hatch and Gradient dialog boxes တြင္ရိွေသာ Type and Pattern area ကိုအသံုးျပဳျပီး hatch pattern ကုိ select လုပ္ပါ။ Pattern

list မွ (သို႕မဟုတ္) browse button or Swatch area ကို click ျပီး Hatch Pattern Palette dialog box ဖြင့္ကာ Pattern မ်ားကို

select ႏိုင္ပါသည္။

Hatch Pattern Palette Dialog Box
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Angle and Scale

Angle and Scale area ကုိအသံုးျပဳျပီး patterns မ်ား၏ angle and scale ကို ျပင္ဆင္သတ္မွတ္ ႏိုင္ပါသည္။ မိမိတို႕ အေနျဖင့္ angle

တန္ဖုိးကုိ ရိုက္ထည့္ေသာအခါတြင္၊ ထုိရိုက္ထည့္ လိုက္ေသာ တန္ဖိုးသည္ hatch ၏ default angle ကိုထပ္မံ ထည့္ေပါင္းသြားသည့္

သေဘာပင္ျဖစ္သည္။ ဥပမာ အားျဖင့္ - ANSI 31 hatch pattern ၏ default angle တန္ဖိုး 45 ဒီဂရီျဖစ္ပါသည္။ မိမိတို႕ အေနျဖင့္

angle field တြင္ 45 ဒီဂရီ ရိုက္ထည့္လုိက္မည္ ဆိုလွ်င္ default angle 45 ဒီဂရီကုိ ထပ္မံ၍ 45 ဒီဂရီ ထပ္ေပါင္းသြားသည့္

သေဘာျဖစ္ျပီး၊ pattern lines သည္ vertically အတုိင္း 90ျဖင့္ ေရးဆြဲသြားမည္ ျဖစ္သည္။
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Hatch Origin

တစ္ခ်ိဳ႕တစ္ခ်ိဳ႕ေသာ hatching လုပ္ေသာ အေျခေနတြင္ hatch pattern ကိုအေကာင္းဆံုး ေနရာသတ္မွတ္ေပး ႏိုင္ရန္ hatch origin

ကိုျပဳျပင္သြားရပါမည္။ Hatch Origin options ကိုအသံုးျပဳျပီး pattern စတင္သည့္ ေနရာကုိ ထိန္းခ်ဳပ္ျပီး realistic pattern

မ်ားဖန္တီးသြား ႏိုင္ပါသည္။

Command Access

Gradient

Command Line: GRADIENT

Ribbon: Home tab > extended Draw panel > Gradient



“Workgroup” AotoCAD & 3ds Max Job Training Center မွ ပညာဒါန အခမ့ဲ ျဖန္႔ေ၀သည္။

( ဤစာအုပ္ကုိ ေငြေၾကးျဖင့္ ျပန္လည္ေရာင္းခ် ခြင့္မျပဳပါ )

ေအာင္ေဇာ္လတ္ {(Master of Engineering in Science and Production Engineering) Moscow State University Of Railway Engineering}

ဘာသာျပန္ ေရးသား ျပဳစုသည္။

“Workgroup “ AutoCAD & 3ds Max Training Center, International Computer Driving Licence Approved Test Center,
Rm- 403, Excel Tower, Yangon, Myanmar.

Ph: 951 559377 Ext: 6413 or 6403, Email – infor@workgroupweb.com

215

Hatch and Gradient Dialog Box: Gradient Tab

Hatch and Gradient dialog box တြင္ရိွေသာ Gradient tab ကုိ click ျပီး မိမိတုိ႕၏ drawing တြင္ gradients မ်ား ဖန္တီးႏိုင္ပါသည္။

one color gradient ကို select ျပီး၊ shading or tint ျပဳလုပ္ႏိုင္သလုိ၊ two color option ကုိအသံုးျပဳျပီး gradients အတြက္ color

ႏွစ္မ်ိဳး သတ္မွတ္ႏိုင္ပါသည္။ Gradient pattern (၉) မ်ိဳးမွ မိမိတုိ႕ ႏွစ္သက္ေသာ pattern ကိုေရြးခ်ယ္ႏိုင္ အသုံးျပဳႏိုင္ပါသည္။

Orientation area တြင္ gradient ကုိ boundary အတြင္း centered တြင္ ရိွေနေစရန္ႏွင့္ gradient ရ႕ဲ angle ကုိျပဳျပင္ႏိုင္ပါသည္။

Hatch and Gradient - Boundaries and Advanced Options

Hatches and gradients နွစ္ခုလံုးကုိ apply လုပ္ရန္ ေအာက္ေဖာ္ျပပါ interface options မ်ားကုိ ေတြ႕ျမင္ရေပမည္။
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Boundaries

မိမိတုိ႕ဖန္တီးလိုက္ေသာ hatch (သို႕မဟုတ္) gradient တိုင္းသည္ မိမိတုိ႕ သတ္လိုက္ေသာ boundary ေပၚမူတည္ျပီး ျဖစ္ေပၚပါသည္။

Boundary အတြင္းမွ points မ်ားကုိ selecting လုပ္ျပီး (သုိ႕မဟုတ္) boundary ရ႕ဲ objects မ်ားကို selecting လုပ္ျပီး boundaries

မ်ားဖန္တီးရန္ Hatch and Gradient Dialog Box တြင္ရိွေသာ boundaries area မွ options မ်ားကုိအသံုးျပဳသြားရမည္ ျဖစ္ပါသည္။

Options

Associative option ကုိ selected ျပီးေသာ အခ်ိန္တြင္ ရရိွလာမည့္ hatch သည္ boundary ျဖင့္ ဆက္စပ္ေနမည္ ျဖစ္သည္။ Multiple

boundaries မ်ားတြင္ hatch patterns ကုိတစ္ျပိဳင္တည္း ဖန္တီးလုိေသာ အခါတြင္ Create Separate Hatches option ကိုအသုံးျပဳျပီး

boundary တစ္ခုဆီတြင္ patterns မ်ားကုိ သီးသန္႕ခြဲျခား ဖန္တီး ေပးႏိုင္ပါသည္။ Draw Order list ကုိအသုံးျပဳျပီး hatch pattern

မ်ားကို objects မ်ား၏ေနာက္ (သို႕မဟုတ္) ေရွ႕စသည္ျဖင့္ ျပဳျပင္ ပို႕ေဆာင္ျခင္းကုိ ျပဳလုပ္ႏိုင္ပါသည္။
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Inherit Properties

Hatch patterns ပါရိွျပီးသား drawing ကုိ edit လုပ္ေသာ အခ်ိန္တြင္ ဤ option ကုိအသုံးျပဳပါသည္။ ဖန္တီး ထားေသာ hatch

patterns မ်ား၏ properties ကိုလိုအပ္သလို modify လုပ္ႏိုင္ပါသည္။ ဤ feature ကိုအသုံးျပဳကာ အျခားေသာ hatch patterns

(သုိ႕မဟုတ္) gradients တုိ႕၏ properties မ်ားကို လြယ္ကူစြာ match properties လုပ္ႏိုင္ပါသည္။

Islands

မိမိတုိ႕ သတ္မွတ္လိုက္ေသာ boundary အတြင္းမွ မိမိတုိ႕ ျမင္သာေစလိုေသာ boundaries ကိုသာ hatching လုပ္လိုလွ်င္ Island

Detection ကို select ေပးရပါမည္။ ထုိသုိ႕ ျပဳလုပ္ရာတြင္ Normal, Outer(သုိ႕မဟုတ္) Ignore စသည့္ ပုံစံအသီးသီးတုိ႕ကို

ေရြးခ်ယ္နိုင္ပါသည္။ Hatching areas တြင္ text မ်ားပါ၀င္ေသာ အေျခအေနမ်ိဳးတြင္ အလြန္အသုံး၀င္ လွပါသည္။

Boundary Retention

အကယ္၍ Retain Boundaries option ကုိ select လိုက္မည္ဆုိလွ်င္၊ လက္ရိွ သတ္မွတ္ထားေသာ boundary တြင္ New object

created လုပ္ႏိုင္ပါသည္။ Region (သုိ႕မဟုတ္) Polyline object ကုိေရြးခ်ယ္ႏိုင္ပါသည္။
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Boundary Set

ဤ option ကိုအသံုးျပဳျပီး ဘယ္လို drawing က boundaries မ်ားအတြက္ analyzed ျဖစ္သည္ကို ဆံုးျဖတ္ႏိုင္ပါသည္။

Gap Tolerance

Boundaries တြင္ အနားမပိတ္ပဲ (gap) ရိွေနလွ်င္၊ ထုိ gap ကုိ လ်စ္လ်ဴရႈ႕ထားႏိုင္သည္ အထိ ေသးငယ္သြားေအာင္ gap tolerance

တြင္ tolerance မ်ားျပင္ဆင္သတ္မွတ္ေပး ႏိုင္ပါသည္။

မွတ္ခ်က္။ ။ Boundary တြင္ gaps မ်ားရိွေနလွ်င္ hatch pattern သည္ associative ျဖစ္မည္ မဟုတ္ေပ။

Inherit Options

အကယ္၍ Inherit Properties option ကိုအသုံးျပဳျပီး hatch မ်ားဖန္တီးမည္ ဆုိလွ်င္၊ Inherit options ကိုအသုံးျပဳျပီး hatch origin

၏တည္ေနရာကုိ control လုပ္ႏိုင္ပါသည္။

Procedure: Creating a Hatch Pattern

Drawing တြင္ hatch (သို႕မဟုတ္) gradient မ်ားဖန္တီးပုံကို ေအာက္တြင္ အဆင့္ဆင့္ ေဖာ္ျပေပး ထားပါသည္။

၁) Ribbon, click Home tab > Draw panel > Hatch.
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၂) Hatch pattern type ကို select ျပီး၊ ၎၏ Properties မ်ားကုိ ျပင္ဆင္သတ္မွတ္ေပးပါ။

၃) Add: Pick Points (သုိ႕မဟုတ္) Add: Select Objects ကို click ျပီး၊ boundary ရ႕ဲအတြင္းအမွတ္ကုိ select ကာ (သို႕မဟုတ္)

boundary ၏ object ကို select လိုက္ပါ။

၄) Hatch and Gradient dialog box တြင္ လုိအပ္သလို အျခားေသာ options မ်ားကုိလည္း ျပင္ဆင္အသံုးျပဳ ႏိုင္ပါသည္။

၅) မိမိတုိ႕ ဖန္တီးလုိက္ေသာ hatch ကုိအစမ္းသေဘာမ်ိဳး ၾကည့္ရႈ႕ရန္ Preview ကို click လုိက္ပါ။

၆) Hatch ကို previewed ျပီးေသာအခါတြင္ drawing အတြင္း တစ္ေနရာရာကုိ click ျပီး Hatch and Gradient dialog box

သို႕ျပန္သြားပါ (သို႕မဟုတ္) ဖန္တီးလိုက္ေသာ hatch pattern ကိုစိတ္ၾကိဳက္ေတြ႕ပါက အသံုးျပဳရန္ Right– click ႏိွပ္ပါ။

Practice Exercise: Create Hatched Objects
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ဤလက္ေတြ႕ ေလ့က်င့္ခန္းတြင္ ေအာက္တြင္ေဖာျ္ပ ေပးထားေသာ ပုံအတုိင္း ေရးဆြဲျပီး Hatch and Gradient commands ျဖင့္ hatch

objects မ်ားဖန္တီးျခင္းကို ေလ့က်င့္သြားရမည္ ျဖစ္သည္။

၁) Hatch and gradient fill ျပဳလုပ္ရန္ အထက္တြင္ေဖာ္ျပ ေပးထားေသာ objects မ်ားကုိေရြးဆဲြလိုက္ပါ။

၂) Selected ထားေသာ object တြင္ solid hatch pattern မ်ားဖန္တီးေပးရန္ -

 Home tab, click Draw panel > Hatch.

 Hatch and Gradient dialog box တြင္ရိွေသာ Pattern list မွ ANSI31 ကုိ select ပါ။

 Angle list မွ 0 ကုိ select ပါ။

 Scale list 1.000 ကုိ select ပါ။

 Boundaries ေအာက္တြင္ ရိွေသာ Add: Select Objects ကို click ပါ။

 ေအာက္တြင္ေဖာ္ျပ ေပးထားသည့္ အတိုင္း rectangle တစ္ခုကို select လုပ္လိုက္ပါ။

 Selected object တြင္ Right–click ႏိွပ္ျပီး၊ Preview ကုိ click ပါ။
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 Hatch ကုိလက္ခံရန္ Right–click ႏိွပ္ပါ။

၃) Two colors အသံုးျပဳျပီး gradient fill ဖန္တီးရန္ -

 Home tab, click Draw panel > Hatch.

 Hatch and Gradient dialog box က Gradient tab ကုိ click ပါ။

 Color ေအာက္မွ Two color ကို click ပါ။

 Gradient patterns တစ္ခုခုကုိ select လိုက္ပါ။

 Boundaries ေအာက္မွ Add: Pick points ကို select ပါ။

 ေအာက္တြင္ေဖာ္ျပ ေပးထားေသာ ပုံအတုိင္း အျခားေသာ rectangle ကို select လုိက္ပါ။

 Selected object တြင္ Right – click ႏိွပ္ျပီး၊ Preview ကို click ပါ။

 Dialog box သို႕ျပန္သြားရန္ drawing window တြင္ တစ္ခ်က္ click လိုက္ပါ။

 အျခားေသာ gradient pattern ကုိ select လုိက္ပါ။

 Preview ကို click ပါ။

 Gradient ကိုလက္ခံရန္ Right–click ႏိွပ္ပါ။
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၄) Solid fill hatch pattern ဖန္တီးရန္ -

 Home tab, click Draw panel > Hatch.

 Hatch and Gradient dialog box တြင္ရိွေသာ Pattern list မွ solid ကုိ select ပါ။

 Swatch list မွ Select Color ကုိ select ပါ။

 Select Color dialog box က Color Books tab ကုိ click ပါ။

 Color book guides မွ color တစ္ခုကုိ select လိုက္ပါ။ Hatch and Gradient dialog box သို႕ျပန္သြားရန္ Ok ကို click ပါ။

 Boundaries ေအာက္မွ Add: Pick points ကို click ပါ။

 Circle အတြင္းကုိ click ပါ။ Boundary သည္ highlighted ျဖစ္သြားမည္ ျဖစ္သည္။

 Preview ရန္ Right-click ႏိွပ္ပါ။

 Hatch ကုိ လက္ခံရန္ Enter ႏိွပ္ပါ။
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၅) Associative hatched object ကုိ modify လုပ္ရန္ -

 Command line ကုိ blank အေနအထားျဖင့္ hatched objects ကို select လိုက္ပါ။

 Objects မ်ား၏ shape ကို ျပဳျပင္ရန္ grips ကုိ select ပါ။

 Object ကို deselect လုပ္ရန္ Esc key ႏိွပ္ပါ။
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Shape ကုိ modify လုပ္ထားေသာ object ထဲမွ hatch and gradient fills သည္လည္း modify ျဖစ္သြားမည္။ အဘယ့္ေၾကာင့္ ဆိုေသာ္

Hatch and Gradient dialog box ထမွဲ Associative option ကုိ selected ထားေသာေၾကာင့္ ျဖစ္သည္။

Exercise: Create Hatches

Elevation drawing တြင္ Hatch command ကုိအသံုးျပဳျပီး hatch patterns မ်ားဖန္တီးျခင္းကုိ ေလ့က်င့္သြား ရမည္ျဖစ္သည္။ Create

Separate Hatch option ကုိအသုံးျပဳျပီး multiple boundary pattern မ်ားေပၚတြင္ အက်ိဳး သက္ေရာက္ပုံ ကုိပါ ေလ့လာသြားရမည္

ျဖစ္သည္။

The completed exercise

၁) M_Hatch-Objects.dwg ကိုဖြင့္ပါ။

၂) ေအာက္တြင္ ေဖာ္ျပေပးထားသည့္ အတိုင္း elevation ၏ဘယ္ဖက္ area ကို zoom ခ်ဲ႕လိုက္ပါ။
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၃) Building ေရွ႕တြင္ Hatch command ကိုအသံုးျပဳျပီး separate hatches ဖန္တီးသြားရန္ -

 Home tab, click Draw panel > Hatch.

 Hatch and Gradient dialog box တြင္ရိွေသာ Pattern list မွ AR-B816C ကို select ပါ။

 Scale field တြင္ 1 ကိုရိုက္ထည့္ပါ။

 Box အတြင္းတြင္ Create Separate Hatches option အသံုးျပဳရန္ check ေပးပါ။

 Add: Pick Points ကုိ click ပါ။

 အမွတ္ (1) နဲ႕ (2) ကုိ boundary တြင္ေအာက္ေဖာ္ျပပါ ပုံအတိုင္း click ေပးပါ။

၄) Hatch ဖန္တီးျခင္း ျပီးေျမာက္ရန္ -

 Enter ႏိွပ္ပါ။

 Hatch ကုိ အစမ္းသေဘာမ်ိဳး ၾကည့္ရန္ Hatch and Gradient dialog box မွ Preview ကို click ပါ။

 အကယ္၍ မိမိတို႕ လိုခ်င္ေသာ hatch ပုံစံကုိ ရျပီဆုိလွ်င္၊ hatch ကုိလက္ခံရန္ Enter ႏိွပ္ပါ။

၅) Elevation ၏ညာဖက္သုိ႕ Pan ျဖင့္ေရြ႕လုိက္ပါ။

၆) Elevation ၏ညာဖက္တြင္ရိွေသာ area သုံးခုတြင္ single hatch ဖန္တီးရန္ -

 Home tab, click Draw panel > Hatch.
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 Create Separate Hatches option ကို clear လုပ္လုိက္ပါ။

 Add: Pick Points ကုိ click ပါ။

 ေအာက္တြင္ ေဖာ္ျပေပးထားသည့္ အတိုင္း boundaries အမွတ္သံုးမွတ္ (1), (2) နဲ႕ (3) ကုိသတ္မွတ္ ေပးပါ။

၇) Hatch ဖန္တီးျခင္း ျပီးေျမာက္ရန္ -

 Hatch and Gradient dialog box သုိ႕ျပန္သြားရန္ Enter ႏိွပ္ပါ။

 Origin ကုိသတ္မွတ္ေပးပါ။

 Click to Set New Origin button ကုိ click ပါ။

 ေအာက္တြင္ ေဖာ္ျပထားသည့္ ပုံအတိုင္း end point ကို select ေပးပါ။

 Hatch and Gradient dialog box က Ok ကို click ပါ။

၈) Previously က created ထားေသာ hatch ကုိ select ပါ။ Boundaries အားလံုးသည္ single hatch object ပုံစံမ်ိဳး ျဖစ္သြားမည္။

၉) Drawing တစ္ခုလံုးကုိ Zoom ခ်ဲ႕လုိက္ပါ။

၁၀) View tab, click Navigate panel>Extents drop-down>Window. ေအာက္တြင္ ေဖာ္ျပထားသည့္ အတုိင္း Zoom window ျဖင့္

ျမင္ကြင္းကို ခ်ဲ႕လိုက္ပါ။ အိမ္ေခါင္မိုးကုိသာ ျမင္ကြင္းက်ယ္ျဖင့္ ျမင္ႏိုင္ေအာင္ လုပ္ပါ။
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၁၁) Command line တြင္ Regen ကုိရိုက္ထည့္လိုက္ပါ။

၁၂) Hatch dialog box ကုိ Expand လုပ္ရန္ -

 Home tab, click Draw panel > Hatch.

 Hatch and Gradient dialog box ကုိ Expand လုပ္ပါ။

၁၃) Islands ေအာက္မွ island detection type ကို သတ္မွတ္ေပးရန္ Outer ကုိ select ေပးပါ။

၁၄) Hatch pattern ကုိအိမ္ေခါင္မိုးတြင္ apply လုပ္မည္ ျဖစ္ေသာ္လည္း၊ area တစ္ခုလုံးတြင္ displayed မျဖစ္ေစရန္ -
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 Pattern list က AR-B88 ကို select လုပ္ပါ။

 Add: Pick Points ကုိ click ပါ။

 Roof ေပၚတြင္ point ကုိသတ္မွတ္ေပးပါ။

 Enter ႏိွပ္ပါ။

 Preview ကိုႏိွပ္ပါ။

 Hatch pattern ကို လက္ခံရန္ Enter ႏိွပ္ပါ။

၁၅) Drawing တစ္ခုလုံးကို Zoom ခ်ဲ႕ပါ။

၁၆) Files အားလုံးကို မ Save ပဲပိတ္လိုက္ပါ။

Exercise: Create Fills and Gradients

ဤလက္ေတြ႕ ေလ့က်င့္ခန္းတြင္ solid fills and gradients မ်ားကို ဖန္တီးသြားရမည္ ျဖစ္သည္။ Gradients and fills ကို existing

patterns ေနာက္တြင္ဖန္တီးသြားရမွာျဖစ္ျပီး၊ Inherit Properties ကိုအသံုးျပဳျပီး gradient and fill patterns ကုိ Copy လုပ္သြားရမည္

ျဖစ္သည္။
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The completed exercise

၁) M_Create-Fills-Gradients.dwg ကိုဖြင့္ပါ။

၂) Elevation roof တြင္ gradient ကုိ apply လုပ္ရန္ -

 Home tab, click Draw panel > Gradient.

 Inherit Properties ကုိ click ပါ။

 ထိပ္ဆံုး တြင္ရိွေသာ block ၏ gradient pattern ကို Select ပါ။

၃) Roof ေပၚတြင္ ရိွေသာ point ကုိ ေအာက္တြင္ ေဖာ္ျပထားသည့္ အတုိင္း select ပါ။
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၄) Drawing အတြင္းမွ တစ္ေနရာရာတြင္ Right – click ႏိွပ္ပါ။ Preview ကုိ click လုိက္ပါ။ Gradient pattern သည္ roof ရ႕ဲ hatch

pattern ေနာက္တြင္ hide ေနသည္ကုိ သတိထား ၾကည့္ၾကည့္ပါ။

၅) Gradient pattern ကုိ roof ရ႕ဲ hatch pattern ေနာက္သို႕ move ရန္ -

 Hatch and Gradient dialog box သုိ႕ျပန္သြားရန္ Esc ကိုႏိွပ္ပါ။

 Option ေအာက္တြင္ရိွေသာ Draw Order list ထမွဲ Send to Back ကုိ select ပါ။

 Islands ေအာက္က Outer ကို select လုပ္လုိက္ပါ။

 Option ေအာက္တြင္ရိွေသာ Draw Order list ထမွဲ Send to Back ကုိ select ပါ။

 Preview ကုိ click လိုက္ပါ။ Gradient pattern သည္ roof ရဲ႕ hatch pattern ေနာက္သို႕ ေရာက္ရွိသြားသည္ကုိ ေတြ႕ရမည္

ျဖစ္သည္။

 Gradient fill ကို လက္ခံရန္ drawing ၏တစ္ေနရာရာကုိ Right – click ႏိွပ္ပါ။

၆) Elevation ရ႕ဲ fascia and columns area တြင္ gradient fill ကုိ add ရန္ -
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 Home tab, click Draw panel > Gradient.

 Inherit Properties ကုိ click ပါ။ ဒုတိယ ေနရာမွ swatch ကုိ select ပါ။

၇) Hatch and Gradient dialog box သုိ႕ျပန္သြားရန္ ESC ကုိႏိွပ္ပါ။

 Fill တြင္ solid color က႕ဲသို႕ detected ျဖစ္သြားမည္ ျဖစ္ျပီး၊ dialog box ၏ Hatch tab သို႕ျပန္ေရာက္သြားမည္ ျဖစ္သည္။

၈) Option ေအာက္တြင္ရိွေသာ Draw Order list မွ Send to Back ကို select ရန္ -

 Add: Pick Points ကုိ select ပါ။

 Fascia area ,columns အတြင္းပိုင္း ရိွ points မ်ားနွင့္ windows ၏ အထက္ floor အျပင္ဖက္ အျခမ္းရိွ area တို႕မွ points

မ်ားကို select ပါ။

 ENTER ကုိႏိွပ္ပါ။

 Preview ကို click ပါ။
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၉) Fills သည္ လိုခ်င္ေသာ ပုံစံျဖစ္ျပီဆိုလွ်င္ လက္ခံရန္ drawing အတြင္းတစ္ေနရာရာကုိ Right – click ႏိွပ္ပါ။

၁၀) Gradient command ကုိ repeat လုပ္ပါ။ ေအာက္ဆုံးက swatch တြင္ရိွေသာ gradient ျဖင့္ elevation အေရွ႕ဖက္ျခမ္းက bricks

မ်ားသို႕ Inherit Properties option အသုံးျပဳျပီး assign လုပ္ပါ။

 တစ္ၾကိမ္ applied လုပ္ျပီးသြားသည္နွင့္ elevation သည္ေအာက္ေဖာ္ျပပါ ပုံအတုိင္း ျဖစ္လာပါလိမ္႕မည္။
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၁၁) Foundation area (သုိ႕မဟုတ္) elevation သို႕ solid hatch မ်ား add ရန္ -

 Home tab, click Draw panel > Hatch.

 Pattern list မွ SOLID ကို select လုပ္ပါ။

 Swatch list မွ Select Color ကို ေရြးခ်ယ္ပါ။

 Select Color dialog box တြင္ရိွေသာ Index Color tab ကုိ ႏိွပ္ပါျပီး၊ Color ေအာက္တြင္ 254 ကုိထည့္ေပးပါ။

 Ok ကုိ click ပါ။

၁၂) Add: Pick Points ကုိ click ပါ။ Elevation ၏ foundation area ကုိ select ပါ။

 Hatch ကုိ preview လုပ္ပါ။

 Hatch ကုိလက္ခံရန္ drawing ၏အတြင္းတစ္ေနရာ၌ Right – click ႏိွပ္ပါ။

မွတ္ခ်က္။ ။ Foundation area တြင္ရိွေသာ door ႏွစ္ျခမ္းစလံုးကို select ရမည္ကုိ အထူးသတိျပဳပါ။
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၁၃) Layers panel က Hatch_Swatch layer ကုိ freeze လုပ္ပါ။

၁၄) Layers panel က Background- Frame layer ကုိ thaw လုပ္ပါ။

၁၅) Drawing တစ္ခုလုံးကို ျမင္ေတြ႕ႏိုင္ေအာင္ Zoom ခ်ဲ႕လိုက္ပါ။

၁၆) အေပၚ background တြင္ sky ကိုယ္စားျပဳေသာ gradient fill ကို add ရန္ -

 Home tab, click Draw panel > Gradient.

 Color ေအာက္က One Color ကုိ click ပါ။

 Color button ကုိ click ျပီး၊ Select Color dialog box ၏ Index Color tab ကို နိွပ္ကာ Blue ကို select ပါ။

 Ok ကုိ click ပါ။

 ေအာက္တြင္ ေဖာ္ျပေပးထားသည့္ Shade - Tint slider ကို စိတ္ၾကိဳက္ျပင္ပါ။

 ညာဖက္အလယ္တြင္ ရိွေသာ gradient swatch ကိုclick ပါ။

၁၇) Add: Pick Points ကုိ click ပါ။ Elevation ၏ အထက္ဖက္ area ကုိ select ပါ။

 Drawing area ၏ တစ္ေနရာရာတြင္ Right – click ႏိွပ္ပါ။ Preview ကို select ပါ။

 Gradient fill ကိုလက္ခံရန္ drawing အတြင္းတစ္ေနရာရာတြင္ Right – click ႏိွပ္ပါ။

၁၈) Gradient command ကုိ repeat လုပ္ပါ။ Elevation ၏ ေအာက္ဖက္ area အတြက္ green color အသံုးျပဳ ပါ။
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Tip: Select Color dialog box မွ True Color tab ကုိ အသုံးျပဳျပီး Color အတြင္ 109, 184, 71 ကုိထည့္ေပးပါ။

၁၉) Files အားလုံးကို မ Save ပဲပိတ္ပါ။

Lesson: Editing Hatch Objects

ဤသင္ခန္းစာတြင္ Hatchedit command ကိုအသံုးျပဳျပီး hatch and gradient patterns မ်ားကုိ edit လုပ္ျခင္းအပိုင္းကုိ

ေလ့လာသြားရမည္။

Projects အမ်ားစုသည္ designs မ်ားေျပာင္းလဲျခင္းကို လုပ္ေဆာင္ရေလ့ ရိွပါသည္။ ထို႕ေၾကာင့္ အေရးၾကီးေသာ အပိုင္းမ်ားကို ခ်န္ျပီး၊

existing hatch မ်ားကုိ လြယ္ကူစြာ ကၽြမ္းက်င္စြာ modify လုပ္တတ္ရန္မွာ လြန္စြာမွ အေရးပါ လွပါသည္။ ထုိသို႕ designs

မ်ားကိုေျပာင္းလရဲာတြင္ hatch object ၏ Scale မ်ား ေျပာင္းလျဲခင္း (သုိ႕မဟုတ္) ရႈပ္ေထြးလွေသာ boundary မ်ားကုိ ေျပာင္းလဲျခင္း

(သို႕မဟုတ္) islands မ်ားကို adding (သုိ႕မဟုတ္) removing လုပ္ျခင္းတုိ႕ကုိ ရိုးရွင္းလြယ္ကူစြာ ျပဳလုပ္သြားႏိုင္ပါသည္။

Objectives

ဤသင္ခန္းစာကို ေလ့လာျခင္း ျပီးစီးသြားပါက -

 Associative properties မ်ားကုိ maintain (သုိ႕မဟုတ္) destroy ျခင္းတို႕ကို နားလည္လာေစရန္။

 Hatchedit command ကုိအသုံးျပဳျပီး hatches and fills မ်ားကို edit လုပ္တတ္ေစရန္။

Maintaining Associative Properties when Editing Hatches

Hatch သည္ ၎တို႕၏ associativity ကို lose သြားေသာအခါ၊ newly edited object (သို႕မဟုတ္) area တြင္ fill

မျဖစ္ေတာ႕ေသာေၾကာင့္၊ hatched objects မ်ားကုိ edit လုပ္ေသာအခါ မည္သုိ႕ အက်ိဳးသက္ေရာက္မွဳ႕ ရိွသည္၊ အေကာင္းဆုံး

အေျခအေနကို မည္သို႕ maintain လုပ္ထားႏိုင္သည္ စသည္ကို ေလ့လာထားရမည္ ဆိုသည္ကုိ နားလည္ သေဘာေပါက္ ရမည္။
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Hatch Associativity Guidelines

Associative နဲ႕ nonassociative hatches မ်ားကုိ အသံုးျပဳေတာ့မည္ ဆုိလွ်င္ လိုက္နာရမည့္ guidelines မ်ားကုိ ေအာက္ေဖာ္ျပ

ေပးထားပါသည္။

အကယ္၍ hatch's associativity ကုိ lost သြားျပီဆိုလွ်င္၊ restored ျပန္လုပ္၍ ရမည္မဟုတ္ေတာ႕ေပ။ ထိုအေျခအေန မ်ိဳးတြင္ အဆိုပါ

hatch patterns မ်ားကို delete လုပ္ျပီး၊ ျပန္ recreate လုပ္သြားရမည္ ျဖစ္သည္။

အကယ္၍ hatch boundary မ lost ခ႕ဲဘူးဆုိလွ်င္၊ hatch properties ကို associative မွ nonassociative သုိ႕ေျပာင္းလဲ ေပးရမည္။

Gaps in Hatch Boundaries Remove Hatch Associativity

Hatch ပါေသာ object (သုိ႕မဟုတ္) area ကုိ editing လုပ္ေသာ အခါတြင္၊ မိမိတုိ႕ အေနျဖင့္ boundary အတြင္းတြင္ gap

ဖန္တီးလိုက္မည္ ဆိုပါက hatch pattern တြင္ ၎၏ associativity ကုိ loses သြားမည္ ျဖစ္သည္။ ထုိက႕ဲသုိ႕ေသာ အေျခအေနမ်ိဳးတြင္

command line ၌ hatch boundary associativity has been removed ဟူ၍ Prompted ေပးသြားမည္ ျဖစ္သလို၊ hatch pattern

သည္လည္း ေအာက္တြင္ ေဖာျ္ပ ေပးထားသည့္ ပုံအတိုင္း object (သုိ႕မဟုတ္) area ကုိ fill လုပ္ေပးသြားမည္ မဟုတ္ေပ။

Editing Hatches

Options and functionality မ်ားပါ၀င္ေသာ Hatch Edit dialog box သည္ Hatch and Gradient dialog box တြင္ ပါ၀င္ပါသည္။

Hatch pattern (သို႕မဟုတ္) fill ကုိ created ခ႕ဲေသာ options ကိုအသုံးျပဳျပီး၊ hatch pattern or fill မ်ားကုိ edit လုပ္ႏိုင္ပါသည္။
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Hatchedit command ကိုစတင္လိုက္သည္ႏွင့္ command line တြင္ hatch pattern ကုိ select ရန္ prompted ေပးပါလိမ္႕မည္။

Hatch pattern ကို selected ျပီးေသာ အခါတြင္၊ Hatch Edit dialog box က selected ထားေသာ hatch pattern or fill ၏

properties ကုိေဖာ္ျပေပးပါလိမ္႕မည္။ ထို႕ေနာက္ properties အခ်ိဳ႕ကုိ အသုံးျပဳျပီး hatch pattern မ်ားကုိ ဖန္တီးႏိုင္သလို၊

ျပဳျပင္ေျပာင္းလဲ လုိက္ေသာ properties မ်ားကုိလည္း ခ်က္ခ်င္းဆုိသလို apply လုပ္ကာ အသံုးျပဳသြား ႏိုင္ပါသည္။

Grips အသံုးျပဳျပီး nonassociative hatch ကို edit လုပ္သြားႏိုင္ပါသည္။

Command Access

Edit Hatch

Command Line: HATCHEDIT

Ribbon: Home tab > Modify panel > Edit Hatch
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မွတ္ခ်က္။ ။ Drawing အတြင္းမွ hatch patterns မ်ားကို double click ႏိွပ္၍လည္း Hatch Edit dialog box ကုိ access

လုပ္ႏိုင္ပါသည္။

Hatch Edit Dialog Box

Hatch Edit Dialog Box သည္ Hatch and Gradient dialog box တြင္တည္ရိွပါသည္။

Hatch Boundary Grips

ေအာက္တြင္ ေဖာ္ျပေပးထားေသာ grips မ်ားသည္ nonassociative hatch အတြက္ျဖစ္ပါသည္။
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Select a Vertex : Selected point ကုိ moves (သို႕မဟုတ္) removes လုပ္ရန္။

Select an Edge: Line segment အတြက္ new point add ရန္ (သို႕မဟုတ္) line segment ကေန arc သုိ႕ ေျပာင္းရန္။

Select an Edge: Arc segment အတြက္ new point add ရန္ (သို႕မဟုတ္) arc segment ကေန line သို႕ ေျပာင္းရန္

(သုိ႕မဟုတ္) arc ကို stretch လုပ္ရန္။

Location Grip: Selected ထားေသာ grip point ကုိ base point အျဖစ္သတ္မွတ္ျပီး၊ hatch object တစ္ခုလုံးကို location

အသစ္သို႕ ေရြ႕ေျပာင္းရန္။

Island Location: Island ကုိ location အသစ္သုိ႕ ေရြ႕ေျပာင္းရန္။

Island Stretch: သတ္မွတ္ထားေသာ edge stretch လုပ္ရန္။

Grip ေပၚတြင္ hover လုပ္လိုက္သည္ ေသာအခါ tooltip က grip ၏ editing options မ်ားကို ေဖာ္ျပေပး ပါလိမ္႕မည္။Grip ကို

selecting လုပ္ထားျပီးCtrl ႏိွပ္ကာ options မ်ားကုိ တစ္ခုမွ တစ္ခုသုိ႕ ကူးေျပာင္းေက်ာ္ျဖတ္ သြားႏိုင္ပါသည္။ ေအာက္တြင္

ေဖာ္ျပထားေပးေသာ grips မ်ားသည္ nonassociative hatch အတြက္ျဖစ္ပါသည္။
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Procedure: Editing Hatch Patterns and Fills

Hatch patterns and fills မ်ား Editing လုပ္ပုံကို ေအာက္တြင္အဆင့္ဆင့္ ေဖာ္ျပေပးထားပါသည္။

၁) Hatch pattern (သုိ႕မဟုတ္) gradient fillကုိ Double-click ႏိွပ္ပါ။

၂) Hatch Edit dialog box ထဲမွ pattern လိုအပ္သလုိ ျပဳျပင္ေျပာင္းလဲမွဳ႕ မ်ားျပဳလုပ္ျပီး၊ Preview ကုိ click ပါ။

၃) ျပင္ဆင္ သတ္မွတ္ထားေသာ hatch ကို လက္ခံရန္ drawing window တစ္ေနရာရာကို Right – click ႏိွပ္ပါ။ (သုိ႕မဟုတ္) Left –

click ႏိွပ္ျပီး dialog box သို႕ျပန္သြားပါ။

Exercise: Edit Hatch Patterns and Fills

ဤေလ့က်င့္ခန္းတြင္ existing hatch patterns and fills မ်ားကို edit လုပ္ေပးသြားရမည္ ျဖစ္သည္။ Geometry ကို erase လုပ္ရမည္

ျဖစ္ျပီး၊ သင့္ေတာ္္ကိုက္ညီေသာ hatch pattern and fills တုိ႕ျဖင့္ update လုပ္သြားရမည္ ျဖစ္သည္။ မလုိအပ္ေတာ႕ေသာ boundaries

မ်ားကို remove လုပ္ျပီး၊ boundaries အသစ္ကို ဖန္တီးသြား ရမည္ျဖစ္သည္။

The completed exercise

၁) M_Edit-Hatches-Fills.dwg ကိုဖြင့္ပါ။

၂) Elevation ကုိေအာက္တြင္ေဖာ္ျပ ေပးထားသည့္ ပုံအတုိင္း Zoom display လုပ္လုိက္ပါ။
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၃) Roof တြင္ရိွေသာ dormers ႏွစ္ခုကုိ erase လုပ္ရန္ -

 Erase command လုပ္ရန္။

 Window selection ဖန္တီးရန္ w ရိုက္ထည့္ျပီး Enter ႏိွပ္ပါ။

 ေအာက္ပုံတြင္ ျပထားသည့္ အတုိင္း အလယ္ရိွ window ႏွစ္ခုအနီးတြင္ window selection ကိုဖန္တီး လုိက္ပါ။

 Enter ႏိွပ္ပါ။

၄) Roof pattern and gradient မ်ားကုိ အလိုအေလ်ာက္ update ျဖစ္ရန္ အတည္ျပဳ စစ္ေဆးပါ။

၅) Hatchedit command စတင္ႏုိင္ရန္ elevation ေရွ႕က fascia သုိ႕ fill ကုိ applied ျဖစ္ရန္ Double-click ႏိွပ္ပါ။
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၆) dormers ကုိ erased လုပ္ျပီး boundaries associated ကို remove လုပ္ရန္ -

 Hatch Edit dialog box မွ Remove Boundaries ကို click ပါ။

 Boundaries မ်ားကို remove လုပ္ရန္ highlighted boundaries ကုိ select လုပ္ပါ။ Boundaries မ်ားကုိ select

လုိက္သည္ႏွင့္ ထို boundaries မ်ားသည္ ေပ်ာက္ကြယ္သြားမည္ ျဖစ္သည္။

 Boundaries အားလံုး removed ျဖစ္သြားသည္ အထိ select လုပ္သြားပါ။

၇) Hatch Edit dialog box သုိ႕ျပန္သြားရန္ ENTER ႏိွပ္ပါ။

၈) Roof hatch ၏ pattern ႏွင့္ scale ကုိေျပာင္းရန္ -

 Hatchedit ကိုစတင္ရန္ roof hatch ေပၚတြင္ double-click ႏိွပ္ပါ။

 Type and Pattern ေအာက္မွ Pattern list ကို select လုပ္ပါ။

 AR-RSHKE ကုိ select ပါ။

 Angle and Scale ေအာက္တြင္ ရိွေသာ Scale list မွ 1.5 ကိုရိုက္ထည့္ပါ။

 Ok ကုိ click ပါ။

၉) Elevation ၏ဘယ္ဖက္အျခမ္းကုိ Zoom ခ်ဲ႕ပါ။
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၁၀) Window ကုိ move ရန္ -

 Move command ကုိစတင္ပါ။

 Window selection ဖန္တီးရန္ w ရိုက္ထည့္ျပီး ENTER ႏိွပ္ပါ။

 Window selection ကုိေအာက္တြင္ေဖာ္ျပ ေပးထားသည့္ ပုံအတုိင္း အမွတ္ႏွစ္မွတ္ကုိ select လုပ္လိုက္ပါ။

 Enter ႏိွပ္ပါ။

၁၁) PolarSnap (သုိ႕မဟုတ္) ortho ကို turn on လုပ္ျပီး ေအာက္ေဖာ္ျပပါ အတိုင္း လိုက္ပါ လုပ္ေဆာင္ရန္ -

 Base point အတြက္ drawing အတြင္းက တစ္ေနရာရာကုိ click ပါ။

 Cursor ကို 180 ဒီဂရီအတုိင္း ဘယ္ဖက္သုိ႕ drag လုိက္ပါ။

 ေအာက္ေဖာ္ျပပါ ပုံအတုိင္း window ကုိဘယ္ဖက္သုိ႕ အနည္းငယ္ move လုပ္ရန္ click ပါ။
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၁၂) Move လုပ္လုိက္ေသာေၾကာင့္ Boundary အတြင္းတြင္ gap ျဖစ္သြားျပီး၊ hatch boundary associativity သည္ removed

ျဖစ္သြားမည္။ Hatch and the fill ႏွစ္ခုလံုးအတြက္ old boundary ကို remove လုပ္ျပီး၊ new boundary ကုိဖန္တီးရန္ -

 Hatchedit command ကုိစတင္ရန္ fill area တြင္ Double-click ႏိွပ္ပါ။

 Hatch Edit dialog box အတြင္းမွ Remove Boundaries ကုိ click ပါ။

 ေအာက္ပုံတြင္ ျပထားသည့္ အတုိင္း boundary ကုိ select ပါ။

၁၃) New boundary ကို add ရန္ -

 Drawing အတြင္းမွ တစ္ေနရာရာကုိ Right-click ႏိွပ္ပါ။

 Add Boundaries ကို click ပါ။

 ေအာက္တြင္ ေဖာ္ျပထားေသာ ပုံအတိုင္း point ကို select ပါ။

 Enter ႏိွပ္ပါ။



“Workgroup” AotoCAD & 3ds Max Job Training Center မွ ပညာဒါန အခမ့ဲ ျဖန္႔ေ၀သည္။

( ဤစာအုပ္ကုိ ေငြေၾကးျဖင့္ ျပန္လည္ေရာင္းခ် ခြင့္မျပဳပါ )

ေအာင္ေဇာ္လတ္ {(Master of Engineering in Science and Production Engineering) Moscow State University Of Railway Engineering}

ဘာသာျပန္ ေရးသား ျပဳစုသည္။

“Workgroup “ AutoCAD & 3ds Max Training Center, International Computer Driving Licence Approved Test Center,
Rm- 403, Excel Tower, Yangon, Myanmar.

Ph: 951 559377 Ext: 6413 or 6403, Email – infor@workgroupweb.com

245

၁၄) Hatch Edit dialog box မွ Ok ကို click ပါ။

၁၅) Hatch pattern ကုိ double-click ႏိွပ္ျပီး၊ အထက္တြင္ ျပဳလုပ္ခ႕ဲသည့္ အတုိင္း old boundary ကို remove လုပ္ကာ၊ new

boundary ကုိ add ပါ။ ထိုသုိ႕ ျပဳလုပ္ျပီးသြားပါက drawing သည္ ေအာက္တြင္ေဖာ္ျပ ေပးထားသည့္ အတုိင္း ျဖစ္လာမည္။

မွတ္ခ်က္။ ။ ယခင္ အဆင့္ျပဳလုပ္စဥ္က hatch and fill န႕ဲ geometry တို႕သည္ reassociate မျဖစ္ေပ။ Associativity ကုိ hatch

pattern မွ removed လုပ္လုိက္ျပီျဖစ္ေသာေၾကာင့္၊ associativity ျပန္ျဖစ္ရန္ hatch pattern ကုိျပန္ျပီး recreat လုပ္ရန္

လုိအပ္ေပသည္။ ဤသင္ခန္းစာသည္ hatch pattern ကို editing လုပ္ျခင္းကုိ တင္ျပသည့္ သင္ခန္းစာျဖစ္ပါသည္။ သုိ႕ေသာ္

တစ္ခ်္ိဳ႕တစ္ခ်ိဳ႕ေသာ Case မ်ားတြင္ hatch ကုိ editing လုပ္တာထက္ delete လုပ္ျပီး၊ အသစ္ျပန္ recreat လုပ္ျခင္းသည္ ပိုျပီး

ျမန္ဆန္ေသာေၾကာင့္ recreat လုပ္ၾကသည္သာမ်ားသည္။

၁၆) Drawing တစ္ခုလုံး ျမင္ႏိုင္ေအာင္ Zoom ခ်ဲ႕လုိက္ပါ။

၁၇) Files အားလုံးကို မ Save ပဲပိတ္လိုက္ပါ။

Challenge Exercise: Architectural

ဤသင္ခန္းစာတြင္ အထက္၌ ေလ့လာခ႕ဲျပီး ျဖစ္ေသာ မိမိတို႕၏ Project သုိ႕ hatching and fills မ်ား add ျခင္းကို လက္ေတြ႕

ေလ့က်င့္သြားရမည္ ျဖစ္သည္။
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The completed exercise

Metric Units

၁) M_ARCH-Challenge- CHP09.dwg ကိုဖြင့္လိုက္ပါ။

၂) Layers ေဆာက္ျပီး၊ gradient fill ကို add ပါ။

 Existing layer ျဖစ္တ႕ဲ Site – Concrete ကို thaw လုပ္ျပီး current layer အျဖစ္သတ္မွတ္ေပးပါ။

 Dimension layer ကုိ Freeze လုပ္ပါ။

 Geometry သို႕ gradient hatch ကိုေအာက္ေဖာ္ျပပါ ပုံအတုိင္း add ပါ။

၃) Hatching ကုိ မိမိတုိ႕ နွစ္သက္သလို drawing တြင္ add ပါ။ ဥပမာ အားျဖင့္ - wall lines (သုိ႕မဟုတ္) hatch different rooms

တို႕အၾကားက area ကုိ hatch လုပ္သင့္ပါသည္။
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၄) Files အားလံုးကို Save ျပီးမွ ပိတ္လိုက္ပါ။

Imperial Units

၁) I_ARCH-Challenge- CHP09.dwg ကုိဖြင့္လိုက္ပါ။

၂) Layers ေဆာက္ျပီး၊ gradient fill ကို add ပါ။

 Existing layer ျဖစ္တ႕ဲ Site – Concrete ကို thaw လုပ္ျပီး current layer အျဖစ္သတ္မွတ္ေပးပါ။

 Dimension layer ကုိ Freeze လုပ္ပါ။

 Geometry သို႕ gradient hatch ကိုေအာက္ေဖာ္ျပပါ ပုံအတုိင္း add ပါ။

၃) Hatching ကုိ မိမိတုိ႕ နွစ္သက္သလို drawing တြင္ add ပါ။ ဥပမာ အားျဖင့္ - wall lines (သုိ႕မဟုတ္) hatch different rooms

တို႕အၾကားက area ကုိ hatch လုပ္သင့္ပါသည္။

၄) Files အားလံုးကို Save ျပီးမွ ပိတ္လိုက္ပါ။

Challenge Exercise: Mechanical

ဤသင္ခန္းစာတြင္ အထက္၌ ေလ့လာခ႕ဲျပီး ျဖစ္ေသာ မိမိတို႕၏ Project သုိ႕ hatching and fills မ်ား add ျခင္းကို လက္ေတြ႕

ေလ့က်င့္သြားရမည္ ျဖစ္သည္။
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The completed exercise

၁) M_MECH-Challenge- CHP09.dwg ကုိဖြင့္ပါ။

၂) Hatch layer ကုိ current layer အျဖစ္ သတ္မွတ္ေပးလုိက္ပါ။

၃) ANSI32 hatch pattern ကုိေအာက္ေဖာ္ျပပါ ပုံအတိုင္း apply ေပးလိုက္ပါ။ scale န႕ဲ angle ကုိေအာက္ ေဖာ္ျပပါ ပုံအတုိင္း

ရရိွေအာင္ ျပင္ဆင္သတ္မွတ္ေပးပါ။

၄) Hatch pattern ကိုေအာက္ေဖာ္ျပပါ ပုံအတိုင္း ထပ္မံ၍ apply လုပ္ေပးပါ။
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၅) Gradient and solid fills ကိုေအာက္ေဖာ္ျပပါ ပုံအတိုင္း apply လုပ္ပါ။ Color ကိုေတာ႕ မိမိတုိ႕ နွစ္သက္ေသာ color ကုိ ေရြးခ်ယ္ပါ။
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၆) Files အားလံုးကို Save ျပီး ပိတ္လိုက္ပါ။

Chapter Summary

Drawing အတြင္းက objects မ်ားကုိ Hatch and Gradient commands မ်ား အသုံးျပဳျပီး construction, steelwork (သုိ႕မဟုတ္)

road design ႏွင့္အျခားေသာ designs မ်ားတြင္ hatch and fill လုပ္ျခင္းကုိ အထက္တြင္ ေလ့လာခဲ႕ျပီး ျဖစ္သည္။

ဤသင္ခန္းစာကို ေလ့လာျခင္း ျပီးစီးသြားပါက -

 Hatch and fill patterns တို႕၏ characteristics ကုိသိရိွလာမည္။

 Hatch patterns မ်ား၏ ဆက္စပ္ခ်က္မ်ားကုိ သိရိွနားလည္လာမည္။

 Hatch and fill patterns တို႕ကို ဖန္တီးတတ္လာမည္။
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CHAPTER: 10 Working with Reusable Content
Drawing files မ်ားကုိ ဖန္တီးေသာ အခ်ိန္တြင္၊ special database file ျဖင့္ graphical interface ကုိျဖတ္ျပီး၊ drawing မ်ားဖန္တီးျခင္း၊

data မ်ားရိုက္ထည့္ျခင္းတို႕ကုိ ျပဳလုပ္ရပါသည္။ တစ္ခ်ိဳ႕ေသာ case မ်ားတြင္ single objects မ်ားကုိ အသုံးျပဳရ လြယ္ကူေစရန္ objects

တစ္ခုခ်င္းစီတြင္ အမွတ္စဥ္မ်ား သတ္မွတ္ေပးရန္ လိုအပ္ေပသည္။ Single object ကုိ block အသြင္ျပဳလုပ္ရမည္။

ထုိသို႕ အၾကိမ္ၾကိမ္ အသံုးျပဳသြားမည့္ single objects မ်ားကို block ျပဳလုပ္ထားျခင္း အားျဖင့္၊ မည္သို႕ေသာ locations မ်ားတြင္မဆုိ၊

မည္သုိ႕ေသာ drawings မ်ားတြင္ မဆုိ အၾကိမ္ေပါင္း အကန္႕အသတ္ မရိွအသုံးျပဳ သြားႏိုင္ပါသည္။ မိမိတို႕ အသံုးျပဳလိုေသာ object

ပံုစံကုိ objects အေျမာက္အျမားျဖင့္ grouped ဖြဲ႕ျပီး၊ design ဖန္တီးကာ block ျပဳလုပ္ ႏိုင္ပါသည္။

နဂိုပါရိွျပီး design မ်ားကို DesignCenter အသံုးျပဳျပီး drag လုပ္သတ္မွတ္ျခင္း၊ file တစ္ခုမွ တစ္ခုသို႕ drawing မ်ားကုိ ကူးေျပာင္းျခင္း

စသည္တုိ႕ကို ျပဳလုပ္ႏိုင္ပါသည္။ ထုိ႕အျပင္ tool palettes ကုိအသုံးျပဳျပီး organize ျပဳလုပ္ျခင္း၊ blocks, hatches က႕ဲသုိ႕ေသာ data

မ်ားကို share လုပ္ျခင္း စသည္တုိ႕ကုိ ပါျပဳလုပ္ ႏိုင္ပါသည္။

ဤသင္ခန္းစာတြင္ existing drawing information မ်ားကုိ leveraging လုပ္သည့္ နည္းလမ္းမ်ားျဖင့္ မိတ္ဆက္ ေပးသြားမည္

ျဖစ္သည္။

Objectives

ဤသင္ခန္းစာကို ေလ့လာျခင္း ျပီးဆံုးသြားပါက -

 Block မ်ားဖန္တီးကာ drawings မ်ားတြင္ ဖန္တီးထားေသာ block မ်ားကုိ Insert လုပ္တတ္ လာေစရန္။

 Drawing တြင္ DesignCenter ျဖင့္ data မ်ားကုိ ထပ္ကာထပ္ကာ အသံုးျပဳတတ္လာေစရန္။

 Tool palettes တြင္ရိွေသာ tools မ်ားကုိ အသံုးျပဳတတ္ လာေစရန္။

Lesson: Using Blocks

ဤသင္ခန္းစာတြင္ blocks မ်ားဖန္တီးကာ drawing တြင္ blocks မ်ား Insert လုပ္ျခင္းကုိ တင္ျပသြားမည္ ျဖစ္သည္။ ဥပမာ အားျဖင့္

ေအာက္တြင္ေဖာ္ျပ ေပးထားေသာ ပုံႏွစ္ပုံမွ ဘယ္ဖက္ single block object ကုိ ညာဖက္က geometry မ်ားျဖင့္ စုစည္း ဖန္တီးထားျခင္း
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ျဖစ္ပါသည္။ Block ဆုိသည္မွာ အမ်ိဳးမ်ိဳးေသာ objects မ်ားျဖင့္ မိမိတုိ႕ လိုခ်င္ေသာ design ရေအာင္ျပဳလုပ္ျပီး object တစ္ခုတည္း

ျဖစ္လာေအာင္ ဖန္တီးျခင္း ျဖစ္ပါသည္။ Lines, arcs နဲ႕ polylines စသည့္ object အသီးသီးျဖင့္ ျပဳလုပ္ထားေသာ block ကို drawing

တြင္ single block object အျဖစ္ထည့္သြင္း အသုံးျပဳသြား ႏိုင္ပါသည္။ ထုိသို႕ block အျဖစ္ ဖန္တီးထားေသာ single block object ကုိ

delete မလုပ္မခ်င္း drawing တိုင္းတြင္ လိုအပ္သလုိ အသံုးျပဳ သြားႏိုင္ပါသည္။

Objectives

ဤသင္ခန္းစာကို ေလ့လာျခင္း ျပီးစီးသြားပါက -

 Group objects မ်ားကုိ ပူးတြဲ အသုံးျပဳပုံနွင့္ block မ်ားအေၾကာင္းကုိ သိရိွလာေစရန္။

 Block command ကိုအသံုးျပဳျပီး block မ်ားဖန္တီး တတ္လာေစရန္။

 Insert command ကုိအသံုးျပဳျပီး၊ ဖန္တီးထားေသာ block ကို drawing အတြင္းတြင္ Insert လုပ္တတ္ လာေစရန္။

About Blocks

မတူညီေသာ objects မ်ားကို အတူတကြ ေပါင္းစည္ေပးျပီး၊ single block object ဖန္တီးကာ drawing ႏွင့္ project တြင္

ထပ္ကာထပ္ကာ အသံုးျပဳႏိုင္ပါသည္။ Block မ်ားကုိ ကိုယ္တုိင္ဖန္တီး၍ လည္းေကာင္း (သို႕မဟုတ္) ေထာင္ေပါင္း မ်ားစြာေသာ blocks

မ်ားကို အင္တာနက္မွ ရွာေဖြယူႏိုင္ပါသည္။

Office (သို႕မဟုတ္) home layout drawing ဖန္တီးရန္ ေအာက္ေဖာ္ျပပါ typical blocks မ်ားကုိ အသုံးျပဳ သြားရမည္ ျဖစ္သည္။
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Architectural symbols

Mechanical (သို႕မဟုတ္) electrical drawing ဖန္တီးရန္ ေအာက္ေဖာ္ျပပါ typical blocks မ်ားကို အသံုးျပဳ သြားရမည္ ျဖစ္သည္။

Mechanical symbols

Blocks Defined

Blocks မ်ားကုိ symbols မ်ားအျဖစ္ မၾကာခဏ ရည္ညႊန္းအသုံးျပဳၾက ပါသည္။ ထုိ symbols မ်ားကုိ objects မ်ားစုစည္းျပီး block

အျဖစ္သို႕ ဖန္တီးျပဳလုပ္ထားျခင္း ျဖစ္ပါသည္။ Block ကုိ drawing အတြင္းမွ single objects မ်ားျဖင့္ (သုိ႕မဟုတ္) multiple objects

မ်ားျဖင့္ ျပဳလုပ္ႏိုင္ပါသည္။

Drawing တြင္အမ်ားဆုံး အသုံးျပဳသည့္ symbol ျဖစ္သည့္ title block and border.
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"D" sized title block and border

Tracing Analogy

Manual drafting လုပ္ခ်ိန္တြင္ draftsmans မ်ားသည္ ၎တုိ႕ drawing အတြင္းမွ items မ်ားကို trace လုပ္ရန္ cardboard

(သုိ႕မဟုတ္) plastic templates ကုိအသုံးျပဳၾကပါသည္။ Draftsmans မ်ားအတြက္ အရိုးရွင္းဆုံး တစ္ခ်ိဳ႕ေသာ template မွာ circles

and ellipse templates ျဖစ္သည္။ သို႕ေသာ္ mechanical engineers arrowheads,bolts န႕ဲ hydraulic cylinders မ်ားအတြက္

template ကုိအသံုးျပဳၾကပါသည္။ Architects traced အတြက္ fixtures မ်ားမွာ sinks, bath tubs (သို႕မဟုတ္) lavatories တို႕

ျဖစ္ၾကပါသည္။

Example: Blocks used for Architectural Drafting

Architectural drafting တြင္ doors, windows, case goods, plumbing fixtures နဲ႕ furniture စသည့္ objects မ်ားအတြက္ blocks

ကို အမ်ားဆံုး အသုံးျပဳ ၾကပါသည္။ ေအာက္တြင္ ေဖာ္ျပေပးထားေသာ ပုံသည္ blocks အေျမာက္အျမားျဖင့္ ဖန္တီးထားေသာ simple

floor plan ျဖစ္ပါသည္။
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How Blocks Behave

Blocks မ်ားဖန္တီးရာတြင္ အဆင္ေျပေခ်ာေမြ႕ေသာ block မ်ားရရိွလာေအာင္ ေအာက္ေဖာ္ျပပါ rules မ်ားကုိ လုိက္နာက်င့္သုံး

သြားရမည္ ျဖစ္ပါသည္။ Blocks မ်ားကုိ drawing သုိ႕ insert လုပ္ေသာ အခ်ိန္တြင္၊ drawing ၏ current settings သည္ block

တြင္ပါ၀င္ေသာ objects မ်ား၏ color, linetype န႕ဲ lineweight တုိ႕၏ နဂိုမူရင္း setting အတုိင္း ျဖစ္ေနရမည္။ သို႕ေသာ္လည္း current

color, linetype န႕ဲ lineweight settings ျဖစ္သည့္ objects မ်ားျဖင့္ blocks မ်ားဖန္တီးႏုိင္ပါသည္။

ေအာက္တြင္ ေဖာ္ျပေပးထားေသာ ပုံမွ blocks နွစ္ခုလံုးကုိ Visual layer current တြင္ Inserted လုပ္ထား ျခင္းျဖစ္ပါသည္။ အဆိုပါ

ပုံနွစ္ပုံသည္ မတူညီေသာ properties ၊ မတူညီေသာ Layer မ်ားျဖင့္ ဖန္တီးထား ျခင္းျဖစ္ ပါသည္။ ဘယ္ဖက္ပုံမွ original block ၏

geometry ကို layer 0 တြင္ဖန္တီးထားျခင္း ျဖစ္ပါသည္။ ညာဖက္ပုံမွ original block ၏ geometry ကုိ layer 0 ျဖင့္ ဖန္တီးထားျခင္း

မဟုတ္သလို၊ အသံုးျပဳထားသည့္ linetype န႕ဲ color properties မ်ားလည္း ကြဲျပား ၾကပါသည္။
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Definition of Block Behavior

Blocks မ်ားကုိ drawing အတြင္းသို႕ inserted လုပ္ျပီးေသာ အခ်ိန္တြင္၊ properties (Color, Layer, Linetype, and Lineweight)

မ်ားထိန္းသိမ္းကာ blocks မ်ား ေခ်ာေမြ႕ေစေသာ နည္လမ္း သံုးမ်ိဳးရိွပါသည္။ ၎တို႕မွာ - (၁) မူရင္း properties မ်ားကို ထိန္းသိမ္းျခင္း။

(၂) Inserted ထားေသာ block ရ႕ဲ current layer မွ ၎၏ properties မ်ားကို inherit လုပ္ျခင္း။ (၃) Current property settings မွ

၎၏ properties ကုိ inherit လုပ္ျခင္း။

Retain Original Properties (1): Block ထမွဲ object ၏ color, linetype န႕ဲ lineweight properties ကုိ inherit မလုပ္ႏိုင္ေပ။ Block

ထဲမွ object ၏ properties မ်ားသည္ current settings အတိုင္းလိုက္ ေျပာင္းသြားမည္ မဟုတ္ေပ။ ဤနည္းလမ္းကုိ ေရြးခ်ယ္သြားမည္

ဆိုလွ်င္ block မဖန္တီးမီ၊ ဖန္တီးမည့္ block တြင္ အသုံးျပဳမည့္ objects မ်ား၏ color, linetype န႕ဲ lineweight properties မ်ားကို

အရင္ဆံုး သတ္မွတ္ေပးရမည္ ျဖစ္သည္။ ထုိ objects မ်ား၏ properties အတြက္ BYBLOCK (သို႕မဟုတ္) BYLAYER ကိုအသုံးမျပဳ

ပါနွင့္။

Inherit Properties from current Layer (2): Block ထမွဲ object ၏ color, linetype နဲ႕ lineweight properties ကို color, linetype

န႕ဲ lineweight properties မ်ား assigned လုပ္ထားေသာ current layer မွ inherit လုပ္ျခင္းျဖစ္သည္။ ဤနည္းလမ္းကို

ေရြးခ်ယ္သြားမည္ ဆိုလွ်င္ block ထတဲြင္ ပါ၀င္သြားမည့္ objects မ်ားမဖန္တီးမီ current layer ကို 0 သုိ႕ေျပာင္းရမည္။ ထို႕ေနာက္

block အတြက္ geomentry မ်ားဖန္တီးေသာ အခ်ိန္တြင္ current color, linetype န႕ဲ lineweight ကို BYLAYER သုိ႕ေျပာင္းေပးရမည္။
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Inherit Properties from current Property Settings (3): Block ထမွဲ object ၏ color, linetype နဲ႕ lineweight properties ကို

current color, linetype န႕ဲ lineweight မွ inherit လုပ္ျခင္းျဖစ္သည္။ ဤနည္းလမ္းကို ေရြးခ်ယ္သြားမည္ ဆိုလွ်င္ block အတြက္

geomentry မ်ားဖန္တီးေသာ အခ်ိန္တြင္ current color, linetype န႕ဲ lineweight ကို BYBLOCK သုိ႕ေျပာင္းေပးရမည္။

Creating Blocks

Block command သည္ single objects မ်ား၊ multiple objects မ်ားကုိ ေခ်ာေမြ႕ေျပျပစ္ေသာ geometry အစိတ္ အပိုင္းတစ္ခုတည္း

ျဖစ္ေအာင္ ဖန္တီးျခင္း ျဖစ္သည္။ Block Definition dialog box မွ options မ်ားျဖင့္ block ကို သတ္မွတ္ေပးသြား ႏိုင္ပါသည္။ Block

ဖန္တီးမည့္ items အတြက္ block ၏ name ၊ မည္သို႕ေသာ objects မ်ားက block တြင္ပါ၀င္သြားမည္၊ block ၏ base point ၊

geometry ကိုမည္သည့္ Unit ျဖင့္ေရးဆြဲမည္၊ block uniformly ကုိ scale လုပ္ျခင္းႏွင့္ မိမိတို႕၏ လုိအပ္ခ်က္ အရ explode လုပ္ျခင္းကုိ

allow ရန္ allow exploded ေပးျခင္း၊ general description စသည္တုိ႕ကုိ သတ္မွတ္ ေပးသြားရမည္။ Drawing တြင္ block ကို

inserting လုပ္ရန္ အတြက္၊ block ထားမည့္ေနရာ base point ကုိသတ္မွတ္ေပးရမည္။ ထုိအမွတ္သည္ block အတြက္ grip point

ျဖစ္လာမည္။ Block အတြက္ base point သတ္မွတ္ျခင္းသည္ အေရးပါေၾကာင္းကုိ ေအာက္ေဖာ္ျပပါ ပုံတြင္ ထင္ထင္ရွားရွား

ျပသေပးထားပါသည္။ Bi-fold door block ကိုဖန္တီးေသာ အခ်ိန္ႏွင့္ base point သတ္မွတ္ခ်ိန္တြင္ object endpoint (1) ကို snap

သင့္ျပီး၊ ထုိသုိ႕ သတ္မွတ္လိုက္ေသာ end point ျဖင့္ drawing တြင္ Bi-fold door block ကို wall ႏွင့္အနီးစပ္ဆံုး(2) ၌ တိတိက်က်

ထားႏိုင္မည္ ျဖစ္သည္။

Command Access

Block

Command Line: BLOCK, B

Ribbon: Insert tab > Block panel > Create
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Block Definition Dialog Box

မိမိတုိ႕ ဖန္တီးလုိက္ေသာ block တိုင္းအတြက္ name သတ္မွတ္ ေပးရမည္ ျဖစ္သလုိ၊ base point အတြက္လည္း inserting

လုပ္ေပးရမည္။ Block ထတဲြင္ ပါ၀င္သြားမည္ objects မ်ားကုိ select လုပ္သြားရမည္။ အျခားေသာ settings မ်ားကုိလည္း လိုအပ္သလို

ထည့္သြင္းသြား ႏိုင္ပါသည္။

Block ၏ name ကိုသတ္မွတ္ေပးသြား ရမည္။

Base point သတ္မွတ္ေပးရမည္။ Object ေပၚမွာ တစ္ေနရာရာကုိ snap ရန္ Pick Point ကုိ click ျပီးလွ်င္၊ X, Y န႕ဲ Z

တန္ဖိုးမ်ားဆီသုိ႕ ျပန္လာမည္ ျဖစ္ျပီး (သို႕မဟုတ္) X, Y န႕ဲ Z တန္ဖိုးမ်ားကို တိတိက်က် ရိုက္ထည့္ ေပးႏိုင္ပါသည္။

Block အတြင္းတြင္ ပါ၀င္သြားမည့္ geomentry မ်ားကို select ရန္ Select Objects ကုိ click ပါ။ Block ဖန္တီးရန္ Ok ကုိ

click ျပီးပါက selected ထားေသာ geomentry ကို မည္က႕ဲသုိ႕ ျဖစ္သြားေစမည္ စသည္တုိ႕ကို ေရြးခ်ယ္ေပးရန္Objects ေအာက္မွ

Options မ်ားကုိ ေရြးခ်ယ္ေပးႏိုင္ပါသည္။
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Annotative behavior ကို select ျပီး၊ block uniformly ကုိ scale ျပဳလုပ္ရန္ scale uniformly ကုိ select လုပ္ျခင္းႏွင့္ မိမိတို႕၏

လိုအပ္ခ်က္ အရ explode လုပ္ျခင္းကုိ allow ရန္ allow exploded ကုိ select ေပးႏိုင္ပါသည္။

Geomentry ေရးဆြဲမည့္ Unit ကို select လုပ္ႏိုင္ပါသည္။

Block အတြက္ description ကုိ ရိုက္ထည့္ေပးပါ။

Ok ကို click ျပီးပါက block editor ကိုေပၚလာေစလုိလွ်င္ ထုိ box ကုိ check ေပးပါ။

Procedure: Creating a Block

Block command ျဖင့္ block မ်ား ဖန္တီးသြားရန္ ေအာက္တြင္ အဆင့္ဆင့္ ေဖာ္ျပေပး ထားပါသည္။

၁) Ribbon, click Insert tab > Block panel > Create (1).

၂) Block Definition dialog box တြင္ block အတြက္ name (2) ကုိရုိက္ထည့္ေပးျပီး၊ Pick Point (3) ကို click ပါ။

၃) Pick point အတြက္ object ေပၚတြင္ object snap အသံုးျပဳျပီး location သတ္မွတ္ေပးပါ။
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၄) Objects ေအာက္မွ Select Objects (4) ကုိ click ပါ။.

၅) Block အတြင္းတြင္ ပါ၀င္သြားမည့္ geomentry ကို select ပါ။

၆) Geometry ကို selected (5) ျပီးပါက မည္သုိ႕ ျဖစ္ေစလိုသည္ကို Objects ေအာက္က option မ်ားမွ select ပါ။
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Practice Exercise: Create Blocks

ဤလက္ေတြ႕ ေလ့က်င့္ခန္းတြင္ simple object ကိုေရြးဆြဲျပီး block name ေပးကာ block တစ္ခုဖန္တီးျခင္းကို ေလ့လာသြားရမည္

ျဖစ္သည္။

၁) အထက္တြင္ေဖာ္ျပ ထားသည့္အတိုင္း simple object ကိုေရးဆြဲလုိက္ပါ။

၂) Block ဖန္တီးရန္ -

 Insert tab, click Block panel > Create.

 Block Definition dialog box တြင္ block name အတြက္ widget (1)ကို ရိုက္ထည့္ ေပးပါ။

 Block base point အတြက္ Pick Point (2) ကုိ click ပါ။

 Object snap ကုိအသုံးျပဳျပီး object (3) ေပၚမွ point ကုိ select ပါ။

 Select Objects (4) ကို click ျပီး၊ created ထားေသာ geometry ကုိ select ပါ။ Dialog box သို႕ျပန္သြားရန္ Enter ႏိွပ္ပါ။

 Convert to Block option (5) ကို click ပါ။

 Dialog box ကို exit ရန္ Ok ကို ႏိွပ္ပါ။
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၃) Geometry မွ block သို႕ converted ထားသည္ကို check ရန္ -

 Command line ကုိ blank အေနအထားျဖင့္ object ကုိ select ပါ။

 Block အတြက္ selected ထားေသာ base point တြင္ grip point ကုိေတြ႕ျမင္ရမည္ ျဖစ္ျပီး၊ က်န္အပိုင္း မ်ားသည္

အေရာင္မိွန္သြားမည္ ျဖစ္သည္။

၄) Insert command ကုိေနာက္သင္ခန္းစာတြင္ ေလ့က်င့္သြားရမည္ ျဖစ္ေသာေၾကာင့္ drawing ကုိ save ျပီး close လိုက္ပါ။

Inserting Blocks

Insert command ကိုအသုံးျပဳျပီး block ကို select ကာ drawing သို႕ inserting လုပ္ႏိုင္ပါသည္။ Block ကို selecting

လုပ္ျပီးသြားပါက၊ Insert dialog box (သို႕မဟုတ္) drawing window တြင္ insertion point , scale factor, rotation angle တုိ႕ကို

သတ္မွတ္ေပးရပါမည္။ Insert ကိုအသံုးျပဳျပီး select file လုပ္လိုက္သည္နွင့္ block ကို drawing database သို႕ added

ျပီးျဖစ္သြားပါလိမ္႕မည္။

Command Access

Insert
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Command Line: INSERT, I

Ribbon: Insert tab > Block panel > Insert

Insert Dialog Box

Drawing အတြင္းသုိ႕ block ထည့္ရာတြင္၊ blockတုိင္းအတြက္ name, insertion point, scale န႕ဲ rotation တို႕ကို သတ္မွတ္ေပးသြား

ရပါမည္။

Insert လုပ္မည့္ block အတြက္ name သတ္မွတ္ေပးရမည္။

Current drawing သို႕ block အေနျဖင့္ insert လုပ္ေပးမည့္ drawing file ကုိ select ရန္ select file dialog box ကို Open ရမည္။

Selected ထားေသာ block ရ႕ဲ image ကုိ Preview ကုိလုပ္သည္။
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Drawing အတြင္းသို႕ Insert လုပ္မည့္ block အတြက္ insertion point ကုိသတ္မွတ္ေပးရမည္။ ထုိ insertion point အတြက္

dialog box (သုိ႕မဟုတ္) drawing area screen တြင္ သတ္မွတ္ေပးႏိုင္ပါသည္။ အကယ္၍ drawing area screen တြင္သတ္မွတ္

ေပးသြားမည္ ဆုိလွ်င္ Specify On-Screen option ကုိ select ရပါမည္။ အကယ္၍ screen တြင္သတ္မွတ္ေပးသြားမည္ မဟုတ္လွ်င္၊ ထုိ

option ကုိ clear လုပ္ျပီး၊ X, Y နဲ႕ Z အတြက္ တန္ဖိုးကုိ ရိုက္ထည့္ေပးပါ။

Block အတြက္ scale factor ကုိသတ္မွတ္ေပးပါ။ ထို scale factor အတြက္ dialog box (သုိ႕မဟုတ္) drawing area screen တြင္

သတ္မွတ္ေပးႏိုင္ပါသည္။ အကယ္၍ drawing area screen တြင္သတ္မွတ္ ေပးသြားမည္ ဆုိလွ်င္ Specify On-Screen option ကို

select ရပါမည္။ အကယ္၍ screen တြင္သတ္မွတ္ေပးသြားမည္ မဟုတ္လွ်င္၊ ထို option ကို clear လုပ္ျပီး၊ X, Y န႕ဲ Z အတြက္ scaling

factors မ်ားကုိ ရိုက္ထည့္ေပးပါ။

Block အတြက္ rotation angle ကိုသတ္မွတ္ေပးပါ။ ထို rotation angle အတြက္ dialog box (သုိ႕မဟုတ္) drawing area

screen တြင္ သတ္မွတ္ေပးႏိုင္ပါသည္။ အကယ္၍ drawing area screen တြင္သတ္မွတ္ ေပးသြားမည္ ဆုိလွ်င္ Specify On-Screen

option ကုိ select ရပါမည္။ အကယ္၍ screen တြင္သတ္မွတ္ေပးသြားမည္ မဟုတ္လွ်င္၊ ထုိ option ကုိ clear လုပ္ျပီး၊ rotation angle

ကို ရိုက္ထည့္ေပးပါ။

Procedure: Inserting a Block

Drawing အတြင္းသုိ႕ inserting block လုပ္ပုံကို ေအာက္တြင္ အဆင့္ဆင့္ ေဖာ္ျပေပးထားပါသည္။

၁) Ribbon, click Insert tab > Block panel > Insert.

၂) Insert dialog box တြင္ရိွေသာ block list မွ block name ကို select ပါ (သုိ႕မဟုတ္) Browse ကုိ click ျပီး files ကို select ပါ။

၃) Specify On-Screen option (1) ကုိ select ျပီး၊ scale factor (2), rotation angle (3) တုိ႕ကုိ သတ္မွတ္ေပးပါ။ Default rotation

direction သည္ CWW ျဖစ္ပါသည္။
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၄) Ok ကို click ပါ။

 Block ကိုမိမိတို႕ ႏွစ္သက္ေသာ location သုိ႕ drag လုပ္ျပီး၊ လုိခ်င္ေသာ location ေရာက္လွ်င္ ေနရာ သတ္မွတ္ေပးရန္ click

လုိက္ပါ။

၅)
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 Drawing အတြင္းတြင္ Block သည္ မိမိတို႕ သတ္မွတ္ေပးထားေသာ parameters အတုိင္း တည္ရိွေနမည္။

Practice Exercise: Inserting Blocks

ဤလက္ေတြ႕ ေလ့က်င့္ခန္းတြင္ block ဖန္တီးျပီး၊ ဖန္တီးျပီးေသာ block ကုိ drawing သို႕ insert လုပ္ျခင္းကုိ ေလ့က်င့္သြားရမည္

ျဖစ္သည္။ Block ဖန္တီးရန္ အတြက္ widget ဟုေခၚေသာ simple object ကိုဖန္တီးေပး သြားရမည္ ျဖစ္ျပီး၊ ထို widget ကို drawing

သို႕ insert လုပ္သြားရမည္ ျဖစ္သည္။

၁) အထက္တြင္ ေဖာ္ျပေပးထားေသာ ပုံအတုိင္း Simple object ကုိစတင္ဖန္တီး လိုက္ပါ။

၂) Block ဖန္တီးရန္ -

 Insert tab, click Block panel > Create.

 Block Definition dialog box တြင္ block Name အတြက္widget (1) ကုိရိုက္ထည့္ေပးပါ။

 Block base point အတြက္ Pick Point(2) ကုိ click ပါ။
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 Object snap ကုိအသုံးျပဳျပီး object (3) ေပၚမွ အမွတ္တစ္မွတ္ကုိ select ပါ။

 Select Objects (4) ကို click ျပီး၊ created ထားေသာ geomentry ကို select ပါ။ Dialog box သို႕ျပန္သြားရန္ Enter ႏိွပ္ပါ။

 Convert to Block option (5) ကို click ပါ။

 Dialog box ကို exit ေပးရန္ Ok ကုိ select ပါ။

၃) Geomentry သည္ block သုိ႕ converted ျဖစ္မျဖစ္ check ရန္ -

 Command line blank အေနထားျဖင့္ object ကို select ပါ။

 ထို object တြင္ base point အျဖစ္သတ္မွတ္ ေပးထားေသာ point တစ္ခုသာ grip ျဖစ္ျပီး၊ object တစ္ခုလံုးလည္း

အေရာင္မိွန္သြား ရမည္ျဖစ္သည္။

၄) Block ကုိ drawing အတြင္းသို႕ insert လုပ္ရန္ -

 Insert tab, click Block panel > Insert.

 List (1) မွ block name ကုိ select ပါ။

 Insertion point အတြက္ Specify On-screen option (2) ရ႕ဲ box ကုိ check mark လုပ္ေပးပါ။

 Scale (3) ကုိ clear လုပ္ပါ။ X, Y န႕ဲ Z သည္ 1.000 ျဖစ္ရပါမည္။

 Rotation (4) ကုိ clear လုပ္ပါ။ Rotation angle သည္ 0 ျဖစ္ရပါမည္။
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 Ok ကုိ click ပါ။

၅) Insertion point အတြက္ screen တြင္သတ္မွတ္ေပးလိုက္ပါ။

၆) Insert tab, click Block panel > Insert. Block ကို insert ထပ္မံျပဳလုပ္ျပီး scale န႕ဲ rotate angle ကိုေျပာင္းေပး လိုက္ပါ။
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Exercise: Create and Insert Blocks

ဤလက္ေတြ႕ ေလ့က်င့္ခန္းတြင္ ဖုန္းအျဖစ္ ေရးဆြဲထားေသာ Individual lines မ်ားမွ block ဖန္တီးသြားရမည္။ Drawing အတြင္းတြင္

ဖုန္း၏ အျခားေသာ instance ကုိ insert လုပ္သြားရမည္။ ထုိ႕ေနာက္ drawing file ကုိ save ျပီး၊ ၎ကို new drawing သုိ႕ insert

လုပ္ပါ။

The completed exercise

၁) C_Workstation.dwg ကုိ ဖြင့္ပါ။

၂) Object ၏ informations မ်ားကုိ View ရန္ -

 Command line တြင္ List command ကုိစတင္ရန္ List ဟုရိုက္ထည့္လိုက္ပါ။

 Phone ရ႕ဲ ေအာက္ေျခေရျပင္ညီမ်ဥ္းကုိ select ပါ။

 Enter ႏိွပ္ပါ။

 ထြက္လာမည့္ object list သည္ line object ၏ list ျဖစ္ေနသည္ကို သတိထား ၾကည့္ၾကည့္ပါ။
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 AutoCAD® text window ကို ပိတ္ရန္ F2 ႏိွပ္ပါ။

၃) Insert tab, click Block panel > Create.

၄) Block Definition dialog box ကုိအသုံးျပဳျပီး block သတ္မွတ္ေပးရန္ -

 Name အတြက္ Phone (1) ဟုရိုက္ထည့္ေပးပါ။

 Base point အတြက္ Pick Point (2) ကုိ click ပါ။

 Phone ၏ညာဖက္ေအာက္ေထာင့္ (3) ကုိ snap ပါ။

 Objects ေအာက္မွ Select Objects (4) ကုိ click ပါ။

 Window selection ျဖင့္ Phone geometry ကုိ select ပါ။

 Dialog box သို႕ျပန္သြားရန္ Enter ႏိွပ္ပါ။

 Objects ေအာက္မွ Convert to Block (5) ကုိ click ပါ။

 Block Definition dialog box မွ setting ကိုစစ္ေဆးပါ။ ျပီးလွ်င္ OK ကုိ Click ပါ။
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၅) Object ၏ informations မ်ားကုိ View ရန္ -

 Command line တြင္ List command ကုိစတင္ရန္ List ဟုရိုက္ထည့္လိုက္ပါ။

 Previously က selected ခ႕ဲေသာ Phone ရ႕ဲ ေအာက္ေျခေရျပင္ညီမ်ဥ္းကုိ select ပါ။

 Enter ႏိွပ္ပါ။

 ထြက္လာမည့္ object list သည္ Phone ဟုအမည္ရေသာ block ၏ list ျဖစ္ေနမည္ကို သတိထား ၾကည့္ၾကည့္ပါ။

 AutoCAD® text window ကို ပိတ္ရန္ F2 ႏိွပ္ပါ။

၆) Drawing အတြင္းသို႕ block ကုိ insert လုပ္ရန္ -

 Insert tab, click Block panel > Insert.

 Insert dialog box က list တြင္ phone block (1) ကုိ select ပါ။

 Insertion point ကို screen (2) တြင္သတ္မွတ္ပါ။ Default scale သည္ 1.0 ႏွင့္ rotation angle မွာ 0 ျဖစ္ရမည္။

 Ok ကုိ click ပါ။

၇) ေအာက္က Original phone အတုိင္း Phone ကိုေနရာ သတ္မွတ္ေပးရန္ click ပါ။
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၈) အဆိုပါ file ကို save လိုက္ပါ။ Title bar ေပၚမွ C_Workstation.dwg ကို saved ခ႕ဲသည့္ လမ္းေၾကာင္းကို သတိထား

ၾကည့္ၾကည့္ပါ။

၉) Template ကုိအသံုးျပဳျပီး၊ new file ကိုစတင္ရန္ -

 Ribbon, click Application Menu > New.

 Select Template dialog box မွ acadiso.dwt file ကို select ပါ။

 Open ကုိ click ပါ။

၁၀) Insert tab, click Block panel > Insert.

၁၁) Current drawing အတြင္းသုိ႕ file ကုိ insert ရန္ -

 Insert dialog box မွ Browse ကို click ပါ။

 Select Drawing File dialog box မွ လမ္းေၾကာင္းအတိုင္း သြားျပီး C_Workstation.dwg ကို select ပါ။

 Open ကုိ click ပါ။

 Insert dialog box တြင္ C_Workstation ကို listed လုပ္ျပီးသြားလွ်င္ drawing ၌ C_Workstation ကုိ insert လုပ္ရန္ Ok ကို

click ပါ။ Block ကို drawing window ၏တစ္ေနရာရာတြင္ insert လုပ္ရန္၊ (သို႕မဟုတ္) insertion point အတြက္ specify

on–screen option ကုိ clear လုပ္ထားပါက block သည္ 0,0 inserted ျဖစ္သြားမည္။

၁၂) Drawing အတြင္းမွ block ကုိ view ရန္ -

 Block ကုိ view ရန္ Zoom out လုပ္ပါ။

 Insert tab, click Block panel > Insert.

 List ကို select လိုက္ပါ။ Inserted လုပ္လိုက္ေသာ C_Workstation drawing သည္ current drawing တြင္ inserted

လုပ္ထားသည့္ အားလံုးေသာ block မ်ားနည္းတူ listed ျဖစ္ေနမည္ကို ေတြ႕ရမည္ ျဖစ္သည္။ အဆိုပါ block သည္ current

drawing database ရဲ႕ အစိတ္အပိုင္း တစ္ခုျဖစ္သြားမည္ ျဖစ္သည္။

 Insert dialog box ကို close ရန္ cancel ကို click ပါ။
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၁၃) Drawing အတြင္းတြင္ အျခားေသာ properties မ်ားကို view ရန္ -

 Home tab, click Layers panel > Layer Control.

 A-EQPM-IDEN layer သည္ current drawing database ၏အစိတ္အပိုင္း တစ္ခုျဖစ္ေနမည္ကို သတိထား ၾကည့္ၾကည့္ပါ။

အဆိုပါ layer သည္ C_Workstation block အတူ drawing အတြင္းသုိ႕ brought လာခဲ႕ျခင္း ျဖစ္သည္။

၁၄) Files အားလုံးကို မ Save ပဲပိတ္လိုက္ပါ။

Lesson: Working with DesignCenter

ဤသင္ခန္းစာတြင္ အျခားေသာ drawing မွ data မ်ားကို လက္ရွိ drawing တြင္ ျပန္လည္ အသံုးျပဳရန္ DesignCenter အသုံးျပဳျခင္းကုိ

ေလ့လာသြားရမည္ ျဖစ္သည္။
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Objectives

ဤသင္ခန္းစာကို ေလ့လာျခင္း ျပီးစီးသြားပါက -

 DesignCenter အသုံးျပဳျပီး drawing သုိ႕ data မ်ား add တတ္လာေစရန္။

Using DesignCenter

DesignCenter ကိုအသံုးျပဳျပီး အျခားေသာ drawings ၏ existing content view ကုိ current drawing သို႕ drag လုပ္နိုင္ပါသည္။

Drawing file တစ္ခုလံုး (သို႕မဟုတ္) drawing file အတြင္းမွ blocks, dimension styles, layers, layouts, linetypes, table styles,

text styles န႕ဲ xrefs စသည္ objects မ်ားကုိ drag လုပ္ႏိုင္ပါသည္။ DesignCenter မွ drawing file န႕ဲ blocks မ်ားကုိ tool palette

ေပၚသို႕လည္း drag လုပ္ႏိုင္ပါသည္။

Tree view နဲ႕ content pane အၾကားရိွ အုပ္စုခြဲေလးသည္ DesignCenter interface ျဖစ္ပါသည္။ Folders,Open Drawings, History

န႕ဲ DC Online ဟူ၍ four tabs ရိွပါသည္။ Tree view မွ item ကို select လုိက္ေသာ အခါတြင္၊ selected လိုက္ေသာ item ၏ content

ကို content pane တြင္ display ေပးပါလိမ္႕မည္။ ထုိသုိ႕ displayed ထားေသာ content pane မွ current drawing သုိ႕ drag

လုပ္သြားႏိုင္ပါသည္။
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ေအာက္တြင္ေဖာ္ျပ ေပးထားေသာ ပုံတြင္ Open Drawings tab (2) ၏ tree view (1) ကို အက်ယ္ခ်ဲ႕ျပထား ပါသည္။ Blocks

category ကို selected (3) လုိက္ပါက ၎၏ contents မ်ားကုိ အေပၚညာဖက္တြင္ ရိွေသာ pane contents တြင္ display

ေပးပါလိမ့္မည္။ Preview (4) န႕ဲ Description (5) ျဖင့္ selected block (6) ၏ အေသးစိပ္ အခ်က္အလက္မ်ားကုိ ညာဖက္ေအာက္

panes တြင္ၾကည့္ရႈ႕ႏိုင္ပါသည္။

DesignCenter အတြင္း ေအာက္ေဖာ္ျပပါ tabs ကိုအသံုးျပဳျပီး content ကုိ locate လုပ္နိုင္ပါသည္။

Tab Description

Folder Folder tab ကုိနိွပ္ျပီး Standard Windows-like tree view ျဖင့္ display လွ်င္ content files

မ်ားသုိ႕ လြယ္ကူစြာ သြားလာနိုင္ပါသည္။

Open Drawings Software ထဲတြင္ လက္ရိွ ဖြင့္ထားေသာ drawing တစ္ခုတည္းသာ display ရန္။

History Application ၏ current session အေတာအတြင္း accessed ထားေသာ drawing ကုိ display ျခင္း။

DC Online Manufacturers ၏ web pages မွ contents မ်ားကုိ access လုပ္ျခင္း။
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Command Access

DesignCenter

Command Line: ADCENTER

Ribbon: Insert tab > Content panel

Ribbon: View tab > Palettes panel > DesignCenter

Procedure: Reusing Content with DesignCenter

အျခားေသာ drawing မွ current drawing သို႕ DesignCenter အသုံးျပဳျပီး insert content လုပ္ျခင္းကုိ ေအာက္တြင္

အဆင့္ဆင့္ေဖာ္ျပ ေပးထားပါသည္။

၁) Ribbon, click View tab > Palettes panel > DesignCenter.

၂) Tree view ျဖင့္ content မ်ားကိုရွာေဖြရန္ Folders, Open Drawings (သုိ႕မဟုတ္) History tab ကုိ click ပါ။

၃) မိမိတုိ႕ လုိအပ္ေသာ folder (သို႕မဟုတ္) drawing file နဲ႕ category ကို display ေစရန္ tree view ကုိ expand လုပ္ပါ။

၄) Tree view တြင္ folder (သို႕မဟုတ္) category တို႕၏ contents မ်ားကုိ content pane တြင္ display ေစရန္ ၎ folder

(သုိ႕မဟုတ္) category ကုိ click ပါ။
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၅) Content pane မွ Items မ်ားကုိ current drawing အတြင္းသို႕ ေအာက္ေဖာ္ျပပါ နည္းလမ္း (၃) မ်ိဳးတို႕ကို အသုံးျပဳျပီး Insert

လုပ္ပါ။

 ၎ item ကုိ drawing အတြင္းသို႕ Drop လုပ္လိုက္ပါ။

 ၎ item ကုိ Double-click ႏိွပ္လုိက္ပါ။

 ၎ item ကုိ Right-click ႏိွပ္ျပီး၊ option ကုိ select ပါ။

Exercise: Use DesignCenter

ဤေလ့က်င့္ခန္းတြင္ အျခားေသာ drawing မွ current drawing သုိ႕ DesignCenter အသံုးျပဳျပီး block နွစ္ခု insert လုပ္ျခင္းအပိုင္းကုိ

ေလ့က်င့္သြားရမည္။ အဆုိပါ file မွ text style ကုိပါ insert လုပ္သြားရမည္။

The completed exercise

၁) C_Content-To-Reuse.dwg န႕ဲ C_Elevation-Presentation.dwg ကုိဖြင့္ပါ။

၂) View tab, click Palettes panel > DesignCenter.
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၃) DesignCenter တြင္ -

 Open Drawings tab ကုိ click ပါ။

 Tree view တြင္C_Content-To-Reuse.dwg နဲ႕ C_Elevation-Presentation.dwg ၏ေအာက္မွ categories မ်ားကုိ expand

န႕ဲ show လုပ္လုိက္ပါ။

 Tree view မွ C_Content-To-Reuse.dwg ေအာက္တြင္ရိွေသာ blocks ကုိ click ပါ။

၅) Content pane မွ elev-conifer block ကို ေအာက္တြင္ ေဖာ္ျပေပးထားသည့္ အတိုင္း house ၏အေရွ႕ညာဖက္ area သုိ႕ drag and

drop လုပ္ေပးလုိက္ပါ။

၆) DesignCenter ၏ content pane မွ elev-deciduous ကုိ double-click နိွပ္ပါ။

၇) Insert dialog box တြင္ -

 Scale ေအာက္တြင္ X scale factor အတြက္ 2 ဟုရိုက္ထည့္ေပးလိုက္ပါ။

 Scale ေအာက္တြင္ Y scale factor အတြက္ 4 ဟုရိုက္ထည့္ေပးလိုက္ပါ။

 Insertion Point ေအာက္တြင္ Specify-On-Screen ကုိ select ပါ။

 Ok ကုိ click ပါ။
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၈) ေအာက္တြင္ေဖာ္ျပေပးထားသည့္ ပုံအတုိင္း tree ကုိ အိမ္၏ အေရွ႕ဘယ္ဖက္ area သုိ႕ drag and drop လုပ္ေပးလုိက္ပါ။

၉) DesignCenter ၏ tree pane မွ C_Elevation-Presentation.dwg ေအာက္တြင္ရိွေသာ Textstyles category ကုိ click ပါ။

Drawing အတြင္းတြင္ လက္ရိွ ရိွေနမည့္ text styles မွာ Annotative and Standard တို႕ျဖစ္သည္။

၁၀) C_Content-To-Reuse.dwg ေအာက္မွ Textstyles category ကို click ပါ။

၁၁) DesignCenter ၏ content pane မွ Present-Text style ကုိ drawing အတြင္းသို႕ drag and drop လုပ္ပါ။

၁၂) Tree pane အတြင္းရိွ C_Elevation- Presentation.dwg ေအာက္မွ Textstyles ကုိ click ပါ။ Present-Text style

သည္လက္ရိွတြင္ exists ျဖစ္သြားျပီ ျဖစ္ေသာေၾကာင့္ drawing file တြင္အသံုးျပဳ ႏိုင္ျပီျဖစ္သည္။

၁၃) Files အားလုံးကို မ Save ပဲပိတ္လိုက္ပါ။
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Lesson: Using Tool Palettes

ဤသင္ခန္းစာတြင္ tool palettes ကုိ access လုပ္ပုံနွင့္ tools မ်ားျဖင့္ drawings အတြင္း၌ အသံုးျပဳျခင္း အပိုင္းကုိ ေလ့လာသြားရမည္

ျဖစ္သည္။ Tool palettes ကိုအသံုးျပဳျပီး organize လုပ္ျခင္း၊ tools မ်ား access လုပ္ျခင္း တို႕ျဖင့္ မိမိတုိ႕ အလုပ္တြင္ လ်င္လ်င္ျမန္ျမန္

တြင္တြင္က်ယ္က်ယ္ ျပဳလုပ္ႏိုင္ပါသည္။

ေအာက္ပုံ၌ Tool Palettes window တြင္ပါရိွေသာ Architectural န႕ဲ Civil tool palettes မွ tools တစ္ခ်ိဳ႕ကုိ ေဖာ္ျပ ေပးထားပါသည္။

Objectives

ဤသင္ခန္းစာကို ေလ့လာျခင္း ျပီးစီးသြားပါက -

 customized tool palette ကုိအသုံးျပဳျပီး မိမိတုိ႕၏ drawing သို႕ geometry မ်ား add တတ္လာေစရန္။

Using Tool Palette Tools
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Tool Palettes window တြင္ tool palette တစ္ခုစီအတြက္ tab တစ္ခုစီ ပါ၀င္ပါသည္။ Blocks န႕ဲ hatches က႕ဲသုိ႕ မၾကာခဏ

အသုံးျပဳေလ့ ရိွေသာ commands နဲ႕ objects လြယ္ကူလ်င္ျမန္စြာ access လုပ္ႏိုင္ရန္ Tool palettes ကုိအသုံးျပဳျပီး organize

လုပ္ထားႏိုင္ပါသည္။

Shortcut menu ကုိအသုံးျပဳျပီး palettes မ်ားကို createျခင္း, delete လုပ္ျခင္း န႕ဲ rename ေပးျခင္းစသည္ တုိ႕ကို ျပဳလုပ္သြား

ႏိုင္ပါသည္။ Tool ကုိ right-clicking လုပ္ျခင္းအားျဖင့္ ၎ tool ၏ properties မ်ားကုိေျပာင္းလဲ သတ္မွတ္ႏိုင္ပါသည္။

ေအာက္ေဖာ္ျပပါ နည္းလမ္းမ်ားအတိုင္း tools မ်ားကို palette သုိ႕ add သြားႏိုင္ပါသည္။

 DesignCenter မွ blocks (သုိ႕မဟုတ္) drawing files မ်ားကုိ drag လုပ္ျခင္း။

 Drawing window မွ palette သုိ႕ geometry ကို Right-click ႏိွပ္ျပီး drag လုပ္လိုက္ပါ။

 Tool Palettes window ကုိမိမိတုိ႕၏ အလုပ္နွင့္ ကိုက္ညီအဆင္ေျပစြာ display ေစရန္ လုိအပ္သလို ျပဳျပင္ ႏိုင္ပါသည္။ ၎

Tool Palettes window ကုိ resize,dock နဲ႕ title bar တြင္ roll up လုပ္ျခင္းတို႕ကို ျပဳလုပ္ ႏိုင္ပါသည္။

The Mechanical Tool Palette

Command Access

Tool Palettes

Command Line: TOOLPALETTES
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Ribbon: View tab > Palettes panel > Tool Palettes

Procedure: Adding Geometry to a Drawing Using the Tool Palettes

Palette tools ကုိအသံုးျပဳျပီး၊ geometry မ်ား drawing သုိ႕ add ျခင္းကို ေအာက္တြင္အဆင့္ဆင့္ ေဖာ္ျပေပး ထားပါသည္။

၁) Ribbon, click View tab > Palettes panel > Tool Palettes.

၂) မိမိတုိ႕ အသံုးျပဳလိုေသာ item ပါ၀င္သည့္ tool palette tab ကို click ပါ။

၃) Tool palette တြင္ မိမိတုိ႕ အသံုးျပဳလိုေသာ item ၏ icon ကုိ click ပါ။

၄) အဆိုပါ item ကုိ creat ရန္ drawing area တြင္ click လုိက္ပါ။

Exercise: Add Content from Tool Palettes

Tool palette tools မ်ားကုိ အသုံးျပဳျပီး drawing အတြင္းသုိ႕ block, a hatch န႕ဲ text မ်ား add ျခင္း ေလ့က်င့္ခန္း မ်ားကုိလက္ေတြ႕

ေလ့က်င့္သြားရမည္ ျဖစ္သည္။
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The completed exercise

၁) M_Tool-Palettes.dwg ကိုဖြင့္ပါ။

၂) View tab, click Palettes panel > Tool Palettes.

၃) Tool Palettes window မွ Mechanical tab ကုိ click ပါ။

၄) Drawing အတြင္းသို႕ bolt ကုိ insert လုပ္ရန္ -

 Hex Socket Bolt (Side) – Metric တြက္ icon ကုိ click ပါ။

 Top centerline န႕ဲ left line တုိ႕၏ intersection ကို click ပါ။

 Drawing သည္ေအာက္တြင္ေဖာ္ျပ ေပးထားသည့္ အတုိင္း ျဖစ္လာမည္။

၅) Tool Palettes window မွ Hatches and Fills tab ကုိ click ပါ။

၆) Layer 3 ကုိ current လုပ္လိုက္ပါ။
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၇) Steel hatch pattern ကို cutaway section သုိ႕ apply လုပ္ရန္ -

ISO Hatches ေအာက္မွ Steel hatch pattern အတြက္ icon ကို click လုိက္ပါ။

 ေအာက္ေဖာ္ျပပါ ပုံအတုိင္း bolt ကုိ inserted လုပ္ထားေသာ ေနရာ၏ အထက္ rectangular area သို႕ cursor

ကိုေနရာေရြ႕လိုက္ပါ။

 Hatch ကုိ creat ရန္ click လိုက္ပါ။

၈) Bolt ကို inserted လုပ္ထားေသာ ေနရာ၏ ေအာက္တြင္ Steel hatch pattern ကုိပဲ ေအာက္ေဖာ္ျပပါ ပုံအတုိင္း ထပ္မံ၍ insert

လုပ္ပါ။
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၉) Tool Palettes window မွ Draw tab ကို click ပါ။

၁၀) Drawing သို႕ text note ကို add ရန္ -

 Text layer ကုိ current လုပ္လုိက္ပါ။

 MText အတြက္ MText icon ကို click ပါ။

 ေအာက္တြင္ ေဖာ္ျပထားသည့္ အတုိင္း bolt န႕ဲ hatch ၏ညာဖက္တြင္ text window ကုိ creat လုိက္ပါ။

 Ribbon တြင္ျပထားေသာ Text editor ၏ Style panel တြင္ text height အတြက္ 12 ကိုရိုက္ထည့္ေပးပါ။

 COUPLER ကိုရိုက္ထည့္လုိက္ပါ။

 Close Text Editor ကုိ click ပါ။

၁၀) Files အားလုံးကို မ Save ပဲပိတ္လိုက္ပါ။

Challenge Exercise: Architectural

ဤလက္ေတြ႕ ေလ့က်င့္ခန္းတြင္ အထက္၌ ေလ့လာခ႕ဲသည္မ်ားႏွင့္ existing content ကုိျပန္လည္အသုံးျပဳျခင္း၊ block definition

မ်ားဖန္တီးျခင္း စသည္တုိ႕ကုိ လက္ေတြ႕ေလ့က်င့္သြားရမည္ ျဖစ္သည္။

Metric Units

၁) M_ARCH-Challenge- CHP10.dwg ကိုဖြင့္လိုက္ပါ။

၂) Chapter 2 တြင္ created ခဲ႕ေသာ door geometry မွ block တစ္ခုကုိ သတ္မွတ္ေပး သြားပါမည္။ Door-Typical ဟုမည္ေပးပါမည္။
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၃) Block ကုိ inserting မလုပ္ခင္ layer current သတ္မွတ္ေပးပါ။

၄) Locations labeled (1) တပ္ထားေပးေသာ ေနရာမ်ားတြင္ Door_Glass-915 ကုိ Insert and position လုပ္ပါမည္။ ထုိနည္းအတုိင္း

က်န္ရိွေနေသးေသာ door မ်ားတြင္ Door-Typical ကို Insert and position လုပ္ေပးပါ။

၅) M_ARCH-Challenge-Supporting-Details.dwg file မွ block Elevation-Exterior ကုိ Insert and position လုပ္ပါ။
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၆) Openings ေနရာတြင္ different-sized နွစ္ခုျဖင့္ Insert and position လုပ္ေပးပါ။

၇) Floor plan တြင္ plumbing fixtures ကုိ Insert and position လုပ္ေပးပါ။

၈) Files အားလံုးကို save ျပီး ပိတ္လိုက္ပါ။

Imperial Units

၁) I_ARCH-Challenge- CHP10.dwg ကုိဖြင့္လိုက္ပါ။

၂) Chapter 2 တြင္ created ခဲ႕ေသာ door geometry မွ block တစ္ခုကုိ သတ္မွတ္ေပး သြားပါမည္။ Door-Typical

ဟုမည္ေပးပါမည္။

၃) Block ကုိ inserting မလုပ္ခင္ layer current သတ္မွတ္ေပးပါ။

၄) Locations labeled (1) တပ္ထားေပးေသာ ေနရာမ်ားတြင္ Door_Glass-3-0 ကုိ Insert and position လုပ္ပါမည္။ ထုိနည္းအတုိင္း

က်န္ရိွေနေသးေသာ door မ်ားတြင္ Door-Typical ကို Insert and position လုပ္ေပးပါ။
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၅) I_ARCH-Challenge-Supporting-Details.dwg file မွ block Elevation-Exterior ကုိ Insert and position လုပ္ပါ။

၆) Openings ေနရာတြင္ different-sized နွစ္ခုျဖင့္ Insert and position လုပ္ေပးပါ။

၇) Floor plan တြင္ plumbing fixtures ကုိ Insert and position လုပ္ေပးပါ။

၈) Files အားလံုးကို save ျပီး ပိတ္လိုက္ပါ။
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Challenge Exercise: Mechanical

ဤလက္ေတြ႕ ေလ့က်င့္ခန္းတြင္ အထက္၌ ေလ့လာခ႕ဲသည္မ်ားႏွင့္ existing content ကုိ ျပန္လည္အသံုးျပဳျခင္း၊ block definition

မ်ားဖန္တီးျခင္း စသည္တုိ႕ကုိ လက္ေတြ႕ေလ့က်င့္သြားရမည္ ျဖစ္သည္။

The completed exercise

၁) M_MECH-Challenge- CHP10.dwg ကုိဖြင့္ပါ။

၂) Model space တြင္ border and title block ကိုေအာက္တြင္ေဖာ္ျပ ေပးထားသည့္ အတိုင္းေရးဆြဲ လုိက္ပါ ( dimensions မပါ)။

၎ကို Titleblock ဆုိေသာ အမည္ျဖင့္ block လုပ္ေပးလိုက္ပါ။ အဆုိပါ border ၏ဘယ္ဖက္ ေအာက္ေထာင့္ကို basepoint

အျဖစ္သတ္မွတ္ေပး လိုက္ပါ။

မွတ္ခ်က္။ ။ ဤ block ကုိေနာက္လာမည့္ challenge exercises မ်ားတြင္ အသုံးျပဳ သြားရမည္ ျဖစ္သည္။
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၃) C:\Program Files\AutoCAD 2010\Sample\DesignCenter\Fasteners - Metric.dwg မွ Hex Flange Screw - 10 mm top

block ကုိ Insert လုပ္ပါ။ Scale ကုိ (Uniform Scale) 1.6 times သို႕တိုးျပီး၊ ေအာက္ တြင္ေဖာ္ျပ ေပးထားေသာ ပုံအတိုင္း screws ကုိ

assembly ထိပ္တြင္ position လုိက္ပါ။

၄) Block definition Hex Bolt Head (10mm) ၏ေဘးတိုက္ျမင္ကြင္း ျဖစ္ပါသည္။

၅) Drawing ကုိ save ျပီး ပိတ္လိုက္ပါ။

Chapter Summary

နဂိုပါရိွျပီး design မ်ားကို DesignCenter အသံုးျပဳျပီး drag လုပ္သတ္မွတ္ျခင္း၊ file တစ္ခုမွ တစ္ခုသုိ႕ drawing မ်ားကို ကူးေျပာင္းျခင္း

စသည္တို႕ကို ျပဳလုပ္ႏိုင္ပါသည္။ ထို႕အျပင္ tool palettes ကုိအသံုးျပဳျပီး organize ျပဳလုပ္ျခင္း၊ blocks, hatches ကဲ႕သို႕ေသာ data

မ်ားကို share လုပ္ျခင္း စသည္တုိ႕ကုိ ပါျပဳလုပ္ ႏိုင္ပါသည္။

ဤသင္ခန္းစာကို ေလ့လာျခင္း ျပီးဆုံးသြားပါက -

 Block မ်ားဖန္တီးကာ drawings မ်ားတြင္ ဖန္တီးထားေသာ block မ်ားကို Insert လုပ္တတ္လာမည္။

 Drawing တြင္ DesignCenter ျဖင့္ data မ်ားကို ထပ္ကာထပ္ကာ အသံုးျပဳတတ္လာမည္။

 Tool palettes တြင္ရိွေသာ tools မ်ားကုိ အသုံးျပဳတတ္ လာမည္။
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CHAPTER: 11 Creating Additional Drawing
Objects
မိမိတုိ႕ ေရးဆြဲမည့္ design ၏ လုိအပ္ခ်က္မ်ားေပၚ မူတည္ျပီး၊ single continuous object က႕ဲသို႕ေသာ object မ်ိဳးအတြက္ connected

line နဲ႕ arc segments ရိွရန္လုိအပ္သည္ (သုိ႕မဟုတ္) free-form shape တြင္ smooth curves ဖန္တီးရန္ လုိအပ္ေပမည္။ ထို႕အျပင္

မိမိတုိ႕၏ drawing တြင္ဇယားျဖင့္ tabular information မ်ား add ရန္လည္း လိုအပ္ေပသည္။ ထုိလုိအပ္ခ်က္မ်ား အတြက္

မွန္ကန္ေသာ commands မ်ားအသံုးျပဳျပီး လြယ္ကူစြာ အသုံးျပဳတတ္ရန္ လိုအပ္ေပသည္။

Objectives

ဤသင္ခန္းစာကို ေလ့လာျခင္း ျပီးစီးသြားပါက -

 Polyline command ျဖင့္ polylines မ်ားကုိ create and edit လုပ္တတ္လာေစရန္။

 Spline command ျဖင့္ smooth curves မ်ားကုိ create တတ္လာေစရန္။

 Ellipse command ျဖင့္ ellipses and elliptical arcs မ်ား create တတ္လာေစရန္။

 Basic tables မ်ား create and edit လုပ္ျခင္းႏွင့္ table styles မ်ားအသံုးျပဳျပီး ၎တုိ႕၏ appearance ကို control

လုပ္တတ္လာေစရန္။

Lesson: Working with Polylines

ဤသင္ခန္းစာတြင္ polylines မ်ား create and edit လုပ္ပုံကုိ ေလ့လာသြားရမည္ ျဖစ္သည္။ Boundary line အေျမာက္အျမား

အတြင္းတြင္ polyline segments ႏွင့္ polyline ျဖင့္ created ထားေသာ arrow တုိ႕ကုိ ေအာက္ေဖာ္ပါ ပုံတြင္ ေဖာ္ျပေပးထားပါသည္။

Polylines မ်ားျဖင့္ geomentry ဖန္တီးနိုင္ျပီး၊ Polyline ကိုအသံုးျပဳကာ perimeter distance ကုိလြယ္ကူစြာ တြက္ခ်က္ႏိုင္ပါသည္။

Polylines မ်ားကို offsetting လုပ္ျခင္းအားျဖင့္ geometry corners မ်ား၌ အခ်ိန္ကုန္ခံျပီး trimming (သို႕မဟုတ္) extending

မ်ားလုပ္ေပးေနရန္ မလိုအပ္ေတာ႕ေပ။
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Objectives

ဤသင္ခန္းစာကို ေလ့လာျခင္း ျပီးသြားပါက -

 Polylines အေၾကာင္းနွင့္ ၎တို႕၏ standard objects ျဖင့္ကြားျခားခ်က္ကုိ သိရိွနားလည္ လာေစရန္။

 Polyline command အသံုးျပဳျပီး Polyline မ်ား create တတ္လာေစရန္။

 Edit Polyline command ကိုအသံုးျပဳျပီး polylines မ်ားကို edit လုပ္တတ္လာေစရန္။

About Polylines

Polylines ျဖင့္ complex geometry မ်ားကို တစ္ခ်ိန္းတည္း ဖန္တီးႏိုင္ပါသည္။ Object selection လုပ္ရာတြင္

ရိုးရွင္းလြယ္ကူလွပါသည္။ အဘယ္႕ေၾကာင့္ ဆိုေသာ္ အားလုံးကိုတစ္ျပိဳင္တည္း selection လုပ္ျပီး single object ကုိ editing

လုပ္သက႕ဲသို႕ လြယ္ကူလ်င္ျမန္စြာ ျပဳလုပ္သြား ႏိုင္ပါသည္။

ေအာက္တြင္ ေဖာ္ျပေပးထားေသာ objects မ်ားသည္ single polyline ကုိယ္စားျပဳ objects မ်ားျဖစ္ျပီး၊ ကြဲျပားျခားနားေသာ

နည္းလမ္းမ်ားျဖင့္ ဖန္တီးထားျခင္း ျဖစ္ပါသည္။
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Definition of Polylines

Single object သုိ႕ lines န႕ဲ arcs က႕ဲသုိ႕ေသာ entities မ်ား ထည့္သြင္းျဖည့္စြက္ရာတြင္ Polylines သည္ special types ျဖစ္ပါသည္။

Polylines တြင္ အျခားေသာ objects မ်ား၌ မရိွႏိုင္ေသာ special properties မ်ားပါရိွ ပါသည္။

အဆိုပါ Properties မ်ားမွာ -

 Global Width

 Start Segment Width

 End Segment Width

6 segments ပါရိွေသာ ေအာက္တြင္ေဖာ္ျပထားသည့္ polyline ကုိ ေလ့လာၾကည့္ပါ။ Segments (1) နဲ႕ (6) တြင္ start segment

widths နဲ႕ end segment widths တုိ႕သည္ျခားနားေနသည္ကုိ ေတြ႕ရမည္။ Segments (2) နဲ႕ (5) တြင္ constant widths segment

မ်ားျဖစ္သည္။ Segments (3) န႕ဲ (4) တြင္ width arc segments မ်ားျခားနားေနသည္ကုိ ေတြ႕ရမည္။
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Example of Polylines Being Used in a Drawing

ေအာက္ေဖာ္ျပပါ ပုံတြင္ Polyline ျဖင့္ boundary ႏွင့္ building footprint ကုိဖန္တီးထားျခင္း ျဖစ္ပါသည္။ Polyline objects

ကိုအသုံုးျပဳျခင္း အားျဖင့္ objectsမ်ား၏ area (သုိ႕မဟုတ္) perimeter တို႕၏ properties မ်ားကို designer မ်ားအေနျဖင့္

လ်င္ျမန္လြယ္ကူစြာ စိစစ္ေပးႏိုင္ပါသည္။

Creating Polylines

Polyline command ကုိအသံုးျပဳျပီး continuous single object ကဲ႕သို႕ေသာ line နဲ႕ arc segments မ်ားကုိဖန္တီး ႏိုင္ပါသည္။

Polylines ဖန္တီးေသာ အခ်ိန္တြင္ straight line segments နဲ႕ arc segments တို႕အၾကားေရွ႕(သုိ႕မဟုတ္) ေနာက္ကို လိုအပ္သလို

ေရြ႕ေျပာင္းေရးဆြဲ ႏိုင္ပါသည္။ Polylines တြင္ရိွေသာ segments အားလုံးကိုလည္း single width အျဖစ္ေျပာင္းလဲ သတ္ႏိုင္ပါသည္။

(သုိ႕မဟုတ္) Segments ရ႕ဲ width ကုိ အစမွ အဆံုးထိ ျခားနားေသာ width ျဖင့္လည္း သတ္မွတ္ေရးဆြဲ ႏိုင္ပါသည္။
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ေအာက္တြင္ေဖာ္ျပ ထားေသာ polylines ၏ ဥပမာကို ေလ့လာၾကည့္ပါ။ Boundary သည္ object တစ္ခုတည္း ျဖစ္သြားျပီဆိုလွ်င္ Area

command ျဖင့္ area ကိုတြက္ခ်က္ႏိုင္ပါသည္။ Polylines ကို အသံုးျပဳျပီး မတူညီေသာ width မ်ားျဖင့္ straight န႕ဲ arcing arrows

မ်ားကို ဖန္တီးသြားႏိုင္ပါသည္။

Command Access

Polyline

Command Line: PLINE, PL

Ribbon: Home tab > Draw panel > Polyline

Command Options

Creating (သုိ႕မဟုတ္) changing polylines အတြက္ options မ်ားကို ေအာက္တြင္ေဖာ္ျပ ေပးထားပါသည္။

Option Description

Arc Polyline ျဖင့္ arc segments မ်ား ေရးဆြဲလုိေသာ အေျခအေန မ်ိဳးတြင္ အသံုးျပဳပါသည္။

Close Arc (သို႕မဟုတ္) line segment မ်ားေရးဆြဲ ေနစဥ္ End point ေရာက္ေသာအခါ Polyline ၏

First point ျဖင့္ အလိုအေလ်ာက္ ဆက္ေပးလိုလွ်င္ အသုံးျပဳ နိုင္ပါသည္။
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Undo Previous segment ကို remove လုပ္လိုေသာ အခါ (သုိ႕မဟုတ္) new segment မ်ားကုိ မတူူ

ညီေသာ appearance ျဖင့္ ဖန္တီးလိုေသာ အခါ အသုံးျပဳ ႏိုင္ပါသည္။

Width Drawing အတြင္းတြင္ Polyline မ်ားေရးဆြဲရာတြင္ Polyline ၏ first vertex မွ second vertex

အထိ Width ကုိသတ္မွတ္ေပးလိုလွ်င္ အသုံးျပဳ ႏိုင္ပါသည္။

Line Polyline တြင္ arc segments မ်ားဖန္တီး ျပီးသြားပါက straight line segments ေရးဆြဲ လုိပါက

အသုံးျပဳ ႏိုင္ပါသည္။

Procedure: Creating a Custom Arrowhead

Pline command ကုိအသုံးျပဳျပီး၊ custom arrowhead ဖန္တီးပုံကုိ ေအာက္တြင္အဆင့္ဆင့္ ေဖာ္ျပေပးထား ပါသည္။

၁) Ribbon, click Home tab > Draw panel < Polyline.

၂) Start point ကုိ သတ္မွတ္ေပးလိုက္ပါ။

၃) Cursor ကိုညာဖက္ 0 ဒီဂရီအတုိင္း drag လိုက္ပါ။ Arrow ၏ length ကုိရိုက္ထည့္ပါ။

၄) Right – click ႏိွပ္ျပီး၊ width ကုိ click ပါ။

၅) Starting width ကို ရိုက္ထည့္ေပးပါ။ Ending width အတြက္ သတ္မွတ္ေပးမည့္ တန္ဖိုးထက္ ၾကီးေသာ တန္ဖိုး ကုိရိုက္ထည့္ ေပးပါ။

၆) Ending width အတြက္ 0 သာ ရိုက္ထည့္ သတ္မွတ္ေပးလိုက္ပါ။

၇) Cursor ကုိညာဖက္ 0 ဒီဂရီအတုိင္း drag လိုက္ပါ။ Arrowhead အတြက္ length တန္ဖိုးကုိ ရိုက္ထည့္ေပး၍ ျဖစ္ေစ (သုိ႕မဟုတ္)

drawing area တြင္ click ျပီးသတ္မွတ္ေပး၍ ျဖစ္ေစ သတ္မွတ္ေပးလိုက္ပါ။

၈) Enter နိွပ္ပါ။
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Editing Polylines

Line (သို႕မဟုတ္) circle ကို modify လုပ္ရာတြင္ အသုံးျပဳေသာ command ျဖင့္ Polylines မ်ားကုိလည္း modify လုပ္ႏိုင္ပါသည္။

Copy, Erase, Move, Offset န႕ဲ Array စသည့္ commands မ်ားကုိလည္း Ploylines မ်ား modify ျပဳလုပ္ရာတြင္ အသုံးျပဳ

သြားႏိုင္ပါသည္။ Fillet န႕ဲ Chamfer command ကိုအသံုးျပဳျပီး Polyline ၏ segments တစ္ပိုင္းဆီကို modify လုပ္လိုပါက လုပ္၍ရမည္

မဟုတ္ေပ။ Polyline object သည္ single object ျဖစ္ေသာေၾကာင့္ အဆုိပါ Polyline ကို explode commad ျဖင့္ exploade

လုပ္ျပီးမွသာ Fillet န႕ဲ Chamfer command အသုံးျပဳျပီး modify လုပ္သြား ႏိုင္မည္ျဖစ္သည္။

Polyline Edit

Pedit command ျဖင့္ Polyline ၏ characteristics မ်ား (သို႕မဟုတ္) line or arc မွ polyline သုိ႕ေျပာင္းလဲေပးႏိုင္ ပါသည္။

Command Access

Edit Polyline

Command Line: PEDIT, PE

Shortcut menu for selected polyline: Polyline Edit

Ribbon: Home tab > Modify panel > Edit Polyline

Command Options
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Open Closed polyline ကုိ edit လုပ္ရာတြင္ အသုံးျပဳပါသည္။ Closed polyline ကို open လုပ္ျခင္း(သို႕

မဟုတ္) Close option အသုံးျပဳျပီး ဖန္တီးထားေသာ Polyline ၏ last segment ကုိ remove

လုပ္ရာတြင္ အသံုးျပဳ ပါသည္။

Close Open polyline ကို edit လုပ္ရာတြင္ အသံုးျပဳပါသည္။ Arc (သုိ႕မဟုတ္) line segment မ်ားေရးဆြဲ

ေနစဥ္ End point ေရာက္ေသာအခါ Polyline ၏ First point ျဖင့္ အလိုအေလ်ာက္ ဆက္ေပးလို

လွ်င္ အသံုးျပဳ နိုင္ပါသည္။

Join Edited ထားေသာ polyline သုိ႕ polylines, lines န႕ဲ arcs မ်ား add ရာတြင္ အသံုးျပဳ ႏိုင္ပါသည္။

Segments ႏွစ္ခုတည္းသာ vertex သုိ႕ Join ႏိုင္မည္။

Reverse Selected ထားေသာ polyline ၏ vertices မ်ားကုိ reverse လုပ္ရာတြင္ အသံုးျပဳ ပါသည္။

Width Polyline အတြင္းမွ အားလုံးေသာ segments မ်ားအတြက္ width မ်ား သတ္မွတ္ေပးရာတြင္

အသုံးျပဳ ပါသည္။

Exploding Polylines

Explode command ကုိအသံုးျပဳျပီး polyline lines န႕ဲ arcs မ်ားကုိ basic shapes သုိ႕ေျပာင္းလဲ ေပးႏိုင္ပါသည္။ Explode command

ကိုအသံုးျပဳျပီး polyline lines ကို explode လုပ္လုိက္သည္နွင့္ တစ္ျပိဳင္နက္ segments အားလံုးသည္ တစ္ပိုင္းစီ ကြဲသြားမည္ျဖစ္ျပီး၊

ထိုတစ္ပိုင္းစီ ကြဲသြားေသာ segments မ်ားသည္လည္း object တစ္ခုစီ ျဖစ္သြားမည္။

Command Access

Explode
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Command Line: EXPLODE, X

Ribbon: Home tab > Modify panel > Explode

Procedure: Joining Lines and Arcs into a Polyline

Pedit command ၏ Join option ကုိအသုံးျပဳျပီး၊ lines န႕ဲ arcs ကုိ series ျဖစ္သြားေအာင္ combine လုပ္ျခင္းကုိ ေအာက္တြင္

အဆင့္ဆင့္ ေဖာ္ျပေပးထားပါသည္။

၁) Ribbon, click Home tab > Modify panel > Edit Polyline.

၂) Polyline သို႕ join ေပးလိုေသာ lines (သုိ႕မဟုတ္) arcs ကုိ select လုပ္ပါ။

၃) Selected object သည္ polyline ျဖစ္ျပီးသားဆိုလွ်င္ command line သည္ ေရွ႕ဆက္ လုပ္ေဆာင္ရမည့္ ညႊန္ၾကားခ်က္မ်ားကုိ

prompted ေပးေတာ႕မည္ မဟုတ္ေပ။ Selected object မ်ားသည္ polyline မျဖစ္ေသး ပါက၊ object တစ္ခုတည္း ျဖစ္သြားေအာင္

prompt တြင္ enter ႏိွပ္ေပးရပါမည္။

၄) Join ကုိ click ပါ။

၅) Polyline အျဖစ္သို႕ ေျပာင္းေပးခ်င္ေသာ objects အားလံုးကုိ select လုိက္ပါ။ Enter ႏိွပ္ပါ။

၆) Polyline edit ျပီးေျမာက္သြားေစရန္ Enter ႏိွပ္ပါ။ ထုိ႕ေနာက္ single object ျဖစ္သြားပါက object ကို select လုိက္သည္နွင့္

ေအာက္ေဖာ္ျပပါ ပုံအတုိင္း highlights ျဖစ္သြားမည္။
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Procedure: Exploding a Polyline

Explode command ကိုအသံုးျပဳျပီး polyline ကုိ individual lines န႕ဲ arcs မ်ားျဖစ္သြားေအာင္ break လုပ္ျခင္းကုိ

ေအာက္တြင္အဆင့္ဆင့္ ေဖာ္ျပေပးထားပါသည္။

၁) Ribbon, click Home tab > Modify panel > Explode.

၂) Drawing အတြင္းမွ object တစ္ခု (သုိ႕မဟုတ္) တစ္ခုထက္ပိုျပီး select လုိက္ပါ။

၃) Explode ျပီးေျမာက္သြား ေစရန္ Enter ႏိွပ္ပါ။ ေအာက္ေဖာ္ျပပါ ပုံအတိုင္း individual objects မ်ားျဖစ္သြားျပီး၊ တစ္ခုခ်င္းစီ

highlights ျဖစ္သြားမည္ ျဖစ္သည္။

Exercise: Create and Modify Polylines

ဤေလ့က်င့္ခန္းတြင္ မတူညီေသာ width မ်ားျဖင့္ lines နဲ႕ arcs မ်ားပါ၀င္ေသာ polyline တစ္ခုကုိ ဖန္တီး သြားရမည္ ျဖစ္သည္။

ထို႕ေနာက္ Polyline ရိွ segments အားလုံး၏ width ကုိ ေျပာင္းေပးသြားရမည္ ျဖစ္သလုိ၊ Polyline ကုိ fillet ပါလုပ္ေပး သြားရမည္

ျဖစ္သည္။
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The completed exercise

၁) M_Polylines.dwg ကုိဖြင့္ပါ။

၂) ေနာက္တစ္ဆင့္ အေနျဖင့္ custom arrow ဖန္တီးရန္ -

 Home tab, click Modify panel > Polyline.

 Drawing အတြင္းမွ ရိွျပီးသား geomentry ညာဖက္တြင္ start point ကုိသတ္မွတ္ေပးရန္ click လိုက္ပါ။

 Cursor ကိုအေပၚတည့္တည့္သုိ႕ move လိုက္ပါ။

 6000 ရိုက္ထည့့္ျပီး Enter ႏိွပ္ပါ။

၃) Polyline arc segments ကုိဖန္တီးရန္ -

 Right – click ႏိွပ္ျပီး၊ Arc ကုိ click ပါ။

 Cursor ကိုညာဖက္ အတည့္အတုိင္း move လုိက္ပါ။

 3000 ရိုက္ထည့့္ျပီး Enter ႏိွပ္ပါ။

 Cursor ကိုညာဖက္ သုိ႕ထပ္မံ၍ move လုိက္ပါ။

 3000 ရိုက္ထည့့္ျပီး Enter ႏိွပ္ပါ။
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၄) Polyline line segments ကိုေနာက္ဖက္ လမ္းေၾကာင္းသုိ႕ ေျပာင္းရန္ -

 Right–click ႏိွပ္ျပီး Line ကုိ click ပါ။

 Cursor ကို အေပၚသုိ႕ move ပါ။

 9000 ရိုက္ထည့့္ျပီး Enter ႏိွပ္ပါ။

၅) Arrowhead အတြက္ width add ေပးရန္ -

 Right – click ႏိွပ္ျပီး width ကို click ပါ။

 Starting width အတြက္ 2000 ရိုက္ထည့့္ျပီး Enter ႏိွပ္ပါ။

 Ending width အတြက္ 0 ရိုက္ထည့့္ျပီး Enter ႏိွပ္ပါ။

၆) Polyline ကို finish ေစရန္ -

 Cursor ကိုအထက္သုိ႕ move ပါ။

 3500 ရိုက္ထည့့္ျပီး Enter ႏိွပ္ပါ။

 Object ကို complete သြားေစရန္ Enter ႏိွပ္ပါ။

၇) Polyline ကို edit လုပ္ရန္ -

 Select လုပ္ျပီး၊ structure ၏ blue outline ကို right-click ႏိွပ္ပါ။
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 Shortcut menu ေပၚမွ Properties ကို click ပါ။

 Properties palette ေပၚတြင္ Global Width အတြက္ 200 ရိုက္ထည့္ပါ။

 Selection ကုိ clear လုပ္ရန္ ESC ကုိ ႏိွပ္ပါ။

၈) Dark green lot boundary မွ arc ကို Click ပါ။ Grips မ်ား displayed လာမည္ျဖစ္ျပီး၊ Arc သည္ Polyline ၏ part

အျဖစ္ေဖာ္ျပေပးပါလိမ္႕မည္။

၉) Esc ကုိႏိွပ္ပါ။

၁၀) Fillet command ကုိအသံုးျပဳျပီး line ကုိ polyline သို႕ add ရန္ -

 Home tab, click Modify panel > Fillet.

 ေအာက္ေျခမွ polyline (1) ကို click ပါ။

 SHIFT ကုိနိွပ္ထားျပီး၊ ေအာက္ပုံတြင္ ျပထားသည့္ အတုိင္း ဘယ္ဖက္က line (2) ကုိ click ပါ။
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၁၁) ဘယ္ဖက္မွ line ကို click ပါ။ Original polyline အတုိင္း တစ္ဆက္တည္း ျဖစ္သြားမည္ကုိ သတိထား ၾကည့္ၾကည့္ပါ။

၁၂) ေအာက္ေဖာ္ျပပါ ပုံအတုိင္း ဘယ္ဖက္ ထိပ္ေထာင့္ကုိလည္း ေအာက္ေထာင့္အတိုင္း ျဖစ္ေအာင္ fillet ဆက္လုပ္ လုိက္ပါ။

၁၃) New polyline ၏ area နဲ႕ perimeter ကို determine လုပ္ရန္ -

 Command line တြင္ list command ကိုစတင္ရန္ list ကုိရိုက္ထည့္လိုက္ပါ။

 ထိပ္ဆံုးမွ green line ကို click ပါ။

 Enter ႏိွပ္ပါ။
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၁၄) AutoCAD® Text Window တြင္အဆိုပါ closed polyline ၏ area န႕ဲ perimeter ကုိ ေဖာ္ျပေပး သြားပါလိမ္႕မည္။

၁၅) Files အားလုံးကို မ Save ပဲပိတ္လိုက္ပါ။

Lesson: Creating Splines

ဤသင္ခန္းစာတြင္ Spline command ကုိအသံုးျပဳျပီး splines ဖန္တီးျခင္းကို တင္ျပသြားမည္ ျဖစ္သည္။ Edge မ်ားကုိ straight lines နဲ႕

arcs မ်ားျဖင့္ ေဖာ္ျပ၍ မရေသာ designs မ်ား (သုိ႕မဟုတ္) smooth free-form line ျဖင့္ေဖာ္ျပလုိေသာ ေအာက္ေဖာ္ျပပါ curved edge

designs မ်ားတြင္ Spline ကုိအသုံးျပဳသြားရန္ လိုအပ္ပါသည္။

Objectives

ဤသင္ခန္းစာကို ေလ့လာျခင္း ျပီးစီးသြားပါက -

 Splines အေၾကာင္းကို နားလည္သေဘာေပါက္ လာေစရန္။

 Splines ဖန္တီးပုံ အဆင့္ဆင့္ကို နားလည္သေဘာေပါက္ လာေစရန္။

About Splines

မိမိတုိ႕ သတ္မွတ္လုိက္ေသာ အမွတ္တစ္မွတ္မွ ေနာက္အမွတ္တစ္ခုသုိ႕ smooth curves မ်ားျဖင့္ ေရးဆြဲျခင္းကုိ Spline ဟုေခၚပါသည္။

Spline ၏ curve elements မ်ားသည္ polylines ၏ true arcs မဟုတ္ေပ။ ထုိ႕ေၾကာင့္ splines သည္ arcs (သုိ႕မဟုတ္) arc

segments မ်ားျဖင့္ ကြဲျပားနားပါသည္။ Spline ကုိ modify လုပ္ရာတြင္ အရိုးရွင္းဆုံးေသာ နည္းလမ္းမွာ girps ျဖင့္ modify လုပ္ျခင္း

ပင္ျဖစ္သည္။
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Spline Definition

Drawing အတြင္းတြင္ မိမိတုိ႕ လိုအပ္ေသာ smooth curvature ပုံစံမ်ိဳးရရိွေစရန္ Splines ကို fit tolerance ျဖင့္ fit points ကုိျဖတ္ျပီး

ေရးဆြသဲြားႏိုင္ပါသည္။ အဆိုပါ Splines မ်ားကို grips ကုိအသုံးျပဳ၍လည္းေကာင္း၊ spline edit options ကုိအသံုးျပဳ၍ လည္းေကာင္း

editing လုပ္သြား ႏိုင္ပါသည္။ Spline option ျဖင့္ edited လုပ္ထားေသာ Polylines သည္ spline ျဖင့္ခပ္ဆင္ဆင္ တူညီသြားမည္

ျဖစ္သည္။ Polyline မွ spline သို႕ ေျပာင္းလဲ ေပးႏိုင္ေသာ္လည္း၊ basic AutoCAD commands မ်ားျဖင့္ spline မွ Polyline သို႕

ေျပာင္းလဲေပး ႏိုင္မည္ မဟုတ္ေပ။

Spline ကုိ Polyline ဖန္တီးေသာ နည္းလမ္းအတုိင္း ဖန္တီးသြားရမည္ ျဖစ္သည္။ မိမိတို႕ လိုခ်င္ေသာ shape အတိုင္း points

(သုိ႕မဟုတ္) vertex မ်ားကုိ ဆက္တုိက္ သတ္မွတ္ျပီး ေရးဆြဲသြားရမည္ ျဖစ္ပါသည္။ ေအာက္ေဖာ္ျပပါ ပုံသည္ Polyline ေရးဆြဲေသာ

ဥပမာ ျဖစ္ပါသည္။ Vertex point တုိင္းတြင္ highlights ျဖစ္ေနမည္။



“Workgroup” AotoCAD & 3ds Max Job Training Center မွ ပညာဒါန အခမ့ဲ ျဖန္႔ေ၀သည္။

( ဤစာအုပ္ကုိ ေငြေၾကးျဖင့္ ျပန္လည္ေရာင္းခ် ခြင့္မျပဳပါ )

ေအာင္ေဇာ္လတ္ {(Master of Engineering in Science and Production Engineering) Moscow State University Of Railway Engineering}

ဘာသာျပန္ ေရးသား ျပဳစုသည္။

“Workgroup “ AutoCAD & 3ds Max Training Center, International Computer Driving Licence Approved Test Center,
Rm- 403, Excel Tower, Yangon, Myanmar.

Ph: 951 559377 Ext: 6413 or 6403, Email – infor@workgroupweb.com

307

Spline ဖန္တီးေသာ အခါ မိမိတုိ႕ သတ္မွတ္လုိက္ေသာ အမွတ္မ်ားကုိ line segments မ်ားအစား smooth curve ျဖင့္ဆက္သြား

ေပးမည္ျဖစ္ျပီး၊ လုိခ်င္ေသာ shape ကိုေရးဆြဲျပီး end point ေရာက္လွ်င္ tangency ကုိသတ္မွတ္ ေပးရပါမည္။ Polyline

ေရးဆြထဲားသည့္ နည္းအတုိင္း ေရးဆြထဲားသည့္ ေအာက္ေဖာ္ျပပါ Spline ကုိေလ့လာၾကည့္ပါ။

Spline Examples

Spline ကုိဖန္တီးျပီး spline edit command ျဖင့္ ၎ကုိ close ႏိုင္ပါသည္။ Closed spline ဥပမာကို ေအာက္တြင္ ေဖာ္ျပ

ေပးထားပါသည္။

Polyline ကုိဖန္တီးျပီး၊ polyline edit command အသုံးျပဳကာ splined polyline ကုိဖန္တီးႏိုင္ပါသည္။ Spline edit command မွ

Object option ျဖင့္ ၎တုိ႕ကုိ spline သုိ႕ေျပာင္းလဲေပးႏိုင္ပါသည္။ Splined polyline နွစ္ခုလံုးကုိ spline သို႕ေျပာင္းလေဲပးပါက

ေအာက္တြင္ေဖာ္ျပ ေပးထားသည့္အတုိင္း တစ္ထပ္တည္း ဆင္တူစြာ ေပၚလာမည္ ျဖစ္သည္။ သို႕ေသာ္လည္း အဆိုပါ objects

ႏွစ္ခုလုံးသည္ ကြဲျပားျခားနားစြာ တည္ရိွေနမည္ ျဖစ္သည္။

Polyline splined မွ Spline သို႕ေျပာင္းထားျပီး၊ spline edit command ျဖင့္ closed ထားေသာ ဥပမာပုံကို ေအာက္တြင္

ေဖာ္ျပေပးထားပါသည္။ အဆိုပါ ပုံသည္ closed spline ျဖစ္ပါသည္။
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Polyline edit option ကုိအသံုးျပဳျပီး polyline splined ကုိ closed ဖန္တီးလိုက္ပါက မတူညီေသာ result ကုိရလာမည္ ျဖစ္သည္။

ေအာက္တြင္ ေဖာ္ျပေပးထားေသာ ပုံသည္ closed polyline ျဖစ္ပါသည္။

Creating Splines

Spline command ကိုအသုံးျပဳျပီး မိမိတုိ႕ သတ္မွတ္လိုက္ေသာ points မ်ားအနီးတြင္ smooth curves မ်ားဖန္တီး ႏိုင္ပါသည္။ Spline

အတြက္ initial tolerance value သည္ 0 ျဖစ္ေနပါက default အရ spline သည္ points မ်ားကိုျဖတ္သြားမည္ ျဖစ္သည္။ Spline

တြင္ပါ၀င္ေသာ defining points, tolerances န႕ဲ tangencies stored အားလုံးနွင့္အတူ drawing အတြင္းမွ spline သည္ single

object ျဖစ္ပါသည္။

ေအာက္တြင္ spline objects နွစ္ခုကုိ ေဖာ္ျပေပးထားပါသည္။ ပုံနွစ္ပုံမွ ေအာက္မွပုံသည္ သတ္မွတ္ထားေသာ အမွတ္မ်ားျဖင့္ spline

ကိုေဖာ္ျပေပးျခင္း ျဖစ္သည္။

Command Access
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Spline

Command Line: SPLINE

Ribbon: Home tab > Draw extended panel > Spline

Edit Spline

Command Line: SPLINEDIT

Ribbon: Home tab > Modify panel > Edit Spline

မွတ္ခ်က္။ ။ Grip ျဖင့္ spline ၏ shape ကုိ modify လုပ္ျခင္းသည္ အလြယ္ကူဆံုးေသာ နည္းလမ္းျဖစ္ပါသည္။

Procedure: Creating a Spline

Drawing အတြင္းတြင္ spline ဖန္တီးပုံကို ေအာက္တြင္အဆင့္ဆင့္ ေဖာ္ျပေပးထားပါသည္။

၁) Ribbon, click Home tab > Draw panel > Spline.

၂) မိမိတုိ႕ ဖန္တီးလုိေသာ location တြင္ ဆက္တုိက္ click ျပီး spline ကုိေရးဆြလဲိုက္ပါ။

၃) Right – click ႏိွပ္ျပီး Enter ႏိွပ္ပါ။

၄) ေအာက္ေဖာ္ျပပါ အတိုင္း ပုံတစ္ပုံကုိ ေရးဆြၾဲကည့္ပါ။
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 First point ကုိျဖတ္သြားေသာ default tangency လက္ခံရန္ Right – click ႏိွပ္ပါ။

 Spline ၏ပထမအပိုင္းကို tangent လုပ္ရန္ cursor ကုိ move ျပီး click ပါ။

၅) ေအာက္ေဖာ္ျပပါ အတိုင္း ပုံတစ္ပုံကုိ ေရးဆြၾဲကည့္ပါ။

 Last point ကိုျဖတ္သြားေသာ default tangency လက္ခံရန္ Right – click ႏိွပ္ပါ။

 Spline ၏ ေနာက္ဆံုးအပိုင္းကို tangent လုပ္ရန္ cursor ကုိ move ျပီး click ပါ။

Procedure: Editing a Spline

Drawing အတြင္းမွ Spline ကို grips အသံုးျပဳျပီး editing လုပ္ျခင္းကုိ ေအာက္တြင္ အဆင့္ဆင့္ ေဖာ္ျပေပးထား ပါသည္။

၁) Command line တြင္ blank အေနထားျဖင့္ Spline ကုိ select ပါ။
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၂) Grip control point (1) ကို select ျပီး new location (2) သုိ႕ drag ျပီး Click ပါ။

၃) Grip အသံုးျပဳျပီး spline ကိုျပင္ဆင္ျပီးပါက Esc ႏိွပ္ပါ။

Procedure: Convert Spline to Polyline

Spline မွ polyline သုိ႕ ေျပာင္းပုံကို ေအာက္တြင္ အဆင့္ဆင့္ ေဖာ္ျပေပးထားပါသည္။

၁) Command line တြင္ blank အေနထားျဖင့္ Spline ကုိ select ပါ။

၂) Drawing area တြင္ Right–click ႏိွပ္ျပီး Spline ကုိ click ပါ။
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၃) အကယ္၍ Dynamic Input သည္ turned off ျဖစ္ေနလွ်င္ drawing area တြင္ Right–click ႏိွပ္ျပီး Convert to Polyline ကုိ click

ပါ။ အကယ္၍ Dynamic Input ကုိ turned on ေပးထားပါက menu သည္အလို အေလ်ာက္ ေပၚလာမည္ ျဖစ္သည္။

၄) Command line တြင္ တိက်ေသာ တန္ဖိုး တစ္ခုကုိရိုက္ထည့္၍ ေသာ္လည္း (သုိ႕မဟုတ္) default value ကိုလက္ခံရန္ Enter ႏိွပ္ပါ။

Spline သည္ polyline သို႕ေျပာင္းသြားမည္ ျဖစ္သည္။

၅) Polyline ကို view (သို႕မဟုတ္) edit လုပ္ရန္ select ပါ။

Exercise: Create a Spline

ဤေလ့က်င့္ခန္းတြင္ ေပးထားေသာ အမွတ္မ်ားကုိ ျဖတ္ျပီး Spline ကုိဖန္တီးသြားရမည္ ျဖစ္သည္။
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The completed exercise

၁) C_Spline.dwg ကုိဖြင့္ပါ။

၂) Object snap မွ Note mode တစ္ခုတည္းကုိသာ select ပါ။

၃) ေအာက္ေဖာ္ျပပါ area ကုိ zoom ခ်ဲ႕လုိက္ပါ။

၄) Home tab, click Draw panel > Spline.

၅) Spline ဖန္တီးရန္ -

 Spline ကုိစတင္ရန္ ေအာက္ဆံုးမွ magenta point ကုိ click ပါ။

 က်န္ရိွေနေသးေသာ အမွတ္ခုနွစ္မွတ္လုံးကို ေအာက္မွ အေပၚသုိ႕ ဆက္တုိက္ click သြားပါ။

 အမွတ္အားလံုးကို selecting လုပ္ျပီးပါက right – click ႏိွပ္ပါ။

 Enter ႏိွပ္ပါ။
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 Start tangent ကုိသတ္မွတ္ေပးရန္ prompted ပါက Right-click နိွပ္ပါ။

၇) End tangent ကုိသတ္မွတ္ေပးရန္ -

 ေနာက္ဆုံးအမွတ္ကို ျဖတ္ျပီး ညာဖက္တြင္ tangency ကုိသတ္မွတ္ေပးရန္ cursor ကုိေအာက္တြင္ေဖာ္ျပ ေပးထားသည့္

အတိုင္း အထက္သုိ႕ move ပါ။

 Spline ကုိ complete ျဖစ္သြားေစရန္ drawing area တြင္ click လိုက္ပါ။

၈) Files အားလံုးကို မ Save ပဲပိတ္လိုက္ပါ။

Lesson: Creating Ellipses
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ဤသင္ခန္းစာတြင္ Ellipse command ျဖင့္ ellipses နဲ႕ elliptical arcs မ်ားဖန္တီးပုံကို တင္ျပသြားမည္ ျဖစ္သည္။ Drawing အတြင္းမွ

ellipses နဲ႕ elliptical arcs ဥပမာ တစ္ခ်ိဳ႕ကို ေဖာ္ျပေပးထားပါသည္။ မိမိတုိ႕၏ designs မ်ားတြင္ elliptical shape ကိုလိုအပ္ပါက၊

ellipses န႕ဲ elliptical arcs မ်ားကို lines နဲ႕ circles က႕ဲသုိ႕ေသာ geomentry မ်ားဖန္တီးသကဲ႕သို႕ လြယ္ကူစြာ ဖန္တီးႏိုင္ပါသည္။

Objectives

ဤသင္ခန္းစာကို ေလ့လာျခင္း ျပီးစီးသြားပါက -

 Ellipses အေၾကာင္းကို နားလည္သေဘာေပါက္ လာေစရန္။

 Ellipses objects မ်ား ဖန္တီးတတ္လာေစရန္။

About Ellipses

Ellipse command သည္ closed ellipse ကုိဖန္တီးေပး ႏိုင္ပါသည္။ Ellipse Arc command သည္ ellipse အပိုင္းေလး မ်ားကို

ဖန္တီးေပးႏိုင္ပါသည္။ အဆိုပါ objects နွစ္မ်ိဳးစလံုးကုိ အျခား objects မ်ား modify လုပ္ေသာ နည္းလမ္းကို အသုံးျပဳျပီး modify

လုပ္ႏိုင္ပါသည္။



“Workgroup” AotoCAD & 3ds Max Job Training Center မွ ပညာဒါန အခမ့ဲ ျဖန္႔ေ၀သည္။

( ဤစာအုပ္ကုိ ေငြေၾကးျဖင့္ ျပန္လည္ေရာင္းခ် ခြင့္မျပဳပါ )

ေအာင္ေဇာ္လတ္ {(Master of Engineering in Science and Production Engineering) Moscow State University Of Railway Engineering}

ဘာသာျပန္ ေရးသား ျပဳစုသည္။

“Workgroup “ AutoCAD & 3ds Max Training Center, International Computer Driving Licence Approved Test Center,
Rm- 403, Excel Tower, Yangon, Myanmar.

Ph: 951 559377 Ext: 6413 or 6403, Email – infor@workgroupweb.com

316

Definition of Ellipse

Ellipse သည္ fixed points 4 points၊ major ၀င္ရိုး အျဖစ္သတ္မွတ္ ထားေသာ ၀င္ရိုးအရွည္ႏွင့္ minor ၀င္ရိုးအျဖစ္

သတ္မွတ္ထားေသာ ၀င္ရိုး အျဖစ္သတ္မွတ္ ထားေသာ ၀င္ရိုးအတုိ၊ center ႏွင့္ quadrant point တို႕ျဖင့္ ပါ၀င္ဖြ႕ဲစည္းထားသည့္ closed

curve ျဖစ္ပါသည္။

Object snap က quadrant ဟုေဖာ္ျပေပးေသာ ေနရာသည္ ၀င္ရိုး၏ end point ျဖစ္ပါသည္။
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Creating an Ellipse Arc

Displa လုိသည့္ arc အပိုင္း၏ parameters ေပးကာ ellipse ဖန္တီးသည့္ နည္းလမ္းအတုိင္း ellipse arc ကုိလည္း

ဖန္တီးေပးႏိုင္ပါသည္။ Ellipse ကုိဖန္တီးျပီး လိုခ်င္ေသာ အပိုင္းကုိသာ trimming လုပ္ေသာ နည္းလမ္းျဖင့္လည္း ellipse arc

ကိုဖန္တီးႏိုင္ပါသည္။ Ellipse Arc command မွ arc option ကိုအသံုးျပဳ၍ လည္းေကာင္း (သို႕မဟုတ္) ellipse arc command

ကိုအသံုးျပဳ၍ လည္းေကာင္း ellipse arc ကုိဖန္တီးႏုိင္ပါသည္။

Example of Ellipses

Ellipses and arcs သည္ drawing အတြင္းတြင္ objects မ်ား၏ isometric view ေရးဆြဲရာတြင္ လြန္စြာ အသုံး၀င္ လွပါသည္။

Creating Ellipses
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Ellipse object ဖန္တီးရန္ အတြက္ Ellipse command ကိုအသံုးျပဳ သြားရပါမည္။ Major ၀င္ရိုးႏွင့္ minor ၀င္ရိုးတုိ႕ intersect ျဖစ္ေသာ

ေနရာကို Midpoint ဟုသတ္မွတ္ျပီး၊ တစ္ခုႏွင့္တစ္ခု ေထာင့္မွန္က်ေနသည့္ smooth curve shape သည္ Ellipse ျဖစ္ပါသည္။ Ellipse

ကိုဖန္တီးေသာ ေသာအခါ၊ ၀င္ရိုးတစ္ခုတြင္ start point ႏွင့္ end point သတ္မွတ္ေပးျပီး၊ က်န္၀င္ရိုးတြင္ end point ကိုသတ္မွတ္ေပး၍

လည္းေကာင္း၊ (သို႕မဟုတ္) ellipse ၏ center point ကုိသတ္မွတ္ေပးျပီး ထုိ center point ျဖင့္ ဆက္စပ္ေနေသာ ၀င္ရိုး၏ end point

ကိုသတ္မွတ္ ေပး၍လည္းေကာင္း ဖန္တီးႏိုင္ပါသည္။

ေအာက္တြင္ေဖာ္ျပ ေပးထားေသာ ပုံမွ အေပၚဘယ္ဖက္ ellipse သည္ major ၀င္ရိုးႏွင့္ minor ၀င္ရိုးမ်ဥ္းမ်ား ပါ၀င္ေသာ

ဘယ္ဖက္ေအာက္မွ ellipse ႏွင့္တူညီပါသည္။ Major ၀င္ရိုးႏွင့္ minor ၀င္ရိုးမ်ဥ္းမ်ား တစ္၀က္စီ ပါ၀င္ေနေသာ အေပၚညာဖက္ elliptical

arc နွင့္ ညာဖက္ေအာက္မွ elliptical arc သည္တူညီပါသည္။

Ellipse (သို႕မဟုတ္) elliptical arc ဖန္တီးျခင္းတြင္ အဆင့္သံုးဆင့္ျဖင့္ ဖန္တီးသြားရပါမည္။ Procedure သည္မိမိတို႕ ဖန္တီးလုိေသာ

ပုံစံတြင္ မူတည္ပါသည္။

Command Access

Ellipse/ Ellipse Arc

Command Line: ELLIPSE

Ribbon: Home tab > Draw panel > Center/Axis, End/Elliptical Arc



“Workgroup” AotoCAD & 3ds Max Job Training Center မွ ပညာဒါန အခမ့ဲ ျဖန္႔ေ၀သည္။

( ဤစာအုပ္ကုိ ေငြေၾကးျဖင့္ ျပန္လည္ေရာင္းခ် ခြင့္မျပဳပါ )

ေအာင္ေဇာ္လတ္ {(Master of Engineering in Science and Production Engineering) Moscow State University Of Railway Engineering}

ဘာသာျပန္ ေရးသား ျပဳစုသည္။

“Workgroup “ AutoCAD & 3ds Max Training Center, International Computer Driving Licence Approved Test Center,
Rm- 403, Excel Tower, Yangon, Myanmar.

Ph: 951 559377 Ext: 6413 or 6403, Email – infor@workgroupweb.com

319

Command Options

Ellipse (သုိ႕မဟုတ္) elliptical arc မ်ားဖန္တီးရာတြင္ ေအာက္ေဖာ္ျပပါ options မ်ားကုိ အသုံးျပဳသြား ရပါမည္။

Option Description

Center Center point ကိုသတ္မွတ္ေပးျပီး ထို center point ျဖင့္ ဆက္စပ္ေနေသာ ၀င္ရိုး၏ end point

ကုိသတ္မွတ္ ေပး၍ ellipse ဖန္တီးရာတြင္ ဤ option ကိုအသံုးျပဳ သြားရပါမည္။

Arc Elliptical arc (သုိ႕မဟုတ္) full continuous ellipse မ်ားဖန္တီးရန္ command sequence သို႕

prompts မ်ား add ျခင္းျဖင့္ ေရးဆြဲလုိလွ်င္ ဤ option ကုိ အသုံးျပဳသြား ရပါမည္။

Axi,End ၀င္ရိုးတစ္ခုတြင္ start point ႏွင့္ end point သတ္မွတ္ေပးျပီး၊ က်န္၀င္ရိုးတြင္ end point ကုိသတ္

မွတ္ေပး၍ ellipse ဖန္တီးလိုလွ်င္ ဤ option ကိုအသုံုးျပဳသြား ရပါမည္။

Procedure: Creating an Ellipse

၀င္ရိုး၏ endpoint ကုိသတ္မွတ္ေပးျခင္းျဖင့္ ellipse ဖန္တီးပုံကို ေအာက္တြင္ အဆင့္ဆင့္ ေဖာ္ျပေပးထား ပါသည္။

၁) Ribbon, click Home tab > Draw panel > Ellipse.

၂) ပထမ axis ၏ endpoint (1) ႏွင့္ အျခားေသာ axis ၏ endpoint (2) ကုိသတ္မွတ္ေပးရန္ click ပါ။
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၃) Distance သတ္မွတ္ေပးရန္ အျခားေသာ axis ၏ endpoint (3) ကုိသတ္မွတ္ေပးရန္ click ပါ။

 Completed ျဖစ္သြားေသာ ellipse ကုိရရွိလာမည္ ျဖစ္ပါသည္။

မွတ္ခ်က္။ ။ အျခားေသာ ellipse option ကိုအသံုးျပဳလိုလွ်င္ command line prompts တြင္ေရြးခ်ယ္ျပီး အသံုးျပဳ ႏုိင္ပါသည္။ Right –

clickႏိွပ္ျပီး shortcut menu မွလည္း ေရြးခ်ယ္အသံုးျပဳ ႏိုင္ပါသည္။

Procedure: Creating an Elliptical Arc

Elliptical arc ဖန္တီးပုံကုိ ေအာက္တြင္ အဆင့္ဆင့္ ေဖာ္ျပေပးထားပါသည္။ အစပိုင္း အဆင့္မ်ားသည္ ellipse ဖန္တီးပုံႏွင့္

ထပ္တူပင္ျဖစ္သည္။

၁) Ribbon, click Home tab > Draw panel > Ellipse Arc.

၂) ပထမ axis ၏ endpoint (1) ႏွင့္ အျခားေသာ axis ၏ endpoint (2) ကို သတ္မွတ္ေပးရန္ click ပါ။
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၃) Distance သတ္မွတ္ေပးရန္ အျခားေသာ axis ၏ endpoint (3) ကုိသတ္မွတ္ေပးရန္ click ပါ။

၄) Start angle position (4) သတ္မွတ္ေပးရန္ cursor ကုိ move ပါ။

၅) End angle (5) သတ္မွတ္ေပးရန္ cursor ကုိ move ပါ။ Polar angle သည္ 45 ဒီဂရီျဖစ္သြားမည္ကို သတိထား ေလ့လာၾကည့္ပါ။

မွတ္ခ်က္။ ။ မိမိတုိ႕ သတ္မွတ္လိုက္ေသာ start နဲ႕ end angle ၾကားမွ ellipse ၏အစိတ္အပိုင္းသည္ removed ျဖစ္သြားမည္။
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Exercise: Create Ellipses

ဤလက္ေတြ႕ ေလ့က်င့္ခန္းတြင္ Ellipse command ျဖင့္ full ellipses နွစ္ခုကုိ မတူညီေသာ နည္းလမ္းနွစ္မ်ိဳးျဖင့္

ဖန္တီးသြားရမည္ျဖစ္သည္။ Ellipse တစ္ခုကို trim လုပ္ျခင္းျဖင့္ elliptical arc ဖန္တီးျခင္း၊ ellipse command ျဖင့္ elliptical arc

ဖန္တီးျခင္း စသည္နည္းလမ္း နွစ္မ်ိဳးျဖင့္ ေလ့က်င့္သြားရမည္ ျဖစ္ပါသည္။

The completed exercise

၁) C_Ellipse.dwg ကိုဖြင့္ပါ။

၂) Top view ၏မျပီးဆုံးေသးေသာ area ကို zoom ခ်ဲ႕လိုက္ပါ။

၃) Inclined surface မွထိပ္ဆုံးတြင္ ရိွေသာ hole ကုိကိုယ္စားျပဳေပးေသာ ellipse ကုိဖန္တီးရန္ -

 Home tab, click Draw panel > Ellipse.

 ေအာက္ေဖာ္ျပပါ ပုံတြင္ ညြန္ျပထားေပးေသာ ျမွားမ်ားအနက္ ေအာက္ဆံုးျမွားေနရာ intersection point တြင္ first point

ကိုသတ္မွတ္ေပးပါ။

 ေအာက္ေဖာ္ျပပါ ပုံတြင္ ညြန္ျပထားေပးေသာ ျမွားမ်ားအနက္ အေပၚဆုံးျမွားေနရာ intersection point တြင္ second point

ကိုသတ္မွတ္ေပးပါ။

 Third point အတြက္ ညာဖက္ဆံုးတြင္ ညႊန္ျပထားေသာ ျမွားေနရာတြင္ သတ္မွတ္ေပးရန္ click ပါ။
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၄) ) Inclined surface မွေအာက္ေျခတြင္ ရိွေသာ hole ကုိကုိယ္စားျပဳေပးေသာ ellipse ကုိဖန္တီးရန္ -

 Home tab, click Draw panel > Ellipse.

 Right-click ႏိွပ္ျပီး Center ကုိ Click ပါ။

 ေအာက္ပုံတြင္ ျပထားသည့္ အတုိင္း previous ellipse ၏ဘယ္ဖက္ intersection ကုိ click ပါ။

၅) Cursor ကိုအေပၚတည့္တည့္သုိ႕ ေရြ႕ျပီး intersection point ေနရာတြင္ click ပါ။

၆) First ellipse ၏ center ကို click ပါ။

၇) Second ellipse မွအပိုင္းကုိ trim လုပ္ရန္ -

 Trim command ကုိစတင္လုိက္ပါ။

 Cutting edge အျဖစ္ first ellipse ကုိ click ပါ။
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 Trim လုပ္မည့္ second ellipse ၏ ဘယ္ဖက္အျခမ္းကို click လုိက္ပါ။

 ဘယ္ဖက္ ellipse ကို trimed လုပ္ျပီးသြားပါက elliptical arc ျဖစ္သြားေသာ ေအာက္ေဖာ္ျပပါ ပုံကုိ ေလ့လာၾကည့္ပါ။

၈) Top view မွ inclined surface ၏ outer edge ကုိကိုယ္စားျပဳေသာ ellipse ကိုဖန္တီးရန္ -

 Home tab, click Draw panel > Ellipse.

 Right-click ႏိွပ္ျပီး Arc ကို Click ပါ။

 Right-click ႏိွပ္ျပီး Center ကုိ Click ပါ။

၉) First ellipse ၏ center point ကုိ click ပါ။

၁၀) ေရျပင္ညီမ်ဥ္း၏ end ကိုsnap ျပီး၊ first axis ၏ endpoint တြင္သတ္မွတ္ေပးပါ။

၁၁) ညာဖက္တြင္ရိွေသာ intersection ကို snap ျပီး၊ second axis ၏ endpoint တြင္သတ္မွတ္ေပးပါ။
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၁၂) ေရျပင္ညီမ်ဥ္း၏ end ကိုsnap ျပီး၊ start angle ကုိသတ္မွတ္ေပးပါ။

၁၃) ထိပ္တြင္ရိွေသာ ေရျပင္ညီမ်ဥ္း၏ end ကုိsnap ျပီး၊ end angle တည္ေနရာကို သတ္မွတ္ေပးပါ။

၁၄) Layer construction ကုိ Freeze လုပ္ပါ။ Completed ျဖစ္သြားေသာ drawing ကိုၾကည့္ရန္ Zoom ခ်ဲ႕လိုက္ပါ။

၁၅) Files အားလုံးကို မ Save ပိတ္လိုက္ပါ။

Lesson: Using Tables

ဤသင္ခန္းစာတြင္ table styles ကုိဖန္တီးပုံနွင့္ modify လုပ္ပုံတို႕ကို ေလ့လာသြားရမည္ ျဖစ္သလုိ၊ Tablestyle and Table

commands တုိ႕ကိုအသုံးျပဳျပီး tables မ်ားဖန္တီးပုံကိုလည္း တင္ျပသြားမည္ ျဖစ္သည္။ လိုအပ္ေသာ တန္ဖိုးမ်ား ၾကည့္ႏိုင္ရန္ drawing

အတြင္း၌ table ဖန္တီးျပီး ေဖာ္ျပႏိုင္ပါသည္။ ဥပမာ အားျဖင့္ - ထုိသို႕ တန္ဖိုးမ်ား ျဖည့္စြက္လိုပါက ေအာက္တြင္ ျပထားသည့္ အတုိင္း

tabulated dimensions မ်ားကုိ ဖန္တီးသြားရမည္ ျဖစ္သည္။
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ေအာက္ေဖာ္ျပပုံသည္ tabular dimension table ကိုကုိယ္စားျပဳေသာ ပုံျဖစ္သည္။

Objectives

ဤသင္ခန္းစာကို ေလ့လာျခင္း ျပီးစီးသြားပါက -

 Tables မ်ားအေၾကာင္းကုိ သိရိွသြားေစရန္။

 Tablestyle command ကိုအသံုးျပဳျပီး table styles ကုိဖန္တီးတတ္ေစရန္။

 Tables မ်ားဖန္တီးျပီး၊ table cells မ်ားတြင္ တန္ဖိုးမ်ား ရုိက္ထည့္ျခင္းကုိ နားလည္သြားေစရန္။

About Tables

Table ကုိအသံုးျပဳျပီး data မ်ားကုိ columns and rows အလိုက္ organize လုပ္ေပးႏိုင္ပါသည္။ Table တြင္ ရိုက္ထည့္ေပး၍

လည္းေကာင္း (သုိ႕မဟုတ္) special attributes ျဖင့္ block ပါ၀င္ေသာ object မွ extracted လုပ္၍လည္းေကာင္း data မ်ားထည့္ေပး

ႏိုင္ပါသည္။ Table အတြင္းသုိ႕ information ထည့္ခ်ိန္တြင္ rows and columns ကို format လုပ္ႏိုင္သလုိ၊ formulas ကုိလည္း apply

လုပ္ႏိုင္ပါသည္။
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Definition of a Table

Row number and column letter ျဖင့္ cells မ်ားကုိ သတ္မွတ္ေပးထားျပီး၊ ၎ individual cells မ်ား array သဏၭာန္ျဖင့္ rows and

columns မ်ားပါ၀င္ေနသည္ကို table ဟုေခၚပါသည္။

Table သည္ database ျဖစ္ျပီး၊ ၎သည္ AutoCAD program အတြင္းတြင္သာ တည္ရိွပါသည္။

Example of Using Tables

Table command ကိုအသံုးျပဳျပီး မိမိတုိ႕၏ drawing တြင္ tables မ်ားကုိ insert လုပ္ႏိုင္ပါသည္။ Rows and columns ၏

အေရအတြက္မ်ား၊ heading style မ်ားနွင့္အျခားေသာ parameters မ်ားကုိသတ္မွတ္ေပး ရပါမည္။ Drawing အတြင္းတြင္ မတူညီေသာ

table styles မ်ားကိုလည္း အသံုးျပဳသြားႏိုင္ပါသည္။
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Insert table လုပ္ျခင္းသည္ OLE Objects (Object Linking and Embedding) ကိုအသံုးျပဳျပီး အျခားေသာ program မွ external

database မ်ား inserting လုပ္ျခင္းနွင့္ မတူညီေပ။

Creating Table Styles

Table styles ဖန္တီးျခင္းသည္ dimension styles ဖန္တီးျခင္းႏွင့္ သေဘာတရားျခင္း အတူတူပင္ ျဖစ္သည္။ အဘယ့္ေၾကာင့္ ဆိုေသာ္

drawing အတြင္းတြင္ ဖန္တီးမည့္ table styles အတြက္ အရင္ဆုံး လုိခ်င္ေသာ format ရေအာင္ ျပင္ဆင္ေပးရပါသည္။ Tablestyle
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command ကုိအသံုးျပဳျပီး tables မ်ားကုိ create and manage မ်ားျပဳလုပ္ႏိုင္ပါသည္။ Table styles မ်ားကို တစ္ခု (သို႕မဟုတ္)

တစ္ခုထက္ပိုျပီး ဖန္တီးႏိုင္ပါသည္။ သုိ႕ေသာ္ new drawing တစ္ခုတုိင္းတြင္ standard အမည္ရေသာ table style တစ္ခုသာ

ပါ၀င္ပါသည္။ အကယ္၍ additional table styles မ်ားဖန္တီးေသာအခါ၊ current table style အျဖစ္ သတ္မွတ္ေပးရန္ Styles toolbar

Table ေပၚမွ Styles list ကုိအသုံးျပဳသြား ရပါမည္။

Drawing အတြင္းတြင္ အသံုးျပဳမည့္ table styles ကို လက္ရိွ style မွအျခားေသာ style တစ္ခု ေျပာင္းလဲ အသုံးျပဳရာတြင္ dimension

styles မ်ားေျပာင္းလဲျခင္း ကဲ႕သို႕ပင္ update လုပ္ေပးရပါသည္။ ေအာက္တြင္ ေဖာ္ျပထားေသာ ပုံသည္ table style ကို modifying

လုပ္ျခင္း၏ effect ကိုျပထားေသာ ပုံျဖစ္ပါသည္။

Command Access

Table Styles

Command Line: TABLESTYLE

Ribbon: Home tab > Annotation extended panel > Table Style



“Workgroup” AotoCAD & 3ds Max Job Training Center မွ ပညာဒါန အခမ့ဲ ျဖန္႔ေ၀သည္။

( ဤစာအုပ္ကုိ ေငြေၾကးျဖင့္ ျပန္လည္ေရာင္းခ် ခြင့္မျပဳပါ )

ေအာင္ေဇာ္လတ္ {(Master of Engineering in Science and Production Engineering) Moscow State University Of Railway Engineering}

ဘာသာျပန္ ေရးသား ျပဳစုသည္။

“Workgroup “ AutoCAD & 3ds Max Training Center, International Computer Driving Licence Approved Test Center,
Rm- 403, Excel Tower, Yangon, Myanmar.

Ph: 951 559377 Ext: 6413 or 6403, Email – infor@workgroupweb.com

330

Ribbon: Annotate tab > Tables panel > Table Style

Table Style Dialog Box

Table Style dialog box ကိုအသံုးျပဳျပီး table styles မ်ား create ျခင္း, modify လုပ္ျခင္းန႕ဲ manage လုပ္ျခင္း တို႕ကိုျပဳလုပ္

သြားႏိုင္ပါသည္။
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Current table style အျဖစ္ သတ္မွတ္ေပးလုိေသာ table style ကုိ select ေပးရပါမည္။

Selected style ကုိ current အျဖစ္ သတ္မွတ္ေပးရာတြင္ click ရပါမည္။

Selected style ေပၚမူတည္ျပီး new style ဖန္တီးရန္ click ပါ။

Selected style ကုိ edit လုပ္ရန္ click ပါ။

New Table Style Dialog Box

New Table Style dialog box ကိုအသုံးျပဳျပီး new table style ၏ properties မ်ားကို ျပင္ဆင္သတ္မွတ္ ေပးသြား ရပါမည္။
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Default table style (သုိ႕မဟုတ္) own style တစ္ခုခုကို new style အတြက္ basis အျဖစ္အသုံးျပဳရန္။

Table ၏ direction - up or down ကုိ select ေပးရန္။

ျပဳျပင္လိုက္သာ table style ၏ preview ကုိရည္ညြန္းပါသည္။

Data, Header န႕ဲ Title cells အတြက္ မိမိတို႕၏ style ကို Creat နဲ႕ Save လုပ္ျခင္း။

Data, Header န႕ဲ Title cells တုိ႕၏ properties တို႕ကို ျပင္ဆင္ သတ္မွတ္ျခင္း။

ေရြးခ်ယ္ထားေသာ cell style ၏ margins မ်ားကုိ ျပင္ဆင္သတ္မွတ္ေပးရမည္။ Data, Header န႕ဲ Title cells မ်ားအတြက္

မတူညီေသာ margins မ်ားကုိ ျပင္ဆင္သတ္မွတ္ေပး ႏိုင္ပါသည္။

Procedure: Creating Table Styles

Table styles မ်ားဖန္တီးပုံကုိ ေအာက္တြင္ အဆင့္ဆင့္ ေဖာ္ျပေပးထား ပါသည္။

၁) Tablestyle command ကုိစတင္လုိက္ပါ။

၂) Table Style dialog box မွ New ကို click ပါ။
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၃) New table style အတြက္ အမည္ကုိ ရိုက္ထည့္ေပးပါ။ Start With list မွ existing style ကို select ပါ။ Continue ကို click ပါ။

၄) New Table Style dialog box တြင္ Data, Header န႕ဲ Title cells မ်ားအတြက္ Cell styles area ၌ general, text န႕ဲ borders

properties မ်ားကုိ ျပဳျပင္ပါ။

၅) Table Style dialog box တြင္ new table style ကို current style ျပဳလုပ္ေပးရန္ double-click ႏိွပ္လိုက္ပါ။

Creating Tables and Entering Table Data

Tables မ်ား Inserting လုပ္ရာတြင္ အဓိကအဆင့္ၾကီး (၃) ဆင့္ရိွပါသည္။ ပထမဆုံး အေနနဲ႕ table style ကို select ရပါမည္။ ဒုတိယ

အေနန႕ဲ drawing အတြင္းတြင္ table ကုိေနရာ သတ္မွတ္ေပးရပါမည္။ တတိယ အေနန႕ဲ cells မ်ားတြင္ data မ်ား ရုိက္ထည့္ေပးသြား

ရပါမည္။ Insert Table dialog box ၌ style ကုိ select လုပ္ေသာ အခါတြင္ columns and data rows ၏ number န႕ဲ size

မ်ားကိုလည္း ျပင္ဆင္သတ္မွတ္ ေပးႏိုင္ပါသည္။

Cell ကို double – click ႏိွပ္ကာ In-Place Text Editor အသံုးျပဳျပီး data မ်ားကုိ ရိုက္ထည့္ေပးသြား ရပါမည္။ Multiline text ကုိ edit

လုပ္ေသာ နည္းလမ္းျဖင့္ သေဘာတရားျခင္း အတူတူပင္ ျဖစ္ပါသည္။ Cells မ်ားတစ္ခုမွ တစ္ခုသုိ႕ ကူးေျပာင္းရာတြင္ keyboard မွ TAB

or ARROW key မ်ားကုိ အသံုးျပဳသြား ႏိုင္ပါသည္။

Cell ကို Single-click ႏိွပ္ျပီး table formatting options ကို access ႏိုင္ပါသည္။
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Command Access

Table

Command Line: TABLE

Ribbon: Home tab > Annotation panel > Table

Ribbon: Annotate tab > Tables panel > Table
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Insert Table Dialog Box

Table ကို insert လုပ္ရာ၌ ပထမဆုံးအေနနဲ႕new table တြင္အသံုးျပဳသြားမည့္ table style ကုိ select ေပးရပါမည္။ ထို႕ေနာက္ table

ကို insert လုပ္ေပးမည့္ point ကိုသတ္မွတ္ေပးရပါမည္။ Columns အေရတြက္၊ column width, data rows အေရတြက္ န႕ဲ row

height တုိ႕ကို ျပင္ဆင္ သတ္မွတ္ေပးရန္အတြက္ Column & Row Settings ေအာက္ရိွ options မ်ားကို အသံုးျပဳသြားရပါမည္။

မိမိတို႕ ႏွစ္သက္ေသာ table style ကို select ပါ (သုိ႕မဟုတ္) new style ကုိ ဖန္တီးရန္ click ပါ။
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Insert option ကို select ရန္ -

 Start from an empty table.

 From a data link. Existing spreadsheet ကို table အေနန႕ဲ link ခ်ိတ္ျပီး အသုံးျပဳလုိလွ်င္ ဤ option ကုိ select ရပါမည္။

 From object data in the drawing. Drawing အတြင္းရိွ existing object မွ data မ်ားကုိ extract လုပ္လုိလွ်င္ ဤ option

ကို select ရပါမည္။

Corner point သတ္မွတ္၍ လည္းေကာင္း (သုိ႕မဟုတ္) windowed area အတြက္ selecting လုပ္၍ လည္းေကာင္း table ကုိ

insert လုပ္ရန္ ေရြးခ်ယ္ရပါမည္။

Columns and rows အေရအတြက္, column width န႕ဲ row spacing တုိ႕ကုိေရြးခ်ယ္ေပးရပါမည္။

First row cell , second row cell နွင့္ All other row cells မ်ားအတြက္ cell style ကုိေရြးခ်ယ္ေပးရပါမည္။

သတ္မွတ္လုိက္ေသာ setting ကို စစ္ေဆးရန္ Preview တြင္ၾကည့္ႏိုင္ပါသည္။

Procedure: Inserting a Table

Tables မ်ား inserting လုပ္ပုံကုိ ေအာက္တြင္ အဆင့္ဆင့္ ေဖာ္ျပေပးထားပါသည္။

၁) Table command ကိုစတင္လိုက္ပါ။

၂) Insert Table dialog box မွ table style ကုိ select ပါ။ Insert Behavior and Column and Row Settings options တြင္

လုိအပ္သလို သတ္မွတ္ေပးပါ။ Ok ကို click ပါ။

၃) Table အတြက္ insertion point ကုိသတ္မွတ္ေပးပါ။ အကယ္၍ Specify Window option ကုိအသုံးျပဳမည္ ဆိုလွ်င္ table size

အတြက္ အမွတ္ႏွစ္မွတ္ သတ္မွတ္ေပးသြား ရပါမည္။

 Table အတြင္းမွ first cell သည္ edit လုပ္ရန္ အလိုအေလ်ာက္ activated ျဖစ္ေနေပလိမ္႕မည္။
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Procedure: Navigating and Entering Table Data

Table အတြင္းသုိ႕ data မ်ား entering and navigating လုပ္ျခင္းတုိ႕ကို ေအာက္တြင္ အဆင့္ဆင့္ ေဖာ္ျပေပးထား ပါသည္။

၁) In-Place Text Editor ကုိစတင္ရန္ table အတြင္းမွ cell ကုိ Double-click ႏိွပ္ပါ။ Cell အတြင္းတြင္ ရိုက္ထည့္ လုိေသာ တန္ဖိုးကုိ

ရိုက္ထည့္ေပးပါ။

၂) အျခားေသာ cell သုိ႕ navigate ရာတြင္၊ TAB key ကိုႏိွပ္ျပီး ညာဖက္သုိ႕ ေရြ႕ရမည္ျဖစ္ျပီး၊ SHIFT+TAB ကုိႏိွပ္ကာ

ဘယ္ဖက္သုိ႕ေရြ႕ႏိုင္ပါသည္။ (သို႕မဟုတ္) ARROW keys မ်ားျဖင့္ သြားလုိေသာ ဦးတည္ဘက္ကုိ ေရြ႕ေျပာင္းႏိုင္ပါသည္။

၃) Table အတြင္းမွ အျခားေသာ cells မ်ားကုိ ရည္ညြန္းရန္ standard spreadsheet-style formulas ကုိ cells အတြင္းသို႕

ရိုက္ထည့္ႏိုင္ပါသည္။

၄) Auto-Fill grip ကုိအသံုးျပဳျပီး cell တစ္ခုအတြင္းမွ formula or value ကုိ multiple cells မ်ားသို႕ copy လုပ္ႏိုင္ပါသည္။ Copied

ျဖစ္သြားရန္ cell ကုိ click ျပီးလွ်င္၊ cell ၏ Auto-Fill grip (1) ကုိ click ပါ။ Mouse ကို copy လုပ္မည့္ cell ေပၚတြင္ up or down drag

လုပ္ျပီး၊ last cell ကို complete ျဖစ္ေစရန္ copy (2) ကို click ပါ။
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၅) Table ကို editing လုပ္ျခင္း ျပီးဆံုးသြားေစရန္ Esc ကိုႏိွပ္ပါ။

Exercise: Create a Dimension Table

ဤေလ့က်င့္ခန္းတြင္ Tablestyle command ကုိအသုံးျပဳျပီး new table style ကိုဖန္တီးေပးသြား ရပါမည္။ Design အတြက္ tabulated

dimensions ပါ၀င္ေသာ new table ကုိ ဖန္တီးပါ။ Static values ကုိ table အတြင္းသုိ႕ ရိုက္ထည့္ျပီး၊ formula အတုိင္း အျခားေသာ

cells မ်ားသို႕လည္း copy လုပ္ေပးသြားရမည္။
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The completed exercise

၁) M_Create-Table.dwg ကုိဖြင့္ပါ။

၂) New table style ဖန္တီးျပီး current အျဖစ္သတ္မွတ္ေပးရန္ -

 Annotation panel (or Annotate tab> Tables panel) မွ Table Style ကုိ click ပါ။

 Table Style dialog box မွ New ကုိ click ပါ။

 Create New Table Style dialog box တြင္ NT-2.5 ကုိရိုက္ထည့္ေပးပါ။

 Continue ကုိ click ပါ။

၃) Data cells အတြက္ text height ကိုသတ္မွတ္ေပးရန္ -
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 Data Cell style ကုိ click ပါ။

 Text tab ကုိ click ပါ။

 Text Height အတြက္ 2.5 ကုိ ရိုက္ထည့္ေပးပါ။

၄) Column cells အတြက္ text height ကိုသတ္မွတ္ေပးရန္ -

 Header cell style ကုိ click ပါ။

 Text tab ကုိ click ပါ။

 Text Height အတြက္ 3.5 ကုိ ရိုက္ထည့္ေပးပါ။

 Ok ကုိ click ပါ။

၅) New table style ကုိ current အျဖစ္သတ္မွတ္ေပးရန္ -

 Table Style dialog box မွ new style ကုိ double-click ႏိွပ္ပါ။

 Close ကုိ click ပါ။
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၆) Drawing အတြင္းတြင္ table ကို ေနရာသတ္မွတ္ေပးရန္ -

 Table command ကုိစတင္ပါ။

 Insert Table dialog box အတြင္းရိွ Insertion Behavior ေအာက္မွ Specify Insertion Point ကုိ click ပါ။

 Column & Row Settings ေအာက္မွ options တြင္ေအာက္ေဖာ္ျပပါ ပုံအတိုင္း သတ္မွတ္ေပးပါ။

 Title row မပါေသာ table ကုိဖန္တီးရန္ Set Cell Styles ေအာက္မွ options မ်ားကို ေအာက္တြင္ ေဖာ္ျပေပး

ထားသည့္အတိုင္း သတ္မွတ္ေပးပါ။

 Ok ကုိ click ပါ။

၇) Table အတြက္ ေအာက္တြင္ေဖာ္ျပ ေပးထားသည့္ အတိုင္း insertion point ကုိသတ္မွတ္ေပးပါ။
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၈) Table အတြင္း၏ first cell သုိ႕ In-Place Text Editor ကုိေပၚလာေစျပီး editing လုပ္ျခင္း အတြက္ အဆင္သင့္ ျဖစ္ေစရန္ -

 PART NAME ဟုရိုက္ထည့္ျပီး TAB ကိုနိွပ္ပါ။

Tip: Cell အတြင္းတြင္ second line ဖန္တီးရန္ Alt + Enter ႏိွပ္ပါ။

 A ရိုက္ထည့္ျပီး TAB ကိုနိွပ္ပါ။

 B ရိုက္ထည့္ျပီး TAB ကိုနိွပ္ပါ။

 C ရိုက္ထည့္ျပီး TAB ကိုနိွပ္ပါ။ ေအာက္တြင္ေဖာ္ျပ ေပးထားသည့္ ပုံအတိုင္း ရရိွလာမည္ ျဖစ္သည္။

မွတ္ခ်က္။ ။ Table ကုိ move လုပ္လိုပါက၊ table ကို select ျပီး၊ ထိပ္ေထာင့္မွ grip ကို click ကာ move နိုင္ပါသည္။

၉) Table သို႕ Zoom in လုပ္လုိက္ပါ။

၁၀) Table အတြင္းမွ cells မ်ားသို႕ data မ်ား add ရန္-

 PART NAME ေအာက္မွ empty cell ကုိ double – click ႏိွပ္ပါ။
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 B762 ရုိက္ထည့္ျပီး DOWN ARROW ကုိႏွိပ္ပါ။

 Cells မ်ားအတြင္းသုိ႕ ေအာက္တြင္ျပထားသည့္ အတ္ိုင္း တန္ဖိုးမ်ားကို ရိုက္ထည့္ျပီး၊ ေအာက္ cell သုိ႕ေျပာင္းရန္ DOWN

ARROW ကုိနိွပ္ပါ။

၁၁) Table အတြင္းသို႕ တန္ဖိုးမ်ား ဆက္လက္ရိုက္ထည့္ သြားရန္ -

 Last row တြင္ တန္ဖိုးမ်ား ရိုက္ထည့္ျပီးသြားပါက next column သုိ႕ move ရန္ TAB key ကုိႏိွပ္ပါ။

 Table ၏ထိပ္သုိ႕ move ရန္ UP ARROW ကုိႏိွပ္ပါ။

 Column A အတြက္ ေအာက္တြင္ေဖာ္ျပ ေပးထားသည့္အတုိင္း တန္ဖိုးမ်ားကုိ ရိုက္ထည့္ပါ။

Tip: တန္ဖိုးမ်ားသည္ B မပါသည္မွ အပ PART NAME column မွတန္ဖိုးမ်ား အတိုင္းပင္ ျဖစ္ပါသည္။
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၁၂) Cell အတြင္းသို႕ formula ရိုက္ထည့္ရန္ -

 Next column အတြင္းမွ last row သို႕ move ရန္ TAB key ကိုႏိွပ္ပါ။

 =B6-76 ကိုရိုက္ထည့္ေပးပါ။ Cell B:6 ရိွတန္ဖိုးမွ 76 ကို ႏုတ္ျခင္းျဖစ္ပါသည္။

 In-Place Text Editor ကို ပိတ္ရန္ Ok ကုိ click ပါ။

၁၃) One cell မွ အျခားေသာ cells မ်ားသို႕ copy လုပ္ရန္ -

 Formula ပါရိွေသာ cell ကို highlight ျဖစ္သြားေစရန္ click လိုက္ပါ။

 Auto-Fill grip (1) ကုိ click ပါ။

 Cursor ကို အထက္(2) သုိ႕ move ပါ။

 ထိပ္ဆံုး cell (3) ၏တစ္ေနရာရာကို click လုိက္ပါ။

 Copied formula သည္အျခားေသာ cells မ်ားတြင္ pasted ျဖစ္သြားမည္ ျဖစ္ျပီး၊ cell numbers မ်ားန႕ဲ ပတ္သက္ေသာ

တန္ဖိုးမ်ားကို တြက္ခ်က္ေဖာ္ျပ ေပးသြားပါလိမ့္မည္။

 Selection ကုိ clear လုပ္ရန္ Esc key ႏိွပ္ပါ။
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၁၄) က်န္ရိွေနေသးေသာ data မ်ားကုိ column C သုိ႕ add ရန္ -

 Last column အတြင္းမွ first cell ကုိ double-click ႏိွပ္ပါ။

 ေအာက္တြင္ ေဖာ္ျပေပးထားသည့္ အတိုင္းတန္ဖိုးမ်ားကုိ ရိုက္ထည့္ေပးပါ၏

၁၅) မိမိတုိ႕၏ table အတြင္းမွ တန္ဖိုးမ်ားကို ေအာက္တြင္ ေဖာ္ျပေပးထားေသာ တန္ဖိုးမ်ားႏွင့္ ႏိႈင္းယွဥ္ၾကည့္ပါ။
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၁၆) Zoom extents လုပ္လုိက္ပါ။

၁၇) Files အားလုံးကို မ Save ပဲပိတ္လိုက္ပါ။

Challenge Exercise: Architectural

ဤလက္ေတြ႕ ေလ့က်င့္ခန္းတြင္ အထက္၌ ေလ့လာခ႕ဲျပီး ျဖစ္ေသာ table ဖန္တီးျခင္း၊ area ကိုတြက္ခ်က္ရန္ အတြက္ closed polyline

ဖန္တီးျခင္း၊ spline topographic lines ဖန္တီးျခင္း တို႕ကုိ လက္ေတြ႕ေလ့က်င့္သြား ရမည္ျဖစ္သည္။
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The completed exercise

Metric Units

၁) M_ARCH-Challenge- CHP11.dwg ကိုဖြင့္ပါ။

၂) Layer သတ္မွတ္ျပီး၊ contours ဖန္တီးပါ။

 Topo ဆုိေသာ layer ကို Thaw ျပီး current the existing layer အျဖစ္သတ္မွတ္ေပးပါ။

 Node to node မွ smooth curved contours ကုိေအာက္ေဖာ္ျပပါ ပုံအတုိင္း ေရးဆြဲလိုက္ပါ။
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၃) Fire station sits ေပၚမွ square area ကို calculate လုပ္ပါမည္။ ေအာက္ေဖာ္ျပ ပုံအတုိင္း lot သည္ blue grips active

ျဖစ္ေနမည္ကုိ ေတြ႕ရမည္။

၄) Layout ေပၚတြင္ title block ကို ေနရာသတ္မွတ္ရန္ -

 Plan View layout ကုိ Activate လုပ္ပါ။

 Block Titleblock centered ကို Layout သုိ႕ insert လုပ္ပါ။

 Titleblock တြင္ ေအာက္ေဖာ္ျပပါ ပုံအတိုင္း text မ်ား add ေပးပါ။
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၅) Viewports နွစ္ခုတြင္ တြဲဖက္ျမင္ႏိုင္ေစရန္ add ပါ။

 Elevation ၏ view သည္ 1:100 scale တြင္ရိွရမည္။

 Title block ၏ညာဖက္ အေပၚေထာင့္မွ key plan ကုိ fit ျဖစ္သြားေစရန္ zoom ျပင္လိုက္ပါ။

၆) ေအာက္ေဖာ္ျပပါ Room Schedule data မ်ားျဖင့္ table ဖန္တီးရန္ -

 NUMBER - NAME - AREA

 221 - SLEEPING QUARTERS - 21 m2
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 201 - READY ROOM - 36 m2

 202 - LOCKER ROOM - 14 m2

 203 - EXERCISE ROOM - 23 m2

 205 - DINING ROOM - 24 m2

 206 - KITCHEN - 6 m2

 207 - MEN'S TOILET ROOM - 11 m2

 208 - WOMEN'S TOILET ROOM - 14 m2

၇) Drawing ကုိ save ျပီး close လိုက္ပါ။

Imperial Units

၁) M_ARCH-Challenge- CHP11.dwg ကိုဖြင့္ပါ။

၂) Layer သတ္မွတ္ျပီး၊ contours ဖန္တီးပါ။

 Topo ဆုိေသာ layer ကို Thaw ျပီး current the existing layer အျဖစ္သတ္မွတ္ေပးပါ။

 Node to node မွ smooth curved contours ကုိေအာက္ေဖာ္ျပပါ ပုံအတုိင္း ေရးဆြဲလိုက္ပါ။

၄) Layout ေပၚတြင္ title block ကို ေနရာသတ္မွတ္ရန္ -



“Workgroup” AotoCAD & 3ds Max Job Training Center မွ ပညာဒါန အခမ့ဲ ျဖန္႔ေ၀သည္။

( ဤစာအုပ္ကုိ ေငြေၾကးျဖင့္ ျပန္လည္ေရာင္းခ် ခြင့္မျပဳပါ )

ေအာင္ေဇာ္လတ္ {(Master of Engineering in Science and Production Engineering) Moscow State University Of Railway Engineering}

ဘာသာျပန္ ေရးသား ျပဳစုသည္။

“Workgroup “ AutoCAD & 3ds Max Training Center, International Computer Driving Licence Approved Test Center,
Rm- 403, Excel Tower, Yangon, Myanmar.

Ph: 951 559377 Ext: 6413 or 6403, Email – infor@workgroupweb.com

351

 Plan View layout ကုိ Activate လုပ္ပါ။

 Block Titleblock centered ကို Layout သုိ႕ insert လုပ္ပါ။

 Titleblock တြင္ ေအာက္ေဖာ္ျပပါ ပုံအတိုင္း text မ်ား add ေပးပါ။

၅) Viewports နွစ္ခုတြင္ တြဲဖက္ျမင္ႏိုင္ေစရန္ add ပါ။

 Elevation ၏ view သည္ 1/8" = 1'scale တြင္ရိွရမည္။

 Title block ၏ညာဖက္ အေပၚေထာင့္မွ key plan ကုိ fit ျဖစ္သြားေစရန္ zoom ျပင္လိုက္ပါ။
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၆) ေအာက္ေဖာ္ျပပါ Room Schedule data မ်ားျဖင့္ table ဖန္တီးရန္ -

 NUMBER - NAME - AREA

 221 - SLEEPING QUARTERS - 236 SQ/FT

 201 - READY ROOM - 386 SQ/FT

 202 - LOCKER ROOM - 150 SQ/FT

 203 - EXERCISE ROOM - 383 SQ/FT

 205 - DINING ROOM - 134 SQ/FT

 206 - KITCHEN - 200 SQ/FT

 207 - MEN'S TOILET ROOM - 114 SQ/FT

 208 - WOMEN'S TOILET ROOM - 149 SQ/FT

၇) Drawing ကုိ save ျပီး close လိုက္ပါ။

Challenge Exercise: Mechanical

ဤလက္ေတြ႕ ေလ့က်င့္ခန္းတြင္ အထက္၌ ေလ့လာခဲ႕ျပီး ျဖစ္ေသာ အစိတ္အပိုင္း တစ္ခုေပၚမွ edge ကုိ ကုိယ္စားျပဳေသာ objects

မ်ားဖန္တီးျခင္း၊ View ပတ္လည္တြင္ border ဖန္တီးျခင္း၊ area ကုိတြက္ခ်က္ရန္ closed loop ဖန္တီးျခင္း စသည္တုိ႕ကို

ေလ့က်င့္သြားရမည္ ျဖစ္သည္။ Titleblock ပါ၀င္ေသာ မိမိတုိ႕၏ layout ကို update လုပ္သြားရမည္ ျဖစ္သည္။
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The completed exercise

၁) M_MECH-Challenge- CHP11.dwg ကုိဖြင့္ပါ။

၂) Base part and assembly နွစ္ခုလုံး၏ side views တြင္ရိွေသာ hole အတြက္ cut သည္ arc ျဖင့္ဆိုလွ်င္ လြန္စြာျမင့္ေနမည္။

မွန္မွန္ကန္ကုန္ ေဖာ္ျပေပးႏိုင္ရန္ ellipse ကိုအသုံုးျပဳျပီး ျပန္လည္ေရးဆြေဲပးပါ။

၃) View ပတ္လည္တြင္ ရိွေသာ border ကို circle မွ spline shape သို႕ေျပာင္းေပးပါ။
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၄) Base part ၏ front view မွ flat surfaces နွစ္ခုရ႕ဲ square millimeter area ကိုတြက္ခ်က္ေပးပါ။

(Value Check: lower face ၏ area = 17185.9487)

၅) Parts layout ကို Update လုပ္ပါ။

 Parts layout သို႕ေျပာင္းပါ။

 Titleblock block ကုိ insert လုပ္ပါ။

၆) Drawing ကုိ save ျပီး close ပါ။

Chapter Summary

မိမိတုိ႕ designs မ်ားအတြက္ လုိအပ္သလို line ကုိ multiple segments မ်ားျဖင့္ ဖန္တီးျခင္း၊ arcs မ်ားကုိ single polyline

အျဖစ္ဖန္တီးျခင္း၊ splines က႕ဲသုိ႕ေသာ smooth curved geometry (သို႕မဟုတ္) ellipses မ်ားဖန္တီးျခင္းနွင့္ drawing တြင္ table

add ျခင္းတုိ႕ကို တင္ျပေပးထားပါသည္။
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ဤသင္ခန္းစာကို ေလ့လာျခင္း ျပီးစီးသြားပါက -

 Polyline command ျဖင့္ polylines မ်ားကုိ create and edit လုပ္တတ္လာမည္။

 Spline command ျဖင့္ smooth curves မ်ား create လုပ္တတ္လာမည္။

 Ellipse command ျဖင့္ ellipses and elliptical arcs မ်ား create လုပ္တတ္လာမည္။

 Basic tables မ်ားဖန္တီးျခင္း၊ table styles မ်ားျဖင့္ ၎တုိ႕၏ appearance ကို control လုပ္တတ္လာ မည္။

CHAPTER: 12 Plotting Your Drawings

Drawings မ်ားကို ဖန္တီးျပီးသြားပါက ေနာက္ဆံုးအဆင့္အေနျဖင့္ မိမိတို႕ဖန္တီး လိုက္ေသာ drawings မ်ားကို design တစ္ခုအေနျဖင့္

အတည္ျပဳတင္ျပ သြားရန္ Paper and electronic media သုိ႕ခ်ိတ္ဆက္ေပးသြား ရပါမည္။

Objectives

ဤသင္ခန္းစာကို ေလ့လာျခင္း ျပီးစီးသြားပါက -

 Page setups မ်ားကုိ creat and activate လုပ္တတ္လာေစရန္။

 Model space (သုိ႕မဟုတ္) layout မွ Plot design geometry geomentry မ်ား ျပဳလုပ္တတ္လာ ေစရန္။

Lesson: Using Page Setups

ဤသင္ခန္းစာတြင္ layout environment အတြင္းမွ page setups မ်ားကုိ activate and save လုပ္ျခင္းအပိုင္းကို တင္ျပသြား

မည္ျဖစ္ပါသည္။ အမ်ိဳးမ်ိဳးေသာ devices မ်ားျဖင့္ data ကုိ output လုပ္ရန္ လိုအပ္လာေသာ အခ်ိန္နွင့္ မတူညီေသာ အခ်ိန္၌
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ကြဲျပားေသာ ပုံစံမ်ားျဖင့္ print ထုတ္လိုေသာအခါ page setups ကို saved ထားျခင္းအားျဖင့္ လုိအပ္ေသာ အခ်ိန္တြင္ အရန္သင့္

အသုံးျပဳသြားႏိုင္ပါသည္။ Publish command ျဖင့္ file တစ္ခုအတြင္းမွ multiple sheets မ်ားကုိ outputting လုပ္ေသာ အခ်ိန္တြင္

saved ထားေသာ page setups ကုိ selecting လုပ္ျပီး output လုပ္လိုက္ျခင္းအားျဖင့္ အခ်ိန္ကုန္သက္သာျပီး လ်င္ျမန္စြာ

ျပဳလုပ္ႏိုင္မည္ ျဖစ္သည္။

Objectives

ဤသင္ခန္းစာကို ေလ့လာျခင္းျပီးစီးသြားပါက -

 Page setup ကုိ existing layout သုိ႕ apply လုပ္ျခင္းကုိ နားလည္သေဘာေပါက္ လာေစရန္။

 Page setup ကုိ creat and modify လုပ္တတ္လာေစရန္။

Applying Page Setups to Layouts

Page setup ကိုအမည္ေပးျပီး မတူညီေသာ နည္းလမ္းမ်ားျဖင့္ layout ကုိလြယ္ကူလ်င္ျမန္စြာ plotting လုပ္သြားႏိုင္ပါသည္။ Layout

တစ္ၾကိမ္ ဖန္တီးတိုင္း (သုိ႕မဟုတ္) Plot command ကိုတစ္ၾကိမ္ အသံုးျပဳတုိင္း configuration options မ်ားကုိ စိတ္ၾကိဳက္

ျပင္ဆင္သတ္မွတ္ျပီး၊ ၎ setting ကုိ save လုိက္လွ်င္ page setup ကုိဖန္တီးျပီး ျဖစ္သြားလိမ္႕မည္။ Page Setup Manager

ကိုအသံုးျပဳျပီး မိမိတုိ႕၏ page setups မ်ားကုိ layout or modify လုပ္ရန္ အတြက္ activate လုပ္ႏိုင္ပါသည္။ မိမိတုိ႕ အေနျဖင့္ layout

environment တြင္ page setup ကုိဖန္တီးလိုက္မည္ ဆုိပါက ၎သည္ current layout အတြက္သာ ျဖစ္ျပီး၊ model space

အတြက္မဟုတ္ေပ။ သုိ႕ေသာ္လည္း model space plotting အတြက္ page setup ကိုဖန္တီးသြား ႏိုင္ပါသည္။

Command Access



“Workgroup” AotoCAD & 3ds Max Job Training Center မွ ပညာဒါန အခမ့ဲ ျဖန္႔ေ၀သည္။

( ဤစာအုပ္ကုိ ေငြေၾကးျဖင့္ ျပန္လည္ေရာင္းခ် ခြင့္မျပဳပါ )

ေအာင္ေဇာ္လတ္ {(Master of Engineering in Science and Production Engineering) Moscow State University Of Railway Engineering}

ဘာသာျပန္ ေရးသား ျပဳစုသည္။

“Workgroup “ AutoCAD & 3ds Max Training Center, International Computer Driving Licence Approved Test Center,
Rm- 403, Excel Tower, Yangon, Myanmar.

Ph: 951 559377 Ext: 6413 or 6403, Email – infor@workgroupweb.com

357

Page Setup

Command Line: PAGESETUP

Application Menu: Print > Page Setup

Shortcut menu: Right-click the Model or Layout tab, click Page Setup Manager

Ribbon: Output tab > Plot panel > Page Setup Manager

Page Setup Manager Dialog Box

Page Setup Manager တြင္ existing page setup ကုိ current အျဖစ္သတ္မွတ္ျခင္း၊ page setups မ်ားကုိ modify လုပ္ျခင္း၊ new

page setups မ်ား create ျခင္းန႕ဲ drawing file အသီးသီးမွ page setup ကို import လုပ္ျခင္း စသည္တို႕ကို ျပဳလုပ္သြားႏိုင္ပါသည္။

Plot command ကုိေခၚလိုက္သည္နွင့္ current page setup သာ effect ျဖစ္သြားမည္ ျဖစ္သည္။
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Page Setup Manager Access Options

Ribbon မွ Page Setup Manager ကုိ click လုိက္သည္နွင့္ current drawing layout or model space မ်ားအတြက္ settings မ်ားကုိ

creating ျပဳလုပ္သြား ႏိုင္မည္ျဖစ္သည္။ Selected ထားေသာ layout or model space မွ Page Setup Manager ကို access

လုပ္ႏိုင္ျပီး၊ ၎တြင္ options ၂မ်ိဳးရိွပါသည္။

Option #1: Layout and Model Space tabs ကို visible လုပ္ရန္ -

 Drawing window or Command line area တြင္ right-click နိွပ္ျပီး options ကုိ select ပါ။
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 Options dialog box မွ Display tab ကုိ select လုပ္ပါ။

 Display Layout and Model Tabs ကို checkmark ေပးရန္ click လုိက္ပါ။

 Options dialog box ရ႕ဲ Apply ,Close ကိုနိွပ္ပါ။

 ႏွစ္သက္ရာ layout or model tab ကုိ select ပါ။

 Page Setup Manager ကို access လုပ္ရန္ right – click ႏိွပ္ပါ။

Option #2: Status bar ေပၚရိွ Quick View Layouts or Quick view Drawings button ကို click ျပီး Page Setup ကို activate

လုပ္ရန္ -

 Quick View Layouts ကုိ Double-click ႏိွပ္ပါ။ (သို႕မဟုတ္) Drawings ကုိ click ပါ။

 ႏွစ္သက္ရာ Layout (2) ကုိ select ျပီး၊ right-click ႏိွပ္ပါ။

 Page Setup Manager (3) ကုိ select ပါ။
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Procedure: Applying a Saved Page Setup to a Layout

Existing layout တြင္ saved ထားေသာ page setup ကို current အျဖစ္ျပဳလုပ္ပုံကို ေအာက္တြင္ အဆင့္ဆင့္ ေဖာ္ျပေပးထားပါသည္။

၁) Layout tab ကို select ပါ။

၂) Tab ကို right – click ႏိွပ္ပါ။ Page Setup Manager ကို click ပါ။

၃) Page Setup Manager တြင္ရိွေသာ list မွ saved ထားေသာ page setups မ်ားမွ page setup တစ္ခု၏ အမည္ကို double-click

ေပးလုိက္ပါ။

၄) Close ကို click ပါ။

Practice Exercise: Applying Page Setups to Layouts
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ဤလက္ေတြ႕ ေလ့က်င့္ခန္း၌ Page Setup Manager တြင္ ရိုးရွင္းေသာ settings မ်ားကို အေျခတည္ျပီး၊ ရိုးရွင္းေသာ page setup

တစ္ခ်ိဳ႕ကို ဖန္တီးသြားရမည္ ျဖစ္သည္။ အဆုိပါ new page setup ကုိ drawing တြင္ apply လုပ္သြားရမည္ ျဖစ္သည္။ လာမည့္

section တြင္ Page Setup Manager ကိုအသံုးျပဳျပီး၊ page setup ကို creating and modifying လုပ္ျခင္းတုိ႕ကို ပိုမိုေလ့လာသြားရမည္

ျဖစ္ပါသည္။

၁) acad.dwt template ကုိ အသုံးျပဳျပီး new drawing ဖြင့္လုိက္ပါ။

၂) Simple geometry တစ္ခ်ိဳ႕ကုိ ဖန္တီးလိုက္ပါ။

၃) Model tab အတြက္ Page Setup Manager ကို Access လုပ္ရန္ -

 Model tab ကုိ select ျပီး right-click (1) ႏိွပ္ပါ။

 Page Setup Manager ကို click ပါ။

မွတ္ခ်က္။ ။ အကယ္၍ Model tab သည္ not visible ျဖစ္ေနလွ်င္၊ Command line area တြင္ right – click ႏိွပ္ပါ။ Options ကုိ

click ပါ။ Options dialog box တြင္ရိွေသာ Display tab မွ Layout elements ေအာက္တြင္ရိွေသာ Display Layout and Model tabs

check box ကုိ select ပါ။

၄) New Page Setup ကုိ Create ရန္ -

 Page Setup Manager မွ New (1) ကုိ select ပါ။
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 New page setup name အတြက္ TEST_PRINT (2) ကုိရိုက္ထည့္ေပးပါ။

 Ok ကုိ click ပါ။

၅) Page Setup dialog box တြင္ simple settings တစ္ခ်ိဳ႕ကုိ ဖန္တီးရန္ -

 Printer/Plotter ေအာက္တြင္ ရိွေသာ Name list မွ printer ကို select ပါ။

 Paper Size list မွသံုးေနၾက paper size ကုိ select ေပးပါ။

 Plot area ေအာက္တြင္ရိွေသာ What to Plot list မွ Extents ကုိ select ပါ။

 Plot Offset ေအာက္မွ Center the Plot ကုိ select လုပ္ပါ။

 Plot Scale ေအာက္တြင္ရိွေသာ Fit to Paper ကို select လုပ္ပါ။

 Drawing Orientation အတြက္ Landscape ကို select ပါ။

 Preview ကို Click ပါ။ Preview window မွ displayed ျပထားေသာ drawing ကုိ စိတ္ၾကိဳက္ျဖစ္ျပီ ဆိုပါက အတည္ျပဳရန္ Esc

key ႏိွပ္ျပီး preview window ကို exit ေပးလုိက္ပါ။

 Page Setup dialog box ကုိ exit လုပ္ရန္ OK ကုိ Click ပါ။

၆) New Page Setup ကုိ current လုပ္ရန္ -

 Page Setup Manager မွ TEST_PRINT ကို select လုပ္ပါ။

 Set Current ကုိ Click ပါ။

 Dialog box ကို close ပါ။

 လက္ရိွ Model tab မွ print လုပ္မည္ဆိုပါက drawing ကုိ current page အတုိင္း print လုပ္ေပးသြားမည္ ျဖစ္သည္။
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Creating Page Setups

မိမိတုိ႕အေနျဖင့္ layout တစ္ခုကို ဖန္တီးျပီးတုိင္း၊ ၎ဆီသုိ႕ page setup တစ္ခုကုိ assign လုပ္သင့္ပါသည္။ Template files or

အျခားေသာ drawings မ်ားမွ page setups မ်ားကို import လုပ္ႏိုင္ပါသည္။ လုိအပ္လွ်င္ အသစ္တစ္ခု ဖန္တီးႏိုင္သလုိ၊

ဖန္တီးျပီးထားမ်ားကုိလည္း modify လုပ္သြားႏိုင္ပါသည္။ New page setup ကိုဖန္ တီးေတာ႕မည္ ဆုိလွ်င္ printer/plotter device,

paper size, plot scale နဲ႕ အျခားေသာ plotproperties မ်ားကုိလည္း သိရိွထားရန္ လိုအပ္ပါသည္။

New Page Setup

Page Setup Manager မွ New ကို click ပါ။ New Page Setup dialog box ပြင့္လာမည္။ ေအာက္တြင္ ေဖာ္ျပထားေသာ ပုံတြင္

existing setup ျဖင့္ စတင္ႏိုင္သလုိ၊ default <None> မွလည္း အသစ္တစ္ခု ဖန္တီးႏိုင္ပါသည္။

Page Setup Dialog Box

New page setup ကို ဖန္တီးေသာ အခ်ိန္တြင္ (သုိ႕မဟုတ္) Page Setup Manager မွ Modify ကို click ေသာအခါတြင္ Page Setup

dialog box သည္ displayed သြားမည္။



“Workgroup” AotoCAD & 3ds Max Job Training Center မွ ပညာဒါန အခမ့ဲ ျဖန္႔ေ၀သည္။

( ဤစာအုပ္ကုိ ေငြေၾကးျဖင့္ ျပန္လည္ေရာင္းခ် ခြင့္မျပဳပါ )

ေအာင္ေဇာ္လတ္ {(Master of Engineering in Science and Production Engineering) Moscow State University Of Railway Engineering}

ဘာသာျပန္ ေရးသား ျပဳစုသည္။

“Workgroup “ AutoCAD & 3ds Max Training Center, International Computer Driving Licence Approved Test Center,
Rm- 403, Excel Tower, Yangon, Myanmar.

Ph: 951 559377 Ext: 6413 or 6403, Email – infor@workgroupweb.com

364

Page Setup dialog သည္ box Plot dialog box ျဖင့္အတူတူပင္ ျဖစ္သည္။

အသံုးျပဳမည့္ plotter or plotter configuration file ကုိ select ပါ။

Output လုပ္မည့္ paper size ကုိ select ပါ။

Plot လုပ္မည့္ file ၏ area ကုိ select ပါ။ Current display, drawing, extents, or specify a window တုိ႕ကို select ျပီး

Plot ႏိုင္ပါသည္။ Model tab ေပၚ၌ page setup ကို create ေသာအခါတြင္ drawing ၏ limits ကို Plot လုပ္ႏိုင္ပါသည္။ Layout tab

ေပၚ၌ page setup ကုိ create ေသာအခါတြင္ layout တစ္ခုလံုးကုိ Plot ႏိုင္ပါသည္။

Geomentry ကို paper ေပၚတြင္ paper ၏ origin point ႏွင့္ ဆက္စပ္ျပီး ေနရာသတ္မွတ္ရန္ select ပါ။

Geomentry ကို outputting လုပ္ေသာအခ်ိန္တြင္ အသံုးျပဳမည့္ scale factor ကို select ပါ။

Output file (သို႕မဟုတ္) Paper ေပၚမွ geomentry မ်ား၏ appearance ကို control လုပ္ရန္ plot style table ကို select ပါ။

Viewport ကုိ shaded ျပီး Plot လိုပါက shaded plot ကို select ျပီး၊ ၎ shading quality ကုိ select ႏိုင္ပါသည္။

Geomentry မ်ား Outputting လုပ္ေသာ အခ်ိန္တြင္ calculation အတြက္ order နွင့္ plot styles ကိုအသံုးျပဳျပီး Plot လုပ္လုိေသာ

အေျခအေနမ်ိဳးတြင္ additional plot options မ်ားကို select ရမည္။

Paper ေပၚမွ geomentry ၏ orientation select ပါ။
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Procedure: Creating and Saving a Page Setup

Page setup မ်ား creating and saving လုပ္ပုံကုိ ေအာက္တြင္ အဆင့္ဆင့္ ေဖာ္ျပေပးထားပါသည္။

၁) Model space or a layout ကို select ပါ။

၂) Application Menu, click Print > Page Setup Manager.

၃) Page Setup Manager dialog box မွ New ကုိ click ပါ။

၄) New Page Setup dialog box တြင္ new page setup အတြက္ name ရိုက္ထည့္ေပးပါ။ Ok ကုိ click ပါ။

၅) Page Setup dialog box တြင္ Options မ်ားကုိ လိုအပ္သလုိ သတ္မွတ္ေပးပါ။ Ok ကုိ click ပါ။

 Layout တစ္ခုခုတြင္ page setup current အျဖစ္ ျပဳလုပ္ႏိုင္ျပီ ျဖစ္ပါသည္။

Exercise: Create and Activate Page Setups

ဤေလ့က်င့္ခန္းတြင္ saved ထားေသာ page setup ကုိ existing layout တြင္ activate လုပ္ေပးရမည္ ျဖစ္ျပီး၊ layout တစ္ခုခုတြင္

အသုံးျပဳႏိုင္ရန္ new page setup တစ္ခုကုိ ဖန္တီးသြားရမည္ ျဖစ္သည္။
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The completed exercise

၁) M_Page-Setup.dwg ကုိဖြင့္ပါ။

၂) Page Setup Manager ကုိ access လုပ္ရန္ -

 Layout2 tab ကို Right-click ေပးလိုက္ပါ။

 Page Setup Manager ကို Click ပါ။

၃) Page setup current လုပ္ရန္ -

 For Book of Examples ကို Double-click ႏိွပ္ပါ။

 အဆိုပါ Page setup သည္ current ျဖစ္သြားမည္ ျဖစ္ျပီး၊ DWF6 ePlot.pc3 plotter configuration နွင့္ 297 x 210 mm

paper size ကုိအသုံးျပဳရန္ သတ္မွတ္ျပီးသြားျဖစ္သည္။

 Close ကုိ click ပါ။
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၄) Layout active ျပဳလုပ္ရန္ Layout1 tab ကို click ပါ။

၅) Ribbon, click Output tab > Plot panel > Page Setup Manager.

၆) New layout ဖန္တီးျခင္း စတင္ရန္ -

 Page Setup Manager တြင္ New ကုိ click ပါ။

 New Page Setup Name အတြက္ A4 (Portrait) - Check Plot ကုိရိုက္ထည့္ေပးပါ။

 Ok ကုိ click ပါ။

၇) Paper size ကုိသတ္မွတ္ေပးရန္ -

 Paper Size list မွ ISO A4 (210.00 x 297.00 MM) ကုိ Select ပါ။

 Ok ကုိ click ပါ။

၈) Page setup ကုိ current အျဖစ္သတ္မွတ္ေပးရန္ -

 Page setups list မွ A4 (Portrait) - Check Plot ကုိ select ပါ။

 Close ကုိ click ပါ။

၉) Layout အတြင္းတြင္ geomentry ကုိျမင္ေတြ႕ႏိုင္ရန္ drawing ကို Zoom extents လုပ္ပါ။

 ဤ layout သည္ A1 size sheet Paper ေပၚတြင္ plot ရန္ မူရင္း scale 1:1 ကိုသတ္မွတ္ျပီး ျဖစ္သည္။ A4 paper ၏ 1:1

အတြက္ fit ျဖစ္မည္ မဟုတ္ေပ။ ထို႕ေၾကာင့္ ဤ page setup အတြက္ scale factor ေျပာင္းေပးရန္ လုိအပ္ပါသည္။
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၁၀) Page Setup Manager ကို access လုပ္ရန္ -

 Layout1 tab ကို Right-click ေပးလိုက္ပါ။

 Page Setup Manager ကို Click ပါ။

၁၁) Existing page setup ကို modify လုပ္ရန္ -

 Paper Size list မွ A4 (Portrait) - Check Plot ကုိ select ပါ။

 Modify ကို click ပါ။

၁၂) Plot options ကုိသတ္မွတ္ေပးရန္ -

 Plot Area ေအာက္တြင္ရိွေသာ What To Plot list မွ Extents ကို select ပါ။

 Plot Scale ေအာက္မွ Fit to Paper option ကို click ပါ။

 Ok ကုိ click ပါ။

 Page setup ကုိ update လုပ္ရန္ prompted ေသာအခါတြင္ Yes ကို click ပါ။

၁၃) Close ကို click ပါ။
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၁၄) Files အားလုံးကို မ Save ပဲပိတ္လိုက္ပါ။

Lesson: Plotting Drawings

ဤသင္ခန္းစာတြင္ layout or model space မွ paper or electronic file သုိ႕ Plot လုပ္ပုံကုိ ေလ့လာသြား ရမည္ျဖစ္သည္။ မိမိတို႕၏

design ideas မ်ားကုိ အျခားေသာ devices မ်ားျဖင့္ ခ်ိတ္ဆက္ျပီး drawings မ်ားကုိ outputting လုပ္ျခင္းသည္ အေရးၾကီးဆံုးေသာ

အဆင့္ျဖစ္ပါသည္။

Objectives

ဤသင္ခန္းစာကို ေလ့လာျခင္း ျပီးစီးပါက -
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 Data မ်ား output လုပ္ႏိုင္သည့္ environments ကို Identify လုပ္တတ္လာေစရန္။

 Model space မွ plotting လုပ္ျခင္း၏ characteristics နွင့္ အေၾကာင္းျပခ်က္ကုိ သိရိွလာေစရန္။

 Layout မွ plotting လုပ္ျခင္း၏ characteristics ကို သိရိွလာေစရန္။

 Model space or Layout မွ drawing ကို plot တတ္လာေစရန္။

 Plot လုပ္မည့္ အရာကို Preview command ကုိအသံုးျပဳျပီး နမူနာသေဘာမ်ိဳး ၾကည့္တတ္လာေစရန္။

About Plotting Environments

Drawings မ်ားဖန္တီးကာ design data အျဖစ္ သိမ္းဆည္းျပီး၊ ၎ကို အျခားေသာ devices မ်ားျဖင့္ communicate လုပ္ရပါသည္။

Communication သည္ data ကုိ paper or electronic file သုိ႕ output လုပ္ေသာအခ်ိန္တြင္ ျဖစ္ေပၚသည္။ ထိုသုိ႕ drawings မ်ားကို

outputting လုပ္ေသာခ်ိန္တြင္ Design Web Format (DWF) အမ်ိဳးအစားကို အသုံးအမ်ားဆံုး ျဖစ္ျပီး၊ စြယ္စြယ္အသုံးျပဳႏိုင္ေသာ

electronic file format ကုိလည္း အသံုးျပဳႏိုင္ပါသည္။

Outputting data လုပ္ရန္အတြက္ နည္းလမ္း (၂) မ်ိဳးရိွပါသည္။ ပထမတစ္နည္းမွာ model space မွ Plot လုပ္ျခင္းျဖစ္ျပီး၊

ဒုတိယနည္းမွာ Layout မွ Plot လုပ္ျခင္း ျဖစ္ပါသည္။ နည္းလမ္းတစ္ခုစီတြင္ မိမိတုိ႕ ႏွစ္သက္ေသာ output မ်ိဳးရရိွရန္ configure and

control လုပ္ရန္အတြက္ ၎တုိ႕တြင္ ကိုယ္စီ item lists မ်ားရိွၾကပါသည္။

Plotting from the drawing Layout or from the drawing Model

ေအာက္တြင္ drawing Layout ကုိေဖာ္ျပေပးထားပါသည္။ Drawing Layout ကုိ activate လုပ္ရန္ layout tab (1) ကို select ပါ။

Layout တြင္ Paper (2), Plot area ကုိသတ္မွတ္ေပးထားေသာ dashed line (3), drawing viewports (4) နဲ႕ ဘယ္ဖက္ေထာင့္တြင္

paper space icon (5) ကုိ display ေပးထားပါလိမ္႕မည္။
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ေအာက္တြင္ drawing model ကုိေဖာ္ျပေပးထားပါသည္။ Drawing model ကုိ activate လုပ္ရန္ model tab (1) ကုိ select ပါ။ Model

tab သည္ drawings မ်ားေရးဆြရဲသည့္ environment ျဖစ္ပါသည္။ အကယ္၍ UCS icon ကုိ On ထားမည္ဆိုလွ်င္၊

၎သည္ဘယ္ဖက္ေထာင့္ (2) တြင္ display ေပးပါလိမ္႕မည္။

Plot or Publish
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Drawing file အတြင္းမွ data မ်ားကုိ single layout မွ output လုပ္ေသာအခ်ိန္တြင္ အမ်ားအားျဖင့္ Plot command

ကုိသာအသုံးျပေလ့ ရိွၾကပါသည္။ Drawing file အတြင္းမွ data မ်ားကို multiple layouts မွ output လုပ္လိုပါက Publish command

ကုိအသံုးျပဳပါသည္။ Publishing သည္ plot လုပ္မည့္ drawings မ်ားကုိ list အျဖစ္ ဖန္တီးျခင္း၊ multiple files မွ plot မည့္ file ကို

select လုပ္ျခင္း၊ selected ထားေသာ informations မ်ားကို Drawing Set Descriptions (DSD) file အျဖစ္ save ျခင္းတို႕ဖန္တီးရန္

သင့္ကုိ ability ေပးပါလိမ့္မည္။

Key Terms Defined

Plotting န႕ဲပတ္သက္ေသာ key term တစ္ခ်ိဳ႕ကုိ ေအာက္တြင္ ေဖာ္ျပေပးလုိက္ပါသည္။

Plot Drawing file ကို plotter, printer, or file သို႕ active လုပ္ျပီး outputting လုပ္ေဆာင္ျခင္း။

Model Space လက္ေတြ႕ ေျမျပင္တြင္ အသုံးျပဳေသာ အကြာအေ၀းမ်ားကို ကိုယ္စားျပဳ သံုးလိုေသာ

(millimeters, centimeters, inches, feet, and so on) စသည့္ Units မ်ားကုိ ေရြးခ်ယ္

သတ္မွတ္ေပးျပီး ပါက full scale ျဖင့္ drawings မ်ားေရးဆြဲရေသာ area။

Layout Data မ်ားကုိ output လုပ္ရန္ အတြက္အသံုးျပဳမည့္ environment ျဖစ္ပါသည္။ Paper size

သတ္မွတ္ေပးျခင္း၊ title block မ်ား add ျခင္း၊ multiple scales မွာပဲ drawing ၏ multiple

views ကုိ display လုပ္ျခင္း၊ plotted sheet သို႕ notes မ်ား add ျခင္း စသည္တုိ႕

ျပဳလုပ္ေသာ ေနရာ။

DWF Electronically view အတြက္ output data မ်ားပါ၀င္သည့္ compressed file အမ်ိဳးအစား။

Plotting from Model Space

Model space မွ Plot ရန္အဓိက အခ်က္မွာ design အတြက္ area သတ္မွတ္ထားေသာ paper printout ရိွရပါမည္။ သုိ႕မွသာ

၎တို႕ကို review လုပ္ႏိုင္မည္ ျဖစ္သည္။ ေအာက္တြင္ေဖာ္ျပ ေပးထားေသာပုံသည္ model space တြင္ Plotted ႏိုင္မည့္ geometry

၏ဥပမာပုံ ျဖစ္ပါသည္။
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Model space မွ Plot ေသာအခ်ိန္တြင္၊ model space environment အတြင္းတြင္ တည္ရိွေနေသာ geomentry အားလုံးကို Printed

လုပ္ႏိုင္ပါသည္။ အကယ္၍ drawing မွလိုခ်င္ေသာ အပိုင္းကိုသာ ေရြးခ်ယ္ျပီး Print လုပ္လုိလွ်င္၊ လိုခ်င္ေသာ အပိုင္းတြက္ area

သတ္မွတ္ေပးျပီး Plot လုပ္ႏိုင္ပါသည္။ Drawing ကိုအသံုးျပဳလုိေသာ scale ျဖင့္ Print လုပ္လိုလွ်င္လည္း၊ Plot scale

ကိုသတ္မွတ္ေပးျပီး plot လုပ္ႏိုင္ပါသည္။ အကယ္၍ model space အတြင္းမွ geomentry ပတ္လည္တြင္ border and title block

မ်ားထည့္လုိပါက၊ မိမိတုိ႕ အသံုးျပဳလိုေသာ plot scale ေပၚမူတည္ျပီး scale ကုိ up or down လုပ္ေပးရပါမည္။

Text and dimension objects မ်ားကုိ plot လုပ္လိုပါက model space တြင္ size ကုိသတ္မွတ္ေပးရမည္ ျဖစ္ျပီး၊ drawing အတြက္

Annotative scale ႏွင့္ style တစ္ခုခ်င္းစီအတြက္ annotative property မ်ားကုိေရြးခ်ယ္ေပးရ မည္။ ေအာက္တြင္ေဖာ္ျပ

ေပးထားေသာပုံသည္ Annotative property ေရြးခ်ယ္ရမည့္ Text Style and Dimension Style dialog box (Fit tab) ျဖစ္ပါသည္။

ေအာက္တြင္ေဖာ္ျပ ေပးထားေသာ ပုံသည္ status bar မွ Annotative Scale list ကို access လုပ္ႏိုင္ေသာ ေနရာကို ေဖာ္ျပေပးေသာ

ပုံျဖစ္သည္။
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Plotting Annotations

Model space မွ plot ေသာအခ်ိန္တြင္၊ objects မ်ားသည္ Screen တြင္သတ္မွတ္ခ႕ဲသည့္ scale အတိုင္း Paper ေပၚသို႕

ေရာက္လာမည္ ျဖစ္သည္။ Annotative objects အတြက္ drawings မ်ား plotting မလုပ္မီ၊ annotation size ကိုပီပီ

သသဖတ္ႏိုင္ေအာင္ annotation scale တန္ဖိုးမ်ားကုိ ျပဳျပင္ေပးသြားရပါမည္။

Procedure: Plotting from Model Space

Model space မွ drawing ကုိ window area ျဖင့္ Plotting လုပ္ပုံကုိ ေအာက္တြင္ အဆင့္ဆင့္ ေဖာ္ျပေပးထား ပါသည္။

၁) Plot command ကုိစတင္လုိက္ပါ။ Plot dialog box တြင္ရိွေသာ Plot Area ေအာက္မွ What to Plot list ရိွ Window ကုိ select ပါ။

၂) Printing လုပ္ရန္အတြက္ window သတ္မွတ္ေပးရန္ prompted ေသာအခါတြင္၊ plotted လုပ္လိုသည့္ area ပတ္လည္

တစ္ေလွ်ာက္တြင္ window ကို drag လုပ္လုိက္ပါ။
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၃) Model dialog box တြင္ Paper size, Plot scale န႕ဲ Plot မွာ အသံုးျပဳလိုသည့္ အျခားေသာ parameters မ်ားကုိ သတ္မွတ္ေပးပါ။

၄) Selected area ကုိ Plot မလုပ္မီ နမူနာၾကည့္ရန္ Preview ကုိ click ပါ။

Plotting from Layouts
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Layout ကိုအသုံးျပဳျပီး data မ်ားကုိ output လုပ္လိုပါက layout တစ္ခုခ်င္းစီ အတြက္ အသံုးျပဳလုိေသာ paper size ကုိ select ေပးျပီး၊

Plot scale ကို 1:1 scale သတ္မွတ္ေပးပါ။ Paper layout ၌ Plotted sheet ေပၚတြင္ paper distance ကိုကုိယ္စားျပဳေသာ Unit မွာ

millimeters or inches ျဖစ္ပါသည္။

Layout ေပၚတြင္ ေရြးခ်ယ္သတ္ျပီးေသာ output size ၌ border န႕ဲ အခ်ိဳ႕ေသာ textual notes မ်ား add ႏိုင္ပါသည္။ ဥပမာအားျဖင့္ -

drawing မွ objects မ်ား၏ Properties တစ္ခ်ိဳ႕ကို tall 1/8", text height 1/8" စသည့္ အညြန္းတပ္ျခင္းတုိ႕ကုိ ျပဳလုပ္ႏိုင္ပါသည္။

Procedure: Plotting from a Layout

Layout မွ Plotting လုပ္ပုံကုိ ေအာက္တြင္ အဆင့္ဆင့္ ေဖာ္ျပေပးထားပါသည္။

၁) Plot command ကိုစတင္လိုက္ျပီး၊ Layout သို႕ေျပာင္းမည့္ Plot area ကုိစစ္ေဆးပါ။ Plot scale ကုိ 1:1 scale သုိ႕ေျပာင္းပါ။

Layout ဖန္တီးခ်ိန္တြင္ paper size ပါေျပာင္းလဲသြားမည္ ျဖစ္ေသာေၾကာင့္ သီးသန္႕ေျပာင္းေပးရန္ မလိုေတာ႕ေပ။
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၂) Layout တြင္ page setup ရိွရမည္ ျဖစ္ျပီး၊ plotter ကုိလည္း Layout tab မွ Page Setup Manager ကုိအသုံးျပဳျပီး assigned

လုပ္ထားရမည္ ျဖစ္သည္။ Output ကို review ကိုလုပ္ရန္ Preview ကို click ပါ။ အကယ္၍ Preview လုပ္ၾကည့္၍ output

သည္လိုခ်င္တဲ႕ အေနထားတြင္ ရိွေနျပီဆိုလွ်င္ right-click ႏိွပ္ျပီး Plot ကုိ click ပါ။ အကယ္၍ အေျပာင္းအလဲ တစ္ခုခုလုပ္ခ်င္လွ်င္

right-click ႏိွပ္ျပီး Exit ကို click ကာ plot dialog box ဆီသို႕ ျပန္သြား၍ ေျပာင္းလုိသည္မ်ားကုိ ေျပာင္းလဲေပးပါ။

Plot Command

Active drawing မွ data မ်ားကုိ Plot dialog box ရိွ settings မ်ားအသံုးျပဳျပီး Plot command ျဖင့္ plotter, printer, or file တြင္

prints လုပ္ႏိုင္ပါသည္။

Command Access

Plot
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Command Line: PLOT, PRINT

Application Menu: Print or Print > Plot

Quick Access Toolbar: Plot

Ribbon: Output tab > Plot panel > Plot

Plot Dialog Box

Plot dialog box ၏ bottom-right တြင္ရိွေသာ Expand button ကုိ click ျပီး more options ကို access ႏိုင္ပါသည္။
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Plot options မ်ားန႕ဲ page setup အျဖစ္ saved ထားသည္မ်ားကုိ select ရန္ ဤ option ကိုအသံုးျပဳ ရမည္။

Plot ကို send ရမည့္ ေနရာကုိ သတ္မွတ္ေပးရန္ ဤ list မွ printer ကို select ေပးရပါမည္။ System printers မ်ားကို select

ေပးႏ္ိုင္ပါသည္။

Selected plotting device အတြက္ list မွ paper size ကုိ select ႏိုင္ပါသည္။

Plot လုပ္မည့္ drawing ၏ area ကိုသတ္မွတ္ေပးပါ။ Layout မွ plotting လုပ္မည္ဆုိပါက area options တြင္ Display, Extents,

Window, View န႕ဲ Layout တုိ႕ပါ၀င္ပါသည္။ Model space မွ plotting လုပ္မည္ဆုိပါက Limits option ကို ေရြးခ်ယ္ႏိုင္ပါသည္။

Printed units ၏ ratio ကို geometry units တြင္သတ္မွတ္ေပးရန္ အသုံးျပဳရပါမည္။ သတ္မွတ္ထားေသာ scale အတုိင္း Plotting

လုပ္ျခင္းအားျဖင့္ printed copy ေပၚမွ distances မ်ား၏ measure သို႕ အဆိုပါ scale ကိုအသံုးျပဳ ႏိုင္ပါသည္။ အကယ္၍ drawings

မ်ားကို scale ေျပာင္းေပးရန္ မလုိအပ္ပါက Fit To Paper ကုိ select ေပးရပါမည္။

Output file (သို႕မဟုတ္) Paper ေပၚမွ geomentry မ်ား၏ appearance ကို control လုပ္ရန္ plot style table ကို select ပါ။

Viewport ကုိ shaded ျပီး Plot လိုပါက shaded plot ကို select ျပီး၊ ၎ shading quality ကုိ select ႏိုင္ပါသည္။

Plotted လုပ္မည့္ objects မ်ား၏ line weights, plot styles, plot stamp မ်ားအတြက္ options မ်ား သတ္မွတ္ေပးရန္ ဤ area

ကိုအသံုးျပဳႏိုင္ပါသည္။
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Paper ေပၚမွ geomentry ၏ orientation select ပါ။

Plotter Configurations

Plot dialog box တြင္သတ္မွတ္ခ႕ဲေသာ settings မ်ားအားလံုးကို saved ထားျပီး၊ အျခားေသာ drawings မ်ား (သို႕မဟုတ္)

မတူညီေသာ workstations မ်ားသုိ႕ imported လုပ္ျခင္းတုိ႕ကုိ ျပဳလုပ္ႏိုင္ပါသည္။ Saved ထားေသာ plot configuration သည္ PC3

file ျဖစ္ပါသည္။ အေစာပိုင္း AutoCAD® versions မ်ားတြင္မူ plotter configurations မ်ားသည္ PCP or PC2 files မ်ားျဖစ္ပါသည္။

Plot dialog box မွ Properties (1) ကုိ click ျပီး Save (2) and Import (3) options ကုိ access လုပ္ရန္ Plot Configuration Editor

ကို access လုပ္ပါ။

Plotter Manager ကိုအသုံးျပဳျပီး plotter configuration ကုိ add or edit လုပ္ႏိုင္ပါသည္။
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Command Access

Plotter Manager

Command Line: PLOTTERMANAGER

Application Menu: Print > Manager Plotters

Ribbon: Output tab > Plot panel > Plot
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Plot Style Manager command သည္ existing plot styles မ်ား၏ folders မ်ားကို open ျပီး plot style ကို edit လုပ္ျခင္း

(သုိ႕မဟုတ္) new plot style add ျခင္းတုိ႕ကို ျပဳလုပ္ႏိုင္ပါသည္။

Command Access

Plot Styles Manager

Command Line: STYLESMANAGER

Application Menu: Print > Manager Plot Styles
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Preview Command

printed sheet (သို႕မဟုတ္) electronic file ေပၚသုိ႕ Print မလုပ္ေသးခင္၊ ေနာက္ဆုံး plot အေနနဲ႕ full-page version သုိ႕ review

ၾကည့္ရႈ႕စစ္ေဆးျခင္းကုိ preview command ျဖင့္ ျပဳလုပ္ႏိုင္ပါသည္။ Preview window အတြင္းမွ review display ကို pan and

zoom တို႕ျဖင့္ လုိအပ္သလို ေရြ႕ေျပာင္းၾကည့္ရႈ႕ႏိုင္ပါသည္။ Plot button ကို click ျပီး displayed ထားေသာ plot ကုိတိုက္ရိုက္ print

ႏိုင္သလုိ၊ preview window ကို click ျပီးမွလည္း print ႏိုင္ပါသည္။

Command Access

Preview
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Command Line: PREVIEW

Application Menu: Print > Plot Preview

Plot Dialog Box: Preview

Ribbon: Output tab > Plot panel > Preview

Exercise: Plot a Drawing

ဤေလ့က်င့္ခန္းတြင္ Plot လုပ္သြားမည့္ geomentry မ်ားကုိ preview လုပ္ျခင္း၊ ထို႕ေနာက္ DWF file သို႕ plot ျခင္းတုိ႕ကို

ေလ့က်င့္သြားရမည္ ျဖစ္သည္။

The completed exercise

၁) M_Plotting.dwg ကုိဖြင့္ပါ။



“Workgroup” AotoCAD & 3ds Max Job Training Center မွ ပညာဒါန အခမ့ဲ ျဖန္႔ေ၀သည္။

( ဤစာအုပ္ကုိ ေငြေၾကးျဖင့္ ျပန္လည္ေရာင္းခ် ခြင့္မျပဳပါ )

ေအာင္ေဇာ္လတ္ {(Master of Engineering in Science and Production Engineering) Moscow State University Of Railway Engineering}

ဘာသာျပန္ ေရးသား ျပဳစုသည္။

“Workgroup “ AutoCAD & 3ds Max Training Center, International Computer Driving Licence Approved Test Center,
Rm- 403, Excel Tower, Yangon, Myanmar.

Ph: 951 559377 Ext: 6413 or 6403, Email – infor@workgroupweb.com

385

၂) Plot ကို preview ရန္ Output tab ကုိ click ျပီး၊ Plot panel > Preview ကို click ပါ။

Layout တြင္ရိွေသာ viewport မွ green rectangular သည္ preview တြင္ေတြ႕ျမင္ရမည္ မဟုတ္သည္ကုိ သတိထား ၾကည့္ၾကည့္ပါ။

အဆိုပါ viewport သည္ no plot ဆိုေသာ layer property ပါရိွသည့္ Layer တြင္တည္ရိွေနေသာေၾကာင့္ ျဖစ္သည္။

၃) Close Preview Window ကုိ Click (သုိ႕မဟုတ္) preview window ကို close ရန္ ESC ကိုႏိွပ္ပါ။

၄) Plot panel မွ plot ကုိ click ပါ။

၅) DWF plot ဖန္တီးရန္ -

 Plot dialog box မွ OK ကုိ click ပါ။

 Plot File dialog box အတြက္ Browse အတြင္းမွ Save ကို click ပါ။

၆) Plotting ျပဳလုပ္ရာတြင္ page setup ကိုသတ္မွတ္ေပးရန္ -

 Plot ကို click ပါ။

 Plot dialog box အတြင္းရိွ Page Setup ေအာက္က Name list တြင္ Check Plot–Monochrome ကို select ပါ။
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၇) Plot ကို preview လုပ္ရန္ Plot dialog box က Preview ကုိ click ပါ။

၈) Plot ဖန္တီးရန္ -

 Preview window မွ Plot ကို click ပါ။

 M_Plotting- Layout1-B.dwf အမည္ရ DWF file ကုိဖန္တီးရန္၊ prompted ေသာအခ်ိန္တြင္ file name ၌ –B ကို add

လုိက္ပါ။

 Save ကုိ click ပါ။

၉) Model tab ကို click ပါ။

၁၀) Plot ကုိ click ပါ။
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၁၁) Printer/plotter ကုိသတ္မွတ္ရန္ Name list မွ DWF6 ePlot.pc3 ကုိ select ပါ။

၁၂) Plot area သတ္မွတ္ေပးရန္-

 What To Plot list မွ Window ကုိ Select ပါ။

 ေအာက္ပုံတြင္ ျပထားသည့္အတုိင္း kitchen area ပတ္လည္တြင္ window ကုိသတ္မွတ္ေပးလုိက္ပါ။

၁၃) Ok ကုိ click ပါ။

၁၄) M_Plotting-Model.dwf အမည္ရ DWF file ကိုဖန္တီးရန္ Save ကို Click လိုက္ပါ။

၁၅) Files အားလုံးကို မ Save ပဲပိတ္လိုက္ပါ။

Chapter Summary

Business environment ေပၚတြင္မူတည္ျပီး ျပီးျပည့္စုံေသာ design တစ္ခုရရန္၊ အဖက္ဖက္မွ စစ္ေဆးျပီးမွ ထုတ္ရပါမည္။

ဤသင္ခန္းစာတြင္ Model and Layout views နွစ္မ်ိဳးစလံုးမွ design data မ်ား output လုပ္ပုံကို ေလ့လာခဲ့ျပီးျဖစ္သည္။

ဤသင္ခန္းစာကို ေလ့လာျခင္းျပီးစီးသြားပါက -

 Page setups မ်ားကုိ Create and activate လုပ္တတ္လာမည္။

 Model and Layout space ႏွစ္ခုစလံုးမွ design geomentry ကုိ plot လုပ္တတ္လာမည္။

CHAPTER: 13 Creating Drawing Templates
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Companies အမ်ားစုသည္ ၎တုိ႕၏ drawings မ်ားကုိ အရည္အေသြး ေကာင္းေကာင္းႏွင့္ ညီညီညာညာ ျမင္ေတြ႕

ၾကည့္ရႈ႕လုိၾကေသာေၾကာင့္ ျပဳလုပ္ျဖည့္စြက္ရမည့္ standard or guidelines တစ္ခ်ိဳ႕ရိွပါသည္။ Drawing properties န႕ဲ အျခားေသာ

settings မ်ား၏ ပုံစံတြင္ အဆုိပါ standard or guidelines တစ္ခ်ိဳ႕ အတုိင္း drawing templates မ်ားဖန္တီးေပးရမည္။ Template

ကိုအသံုးျပဳျပီး new drawing ကုိဖန္တီးပါက drawing ကုိညီညီညာညာန႕ဲ အရည္အေသြး မီွမွီ ရရိွမည္ ျဖစ္သည္။

Objectives

ဤသင္ခန္းစာကုိ ေလ့လာျခင္း ျပီးစီးသြားပါက -

 Drawing templates မ်ားဖန္တီးတတ္လာေစရန္။

Lesson: Creating Drawing Templates

ဤသင္ခန္းစာတြင္ drawing templates မ်ားဖန္တီးပုံကို တင္ျပသြားမည္ ျဖစ္သည္။ Drawing templates ကုိဖန္တီးျခင္း အားျဖင့္၊ new

drawing တစ္ခုဖန္တီးတုိင္း အခ်ိန္ကုန္သက္သာေစမည္ ျဖစ္သည္။ Created ထားေသာ templates ကုိ new drawing ဖန္တီးတုိင္း

အလြယ္တကူရယူ အသံုးျပဳသြားႏိုင္မည္ ျဖစ္သည္။

ေအာက္ေဖာ္ျပပါပုံသည္ measurement units နွင့္ new layer notification တို႕ေဖာ္ျပေပးထားေသာ Template Options dialog box

ျဖစ္ပါသည္။
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Objectives

ဤသင္ခန္းစာကို ေလ့လာျခင္း ျပီးစီးသြားပါက -

 Drawing templates အေၾကာင္းကို သိရိွနားလည္လာေစရန္။

 Drawing templates ၏အမ်ိဳးမ်ိဳးေသာ options ကုိသိရိွနားလည္လာေစရန္။

 Drawing templates မ်ားဖန္တီးတတ္လာေစရန္။

About Drawing Templates

Drawings မ်ားကို layers and text styles က႕ဲသုိ႕ေသာ drawing standard မ်ားျဖင့္ သတ္မွတ္ ေရးဆြဲေပးရမည့္ အေျခအေနမ်ိဳးတြင္

drawing template သည္လြန္စြာမွ အသုံး၀င္လွပါသည္။ Drawing templates ကိုအသံုးျပဳျခင္း အားျဖင့္ drawing တစ္ခုဖန္တီးတိုင္း

setting တြင္ standard ပုံစံကုိ သတ္မွတ္ေပးစရာ မလုိပဲ အခ်ိန္ကုန္ သက္သာစြာျဖင့္ drawing ကိုဖန္တီးသြားႏိုင္မည္ ျဖစ္သည္။

အဖြဲ႕အစည္း ေတာ္ေတာ္မ်ားတြင္ template drawings မ်ားဖန္တီးသည့္ CAD Managers မ်ားသီးသန္႕တစ္ေယာက္ ထားေလ့ရိွၾကျပီး၊

၎သည္ အဖြဲ႕အစည္းအတြက္ လိုအပ္ေသာ template မ်ားကို တာ၀န္ခံ ေရးဆြဲေပးရသည္။

Software တြင္ new drawing ဖန္တီးရန္အတြက္ template drawings အမ်ိဳးမ်ိဳး ပါရိွျပီးျဖစ္ေသာ္လည္း၊ မိမိတို႕ design

အတြက္လုိအပ္ေသာ template drawings မ်ားကုိ ကုိယ္ပိုင္ styles မ်ားဖန္တီးသြားႏိုင္ပါသည္။

Definition of Drawing Templates

Drawing template ဆိုသည္မွာ drawings အမ်ားစုတြင္ အသံုးျပဳေလ့ ရိွၾကသည့္ standard settings မ်ားျဖစ္ေသာ units, title

blocks, layers, text styles န႕ဲ dimension styles တုိ႕ျဖင့္စုစည္း ဖန္တီးထားေသာ အရာျဖစ္သည္။ Drawing template files ၏

extension မွာ .dwt file ျဖစ္ပါသည္။

Drawing Templates and CAD Standards

Project တစ္ခုကို Designers အေျမာက္အျမားစုစည္းျပီး ဖန္တီးၾကေသာအခါ၊ ပါ၀င္ေသာ designer မ်ားကိုယ္စီ အသုံးျပဳၾကေသာ

drawing settings မ်ားသည္ တူညီၾကမည္ မဟုတ္ေပ။ ထုိ႕ေၾကာင့္ designers မ်ားအေနျဖင့္ အသုံးျပဳရမည့္ CAD standards မ်ားကို

ညိႈႏိႈင္းဆံုးျဖတ္ႏိုင္ျပီး၊ DWT files တစ္ခုဖန္တီးျပီး မွ်ေ၀အသုံးျပဳျခင္းအားျဖင့္ တူညီေသာ drawing settings ကုိရရိွႏိုင္မည္ျဖစ္သည္။
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DWT files ဖန္တီးရန္အတြက္ လုိအပ္ေသာ drawing settings မ်ားသတ္မွတ္ေပးရမည္ ျဖစ္ျပီး၊ drawing template အျဖစ္ save

သြားရမည္ ျဖစ္သည္။ DWT files ကို drawing standard (DWS) file အျဖစ္လည္း save ႏိုင္ပါသည္။

Example of Drawing Templates

Drawing templates ၏အမ်ိဳးမ်ိဳးေသာ examples မ်ားကို ေအာက္တြင္ေဖာ္ျပေပးလုိက္ပါသည္။

An architectural template title block
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D-size title block settings ျဖင့္ drawing template

Drawing Template Options

Drawing templates မ်ားဖန္တီးေသာအခါ ေရးဆြဲေသာ drawing အေပၚတြင္မူတည္ျပီး template properties and settings

အားလုံးကုိ save ကာ new template ကိုဖန္တီးသြားႏိုင္ပါသည္။ ဖန္တီးျပီးသည့္ ေနာက္ပိုင္းတြင္လည္း Properties မ်ားကုိ လိုအပ္သလုိ

modify လုပ္ႏိုင္ပါသည္။

Template Properties and Settings

Drawing templates ကိုအသံုးျပဳ၍ new drawings မ်ားဖန္တီးစဥ္ starting point ကုိၾကိဳတင္ သတ္မွတ္ေပးႏိုင္ပါသည္။ Design

environments အမ်ားစုတြင္ မိမိတုိ႕၏ drawing ကုိသာမန္ အသံုးျပဳေလ့ရိွၾကသည့္ properties and settings မ်ားကုိသာ

အသုံးျပဳၾကပါသည္။ ထိုသုိ႕ အမ်ားဆံုး အသံုးျပဳေလ့ရိွၾကသည့္ properties and settings မ်ားျဖင့္ ဖန္တီးျပီး save ထားပါက၊ new

drawing တစ္ခုဖန္တီးတုိင္း လုိအပ္ေသာ properties and settings ကိုယူ၊ မလုိအပ္သည္ မ်ားကိုဖယ္ရွားျပီး လိုအပ္သလုိ

modify လုပ္သြားႏိုင္ပါသည္။

Drawing template တြင္ save ႏိုင္ေသာ properties and settings တစ္ခ်ိဳ႕ကို ေအာက္တြင္ ေဖာ္ျပ ေပးလုိက္ပါသည္။

 Unit settings

 Layers

 Snap, grid, and ortho mode settings

 Limits

 Dimension styles

 Text styles

 Linetypes

 Table styles

 Layouts

 Page setups for all layouts and model space

 Title blocks and borders

 Blocks

Template File Location

Drawing templates မ်ားမဖန္တီးမီတြင္ ၎တုိ႕ကို storage လုပ္ရန္ location သတ္မွတ္ေပးရပါမည္။ Options dialog box က Files

tab ကိုနိွပ္ျပီး template files မ်ား stored လုပ္မည့္ ေနရာကုိသတ္မွတ္ေပးႏိုင္ပါသည္။ By default အရ current user folder ကို



“Workgroup” AotoCAD & 3ds Max Job Training Center မွ ပညာဒါန အခမ့ဲ ျဖန္႔ေ၀သည္။

( ဤစာအုပ္ကုိ ေငြေၾကးျဖင့္ ျပန္လည္ေရာင္းခ် ခြင့္မျပဳပါ )

ေအာင္ေဇာ္လတ္ {(Master of Engineering in Science and Production Engineering) Moscow State University Of Railway Engineering}

ဘာသာျပန္ ေရးသား ျပဳစုသည္။

“Workgroup “ AutoCAD & 3ds Max Training Center, International Computer Driving Licence Approved Test Center,
Rm- 403, Excel Tower, Yangon, Myanmar.

Ph: 951 559377 Ext: 6413 or 6403, Email – infor@workgroupweb.com

392

subfolder အျဖစ္လမ္းေၾကာင္း ညႊန္းထားေပးမည္ ျဖစ္သည္။ ထုိသုိ႕ ညႊန္းေပးေသာ လမ္းေၾကာင္းမွ location သည္ drawing ကုိ

Drawing Template (*.dwt) format အတုိင္း save ေသာအခါမ်ိဳးျဖစ္ေစ၊ Template ကို select ေသာအခါမ်ိဳးျဖစ္ေစ၊ Select File

dialog boxes အျဖစ္ေပၚလာမည္ ျဖစ္သည္။

Template Options Dialog Box

Template Options dialog box ကိုအသုံးျပဳျပီး drawing units အျဖစ္ imperial or metric တစ္ခုခုကို သတ္မွတ္ ေပးျခင္း၊ template

အတြက္ ကုိယ္စားျပဳ ေဖာ္ျပခ်က္ကုိ ထည့္သြင္းျခင္း၊ new layer notification တုိ႕ကို control လုပ္ျခင္း စသည္တို႕ ျပဳလုပ္ႏိုင္ပါသည္။

Template Options dialog box ကုိ access လုပ္ရန္၊ AutoCAD Drawing Template (*.dwt) option မ်ားကို Save As dialog box

အတြင္းရိွ Files of Type list မွ select ႏိုင္ပါသည္။

Command Access

Save As

Command Line: SAVEAS

Application Menu: Save As > AutoCAD Drawing Template

Template Options dialog box ကုိေအာက္တြင္ေဖာ္ျပေပးထားပါသည္။



“Workgroup” AotoCAD & 3ds Max Job Training Center မွ ပညာဒါန အခမ့ဲ ျဖန္႔ေ၀သည္။

( ဤစာအုပ္ကုိ ေငြေၾကးျဖင့္ ျပန္လည္ေရာင္းခ် ခြင့္မျပဳပါ )

ေအာင္ေဇာ္လတ္ {(Master of Engineering in Science and Production Engineering) Moscow State University Of Railway Engineering}

ဘာသာျပန္ ေရးသား ျပဳစုသည္။

“Workgroup “ AutoCAD & 3ds Max Training Center, International Computer Driving Licence Approved Test Center,
Rm- 403, Excel Tower, Yangon, Myanmar.

Ph: 951 559377 Ext: 6413 or 6403, Email – infor@workgroupweb.com

393

Description - DWT file အတြက္ ေဖာ္ျပခ်က္ကုိ သတ္မွတ္ေပးရမည္။ အဆုိပါ ေဖာ္ျပခ်က္သည္

Create New Drawing dialog box တြင္ displayed ေပးပါလိမ္႕မည္။

Measurement - ဖန္တီးေသာ template တြင္ အသံုးျပဳမည့္ drawing ေပၚမူတညျပီး English or Metric

units ကို ဆုံးျဖတ္သတ္မွတ္ႏိုင္ပါသည္။

New Notification - DWT file တြင္အားလုံးေသာ layers မ်ားသည္ default အရ unreconciled ျဖင့္သာ save

ပါသည္။ DWT file ကို unreconciled layers ျဖင့္ template ကို save ေသာအခါတြင္

layer baseline သည္ created ျဖစ္မည္ မဟုတ္ေပ။ ထုိ႕ေၾကာင့္ new layer notification

သည္လည္း displayed မည္မဟုတ္ေပ။ Reconciled layers ျဖင့္ template ကုိ save

ေသာအခါတြင္ layer baseline သည္ created ျဖစ္မည္ျဖစ္ျပီး၊ software ကလည္း

drawing အတြင္းမွ new layers တစ္ခ်ိဳ႕ကို အသိေပး ေဖာ္ျပသြားမည္ ျဖစ္သည္။

Creating Drawing Templates
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Drawing template ကုိဖန္တီးျခင္းအားျဖင့္ drawing ဖန္တီးရာတြင္ အခ်ိန္ကုန္သက္သာေစပါသည္။ ဖန္တီးမည့္ drawing

တြင္အသုံးျပဳသြားမည့္ layers, linetypes, and dimension styles စသည့္ settings မ်ားကို သတ္မွတ္ေပးရမည္။ ဖန္တီးျပီးသား

template ကိုယူျပီး လုိအပ္သည့္ settings မ်ားျပဳျပင္ေပးျခင္းျဖင့္လည္း ျပန္လည္ အသုံးျပဳသြားႏိုင္ပါသည္။

Procedure: Creating Drawing Templates

Drawing template ဖန္တီးပုံကို ေအာက္တြင္အဆင့္ဆင့္ ေဖာ္ျပေပးထားပါသည္။

၁) Existing template ကုိအသုံးျပဳ၍လည္း new drawing ကိုဖန္တီးသြားႏိုင္ပါသည္။

၂) လုိအပ္ေသာ layers, styles, layout settings, and title blocks တုိ႕ပါ၀င္သည့္ drawing ျဖစ္ေအာင္လည္း modify

လုပ္ႏိုင္ပါသည္။

၃) အကယ္၍ လုိအပ္လွ်င္ Options dialog box မွ Drawing Template File Location ၏ path ကုိ ျပဳျပင္သြားႏိုင္ ပါသည္။

၄) Drawing ကုိ save ပါ။

၅) Template Description dialog box တြင္ description ရိုက္ထည့္ေပးျခင္း၊ measurement unit ကုိသတ္မွတ္ျခင္း ႏွင့္ new layer

notification သတ္မွတ္ေပးျခင္း စသည္တုိ႕ကို ျပဳလုပ္ပါ။

၆) အသစ္ဖန္တီးလိုက္ေသာ template ကို open ျပီး၊ မိမိတို႕ သတ္မွတ္ထားေသာ settings မ်ားပါမပါ စစ္ေဆးေပးပါ။

Exercise: Create a Drawing Template
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ဤေလ့က်င့္ခန္းတြင္ text styles, dimension styles, drawing units, layers, layouts, and a title block တို႕ပါ၀င္ေသာ template

ကိုဖန္တီး ေပးသြားရမည္ပါသည္။ Units, styles, layer properties, and page setup တုိ႕သတ္မွတ္ေပးျခင္း၊ drawing template

ဖန္တီးျခင္း၊ new template file ကို drawing ေပၚမူတည္ျပီး open ျခင္းတုိ႕ကုိ အဆင့္ဆင့္ ျပဳလုပ္သြားရမည္ ျဖစ္သည္။

The completed exercise

Set Units, Styles, Layer Properties, and Page Setup

၁) c_create_drawing_template.dwg ကုိ open ပါ။

၂) Annotate tab တြင္ရွိေသာText panel မွ Text Style ကုိ click ပါ။

 Architectural drawings ကိုဖန္တီးလွ်င္ layer settings အေနျဖင့္ AIA standards နဲ႕ကိုက္ညီမွဳ႕ရိွဖို႕ လုိအပ္ပါသည္။

လုိအပ္ေသာ layer settings ကို template တြင္ typical architectural drawings အတြက္ အသံုးျပဳႏိုင္ေသာ settings

အားလုံးကုိ သတ္မွတ္ေပး ႏိုင္ပါသည္။
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၃) Text Style dialog box တြင္ -

 Font Name list မွ Arial ကို select ပါ။

 ေျပာင္းလဲထားသည္မ်ားကုိ save ရန္ apply ကို click ပါ။

၄) Text Style dialog box မွ New ကို click ပါ။

 New Text Style dialog box တြင္ Style Name အတြက္ 3.5 Gen Notes ကိုရိုက္ထည့္ေပးပါ။

 Ok ကုိ click ပါ။

၅) Text Style dialog box တြင္ -

 Font Name list မွ Tahoma ကုိ select ပါ။

 Height အတြက္ 3.5 ကုိရိုက္ထည့္ပါ။

 ေျပာင္းလဲထားသည္မ်ားကုိ save ရန္ apply ကို click ပါ။

 Close ကုိ click ပါ။

၆) Annotate tab က Text panel တြင္ရိွေသာ Text Styles list မွ Standard ကုိ select ပါ။

၇) Annotate tab က Dimension panel တြင္ရိွေသာ Dimension Style ကုိ click ပါ။

၈) Dimension Style Manager dialog box မွ Modify ကုိ click ပါ။

၉) Modify Dimension Style dialog box တြင္ -

 Primary Units tab ေပၚတြင္ရိွေသာ Decimal Separator list မွ '.' (Period) ကုိ select ပါ။

 Text tab က Text Alignment ေအာက္တြင္ရိွေသာ ISO standard ကို click ပါ။

 Ok ကုိ click ပါ။

၁၀) Dimension Style Manager ကုိ exit ရန္ close ကို click ပါ။

၁၁) Layer Properties Manager ကို display ရန္ Home tab တြင္ရိွေသာ Layers panel မွ Layer Properties ကုိ click ပါ။
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၁၂) Layer Properties Manager တြင္ -

 New layers ဖန္တီးရန္ ေအာက္ေဖာ္ျပပါ အတုိင္း layer properties မ်ားကို assign လုပ္ပါ။

 Objects layer ကုိ current အျဖစ္ သတ္မွတ္ေပးလုိက္ပါ။

 Layer Properties Manager ကုိ close ပါ။

မွတ္ခ်က္။ ။Colors မ်ားကိုသတ္မွတ္ ေပးထားေသာ color အတုိင္းမဟုတ္ပဲ မိမိတုိ႕ႏွစ္သက္သလို သတ္မွတ္ေပး ႏိုင္ပါသည္။

၁၃) Status bar ေပၚမွ Layout1 ကုိ activate လုပ္ရန္ Layout1 ကို click ပါ။

 Predefined viewport ကို select ပါ။

 Drawing အတြင္းတစ္ေနရာတြင္ right-click ႏိွပ္ေပးပါ။ Display Viewport Objects မွ No ကုိ click ပါ။

 Application menu မွ Print > Page Setup ကို click ပါ။

၁၄) Page Setup Manager မွ New ကို click ပါ။

 New Page Setup dialog box မွ New page setup name အတြက္ A2-ePlot ကိုရုိက္ထည့္ေပးပါ။

 Ok ကုိ click ပါ။

၁၅) Page Setup - Layout1 dialog box တြင္ -

 Printer/plotter device က႕ဲသုိ႕ေသာ Name list မွ DWF6 ePlot.pc3 ကို click ပါ။
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 Paper size list မွ ISO A2 (594.00 x 420.00 MM) ကုိ select ပါ။

 Scale list မွ 1:1 ကို selected ထားျခင္း ရိွမရိွ စစ္ေဆးပါ။

 Ok ကုိ click ပါ။

၁၆) Page Setup Manager dialog box တြင္ Layout1 ကို assign လုပ္ရန္ A2-ePlot page setup ကုိ double- click ႏိွပ္ပါ။ ျပီးလွ်င္

close ကုိ click ပါ။

၁၇) ေလ့က်င့္ခန္း ေနာက္တစ္ခုကုိ ဆက္လက္လုပ္ေဆာင္ပါ (သုိ႕မဟုတ္) files အားလံုးကို မ save ပဲပိတ္လုိက္ပါ။

Create a Drawing Template

၁) Home tab က Layers panel တြင္ရိွေသာ Layers list မွ TitleBlock ကုိ select ပါ။

၂) Insert tab တြင္ရိွေသာ Block panel မွ Insert ကို click ပါ။

 Insert dialog box မွ Browse ကို click ပါ။

 Select Drawing File dialog box က A2-Title.dwg ကုိသြားပါ။

 Open ကုိ click ပါ။

 Insertion point အတြက္ 0,0 ရိုက္ထည့္ေပးျပီး၊ block insertion ကို procedure အတိုင္း ျပီးဆုံးျပဳလုပ္ေပးပါ။

 Ok ကုိ click ပါ။

၃) Extra layout ကို delete ရန္ -

 Status bar မွ Quick View Layouts ကို click ပါ။
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 Layout2 preview ကုိ Right-click နိွပ္ျပီး Delete ကုိ click ပါ။

 AutoCAD dialog box မွ OK ကုိ click ပါ။

၄) Model space ကုိ activate လုပ္ရန္ model tab ကုိ click ပါ။

၅) Home tab က Layers panel တြင္ရိွေသာ Layer list မွ Objects ကုိ select ပါ။

၆) Drawing တစ္ေနရာတြင္ right-click ႏိွပ္ျပီး option ကုိ click ပါ။

 Options dialog box က Files tab ကိုနိွပ္ျပီး expand လုပ္ကာ Template Settings > Drawing Template File Location

ကိုသြားပါ။

 Existing path ကုိ Double-click ေပးပါ။

 Folder dialog box အတြက္ Browse အတြင္းတြင္ exercise datasets မ်ား installed လုပ္ထားေသာ location

ကိုလမ္းညႊန္ေပးကာ OK ကုိ click ပါ။

 Options dialog box ကို close ရန္ OK ကုိ click ပါ။

၇) Application Menu မွ Click Save As > AutoCAD Drawing Template.

 Save Drawing As dialog box တြင္ -

 Files of Type list မွ selected ထားသည္မွာ AutoCAD Drawing Template (*.dwt) ဟုတ္မဟုတ္ စစ္ေဆးပါ။

 Options dialog box တြင္သတ္မွတ္ခ႕ဲေသာ Folder ထတဲြင္ save ထားျခင္း ဟုတ္မဟုတ္ စစ္ေဆးပါ။

 File name အတြက္ A2-Template ကို ရိုက္ထည့္ေပးပါ။

 Save ကုိ click ပါ။

၈) Template Options dialog box တြင္ ေအာက္တြင္ေဖာ္ျပ ေပးထားသည့္အတုိင္း description ကိုရိုက္ထည့္ေပးျပီး OK ကို click ပါ။
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၉) Drawings အားလုံးကုိ မ Save ပဲပိတ္လုိက္ပါ။

Open a Drawing Based on New Template File

၁) New template ကိုအသံုးျပဳျပီး new drawing ကိုစတင္ရန္ -

 Application Menu မွ, click New > Drawing.

 Select Template dialog box မွ template ကုိ select ျပီး Open ကို click ပါ။

၂) New drawing ၏ units, layers, text styles, dimension styles, Layout1 settings နဲ႕ title block စစ္ေဆးေပးပါ။

၃) Drawing တစ္ေနရာတြင္ right-click ႏိွပ္ျပီး option ကုိ click ပါ။

၄) Configuration settings မ်ားကုိ ၎တို႕၏ default settings မ်ားအတုိင္း ျဖစ္ေအာင္ ျပန္သြားပါ။ Options dialog box မွ Files tab

–

 Expand Template Settings > Drawing Template File Location.

 Existing path ကုိ Double-click ႏွိပ္ပါ။
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 Template file အတြက္ default location ျဖစ္သည့္ C:Users<user name> App\Data\ Local\Autodesk\ AutoCAD

2010R18enu\Template လမ္းေၾကာင္းအတုိင္း ညႊန္ေပးလိုက္ပါ။

မွတ္ခ်က္။ ။ AutoCAD LT® users မ်ားအတြက္ C:Users<user name>App\Data\Local\Autodesk\AutoCADLT 2010R15enu

\Template လမ္းေၾကာင္းအတိုင္း ညႊန္းေပးရပါမည္။

 Folder dialog box အတြက္ Browse မွ OK ကုိ Click ပါ။

၅) Files အားလံုးကို မ Save ပဲပိတ္လုိက္ပါ။

Chapter Summary

Drawing properties နဲ႕ အျခားေသာ settings မ်ား၏ ပုံစံတြင္ အဆုိပါ standard or guidelines တစ္ခ်ိဳ႕ အတုိင္း drawing templates

မ်ားဖန္တီးေပးရမည္။ Template ကုိအသံုးျပဳျပီး new drawing ကုိဖန္တီးပါက drawing ကုိညီညီညာညာန႕ဲ အရည္အေသြး မီွမွီ ရရိွမည္

ျဖစ္သည္။

Objectives

ဤသင္ခန္းစာကုိ ေလ့လာျခင္း ျပီးစီးသြားပါက -

 Drawing templates မ်ားဖန္တီးတတ္လာမည္။


